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Ограничения Ответственности 
Фирма Fritz Gegauf AG, BERNINA, ее разработчики, менеджеры, служащие или работники филиалов в 
соответствии с применимым законом, ни в коем случае не несут ответственности за любые последующие 
прямые или косвенные убытки (включая убытки от потери деловой прибыли, перерывов в работе, потери 
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Прекращение Действия Лицензионного Соглашения  
Ваша Лицензия на использование программного обеспечения фирмы BERNINA действительна до тех пор, 
пока Вы выполняете условия Лицензионного соглашения. Действие Лицензии завершится автоматически 
без уведомления фирмы Fritz Gegauf AG, BERNINA, если Вы будете не в состоянии выполнять любое из 
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всю сопровождающую документацию фирме Fritz Gegauf AG, BERNINA. 
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Указания по инсталляции 
 
Выпуск 2    апрель 2003 г. 
 
Настоящие указания дают важную информацию, относящуюся к установке программного пакета BERNINA 
artista software с компакт-диска. Они поэтапно объяснят Вам всю процедуру инсталляции. 
 
Системные требования 
 
Чтобы запустить программу BERNINA artista, Вы должны убедиться в том, что выполнены приводимые 
ниже обязательные системные требования. 
  
Поддерживаемые операционные системы 
◄ BERNINA artista работает в ОС Windows 98  или более поздней версии.  
◄ BERNINA artista, BERNINA artista Portfolio и BERNINA Quilter требуют Internet Explorer 6.0 или более 

поздней версии. 
 
Характеристики компьютера 
Проверьте, соответствует ли Ваш ПК системным требованиям. Проверьте центральный процессор и 
оперативную память, а также свободное пространство на жестком диске. В таблице приведены 
минимальные и рекомендованные системные требования. 
 
Аппаратные 
средства 

Минимальные требования Рекомендуется 

Центральный 
процессор 

Pentium III (500 МГц) или более 
производительный процессор 

Pentium IV или более 
производительный процессор 

Операционная 
система 

Windows 98 Windows 2000 

Подключение к 
Интернету 

Для доступа к сайту Bernina для 
регулярной информации о 
программных продуктах и обновления 

Для доступа к сайту Bernina для 
регулярной информации о 
программных продуктах и обновления 

Web-броузер Internet Explorer 6.0 Internet Explorer 6.x 

Память 128 Мб (больше, если запускается 
несколько приложений) 

256 Мб – 512 Мб для запуска 
многочисленных приложений 

Свободное 
пространство на 
жестком диске 

1 Гб перед инсталляцией 4 Гб или больше перед инсталляцией 

Графическая 
карта 

Поддержка High Color (16-bit) и 
высокая разрешающая способность – 
по меньшей мере 1024 x 768 

Поддержка High Color (16-bit) и высокая 
разрешающая способность – по 
меньшей мере 1024 x 768 

Монитор 15" при разрешении 1024 x 768  17" при разрешении 1024x768 или 
больше 

Сканер: Совместимый с Windows  Совместимый с Windows 2000 

Принтер Совместимый с Windows  Совместимый с Windows 2000 

Последовательны
е порты 

Свободный последовательный порт 
для подключения вышивальной 
машины 

Стандартный порт COM1 (с 
драйверами Win95/98) 

Параллельные 
порты 

Порты LPT требуются для аппаратного 
ключа (V3) и для принтера 

Выделенный порт для аппаратного 
ключа (V3)  

Порт USB  Выделенный порт USB Выделенный порт USB 

Мышь Последовательная или PS/2-мышь PS/2- или USB-мышь 

Дисководы для 
компакт-дисков и 
дискет 

Дисковод для компакт-дисков для 
инсталляции ПО 

Дисковод для компакт-дисков для 
инсталляции ПО 

Звуковая карта Не требуется Не требуется 
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Установочный комплект 
При приобретении установочного комплекта BERNINA artista Вы получаете следующее:  
◄ Загрузочный компакт-диск BERNINA artista  
◄ Указания по инсталляции программ BERNINA artista  
◄ Указания по поддержке программ BERNINA artista  
◄ Аппаратный ключ для USB-порта с прикрепленным ярлыком 
◄ Руководство пользователя ПО BERNINA artista, часть 1 
◄ Руководство пользователя ПО BERNINA artista, часть 2 
◄ Краткое руководство по программному обеспечению BERNINA artista  
 
Опции инсталляции 
При установке программного обеспечения версии V4.0 предлагаются следующие опции:  
◄ Инсталляция программного обеспечения 
◄ Установка программы Adobe Acrobat Reader V5.0  
◄ Обзор содержания компакт-диска 
◄ Установка программы Internet Explorer V6.0 
 
Выбор опции инсталляции программного обеспечения 
Нажмите кнопку Install Software, чтобы инсталлировать на ПК полную копию BERNINA artista. На Ваш 
выбор предоставляются опции:  
◄ в каком месте будет установлено ПО и коллекции образцов 
◄ какие компоненты будут установлены, например, онлайновое руководство 
◄ какие файлы документации будут установлены 
 
Инсталляция обновления или новой версии ПО BERNINA artista 
 
Примечание: Об обновлении старой версии см. Инсталляция BERNINA artista (обновление) на стр. 5. 
Об инсталляции ПО новыми пользователями см. Инсталляция BERNINA artista (впервые) на стр. 8. 
 
Опция установки программы Adobe Acrobat Reader  
Нажмите на кнопку этой опции, если Вы хотите обновить ранее установленную в Вашей системе версию 
Acrobat Reader. Эта программа нужна Вам для чтения, распечатки и просмотра онлайнового руководства. 
 
Примечание: Если у Вас установлена более ранняя версия, чем  Acrobat Reader V5.0, то Вам нужно 
обновить ее, руководствуясь разделом Установка Adobe Acrobat Reader. См. Установка Adobe Acrobat 
Reader на стр. 10. 
 
Опция Обзор содержания компакт-диска 
Нажмите на Browse CD, чтобы посмотреть, что содержится на Вашем установочном компакт-диске 
BERNINA artista. См. Обзор содержания установочного компакт-диска на стр. 10. 
 
Опция установки программы Internet Explorer V6.0 
Нажмите на кнопку этой опции, чтобы обновить установленную в Вашей системе версию Internet Explorer. 
Эта программа потребуется Вам для получения технической поддержки и регистрации через Интернет, а 
также для соединения с сайтом Bernina. 
Рекомендуется устанавливать Internet Explorer перед инсталляцией BERNINA artista. Если у Вас 
используется Windows 98 или Windows 98SE и Вы установите Internet Explorer после инсталляции 
BERNINA artista, то значок BERNINA artista на рабочем столе компьютера может быть заменен значком 
Internet Explorer. 
 
Примечание: Если у Вас установлена более ранняя версия, чем  Internet Explorer V6.0, то Вам нужно 
обновить ее, руководствуясь разделом Установка Internet Explorer V6.0. См. Установка Internet Explorer 
на стр. 4. 
 
Защита и аппаратные ключи 
Программное обеспечение BERNINA artista контролируется защитным устройством – аппаратным ключом 
("донглем"), подключаемым к компьютеру. Каждому аппаратному ключу присвоен уникальный номер, 
указываемый на ярлыке, прикрепленном к аппаратному ключу. При ссылке на Вашу систему при 
переписке или телефонном разговоре Вам нужно указывать номер аппаратного ключа. 



 
 
1-я сторона: уровень программного продукта и код 
2-я сторона: номер аппаратного ключа 
Аппаратный ключ и ярлык, 1-я и 2-я сторона 
 
Как и номер аппаратного ключа, каждый аппаратный ключ 
имеет уникальный серийный номер и сохраняемый 
внутри идентификационный код, так что Ваша система 
может быть однозначно идентифицирована. 
Идентификационный код может быть получен через 
программу BERNINA artista V4.0. Подробную 
информацию можно получить в пояснениях по  

                инсталляции. 
Все продаваемые программные пакеты BERNINA artista V4.0 для первичной установки или для 
обновления предыдущей версии поставляются с аппаратным ключом для порта USB. Порты USB могут 
быть расположены на передней, боковой или задней стороне компьютера. Аппаратный ключ может быть 
вставлен в любой порт USB. Если Вы не знаете, где находятся порты USB, обратитесь к руководству по 
компьютеру. 
 
Указания по деинсталляции предыдущих версий 
Если Вы обновляете свое ПО, то не удаляйте текущую версию, устанавливайте новую версию поверх 
старой. 
Никогда не удаляйте BERNINA artista вручную перед использованием функции Programs > BERNINA artista 
> Uninstall, т.е. путем выделения папок с программными файлами и нажатия клавиши Delete. Это 
относится ко всем приложениям Windows. 
За исключением особых случаев избегайте удаления программ BERNINA artista путем выбора функции 
Programs > BERNINA artista > Uninstall из меню кнопки Start/Пуск на рабочем столе Windows или 
использования Add/Remove Programs / Установка/Удаление программ из Панели управления Windows. 
Оба эти способа удаляют все файлы, относящиеся к программам BERNINA artista. Вы потеряете 
составленные Вами узорные стежки обрамления, поскольку они сохраняются в общих файлах с 
оригиналами. 
Вместо этого мы рекомендуем деинсталлировать предыдущую версию в процессе установки новой 
версии BERNINA artista в порядке обновлении программного обеспечения. Таким образом, программа 
инсталляции объединит уже выполненные пользовательские настройки с новыми установками. 
Прежде чем инсталлировать ПО BERNINA artista, сохраните все файлы и закройте все приложения. При 
инсталляции BERNINA artista Ваш компьютер перезагружается, чтобы обеспечить успешную установку 
программного обеспечения. 
 
Примечание: Если Вы удалили BERNINA artista с использованием процедуры Programs > BERNINA artista 
> Uninstaller Add/Remove Programs, процесс деинсталяции может оставить некоторые файлы в папке 
BERNINA artista. Вам требуется вручную удалить папку BERNINA artista и ее содержимое, используя 
Windows Explorer/ Проводник Windows. Если Вы не сделаете этого и установите новую версию BERNINA 
artista, то появится диалоговое окно Security Device Not Found (Аппаратный ключ не обнаружен) и новое 
программное обеспечение не будет работать. 
В зависимости от Вашей операционной системы при использовании программы деинсталляции папка My 
Designs может быть удалена. Поэтому ПЕРЕД деинсталляцией программного обеспечения нужно 
переименовать папку My Designs. 
 
Установка Internet Explorer 
Программа Microsoft® Internet Explorer V6 крайне важна для использования BERNINA artista. Она 
используется также для соединения с сайтом BERNINA для получения доступа к страницам продаж и 
информации о новых программных продуктах. 
Рекомендуется устанавливать Internet Explorer перед инсталляцией BERNINA artista. Если у Вас 
используется Windows 98 или Windows 98SE и Вы установите Internet Explorer после инсталляции 
BERNINA artista, то значок BERNINA artista на рабочем столе компьютера может быть заменен значком 
Internet Explorer. 
 
Совет: Если на Вашем компьютере уже установлен Internet Explorer, откройте его проверьте версию 
(выберите Help > About Internet Explorer...). Если это более ранняя версия, то руководствуйтесь 
приводимыми ниже указаниями по установке версии 6. 
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Как установить Internet Explorer 
1 Закройте все программы Windows, но оставьте работающей ОС Windows  
2  Вставьте в дисковод загрузочный компакт-диск BERNINA artista. Инсталляционная программа 

запустится через 30 секунд. Если этого не произойдет, то откройте Windows Explorer/ Проводник 
Windows и выберите файл instpro.exe в корневом каталоге установочного компакт-диска. Дважды 
щелкните по файлу instpro.exe, чтобы запустить процесс установки. 

 
3  Нажмите на кнопку Install Microsoft® Internet Explorer V6. 
4  Руководствуйтесь появляющимися на экране указаниями по установке Internet Explorer V6. 
 
Установка BERNINA artista (обновление) 
Если Вы являетесь владельцем предыдущей версии ПО BERNINA artista и приобрели BERNINA artista 
V4.0, то Вам требуется инсталлировать обновление BERNINA artista. 
Когда Вы обновляете свое ПО, то не удаляйте текущую версию, устанавливайте новую версию поверх 
старой. 
 
Примечание: Возможны исключения в зависимости от конфигурации Вашего компьютера. 
Опция Install Software дает возможность контролировать сохранение BERNINA artista на Вашем 
компьютере или в сети. 
Вам потребуется старый аппаратный ключ для параллельного порта и новый ключ для порта USB, 
которые нужно вставить в компьютер во время инсталляции. 
 
Примечание: Подсоединение через USB не поддерживается Windows NT. 
 
Как установить BERNINA artista (обновление) 
1 Выключите компьютер и вставьте старый аппаратный ключ в параллельный порт. 
 Внимание: Не вставляйте в порт USB новый аппаратный ключ до тех пор, пока это не будет 

потребовано установочной программой. 
2  Включите компьютер. 
3  Перед началом инсталляции закройте все программы Windows, но не закрывайте саму операционную 

систему Windows. Вы увидите на рабочем столе только пиктограммы (значки), а на панели задач 
только кнопку "Пуск". 

4  Вставьте в дисковод загрузочный к омпакт-диск BERNINA artista. Инсталляционная программа 
запустится через 30 секунд. Если этого не произойдет, то откройте Windows Explorer/ Проводник 
Windows и выберите файл instpro.exe в корневом каталоге установочного компакт-диска. Дважды 
щелкните по файлу instpro.exe, чтобы запустить процесс установки. 

 

 
5  Нажмите кнопку Install Software. 
6  Нажмите кнопку Next в окне Welcome. 
7  Нажмите кнопку Next в окне Warning (Предупреждение). 
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 Если у Вас остались открытыми другие программы, нажмите кнопку Cancel, чтобы выйти из программы 

Setup, затем закройте все открытые программы. Перезапустите программу Setup, для этого нужно 
извлечь и снова вставить в дисковод установочный компакт-диск. 

 
 8 Прочитайте Software license Agreement (Лицензионное соглашение) и нажмите Yes, если Вы согласны. 
 9 Выберите компоненты документации для установки. 

 
10  Нажмите кнопку Next. 
11 Выберите папку, в которой Вы хотите установить программное обеспечение. 
 По умолчанию BERNINA artista устанавливается в папке C:\artista.  

◄ Чтобы согласиться с предложенной по умолчанию папкой, нажмите кнопку Next.  
◄ Чтобы изменить местоположение, нажмите кнопку Browse (Обзор). Укажите существующую папку 

или создайте новую. 

 
12 Если Вы выбрали папку для установки, которая содержит прежнюю версию BERNINA artista, то 

появится окно с предупреждением. Ознакомьтесь с предупреждением и следуйте указаниям. 
13 Когда откроется диалоговое окно Choose Design location (Выбор местоположения образцов), выберите 

папку, в которой Вы хотите хранить свои образцы. 



 
 
 
 По умолчанию предлагается папка C:\My Designs. Коллекции образцов, включая входящие в версию 

V4.0, будут храниться в этой папке.  
◄ Чтобы согласиться с предложенной по умолчанию папкой, нажмите кнопку Next. 
◄ Чтобы изменить местоположение, нажмите кнопку Browse (Обзор). Укажите существующую папку 

или создайте новую.  
Если Вы согласились с предложенной по умолчанию папкой, то установленная ранее программа 
BERNINA artista будет деинсталлирована, и будет установлено новое ПО. В зависимости от Вашей 
операционной системы может появится окно со списом компонентов новой группы BERNINA artista. 
Если это окно появится, закройте его. 
 
Примечание: Ваши существующие проекты в папке C:\My Designs не удаляются и не 
перезаписываются, но старые проекты могут быть замещены новыми с тем же именем. Если у Вас есть 
проекты из старой версии, которые Вы хотите сохранить, мы рекомендуем изменить имя новой папки с 
проектами, например, C:\My Designs4. 

14 Для завершения установки следует перезапустить компьютер. Диалоговое окно Restart 
PC(Перезагрузка ПК) открывается автоматически.  

 
15 Нажмите кнопку ОК. 
 Ваш компьютер автоматически перезагрузится, и отроется диалоговое окно Security Error (Ошибка 

защиты). 
 
 Примечание: Диалоговое окно может быть несколько иным в зависимости от Вашей   
      операционной системы. 

BERNINA® artista Указания по инсталляции 
 

VI



 
16 Убедитесь в том, что старый аппаратный ключ вставлен в параллельный порт. 
17 Вставьте новый аппаратный ключ для порта USB. 
 Определите, какой порт USB Вашего компьютера будет использоваться для нового аппаратного ключа. 
 
 Примечание: Убедитесь в том, что вставлены оба аппаратных ключа. При необходимости справьтесь 

в руководстве по компьютеру.  
18 Нажмите кнопку ОК. 
 

 
Аппаратный ключ будет проверен, на этом процедура инсталляции заканчивается. Внутри аппаратного 
ключа загорится светодиод. 

 
19  Нажмите кнопку ОК. 
 

Примечание: Если старый аппаратный ключ предназначен для более высокого уровня программного 
продукта по сравнению с Вашим новым аппаратным ключом, например, Ваш старый ключ пригоден 
для программы Designer, а новый ключ – для Auto Designer, то появится соответствующее сообщение. 
Свяжитесь с Вашим дилером для получения надлежащего аппаратного ключа. 

20 Теперь можно запускать BERNINA artista. 
Программное обеспечение будет работать в соответствии с типом нового аппаратного ключа. Внутри 
аппаратного ключа загорится красный светодиод. 

 
Примечание: Если BERNINA artista не запустится, то просмотрите главу "Устранение возможных 
неисправностей" в Руководстве пользователя или обратитесь к Вашему дилеру.  
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21 После инсталляции извлеките старый аппаратный ключ из параллельного порта и выбросите его. 
 
Установка BERNINA artista (впервые) 
Если Вы являетесь новым владельцем ПО BERNINA artista, то Вам необходимо установить ПО BERNINA 
artista V4.0. 
 
Примечание: Если Вы являетесь владельцем предыдущей версии ПО BERNINA artista и приобрели 
BERNINA artista V4.0, то см. раздел Установка BERNINA artista (обновление) на стр. 5. 
Опция Install Software дает возможность контролировать сохранение BERNINA artista в Вашем 
компьютере. 
Вам нужно иметь наготове аппаратный ключ для порта USB, чтобы вставить его в компьютер во время 
инсталляции. Обождите, пока установочная программа не потребует этого. 
 
Как установить BERNINA artista (впервые) 
1  Закройте все приложения Windows, но не выходите из Windows. 
 Вы увидите на рабочем столе только пиктограммы (значки), а на панели задач только кнопку "Пуск". 
2 Вставьте в дисковод загрузочный к5омпакт-диск BERNINA artista. Инсталляционная программа 

запустится через 30 секунд. Если этого не произойдет, то откройте Windows Explorer/ Проводник 
Windows и выберите файл instpro.exe в корневом каталоге установочного компакт-диска. Дважды 
щелкните по файлу instpro.exe, чтобы запустить процесс установки. 

 
3 Нажмите кнопку Install Software. 
4  Нажмите кнопку Next в окне Welcome. 

Если у Вас остались открытыми другие программы, нажмите кнопку Cancel, чтобы выйти из программы 
Setup, затем закройте все открытые программы. Перезапустите программу Setup, для этого нужно 
извлечь и снова вставить в дисковод установочный компакт-диск. 

 

 
5  Нажмите кнопку Next. 
6  Прочитайте Software license Agreement (Лицензионное соглашение) и нажмите Yes, если Вы согласны. 
7  Выберите компоненты документации для установки. 
 



 
 
8  Выберите папку, в которой Вы хотите установить программное обеспечение. 
 По умолчанию BERNINA artista устанавливается в папке C:\artista.  

◄ Чтобы согласиться с предложенной по умолчанию папкой, нажмите кнопку Next.  
◄ Чтобы изменить местоположение, нажмите кнопку Browse (Обзор). Укажите существующую папку 

или создайте новую. 

 
9  Когда откроется диалоговое окно Choose Design Location (Выбор местоположения образцов), 

выберите папку, в которой Вы хотите хранить свои образцы. 
 

 
 По умолчанию предлагается папка C:\My Designs. Коллекции образцов, включая входящие в версию 

V4.0, будут храниться в этой папке.  
◄ Чтобы согласиться с предложенной по умолчанию папкой, нажмите кнопку Next. 
◄ Чтобы изменить местоположение, нажмите кнопку Browse (Обзор). Укажите существующую папку 

или создайте новую.  
Будет установлено новое программное обеспечение. Появится окно со списком компонентов группы 
BERNINA artista.  

10 Для завершения установки следует перезапустить компьютер. Диалоговое окно Restart PC 
(Перезагрузка ПК) открывается автоматически.  
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11  Нажмите кнопку ОК. 

Ваш компьютер автоматически перезагрузится, и отроется диалоговое окно Setup. 
 

 
 
12 Определите, какой порт USB Вашего компьютера будет использоваться для нового аппаратного ключа. 
13 Нажмите кнопку ОК. 

 
 

Аппаратный ключ будет запрограммирован, на этом процедура инсталляции заканчивается. Внутри 
аппаратного ключа загорится красный светодиод. 

 
14 Нажмите кнопку ОК. 
15 Теперь можно запускать BERNINA artista. 

Программное обеспечение будет работать в соответствии с типом аппаратного ключа. 
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Примечание: Если BERNINA artista не запустится, то просмотрите главу "Устранение возможных 
неисправностей" в Руководстве пользователя или обратитесь к Вашему дилеру.  

 
Установка программы Acrobat Reader 
Программа Adobe Acrobat Reader требуется для чтения, поиска по тексту и распечатки онлайновой 
документации, предоставляемой в формате PDF. 
 
Совет: Если на Вашем компьютере уже установлен Acrobat Reader, откройте его проверьте версию 
(выберите Help > About Acrobat Reader ...). Если это более ранняя версия, то руководствуйтесь 
приводимыми ниже указаниями по установке версии 5. 
 
Как установить программу Acrobat Reader 
1 Закройте все программы Windows, но оставьте работающей ОС Windows  
2  Вставьте в дисковод загрузочный компакт-диск BERNINA artista. Инсталляционная программа 

запустится через 30 секунд. Если этого не произойдет, то откройте Windows Explorer (Проводник 
Windows) и выберите файл instpro.exe в корневом каталоге установочного компакт-диска. Дважды 
щелкните по файлу instpro.exe, чтобы запустить процесс установки. 

 
3 Нажмите кнопку Install Acrobat Reader. 
4  Руководствуйтесь появляющимися на экране указаниями по установке Acrobat Reader 5.0. 
 
Обзор содержания установочного компакт-диска 
Опция Browse CD позволяет, используя Windows Explorer, просмотреть содержание компакт-диска 
BERNINA artista. 
 
Совет: Используйте эту возможность для поиска и открытия онлайновой документации, которая не 
установлена на Вашем ПК. 
 
 
Как просмотреть содержание установочного компакт-диска 
1 Закройте все программы Windows, но оставьте работающей ОС Windows  
2  Вставьте в дисковод загрузочный компакт-диск BERNINA artista. Инсталляционная программа 

запустится через 30 секунд. Если этого не произойдет, то откройте Windows Explorer (Проводник 
Windows) и выберите файл instpro.exe в корневом каталоге установочного компакт-диска. Дважды 
щелкните по файлу instpro.exe, чтобы запустить процесс установки. 

 

 
3  Нажните кнопку Browse CD. 
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4  Ознакомьтесь с содержанием компакт-диска, используя открывшийся Windows Explorer. 
 
Онлайновая документация 
Электронные копии User Manual (Руководства пользователя), Quilter Manual (Руководства по квилтингу)  
и Quick Reference Guides (Краткие руководства), входящие в состав ПО BERNINA artista V4.0 требуют 
для просмотра и/или распечатки программы Adobe Acrobat Reader. 
 
Примечание: BERNINA artista V4.0 не устанавливает программу Acrobat Reader автоматически. См. 
Установка Adobe Acrobat Reader на стр. 10. 
 
Чтение онлайноавого руководства BERNINA artista 
Доступ к онлайновому руководства BERNINA artista можно получить через главное меню Help. Это 
руководство включает в себя краткие руководства и клавиатурные команды для BERNINA artista, программ 
Cross Stitch и Portfolio. 
 
Как читать онлайновое руководство BERNINA artista  
1 Откройте BERNINA artista, затем выберите из строки главного меню опцию Help. 
2  Выберите документ из открывшегося списка. 
 
Примечание: Если документ не открывается, Вам потребуется установить программу Adobe Acrobat 
Reader. См. Установка Adobe Acrobat Reader на стр. 10. 
 
Чтение онлайнового руководства BERNINA Quilter 
Все онлайновые руководства Bernina сохраняются в папке C:\artista\BIN folder. Для доступа к онлайновому 
руководству BERNINA Quilter и отдельному краткому руководству Quick Reference Guide следует 
воспользоваться Проводником Windows (Windows Explorer). Руководство BERNINA Quilter включает в себя 
краткое руководство. Это руководство включает в себя краткие руководства и клавиатурные команды для 
BERNINA artista, программ Cross Stitch, BERNINA Quilter и Portfolio. 
 
Как читать онлайновое руководство BERNINA Quilter  
1 Запустите программу Windows Explorer (Проводник Windows). 
2  Откройте папку C:\artista\BIN. 
3 Выберите и откройте PDF-документ, который Вам нужен:  

◄ quilter.pdf: для руководства BERNINA Quilter  
◄ qrg__enu.pdf: для кратких руководств  
◄ man_enu.pdf: для руководства BERNINA artista  

 
Примечание: Если документ не открывается, Вам потребуется установить программу Adobe Acrobat 
Reader. См. Установка Adobe Acrobat Reader на стр. 10. 



Глава 1: Введение 
 

Глава 1 
 
 
 
 
Введение 
 
Приглашаем Вас ознакомиться с программным обеспечением BERNINA 
artista – ведущим программным продуктом для домашнего машинного 
вышивания. Программное обеспечение BERNINA artista является 
программным продуктом, основанным на операционной системе Windows, 
поэтому в нем используются многие команды, с которыми хорошо знакомо 
большинство пользователей персональных компьютеров. 
 
 
Первичным пользователям 
 
Если Вы впервые приобрели ПО BERNINA artista, то Вам очень понравятся гибкие возможности 
оцифровывания изображений и легкость, с которой Вы сможете создавать и редактировать образцы вышивки и 
простота, с которой можно добавлять или создавать свои собственные тексты. Однако прежде чем Вы начнете 
работать с программами, нужно прочитать главу Оцифровывание проектов вышивки. В этой главе представлен 
обзор основных концепций оцифровывания функциями BERNINA artista и даются важные указания по 
использованию программы для получения наилучших результатов. 
Вы должны также ознакомиться с главой Основные процедуры. Здесь Вы узнаете, как запускать приложение, 
создавать или открывать проект, распечатывать рисунки вышивок и как использовать некоторые наиболее 
важные инструментальные средства и возможности, которые обеспечивает BERNINA artista. Глава Просмотр 
проектов ознакомит Вас со способами просмотра проектов в режиме просмотра BERNINA artista. 
 
 
Пользователям, обновляющим программное обеспечение 
 
BERNINA artista является в значительной мере усовершенствованной версией установленного у Вас 
программного продукта. В ней предусмотрено много новых и расширенных функциональных возможностей, 
которые облегчают и делают более эффективными операции оцифровывания.  В настоящем руководстве 
поэтапно приводятся указания, поясняющие, как можно воспользоваться этими новыми свойствами. Поскольку 
многие из методов оцифровывания усовершенствованы, ознакомьтесь с главой Оцифровывание проектов 
вышивки, чтобы быстро ознакомиться со всеми модификациями. 
Доступ к программному обеспечению BERNINA artista контролируется защитным устройством – аппаратным 
ключом ("донглем"), подключаемым к компьютеру. Обновление может быть легко проведено путем ввода 
нового кода доступа или заменой наружного аппаратного ключа ("донгла"). Подробнее см. в разделе Ввод кодов 
защиты. Программное обеспечение теперь обладает улученной защитой с использованием новых аппаратных 
ключей. 
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Уровни программного продукта BERNINA artista  
 
Ниже описываются уровни программного продукта BERNINA artista: 
 
Editor 
 
Программа BERNINA artista Editor дает возможность редактировать существующие проекты и добавлять 
надписи. С этой системой можно: 
◄ Изменять проекты или комбинировать различные проекты. 
◄ Масштабировать и изменять форму своих проектов. 
◄ Добавлять надписи к любому проекту. На выбор предлагается большой набор алфавитов для вышивания. 
◄ Редактировать индивидуальные стежки для точной настройки обработки мотива. 
◄ Изменение последовательности цветов для улучшения качества вышивки. 
 
 
Auto Designer 
 
Программа BERNINA artista Auto Designer позволяет создавать привлекательные вышивки с минимумом усилий 
по отсканированным рисункам. Она обладает всеми свойствами, требуемыми для редактирования проектов и 
создания текстов, программы BERNINA artista Editor плюс мощными средствами автоматического 
оцифровывания, такими как Auto Digitizer, Magic Wand и PhotoSnap. С этой системой можно: 
◄ Использовать отсканированные или импортированные изображения для оцифровывания проектов на 

экране монитора. 
◄ Использовать функцию Auto Digitizer для автоматического создания привлекательных проектов вышивки по 

отсканированным оригиналам. 
◄ Если Вы хотите лучше контролировать создание проекта, используйте Magic Wand ("Волшебную палочку") 

для преобразования рисунка в вышивку в диалоговом режиме. 
◄ Использовать функцию PhotoSnap, чтобы преобразовать фотографию в строчечную вышивку.  
 
 
Designer Plus 
 
Программа Designer Plus является программным продуктом высшего уровня, позволяющим оцифровывание, 
редактирование и создание надписей с использованием как автоматических, так и ручных инструментальных 
средств и способов оцифровывания. С этой системой можно: 
◄ Использовать отсканированные или импортированные изображения для оцифровывания проектов на 

экране монитора. 
◄ В дополнение к автоматическим средствам оцифровывания можно использовать специализированные 

инструменты оцифровывания, а также большой набор художественных декоративных узоров заполнения. 
◄ Создать аппликации функцией Auto Appliqué. 
◄ Преобразовывать любой шрифт Windows TrueType в вышивальный алфавит. 
◄ Сохранять все предпочитаемые настройки на файле шаблона. 
 
Внимание: Уровни программного продукта и опции дополнительных возможностей контролируются 
аппаратным ключом. Это устройство является наиболее важной и ценной частью Вашей системы, и с ней нужно 
обращаться осторожно. 
 
 

Документация BERNINA artista  
Документация BERNINA artista включает в себя: 
◄ Руководство пользователя 
◄ Онлайновая справка 
◄ Краткое руководство 
◄ Указания по поддержке 
◄ Указания по инсталляции 
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Руководство пользователя 
 
Руководство пользователя имеется как в виде отпечатанного в типографии документа, так и в онлайновом виде. 
Онлайновая версия доступна из меню Help. В печатном руководстве содержатся сотни указаний по поэтапному 
выполнению команд, а также иллюстраций и экранных изображений, воспроизводимых программным 
обеспечением, чтобы наиболее продуктивно ознакомить Вас с процессом оцифровывания. 
Поскольку Вы можете выбирать из нескольких уровней программного продукта BERNINA artista, а также 
добавлять опции по мере возрастания интереса, со всем этим Вам нужно ознакомиться в этом руководстве. 
В первых четырех главах настоящего руководства (включая эту главу) содержится общая информация, которая 
должна быть интересной для всех читателей. 
 
Онлайновая справка 
Онлайновая справочная система доступна из меню Help программ BERNINA artista. 
 
Краткое руководство 
В Кратком руководстве перечислены все клавиатурные команды программ BERNINA artista. Это руководство 
можно постоянно хранить около компьютера, чтобы при необходимости получать справки. Вы можете также 
найти список этих клавиатурных команд в главе Клавиатурные команды BERNINA artista. 
 
Указания по инсталляции 
В Указаниях по инсталляции поясняется, как устанавливается BERNINA artista на компьютере. 
 
Указания по поддержке 
Онлайновые Указания по поддержке – это новая и улучшенная функция текущей версии ПО вместе с 
определенными ограничениями. 
 

Условные, обозначения принятые в Руководстве 
В тексте руководства приняты следующие условные обозначения. 
 
Команды 
В этом руководстве команды меню или подменю указываются со ссылками на имена меню и команды. 
Например, команда ‘Show All’ (‘Показать Все’) из меню ‘View’ (‘Вид’) указывается как View > Show All. 
 
Диалоговые окна 
Диалоговые окна показываются в руководстве только в том случае, когда в них отображена важная информация 
для использования BERNINA artista. Экранные иллюстрации дают лишь примерное представление и не 
являются точными копиями экранных изображений, воспроизводимых программным обеспечением. 
 
Команды для действий мышью: 
 
Указание Символ Действие 
Щелчок мышью 

 

Щелкнуть левой кнопкой мыши 

Щелчок правой 
кнопкой мыши  

Щелкнуть правой кнопкой мыши 

Двойной щелчок 
 

Дважды щелкнуть кнопкой, не перемещая мышь 

Нажать кнопку 
ОК или  

Щелкнуть мышью на кнопке OK диалогового окна или 
нажать клавишу Enter клавиатуры, чтобы завершить 
действие. 

 
Комбинация 
клавиш 

Описание 

Ctrl + S  Удерживая нажатой клавишу CTRL, нажать клавишу буквы "S" в нижнем регистре 
Ctrl + SHIFT + H  Удерживая нажатой клавишу CTRL, нажать клавишу SHIFT и клавишу буквы "Н". 
 
Полный перечень клавиатурных команд приводится в Кратком руководстве 
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Часть I 

Основы 
 
 
 

Глава 2  
 
Оцифровывание проектов вышивки 
 
 
 
BERNINA artista предоставляет возможность быстрым и 
гибким образом создавать и редактировать вышивальные 
проекты. В этом разделе дается обзор процесса 
оцифровывания мотивов вышивки, используемого в 
BERNINA artista. 
Процесс оцифровывания мотивов вышивки может состоять 
из некоторых или всех перечисленных ниже этапов: 
◄ проектирование мотивов 
◄ оцифровывание мотивов 
◄ изменение мотивов 
◄ улучшение качества мотива 
◄ добавление текста 
◄ вышивание мотивов 
 

Проектирование мотивов 
Для создания высококачественной вышивки вам нужно выбрать подходящий рисунок в качестве оригинала 
для оцифровывания. До тех пор, пока вы не станете достаточно опытным пользователем, не используйте 
сложные образцы. Изображения, имеющиеся в нецифровом формате, требуют сканирования. Возможными 
источниками для получения хороших изображений для вышивки являются: 
◄ книги 
◄ Интернет или компакт-диски с графическими файлами 
◄ оригинальные рисунки 
 
Хорошее качество вышивки 
Хорошее качество вышивки должно быть заложено еще на стадии проектирования. Вам нужна хорошая 
машина для вышивания. Но этого недостаточно, если вы не будете использовать надлежащие материалы, 
нитки, прокладки и т.п. Придерживайтесь следующих положений при проектировании мотива вышивки: 
◄ мотив выглядит красиво – по форме, цвету, балансу 
◄ стежки четкие, гладкие и ровные 
◄ контуры правильно заполнены подходящими стежками. 
◄ направление стежков соответствует контурам 
◄ контуры вышиты правильно – без неожиданных пробелов 
◄ детали четко определены 
◄ надписи четкие и легко читаются 
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мотив выглядит красиво – по форме, цвету, балансу 
 

направление стежков соответствует контурам 
 

контуры вышиты правильно – без неожиданных пробелов 
 

надписи четкие и легко читаются 
 

детали четко определены 
 

стежки четкие, гладкие и ровные 
 

контуры правильно заполнены подходящими стежками. 
 
 
 
Вышитый мотив должен также обладать следующими характеристиками: 
◄ Мотив безупречно вышит машиной. 
◄ Ткань не должна сморщиваться вокруг зоны вышивки. 
◄ Мотив не должен иметь рыхлых концов. 
 
Подготовка к оцифровыванию 
Прежде чем приступить к оцифровыванию, необходимо проанализировать и тщательно спроектировать 
контуры и последовательность вышивания. 
Контуры вышивания должны быть тщательно определены, чтобы их можно было проще вышить. Наиболее 
простые для вышивания контуры имеют относительно постоянную ширину, сглаженные кромки, без резких 
изгибов и мелких выступающих деталей. 
 

 
Упрощение контура изображения до или во время оцифровывания 
 
Последовательность оцифровывания 
Последовательность оцифровывания определяет порядок в котором создаются объекты вышивки и в 
котором они будут вышиваться. Вы можете изменить последовательность вышивания объектов в проекте, 
чтобы облегчить вышивания, например, свести к минимуму число переходов от одного цвета к другому. 
Детали необходимо вышивать в последнюю очередь. Подробнее см. в разделе Изменение 
последовательности вышивания объектов. 
 
последняя деталь 
 
 
 
 
Типы стежков 
Примите решение, какого типа стежки вы хотите использовать для каждого контура проекта. Если вы в 
нормальном случае определите тип стежка перед оцифровыванием каждого контура, BERNINA artista 
позволит вам внести изменения на любой стадии. Подробнее см. в разделе Оконтуривающие и 
заполняющие стежки. 
 

          
  Заполняющие стежки  Оконтуривающие стежки 
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Оцифровывание мотивов 
Процесс оцифровывания позволяет вам создавать проекты вышивки по основным контурами. Для создания 
различных контуров имеются различные инструментальные средства. При ручном оцифровывании 
отмечаются базисные точки по очертанию контура, при использовании автоматических инструментов 
контуры создаются автоматически. 
 
Проекты, создаваемые BERNINA artista, составляются из вышивальных "объектов", обладающих 
собственным уникальным набором "свойств". Наиболее важным свойством объекта вышивки является тип 
стежка. 
Во время создания проекта вы можете видеть проект в различных режимах. 
 
◄ Режим Design: открытие, оцифровывание и редактирование всех ваших проектов. 
◄ Режим Artistic View (Художественный Просмотр): изображение проекта примерно в том виде, в каком он 

будет выглядеть после вышиванию 
 
Подробнее см. в разделе Режимы просмотра BERNINA artista . 
 
 
Увеличьте изображение на экране, чтобы 
рассмотреть индивидуальные стежки и отдельные 
детали, просмотрите мотив в фактическом 
размере или уменьшите изображение, чтобы 
увидеть весь проект. См. Увеличение и 
уменьшение изображения. 
 

    Режим Picture      Режим Design:      Режим Artistic View  
 
Используйте линии сетки и изображение пялец, чтобы точно совместить или установить требуемые 
размеры объекта вышивки. Вы можете показывать и скрывать сетку и пяльцы.  Имеются пяльцы нескольких 
размеров, чтобы правильно выбрать размеры проекта. 
См. Отображение сетки и Отображение пялец. 
При работе с проектами вышивки вам необходимо разобраться с последовательностью вышивания. Вы 
можете проверить последовательность вышивания проекта путем ‘обхода’ по стежкам, цветам или 
объектам. Вы можете также проверить последовательность медленным перерисовыванием проекта на 
экране. Подробнее см. в разделе Просмотр последовательности вышивания. 
 
Инструменты оцифровывания 
В зависимости от нужной вам формы и вида вышивания используются различные инструменты для ввода 
"базисных точек", а именно: Open Curve (Незамкнутая кривая), Closed Curve (Замкнутая кривая), Block 
Digitizing (Оцифровывание блока), Circle/Oval (Окружность/Овал) или Rectangle (Прямоугольник). 
 
 
Open curve (Незамкнутая кривая)  
Используйте инструмент Open Curve для оцифровывания линий, которые не имеют 
формы замкнутой кривой. С этим инструментом можно использовать только 
Оконтуривающий стежок (Outline stitch). Подробнее см. в разделе Оцифровывание 
открытых контуров. 
 
Closed curve (Замкнутая кривая) 
Используйте инструмент Closed Curve для оцифровывания линий, которые имеют 
форму замкнутой кривой. С этим инструментом можно использовать Оконтуривающий 
стежок (Outline stitch) или Заполняющий стежок (Fill stitch). Подробнее см. в разделе 
Оцифровывание замкнутых контуров. 
 

Block Digitizing (Оцифровывание блока)  
Используйте инструмент Block Digitizing для оцифровывания колонок с изменяющейся 
шириной и углом вышивания. Оцифрованные пары базисных точек определяют контур, а 
линии, соединяющие эти пары определяют углы вышивания. См. также раздел 
Оцифровывание колонок с изменяющейся шириной. 
 
Окружности 
Используйте инструмент Circle/Oval (Окружность/Овал) для оцифровывания 
окружностей. С этим инструментом можно использовать Оконтуривающий стежок 
(Outline stitch) или Заполняющий стежок (Fill stitch). Подробнее см. в разделе 
Оцифровывание окружностей и овалов. 
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Прямоугольники 
Используйте инструмент Rectangle (Прямоугольник) для оцифровывания квадратов и 
прямоугольников. С этим инструментом можно использовать Оконтуривающий стежок 
(Outline stitch) или Заполняющий стежок (Fill stitch). Подробнее см. в разделе 
Оцифровывание квадратов и прямоугольников. 
 
Оконтуривающие и заполняющие стежки 
 
Программа BERNINA artista предусматривает возможность использования двух типов стежков: 
оконтуривающих и заполняющих. Тип оконтуривающего или заполняющего стежка зависит от: 
 
◄ формы – является ли она простой или сложной?  
◄ размера – насколько большим или малым является контур? 
◄ внешнего вида – какой эффект вы желаете создать? 
 
Оконтуривающий стежок используется для простых линий, контуров или бордюров. Заполняющий стежок 
используется для заполнения контуров в проекте. Подробнее см. в разделе Оконтуривающие и 
заполняющие стежки. 
 
Одинарный и тройной контур 
Одинарный оконтуривающий стежок используется для тонких линий и оконтуривания 
формы. Тройной оконтуривающий стежок используется для создания более широкой 
контурной линии. Подробнее см. в разделе Создание контуров одинарными или 
тройными оконтуривающими стежками, 

 
Оконтуривание стежком гладьевого валика  
Стежок гладьевого валика используется для широких бордюров или контурных линий. 
Подробнее см. в разделе Создание контура стежком гладьевого валика. 
 
Оконтуриванние краеобметочным стежком 
Краеобметочный стежок широко используется для приметывания аппликаций в качестве 
колонки вокруг края. Стежки образуют гребенчатый узор. Подробнее см. в разделе 
Создание контура краеобметочным стежком. 
 
 

Оконтуривание узорным стежком 
Узорный стежок используется для создания декоративных краев или оконтуривающих 
линий. Подробнее см. в разделе Выбор и вставка цепочки узоров. 
 
 
Обрамление в технике Blackwork  
 
Вышивание в технике Blackwork являлось традиционной техникой ручного вышивания с 
использованием черных шелковых ниток на белой льняной ткани. Эта техника может быть 
использована для декорирования предметов одежды или украшения, например, носовых 
платков, скатертей и салфеток. Подробнее см. в разделе Настройка контуров обрамления 
в технике Blackwork . 
 
Стежок "назад в иголку" 
 
Стежок "назад в иголку" (Backstitch) является старым легко приспосабливаемым стежком, 
который может быть использован для изысканного оконтуривания. Строчка этого стежка 
хорошо вписывается в замысловатые кривые, если стежки небольшие и ровные, так что они 
точно располагаются на очертании кривой. Стежок "назад в иголку" может быть использован 
для проектов "красной" вышивки. Подробнее см. в разделе Настройка оконтуривающих 
стежков "назад в иголку". 
 
 
Стебельчатый стежок 
 
Стебельчатый стежок (Stem stitch) является детализированным стежком, который может 
быть использован для оконтуривания. Он используется для вышивки стеблей и 
виноградной лозы вместе с другими декоративными стежками или в качестве 
оконтуривающих стежков совместно с гладьевыми заполняющими стежками. Подробнее 
см. в разделе Настройка оконтуривания стебельчатым стежком. 
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Обрамление строчкой Candlewicking  
 
Стежок для узелкового обрамления (Candlewicking Border) может быть использован для 
оконтуривания участков проекта вышивки. Подробнее см. в разделе Настройка контуров 
обрамления в технике Candlewicking . 
 
 
Гладьевый заполняющий стежок 
 
Гладьевый стежок хорошо подходит для заполнения узких форм. Гладьевый стежок 
создает высококачественный глянцевитый эффект. Специальный гладьевый стежок 
применяется в основном для заполнения контуров, слишком широких для 
использования обычного гладьевого стежка. Подробнее см. в разделе Создание 
заполнения гладьевым стежком. 
 
 
Заполнение простегивающим стежком 
 
Заполнение простегивающими стежками (Step Fill) подходит для крупных контуров с 
нерегулярными очертаниями, при этом получают заполнение, имеющее сплошной 
внешний вид. BERNINA artista предлагает разнообразные простегивающие стежки, 
которые создают текстуру и повышает привлекательность проектов вышивки. Подробнее 
см. в разделе Создание заполнения простегивающим стежком. 
 
Заполнение орнаментными стежками 
 
Заполнение орнаментными стежками (Fancy Fill) аналогично заполнению 
простегивающими стежками. BERNINA artista предлагает разнообразные возможности 
создания красивого творческого заполнения. Подробнее см. в разделе Создание 
заполнения орнаментным стежком. 
 
Заполнение стежками в технике Blackwork  
 
Техника "блэкуорк" (Blackwork) получила свое название от черных шелковых ниток, 
используемых в этом виде вышивания. В большинстве случаев при таком "черно-белом" 
заполнении используются простые стежки для создания комплексных геометрических 
узоров. При использовании различных узоров заполнения "блэкуорк" вы можете 
создавать светлые и темные тона участков проекта. Заполнение черными узорами 
применимо только для объектов в виде замкнутых кривых или прямоугольников. 
Подробнее см. в разделе Настройка заполнения в технике Blackwork. 
 
 
Заполнение строчками в технике Candlewicking  
 
Вышивание узелковыми строчками (Candlewicking) является традиционной техникой 
вышивания "белым-по-белому", выполняемому обычно на белой льняной или 
хлопчатобумажной ткани толстыми хлопчатобумажными нитками. Сегодня более 
популярно использование цветных ниток. Применяются в основном стежки, 
образующие узелки, - "колониальные" и "французские", а также стебельчатый стежок. 
Эта техника может использоваться для вышивания на постельных покрывалах, наволочках и одежде. 
Заполнение узелковыми строчками применимо только для объектов в виде замкнутых кривых или 
прямоугольников. Подробнее см. в разделе Настройка заполнения строчками а технике Candlewicking. 
 
Кружевное переплетение (Lacework)  
Стежки кружевного переплетения образуют похожие на сетку узоры, которые придают 
объекту вид кружева.  Заполнение стежками кружевного переплетения применимо 
только для объектов в виде замкнутых кривых или прямоугольников. С таким 
заполнением вы можете подогнать компоновку стежков к заданным узорам. 
Используйте тот же метод, что и при узорном заполнении. Подробнее см. в разделе 
Настройка заполнения стежками кружевного переплетения. 
 
Пунктирное заполнение (Stippling Fill)  
 
Пунктирные стежки позволяют заполнять объекты извилистыми линиями в пределах 
контура. Этот метод применим для объектов в виде замкнутых кривых или 
прямоугольников. Вы можете регулировать плотность стежков и расстояние между 
строчками. Подробнее см. в разделе Настройка пунктирного заполнения. 
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Свойства объекта и шаблоны 
 
Когда вы начинаете новый проект, BERNINA artista использует установки по умолчанию или "значения", 
сохраняемые в шаблоне. В большинстве проектов используется "нормальный" шаблон, но вы можете 
создать собственный шаблон. Подробнее см. в разделе Создание шаблонов проекта. 
 
 
Цвета ниток и таблицы ниток 
 
Вам нужно решить сколько различных цветных ниток будет использовано и в какой последовательности 
будут вышиваться цветные фрагменты. Когда вы оцифровываете объект, вы выбираете цвета ниток из 
палитры цветов. Если это возможно, упростите проект, чтобы уменьшить количество замены цветов. 
Подробнее см. в разделе Цвета ниток и таблицы ниток. 
BERNINA artista дает возможность выбирать цвет фона в окне 
проекта, чтобы согласовать его с цветом вашей ткани. Или же 
можно выбрать фон ткани для более реалистичного вида и 
воспроизведения. Подробнее см. в разделе Изменение 
цветов фона или ткани. 
 
 

желтый фон      фон джинсовой ткани, 
 
 
Оцифровывание по художественному оригиналу 
 
Для создания высококачественной вышивки вам нужно 
выбрать подходящий рисунок в качестве оригинала для 
оцифровывания. Вы можете отображать оригинал во 
время оцифровывания или временно скрыть его. 
Подробнее см. в разделе Оцифровывание с 
оригиналом. 
 
 
 

 
          оригинальный рисунок       вычерчены требуемые части 

 
Рисунок не в цифровом формате должен быть 
правильно отсканирован, чтобы получить 
изображение хорошего качества. Подробнее см. в 
разделе Сканирование изображения в программу 
BERNINA artista. 
Вам может потребоваться также "очистить" 
сложные изображение в графической программе 
перед тем, как передавать их в BERNINA artista. 
Подробнее см. в разделе Редактирование 
изображений в пакете графических программ. 

 
Автоматическое оцифровывание 
 
Перед использованием изображения для автоматического оцифровывания вам нужно подготовить его с 
применением соответствующих инструментов BERNINA artista. Подробнее см. в разделе Обработка 
изображений для автоматического оцифровывания.  

 
изображение до уменьшения изображение после уменьшения количества цветов 
количества цветов 

 
С вашим рисунком, вставленным в окно проекта в качестве оригинала, вы можете использовать средства 
автоматического оцифровывания: Magic Wand, Auto Digitizer или PhotoSnap. 
Автоматическое оцифровывание контуров производится функцией Magic Wand (Волшебная палочка).  
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Подробнее см. в разделе Автоматическое оцифровывание 
контуров функцией Magic Wand. 

 
 
 
 
 
 
 
 
Автоматическое оцифровывание сложных рисунков 
производится функцией Auto Digitizer. Подробнее см. в 
разделе Оцифровывание функцией Auto Digitizer.  
 
 
 
 
 
 
 
 
Оцифровывание фотографий производится функцией 
PhotoSnap. Подробнее см. в разделе Оцифровывание 
фотографий функцией PhotoSnap. 
 
 
 

Изменение проектов 
 
При оцифровывании проекта вы можете изменять его в целом, редактировать 
индивидуальные объекты или даже индивидуальные стежки.  
Вы можете комбинировать проекты, вставляя один файл в другой. Подробнее см. в 
разделе Комбинирование объектов. 
Объекты проекта связываются соединительными стежками. Подробнее см. в 
разделе Соединение объектов вышивки. 
Последовательность вышивания обычно определяется порядком оцифровывания 
проекта. Однако имеется много способов изменения последовательности 
вышивания. Подробнее см. в разделе Изменение последовательности вышивания 
объектов.  
Функция Color Film выводит на экран последовательность вышивания объектов, сгруппированных по цвету. 
Она дает возможность группировать, вырезать, копировать и вставлять, а также изменять 
последовательность цветных блоков. Подробнее см. в разделе Выбор цветных блоков и обращение с ними. 
 
 
Расположение и трансформация объектов 
 
Вы можете изменять положение, размер и ориентацию объектов в проекте путем их 
перемещения, изменения размеров и трансформации. Объедините объекты в группу, 
чтобы выполнить их изменение одной командой. Вы можете также создать 
многократные копии в форме венка, используя функцию Mirror Merge. Подробнее см. в 
разделе Расположение и трансформация объектов. 

 
уменьшение на 20 %    оригинальный размер  увеличение на 20 % 
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Изменение формы объектов 
 
BERNINA artista позволяет изменять форму объектов, используя контрольные точки. Подробнее см. в 
разделе Изменение формы объектов. Для объектов с заполнением вы можете устанавливать угол наклона 
стежков для всего объекта или задавать сложные углы наклона, используя инструмент Stitch Angles (Углы 
наклона стежков). Подробнее см. в разделе Подгонка углов наклона стежков. 
 

                   
объект с углом наклона стежков 90°   сложные углы наклона стежков 
 
Редактирование стежков 
 
Вы можете использовать функцию Stitch Edit (Редактирование стежка) для выбора 
стежков. Вы можете перемещать индивидуальные и многократно повторяющиеся 
стежки. Вы можете добавлять стежки для заполнения пробелов и удалять стежки. 
Подробнее см. в разделе Редактирование стежков. 

Улучшение качества проекта 
 
Вышивальные стежки втягивают ткань внутрь во время прокола иглой. Это может 
вызвать сморщивание ткани и образование пробелов в вышивке. Используйте 
стабилизирующие стежки и компенсацию стягивания для получения гладкого, 
ровного расположения стежков и устранения пробелов в проекте. Подробнее см. в 
разделе Улучшение качества стежка. 
Большие площади и растягивающиеся материалы, такие как трикотаж и пике, 
требуют больше стабилизирующих стежков, чем малые площади и плотные 
материалы, такие как тик или кожа. Подробнее см. в разделе Регулировка настроек 
ткани. 
 
Добавление аппликации 
 
Вы можете автоматически создавать все вышивки, которые вам нужны для 
аппликаций, используя функцию Auto Appliqué. Подробнее см. в разделе 
Создание объектов аппликации с использованием функции Auto Appliquéé. 
Вы можете создавать объекты аппликации с частичным покрытием вышивкой для 
создания эффекта нахлестки без дублирования обрамления. Важно тщательно 
заблаговременно спланировать ваш проект, чтобы вы знали, где нужны и где не 
нужны аппликационные покрывающие стежки. Подробнее см. в разделе Создание частичного покрытия 
объектов аппликации. 
 
 
Эффекты художественного вышивания 
 
Вы можете создавать в BERNINA artista многочисленные эффекты художественного 
вышивания. 
 
Текстурированный край 
 
Используйте функцию Textured Edge (Текстурированный край) для создания теневых 
эффектов или для имитации меха или других пушистых структур в вашем проекте. Подробнее 
см. в разделе Создание текстурированных краев. 
 
Эффект волнистости 
 
Эффект волнистости (Wave Effect) является функцией, позволяющей искривлять линии 
строчек стежков заполнения. Стежки следуют оцифрованной линии, но сохраняют 
однородную плотность и порядок проколов иглой материала. 
Эффект волнистости может быть применен к объектам замкнутой кривой с использованием 
простегивающих или орнаментных стежков заполнения. Для применения этого эффекта к 
новым объектам замкнутой кривой выберите функцию Wave Effect перед оцифровыванием. 
Подробнее см. в разделе Создание эффекта волнистости. 
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Заполнение с плавным тоновым переходом  
 
Функция Gradient Fill (Заполнение с плавным тоновым переходом) изменяет 
плотность рядов строчек заполнения от весьма плотного до весьма редкого, создавая 
теневые и цветовые эффекты, которые трудно было бы получить вручную. 
Подробнее см. в разделе Создание заполнения с плавным тоновым переходом. 
 
 
Перемещение по краям 
 
Эффект Travel on Edges (Перемещение по краям) создает очень открытое заполнение, 
часто используемое в качестве фона или для заполнения крупных контуров. 
Используйте эту функцию совместно с эффектом Заполнения с плавным тоновым 
переходом. чтобы избежать выполнения соединительных стежков внутри объекта. 
Этим создается более сглаженное заполнение с редкими стежками. Используйте эту 
функцию совместно с эффектом Color Blending (Смешивание цветов), чтобы 
избежать выполнения соединительных стежков внутри объекта со смешиванием 
цветов. Подробнее см. в разделе Создание открытого заполнения. 
 
 
Смешивание цветов 
 
Эффект Color Blending (Смешивание цветов) автоматически создает различные 
теневые, перспективные и трехмерные эффекты путем смешивания двух цветных 
слоев в одном объекте вышивки. Подробнее см. в разделе Создание эффекта 
смешивание цветов. 
 
 
Пуговичные петли 
 
BERNINA artista позволит вам вставлять заданные заранее пуговичные петли, 
назначать размеры петель и соединять петлю с проектом. Пуговичные петли 
выполняются обычно стежками гладьевого валика, обрамляющего прорезь, длина 
которой примерно соответствует диаметру пуговицы. Стежки гладьевого валика 
защищают прорезь от осыпания. Пуговичная петля состоит из двух гладьевых валиков с 
закрепками на концах. Подробнее см. в разделе Создание пуговичных петель. 
 

Добавление текста 
 
Вы можете быстро и просто добавлять текст к проекту во время редактирования 
непосредственно на экране. Вы можете применять форматирование текстовых 
объектов таким же образом, как при работе в текстовом редакторе, включая придание 
тексту курсивное или полужирное начертание или выравнивание по левому или 
правому краю. Подробнее см. в разделах Добавление текста к проектам вышивки и 
Форматирование текста. 
 
Специальные шрифтовые знаки и символы 
Вы можете добавлять специальные шрифтовые знаки и символы, используя диалоговое 
окно Выбрать символ из таблицы шрифтов Windows. 
 
Базовые линии 
 
Вы можете применять к текстовым объектам горизонтальные, вертикальные и изогнутые 
базовые линии. Подробнее см. в разделе Применение базовых линий текста. 
 
Гибкий текстовый объект 
Используя "гибкие текстовые объекты" вы можете изменять форму текста. Подробнее 
см. в разделе Создание специальных эффектов функцией Elastic Lettering. 
 
 
Шрифты TrueType 
 
Вы можете создавать новые алфавиты, конвертируя шрифты TrueType. Подробнее см. в разделе 
Конвертирование шрифтов TrueType в вышивальные шрифты. 
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Монограммы 
 
BERNINA artista позволяет быстро и просто создавать проекты вышивки, состоящие из 
заглавных букв, называемые монограммами. Diamond2 и Diamond3 являются 
специальными монограммными алфавитами. 
 
Вырезание отверстий текстом 
Вы можете вырезать отверстия в выбранных объектах замкнутой кривой или 
прямоугольника с единообразным углом наклона стежков, используя инструмент Lettering Remove Overlay 
(Удаление стежков перекрытия текста). См. также Вырезание отверстий текстом. 

Добавление стежков для вышивки крестом 
 
Используя программу BERNINA artista Cross Stitch, вы можете добавлять стежки для 
вышивки крестом в весь проект или в отдельный его фрагмент. Стежок для вышивки 
крестом иногда комбинируют с аппликацией. Подробнее см. в разделе Основные 
сведения о программе вышивки крестом Cross Stitch. 
Используйте весь набор типов стежков для вышивки крестом для оконтуривания и 
заполнения объектов в любом цвете. Вы можете также изменять ориентацию 
неполных стежков-крестиков для создания различных эффектных узоров. Подробнее см. в разделе Выбор 
типов стежков для вышивки крестом.  
Вышивка крестом является популярной техникой заполнения 
больших зон малым количеством стежков. Такие стежки 
можно использовать также для оконтуривания и обрамления. 
Вы можете регулировать плотность любого стежка для 
вышивки крестом, выполняя его один, два или три раза. 
Подробнее см. в разделе Настройка плотности стежков. 
 
 

в 2 нитки                           в 6 ниток 
 
Вы можете перемещать, поворачивать или переводить в зеркальное отображение блоки крестообразных 
стежков, а также фиксировать стежки и/или обрамление, чтобы не произошло их случайное смещение. 
Подробнее см. в разделе Редактирование стежков для вышивки крестом. 
В программу BERNINA artista Cross Stitch можно вставлять или сканировать рисунки для использования в 
качестве оригинала для оцифровывания. Вы можете автоматически оцифровывать оригинальный рисунок, 
используя функцию Auto Stitch. Вы можете также выбрать для вышивания блоки цветов в вашем рисунке, 
используя функцию Magic Wand. Подробнее см. в разделе Оцифровывание заполненных контуров 
функцией Magic Wand. 
Программа BERNINA artista Cross Stitch позволит вам добавлять тексты впечатыванием непосредственно в 
окно проекта. Подробнее см. в разделе Оцифровывание букв, выполняемых стежками для вышивки 
крестом. 

Обработка проекта 
 
По умолчанию BERNINA artista сохраняет проекты в собственном ["родном"] формате файла, ART. Этот 
формат содержит всю информацию, требуемую как для вышивания проекта, так и для последующих 
изменений. Подробнее см. в разделе Обработка файлов в различных форматах. 
 
Вышивание и сохранение проектов 
 
Вы можете выводить проекты вышивки различными способами – сохранять на карте памяти, на дискете или 
жестком диске или же направлять непосредственно в машину для вышивания. Проекты, сохраняемые на 
карте памяти или в компьютере можно загружать и редактировать в BERNINA artista. Вы можете также 
распечатать проект, получив "твердую" копию. Подробнее см. в разделе Вывод и сохранение проектов. 
 
Magic Box ("Волшебная шкатулка") 
 
Программа Magic Box считывает и записывает проекты, сохраненные в других форматах. Вы можете 
загрузить проект с карты памяти в BERNINA artista, отредактировать и записать затем на карту Magic Card. 
Magic Box легко конвертирует проекты в другие форматы и из других форматов. Можно также использовать 
Magic Box с BERNINA artista для редактирования проекта перед записью его на карту. Подробнее см. в 
разделе Magic Box. 
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Управление проектом 
 
Программа BERNINA artista Portfolio обеспечивает эффективный способ управления проектами вышивки. 
Этот инструмент управления проектами может обеспечить доступ к файлам, сохраняемым на жестом диске 
компьютера, компакт-диске или дискете. Программа Portfolio позволяет даже архивировать и 
просматривать файлы в папках, которые были архивированы с помощью популярного архиватора WinZip. 
Она распознает все форматы файлов проектов, используемые в ПО BERNINA artista. 
Каталоги проектов в папке содержат пиктограммы и/или краткое описание. Они могут быть направлены в 
принтер, опубликованы на вашем сайте в интернете или интранете и экспортированы в форматах, 
совместимыми с программами электронных таблиц или баз данных. Подробнее см. в разделе Управление 
проектом. 
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Основные процедуры 
 
Для работы с программным обеспечением BERNINA artista 
вам требуется знать основные процедуры, такие как запуск 
программ, открытие и создание проектов и сохранение. Другие 
основные процедуры включают показ и скрытие сетки, 
отображение и использование панелей инструментов и 
переключение на Artistic View (Художественный Просмотр). 
Защитные коды доступа контролируют доступ к специальным 
опциям программного обеспечения. Вам нужно уметь 
идентифицировать ваши системные идентификационные 
коды и вводить новые коды доступа для обновления. 
В этом разделе описывается, как запускать программы 
BERNINA artista, как открывать проекты, создавать новые проекты и пользоваться основными 
командами. Здесь также поясняется, как включать и отключать показ сетки и измерять 
расстояния на экране. Также объясняется процедура ввода кодов защиты. 
 

Запуск BERNINA artista 
 
Для запуска BERNINA artista щелкните дважды мышью по этой пиктограмме.  
 
Для открытия BERNINA artista используйте пиктограмму на рабочем столе Windows или меню кнопки Пуск. 
 
Как запустить BERNINA artista 
◄ Щелкните дважды мышью по пиктограмме BERNINA artista на рабочем столе Windows.  

Альтернативно выберите в меню Start/Пуск > Programs/Программы > BERNINA artista > BERNINA artista  
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Строка заголовка 
Строка  меню 
Общая панель 
инструментов 

Кнопки переключения 
режимов 

 
Панель рукодельных 

стежков 
 

Панель рисунка/проекта 
(изменяется при 
выборе режима) 

 
 Окно проекта 

 
 
 
 
 
 
 
 

Панель размещения 
Панель стежков и 
палитры цветов 

Строка состояния 
 
 
 
BERNINA artista открывается с новым, пустым проектом (Design1). 
 
◄ Измените окно проекта по своему желанию, при этом можно отобразить или скрыть сетку, изменить 

размеры сетки, отобразить или скрыть панели инструментов. Подробнее см. в разделе Отображение 
сетки. 

Использование команд 
После запуска BERNINA artista Вы должны пользоваться командами, пиктограммами и диалоговыми 
окнами, чтобы выполнять соответствующие задачи. Команды в BERNINA artista выбираются таким же 
образом, как и в других приложениях Windows, – из меню или панелей инструментов. 
Для наиболее часто используемых команд имеются также клавишные комбинации быстрого вызова -- 
клавиатурные команды. Подробнее см. в разделе Клавиатурные команды BERNINA artista. 
 
Вывод на экран и скрытие панелей инструментов 
Панели инструментов обеспечивают быстрый и простой доступ к командам BERNINA artista. Панели 
инструментов BERNINA artista являются плавающими. Это означает, что вы можете размещать их в любом 
удобном месте поверх всех других окон или скрывать их при необходимости. 
 
Совет: Для увеличения рабочей площади скройте ненужные панели инструментов и пользуйтесь вместо 
них меню или клавиатурными командами. 
 
Как показать или скрыть панель инструментов 
◄ Для перемещения панели инструментов в более удобное место нужно перетащить его мышью. 
◄ Для помещения ее в нормальное положение дважды щелкните мышью по заголовку. 
◄ Чтобы скрыть панель инструментов, щелкните по знаку "Х" в верхнем правом углу панели. 
◄ Чтобы показать панели инструментов, нажмите Shift + P. 
◄ Чтобы показать закрытую панель Design, щелкните на Picture, затем на Design. 
◄ Чтобы показать закрытую панель Picture , щелкните на Design, затем на Picture. 
 
 
Выбор команд с панелей инструментов 
Панели инструментов обеспечивают быстрый и простой доступ к командам BERNINA artista. Щелкните на 
кнопке инструмента, чтобы активировать команду, или, там, где это применимо, щелкните правой кнопкой 
мыши, чтобы изменить ее свойства. 
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Как выбирать команды с панелей инструментов 
◄ Задержите указатель мыши на значке инструмента, чтобы увидеть его название во всплывающей 

подсказке. 
◄ Щелкните по значку, чтобы активировать команду. 
◄ Щелкните правой кнопкой мыши, чтобы изменить опции команды или активировать вторичную команду. 
◄ Если для значка предусмотрены команды как от левой, так и от правой кнопки мыши, то ее название 

разделено косой чертой (/). Например, значок Scale by 20% Down/Up позволяет уменьшить размер 
объекта на 20 %, если щелкнуть левой кнопкой мыши, или увеличить размер на 20 %, если щелкнуть 
правой кнопкой. 

◄ Для многих команд щелчок правой кнопки позволяет установить свойства для основной команды 
(выполняемой от левой кнопки мыши). Например, щелчком левой кнопкой на кнопку Lettering/Values 
(Текст/Значения) выбирается Lettering, а щелчком правой кнопки открывается диалоговое окно Object 
Properties (Свойства объекта) для настройки параметров текста. 

 
Внимание: Не все инструменты обладают функцией правой кнопки мыши. 
 
Отмена и повторение отмененных команд 

 
Используйте кнопку Undo (панель General) для отмены команды. 
 
Используйте кнопку Redo (панель General) для повторения команды, которая была отменена.  
 
Вы можете отменить действие большинства команд. Если вы передумали, то можно снова 

повторить выполнение отмененной команды. BERNINA artista помнит несколько последних команд, которые 
Вы назначали. 
 
Как отменить команду и снова восстановить ее действие 
◄ Для отмены команды щелкните на значке Undo. Если BERNINA artista больше не помнит выполненных 

команд, кнопка Undo становится блеклой. 
◄ Щелкните на значке Redo, чтобы повторить выполнение отмеченной команды. 
 

Работа с проектами 
BERNINA artista позволяет открывать разнообразные "контурные" и "стежковые" файлы, сохраняемые на 
жестком диске компьютера, дискетах и компакт-дисках. BERNINA artista может также считывать проекты из 
памяти вашей вышивальной машины, карт памяти или компакт-дисков, вставленных в вышивальную 
машину. Вы можете также открывать проекты с карт памяти, используя прибор Magic Box. Подробнее см. в 
разделе Magic Box. 
При запуске BERNINA artista автоматически создается новый файл - Design1, – готовый для начала 
оцифровывания. Вы можете создать дополнительные проекты, основанные на шаблоне NORMAL, или 
выбрать другой шаблон. Вы даже можете создать свой собственный шаблон. См. также раздел Управление 
шаблонами проекта. 
BERNINA artista позволяет сохранять проекты в "родном" формате .ART, а также в других форматах 
"контурных" и "стежковых" файлов. Вы можете также сохранять проекты на дискетах или картах памяти. 
Подробнее см. в разделе Обработка файлов в различных форматах. 
 
Примечание: Подробнее о "контурных" и "стежковых" файлах см. в разделе Поддерживаемые форматы 
вышивальных файлов. 
 
Открытие проектов из компьютера 

 
 Нажмите кнопку Open (панель General), чтобы открыть существующий проект. 
 

 
BERNINA artista позволяет открывать разнообразные "контурные" и "стежковые" файлы. См. также 
Поддерживаемые форматы вышивальных файлов. 
 
Внимание: Вы не сможете открыть файлы ART, созданные последней версией программного обеспечения, 
если у вас запущена предыдущая версия. В таком случае появится указание о необходимости обновить 
систему до текущей версии. 
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Как открыть проект из компьютера 
1  Нажмите кнопку Open (Открыть).  

Откроется диалоговое окно Open. 
 
                                                                     Панель просмотра 

 
 

Просмотр вкл./выкл.     Сведения о проекте 
 
2  Выберите папку из списка Look In. 
3  Если проект не в формате ART, то выберите тип файла из списка Files of Type. 
4  Выберите проект или проекты. 

◄ Для выбора нескольких идущих подряд файлов удерживайте нажатой клавишу Shift. 
◄ Для выбора нескольких файлов удерживайте нажатой клавишу Ctrl. 

5  Проставьте "галочку" в окошке Preview, чтобы просмотреть проект (для поддерживаемых форматов) 
вместе с данными о проекте. В эти данные входят количество стежков (S:) и цветов (C:), высота (H:) и 
ширина (W:) проекта и номер версии ПО (V:). 

6  Нажмите кнопку Open. 
 
Совет: Вы можете также открывать проекты с карт памяти, используя прибор Magic Box. Подробнее см. в 
разделе Magic Box. 
 
Открытие проектов из машины 
BERNINA artista может считывать проекты из памяти вашей вышивальной машины, карт памяти или 
компакт-дисков, вставленных в вышивальную машину. После открытия проект можно проверить или 
исправить перед передачей в машину для вышивания. См. также Поддерживаемые форматы вышивальных 
файлов. 
 
Как открыть проект из машины 
1  Откройте новый, пустой файл. 
2  Вставьте карту памяти с проектом в вышивальную машину BERNINA или в модуль считывания и записи 

карт памяти. 
3  Выберите File > Card/Machine Read. 
 Появится диалоговое окно Read from Embroidery System and Design Manager. 
 
 
 
Кнопки выбора вышивальной машины,  
карты памяти или компакт-диска 
 
 
 
 
 
 
 
 
 
 
 
4  Выберите кнопку, соответствующую источнику, с которого вы хотите считать проект. 

◄ Нажмите кнопку Вышивальная машина, чтобы просмотреть проекты, сохраняемые в вашей 
вышивальной машине BERNINA. 

◄ Нажмите кнопку Карта памяти, чтобы просмотреть проекты, сохраняемые на вашей карте памяти. 
◄ Нажмите кнопку Компакт-диск, чтобы просмотреть проекты, сохраняемые на вашем компакт-диске. 
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5  Нажмите на ярлык папки, в которой сохраняется проект, затем выберите проект. Проект будет показан в 

окне просмотра. 
 
 

 
 
 
 
 

Нажмите Edit (Редактировать) 
 
 
 
 
 
 
 
 
6  Нажмите кнопку Edit, чтобы открыть проект на экране BERNINA artista для редактирования.  
 Используйте кнопки Rename (Переименовать) и Delete (Удалить) для переименования или удаления 

проектов. 
 
Совет: Вы можете также открывать проекты с карт памяти, используя прибор Magic Box. Подробнее см. в 
разделе Magic Box. 
 
Создание новых проектов с шаблоном NORMAL 

 
Нажмите кнопку New (панель General) для создания нового проекта с шаблоном NORMAL  
 

При запуске BERNINA artista автоматически создается новый файл - Design1, - готовый для начала 
оцифровывания. По умолчанию Design1 создается на основе шаблона NORMAL. Шаблоны содержат 
предварительно установленные стили, настройки по умолчанию или объекты, что ускоряет и облегчает 
оцифровывание. Если вы создаете файл, основанный на одном из шаблонов, то параметры шаблона 
копируются в новый проект. Подробнее см. в разделе Свойства объекта и шаблоны. 
 
Как создать новый проект с шаблоном NORMAL 
◄ Нажмите кнопку New (Создать).  

В окне проекта откроется новый пустой проект. 
 
Создание новых проектов с шаблонами пользователя 
Вы можете выбрать шаблон пользователя в качестве основы нового проекта. См. также раздел  Управление 
шаблонами проекта. 
 
Как создать новый проект с шаблоном пользователя 
1  Выберите File > New. 
 Откроется диалоговое окно New. 
 
Примечание: Если шаблонов пользователя не имеется, 
диалоговое окно New может не появиться.  
2  Выберите шаблон из списка. 
3  Нажмите кнопку ОК. 
 
Сохранение проектов 
 

Нажмите кнопку Save (панель General), чтобы сохранить текущий проект. 
 
При сохранении проекта сохраняется имя файла, его расположение и формат и происходит его 

обновление в соответствии с выполненными изменениями.  Если вы сохраняете существующий проект под 
новым именем, в другом месте или в другом формате, вы создаете копию оригинального проекта. 
 
Примечание: Вы можете также записывать проекты в модуль памяти вышивальной машине или на карту 
памяти BERNINA. Если у вас имеется прибор Magic Box, вы можете записать проект также и на другие карты 
памяти. Подробнее см. в разделе Сохранение проектов на картах памяти BERNINA и Magic Box. 
Файлы, сохраняемые в формате ART, автоматически архивируются (сжимаются) при сохранении и 
разархивируются при повторном открытии. Благодаря этому сокращается требуемый объем памяти и 
обеспечивается возможность сохранять большие файлы на дискетах или пересылать их по электронной 
почте. 
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Совет: Сохраняйте проект во время работы, как можно чаще. Не ждите полного завершения работы. 
 
Как сохранить проект 
1  Нажмите кнопку Save (Сохранить). 
 Если вы сохраняете проект в первый раз, откроется диалоговое окно Save As (Сохранить как …). 
 

 
 
 
Папка, содержащая проект 
 
 
 
 
 
 
 
Имя проекта 
 
Список форматов 
 
 
 
 

2  Из списка Save In выберите папку, в которой вы хотите сохранить проект. 
3  Введите имя проекта в поле File name. 
4  Выберите формат файла из списка Save as type.  
 Подробнее см. в разделе Поддерживаемые форматы вышивальных файлов. 
5  Нажмите кнопку Save (Сохранить). 
 
Совет: Чтобы сохранить изменения в существующем файле, но оставить без изменений оригинал, 
воспользуйтесь командой Save As. 
Каждый раз, когда вы сохраняете проект кнопкой Save на общей панели инструментов, происходит 
обновление файла.  
 

Отображение сетки 
 
Нажимайте кнопку Show Grid (панель General) для отображения на экране или скрытия сетки. 
Щелчок правой кнопкой мыши позволяет изменить настройки сетки. 
 

Используйте линии сетки, чтобы точно совместить или установить требуемые размеры объекта вышивки. 
Вы можете показывать и скрывать сетку. 
 
Совет: Вы можете изменить интервал сетки, выбрать базисную точку и включить или выключить функцию 
Snap to Grid (Поместить в сетку) в диалоговом окне Options. Подробнее см. в разделе Настройка опций 
сетки. 
 
Как показать сетку на экране 
◄ Нажмите кнопку Show Grid (Показать сетку).  

Если эта кнопка активна, сетка отображается на экране. 
◄ Нажмите кнопку Show Grid еще раз, чтобы скрыть сетку. 
 

Отображение пялец 
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Для отображения пялец нажмите кнопку Show Hoop (панель General). Щелчок правой кнопкой 
мыши позволяет изменить настройки. 
 

Когда вы открываете BERNINA artista, на экране отображаются большие пяльцы. Это те пяльцы, которые 
устанавливаете на вышивальной машине BERNINA. См. также Работа с пяльцами. 
 
Как показать пяльцы на экране 
◄ Нажмите кнопку Show Hoop (Показать пяльцы), чтобы скрыть пяльцы. 
◄ Нажмите кнопку Show Hoop еще раз, чтобы показать пяльцы.  

Если эта кнопка активна, пяльцы отображаются на экране. 
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Измерение расстояний на экране 
 
Используйте команду Measure (меню View), чтобы измерить расстояние на экране. 
 
Измерение расстояния между двумя точками и угла наклона линии между этими точками производится 
командой Measure (Измерить). Результаты измерений показываются в миллиметрах или дюймах, в 
зависимости ль выбранной системы измерения в Панели управления Windows. См. документацию по 
операционной системе Windows. 
 
Совет: Для получения более точных результатов увеличьте изображение на экране. Измеряется всегда 
действительный размер независимо от масштаба изображения. 
 
Как измерить расстояние на экране 
1  Выберите View (Вид) > Measure (Измерить). 
2  Щелкните мышью по начальной точке. 
3  Удерживая кнопку мыши нажатой, переместите указатель мыши в конечную точку. 
 В строке состояния появится следующая информация. 

◄ Координаты положения конечной точки (X=, Y=). 
◄ Длина измеренной линии (L=). 
◄ Угол наклона линии по отношении к горизонтали (A=). 

 
4  Нажмите Esc для завершения. 
 См. также Настройка опций отображения положения указателя мыши. 
 Примечание: Всплывающая подсказка команды Measure показывает расстояние и угол. 
 

Ввод кодов защиты 
 
Для ввода кодов защиты используйте команду Security в меню Settings.. 
 
BERNINA artista контролируется защитным устройством – аппаратным ключом ("донглем"), подключаемым к 
компьютеру, а также защитными кодами доступа, вводимыми в программное обеспечение. Номер 
аппаратного ключа является наиболее важным номером. Подробную информацию можно получить в 
пояснениях по инсталляции. 
Каждому аппаратному ключу присвоен уникальный номер, указываемый на ярлыке, прикрепленному к 
аппаратному ключу. При ссылке на вашу систему при переписке или телефонном разговоре вам нужно 
указывать номер аппаратного ключа. 
 

 
1-я сторона: Указывается уровень продукта или  
обновленный уровень продукта, Editor, AutoDesigner 
 
 
 
2-я сторона: Номер аппаратного ключа –  
ссылайтесь на этот номер при обращении к вашему дилеру 
 

Аппаратный ключ и его ярлык – показаны обе стороны ярлыка 
 
Каждый аппаратный ключ имеет уникальный серийный номер и сохраняемый внутри идентификационный 
код, так что ваша система может быть однозначно идентифицирована. Идентификационный код может 
быть получен через программу BERNINA artista. 
Могут быть добавлены новые опции или обновлены программные продукты путем изменения опций 
аппаратного ключа. Для этого нужно ввести два новых кода защиты. Они пересылаются по факсу или 
электронной почте. Вы можете ввести коды в BERNINA artista вручную или импортировать их из текстового 
файла. 
При открытии BERNINA artista после обновления может появиться сообщение, что коды защиты не 
введены. 
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Вы можете ввести в BERNINA artista новые коды непосредственно или импортировать их из текстового 
файла. Подробнее см. в разделе Импорт кодов доступа. Подробнее см. в разделе Как ввести коды доступа. 
 
Идентификация вашего аппаратного ключа 
 
Для идентификации аппаратного ключа используйте функцию Access Code Order Form из меню Help. 
 
При ссылке на вашу систему при переписке или телефонном разговоре вам нужно указывать номер вашего 
аппаратного ключа. Вам может потребоваться также ссылка на серийный номер и идентификационный код. 
Эту информацию можно найти как в бланке заказа кода доступа (Access Code Order Form), так и диалоговом 
окне Security Device. 
 
Как идентифицировать ваш аппаратный ключ 
◄ Выберите Help > Access Codes Order 

Form.  
Появится бланк заказа кода доступа 
(Access Code Order Form).   

 
     
 
◄ Выберите Settings > Security, чтобы 

открыть диалоговое окно Security Device.  
Откроется диалоговое окно Set Security 
Device Options (Опции настройки 
аппаратного ключа).  

 
 

 
 
 
Серийный номер 
Идентификационный код 
 
 
 

Серийный номер и Идентификационный код вашего аппаратного ключа отображаются в верхней части 
диалогового окна. 

 
Ввод кодов доступа 
Вы можете ввести коды доступа вручную для обновления до новых опций или новой версии ПО. Эти коды 
можно получить у вашего дилера. 
 
Совет: Вы можете ввести коды доступа путем импортирования текстового файла. Подробнее см. в разделе 
Импорт кодов доступа. 
 
Как ввести коды доступа 
1  Выберите Settings > Security. 
 Откроется диалоговое окно Set Security Device Options 

(Опции настройки аппаратного ключа). 
Серийный номер 

 
Идентификационный код 
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2  Проверьте, соответствует ли Серийный номер и Идентификационный код указанным в текстовом 

файле сообщении электронной почты, содержащем новые коды доступа. Оба кода должны быть 
идентичными. 

3  Введите коды доступа в поля, используя клавишу Tab или Enter для перехода от одного поля к другому.  
 
 Примечание: Не вводите 

межсимвольные интервалы. 
Появится сообщение, 
подтверждающее, что коды 
доступа успешно введены.  
 

4  Нажмите кнопку ОК. 
5  Перезапустите BERNINA artista. 
 
Импорт кодов доступа 
Вы можете импортировать защитные коды доступа из текстового файла. Это экономит время. Текстовые 
файлы обычно пересылаются электронной почтой. 
 
Как импортировать коды доступа 
1  Скопируйте текстовый файл в папку кодов доступа BERNINA artista. Для более простого распознавания 

имя файла соответствует серийному номеру аппаратного ключа, указанному на ярлыке. 
 
2  В BERNINA artista выберите Settings > Security, чтобы открыть диалоговое окно Set Security Device 

(Настройка аппаратного ключа). 
 
 
 
 
 
Кнопка импорта кодов 
 
 
 
 

 
3  Проверьте, соответствует ли Серийный номер и Идентификационный код указанным в текстовом 

файле сообщении электронной почты, содержащем новые коды доступа. Оба кода должны быть 
идентичными. 

4  Нажмите кнопку Import Codes. 
 Откроется диалоговое окно Open (Открыть), в котором по умолчанию появится папка, в которой вы 

сохранили файл. 
5  Выберите текстовый файл, содержащий новые коды доступа, и нажмите кнопку Open. 
 Текстовый файл должен сохраняться в папке artista/ACCESSCODES. 
 

 
 
 
Выберите текстовый  
файл с кодами доступа. 
 
 
 
  
 
 
 
 
 
 
 

Коды будут автоматически обновлены. 
6  Перезапустите BERNINA artista. 
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Просмотр онлайновой информации 
 
• Выберите Help Topics (из меню Help), чтобы просмотреть онлайновую справку. 
• Выберите Online Manual (из меню Help), чтобы просмотреть онлайновое руководство. 
• Выберите Bernina International Home Page (из меню Help), чтобы просмотреть международный сайт 

Bernina. 
• Выберите Bernina of America Home Page (из меню Help), чтобы просмотреть сайт Bernina of America. 
• Выберите Embroidery Online (из меню Help), чтобы просмотреть сайт Embroidery Online. 

 
Документация пользователя предоставляется в виде печатного руководства, онлайнового руководства и 
онлайновой справки. 
 
Использование онлайновой справки 
Онлайновая справка обеспечивает быстрый доступ к общей информации о функциях BERNINA artista и к 
пошаговым инструкциям. 
 
Как использовать онлайновую справку 
1  Выберите Help > Help Topics, чтобы открыть главное окно справки BERNINA artista Help. 
2  Нажмите кнопку Contents (Содержание), чтобы открыть главный список тем справки. 
 Темы сгруппированы под заголовками высшего уровня со значками "книга". 
3  Дважды щелкните по значку "книга", чтобы просмотреть список тем, а затем дважды щелкните по 

выбранной теме. 
 Совет: Альтернативно нажмите кнопку Find (Найти) и введите ключевое слово, чтобы найти 

интересующий вас ответ.  
 
Просмотр онлайнового руководства 
Вы можете прочитать это онлайновое руководство, используя программу Adobe Acrobat™ Reader. Эта 
программа поставлена вам вместе с ПО BERNINA artista. В онлайновом руководстве вы можете быстро 
найти нужную вам информацию, используя стандартные функции программы Adobe Acrobat™ Reader. 
 
Как просмотреть онлайновое руководство 
◄ Выберите Help > Online Manual. 

 
Примечание: Если программа BERNINA artista не запущена, вы можете открыть онлайновое руководство 
непосредственно из Windows Explorer (Проводника Windows). Для этого найдите папку artista\bin и дважды 
щелкните по файлу MAN_ENU.PDF. 

 
Соединение с сайтами BERNINA  
Вы можете получить доступ к информации о торговле и поддержке продуктов непосредственно из ПО. 
 
Примечание: Вы должны иметь правильно сконфигурированный веб-браузер в свой системе совместно с 
доступом к Интернету. 
 
Как соединиться с сайтом BERNINA  
◄ Соединитесь с вашим интернет-провайдером. 
◄ Выберите Help > BERNINA Web Page. Вы непосредственно соединитесь с домашней страницей 

BERNINA по следующим адресам:  
◄ Bernina International - http://www.bernina.com/ 
◄ Bernina of America - http://www.berninausa.com/ 
◄ Embroidery Online - http://www.embroideryonline.com 
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Просмотр проектов 
 
BERNINA artista предоставляет несколько возможностей просматривать проекты вышивки, чтобы 
облегчить работу с ними. Увеличение масштаба изображения позволяет увидеть больше 
деталей или просмотреть проект в фактическом размере. Можно рассматривать существующий 
проект с различными цветами на разных материалах. 

 
 
BERNINA artista также предоставляет информацию о проектах разнообразными способами и в 
разных форматах. Даже перед открытием BERNINA artista или своего проекта вы можете 
проверить некоторую информацию о файлах формата ART непосредственно из Проводника 
Windows. Вы можете просмотреть детали вышивания проекта в диалоговом окне Design 
Properties (Свойства проекта). Важную информацию о проекте дает также функция Print Preview 
(Предварительный просмотр), включая просмотр проекта в целом, размеры проекта, 
последовательность цветов и специальные указания. 
Можно отображать на экране или скрывать различные элементы проекта с доступными 
настройками отображения. Вы можете показывать или скрывать точки прокола иглой и сами 
стежки. 
В этом разделе разъясняются режимы просмотра проекта, предоставляемые BERNINA artista, а 
также различные настройки просмотра проекта. Также объясняется, как получать и 
модифицировать информацию о ваших проектах. 
 

Режимы просмотра проектов 
BERNINA artista предлагает несколько различных режимов просмотра. Вы можете увеличить 
изображение на всю площадь экрана, чтобы увидеть больше деталей, просмотреть проект в натуральную 
величину, а также подогнать изображение проекта к разиерам экрана. 
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Режимы просмотра проекта 
BERNINA artista предоставляет три режима просмотра проектов: 
◄ Picture View (Просмотр рисунка) 
◄ Design View (Просмотр проекта) 
◄ Artistic View (Художественный просмотр) 
 
Примечание: Режим Picture View не доступен в программе BERNINA artista Editor. 
 
Picture View (Просмотр рисунка) 
Режим Picture View используется, когда Вы хотите загружать или просканировать изображения. В BERNINA 
artista можно загружать только растровые изображения. Подробнее см. в разделе Поддерживаемые 
форматы рисунков и изображений. 
 
Примечание: Вы не сможете открыть растровое изображение – вместо этого загрузите его, используя 
кнопку Load Picture (Загрузить изображение). Для этого вы должны находиться в режиме Picture. 
 
Design View (Просмотр проекта) 
Режим Design View позволяет открывать, оцифровывать и редактировать все ваши проекты. 
 
Artistic View (Художественный просмотр) 
Режим Artistic View позволяет вам увидеть проект в том виде, в котором он будет выглядеть после 
вышивания. В этом режиме проект выглядит более реалистично, чем  в режиме Design View. 
 
Просмотр проектов в режиме Artistic View 
 
Используйте кнопку Artistic View™ (панель Mode) для перехода от Design View к Artistic View. 
 
Режим Artistic View позволяет получить графическое представление о том, как должна выглядеть вышивка в 
окончательном виде. 
 
Совет: Используйте режим Artistic View совместно фоном материала, чтобы увидеть, как будет выглядеть 
вышивка на выбранном материале. Подробнее см. в разделе Изменение цветов фона или ткани. 
 
Как просматривать проекты в режиме Artistic View 
◄ Нажмайте на кнопку Artistic View, чтобы переключаться между режимами Artistic View и Design View. 

       
   Режим Design:       Режим Artistic View  
 
Увеличение и уменьшение изображения 

Нажмите кнопку Zoom Box (панель General), чтобы увеличить выбранную зону до размера окна. 
 
Нажмите кнопку Zoom Out 2x (панель General), чтобы уменьшить размер изображения в 2 раза.  
 
 
Нажмите кнопку Show All (панель General), чтобы показать весь проект. 
 
Нажмите кнопку Show 1:1 (панель General), чтобы показать проект в натуральную величину. 
 
Увеличьте изображение проекта вышивки, чтобы рассматривать индивидуальные стежки или 
детали, или уменьшите его, чтобы отобразить в окне большее количество деталей проекта. 

Текущий масштабный коэффициент показывается в нижнем правом углу экрана. 
 
Примечание: Чтобы быть уверенным в том, что проект отображается на экране в правильных размерах, 
необходимо калибровать монитор. Подробнее см. в разделе Калибровка монитора. 
Как увеличить и уменьшить изображение на экране 
◄ Чтобы увеличить участок проекта, нажмите кнопку Zoom Box и обведите контур вокруг увеличиваемого 

участка. 
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Увеличенный участок 
 
 
 
Перетащите оконтуренный участок 
 
 
◄ Чтобы отобразить проект в уменьшенном в 2 раза размере, нажмите кнопку Zoom Out 2X. 
◄ Чтобы отобразить весь проект, нажмите кнопку Show All. 
◄ Чтобы отобразить проект в натуральную величину, нажмите кнопку Zoom 1:1. 
 
Совет: Для отображения стежков в частичном масштабе нажмите клавишу F на клавиатуре. Когда появится 
диалоговое окно Zoom Factor (Коэффициент масштаба), введите процентное значение от натуральной 
величины и нажмите OK. 
 
Просмотр всего проекта 

 
Нажмите кнопку Show All (панель General), чтобы показать весь проект. 
 

BERNINA artista обеспечивает несколько технических возможностей для отображения всего проекта. 
 
Как просмотреть весь проект 
◄ Чтобы просмотреть весь проект 
◄ Выберите View > Show All, или 
◄ Нажмите клавишу 0. 

Настройки просмотра проекта 
Вы можете показывать или скрывать элементы проекта разнообразными настройками отображения. Вы 
можете показывать графическое изображение вышивки в готовом виде в режиме Artistic View, показывать 
точки прокола иглой, соединительные и обычные стежки, а также показывать или скрывать выбранные 
цвета. 
 
Просмотр точек укола иглой 
 
Выберите Needle Points в меню View, чтобы показать или скрыть точки укола иглой. 
 
Вы можете показать или скрыть элементы проекта, такие как точки укола иглой или соединительные стежки. 
Например, просмотреть точки укола иглой для выбора стежков для редактирования и соединительных 
стежков, чтобы облегчить позицию ввода стежков и точек выхода. См. также Редактирование стежков. 
Вы можете отображать или скрывать элементы проекта в любой комбинации. При просмотре в режиме 
Artistic View они не отображаются. 
 
Как просмотреть точки укола иглой 
◄ Для просмотра точек укола иглой выберите View (Вид) > Needle Points (Точки укола иглой). 
 
 
 
 
 
 
 
 
 
 

Деталь с показом точек укола иглой 
 
Функция Needle Points включена 
Просмотр объектов проекта в цвете 
 
Выберите By Color (меню View), чтобы обособить элементы проекта по цвету. 
Чтобы выделить индивидуальные элементы для контроля или манипуляций, функция View By Color 
(Просмотр по цвету) позволяет просматривать проект в свете. Это, в частности, полезно, когда вы 
изменяете последовательность вышивания в цвете. См. также Изменение последовательности вышивания 
объектов в цвете. 
Вам может потребоваться перегруппировать проект, прежде чем вы сможете просмотреть объект в цвете. 
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Совет: Функция Color Film предоставляет другой путь просмотра объектов.  Подробнее см. в разделе 
Выбор цветных блоков и обращение с ними. 
 
Как просмотреть объекты проекта в цвете 
1  Создайте или откройте проект.  
2  Выберите View > By Color. 
 Откроется диалоговое окно Select By Color (Выбор по 

цвету).  
 
 
 
 
 
 
 
3  Выберите цвета, которые вы хотите просмотреть. 

◄ Для выбора нескольких идущих подряд файлов удерживайте нажатой клавишу Shift. 
◄ Для выбора нескольких файлов удерживайте нажатой клавишу Ctrl. 

4  Нажмите кнопку All Colors (Все цвета), чтобы просмотреть все цвета проекта. 
5  Нажмите кнопку ОК. 
 
 

 
 
 
 
 
 
 
 
 
 
 
 

Выбраны два цвета 
 
 
 
 
 
 

Проект появится только с теми цветами, которые вы выбрали для просмотра. 

Просмотр последовательности вышивания отдельных фрагментов 
При работе с проектами вышивки вам необходимо разобраться с последовательностью вышивания. Вы 
можете проверить последовательность вышивания проекта путем ‘обхода’ по стежкам, цветам или 
объектам. Вы можете также проверить последовательность медленным перерисовыванием проекта на 
экране. BERNINA artista имитирует вышиванием при изменении стежков от черного до назначенного цвета 
нитки, как это происходит при вышивании. 
 
Обход по стежкам 
Используйте соответствующие инструменты или клавиатурные команды для обхода проекта по одному или 
по нескольким стежкам. Подробнее см. в разделе Обзор функций обхода проекта. 

 
 
 
 
Белый крест – маркер положения иглы 
 
 
Текущее положение иглы отмечается большим белым крестом, или 
"маркером положения иглы". Вначале он располагается в конечной точке 
проекта. Когда вы совершаете обход по стежкам, маркер положения иглы 
соответственно перемещается. Текущий номер стежка появляется в Строке 

состояния. 
Функция Slow Redraw (Медленное перерисовывание) позволяет видеть последовательность вышивания и 
цветных фрагментов проекта при замедленном перемещении. Подробнее см. в разделе Замедленный 
просмотр последовательности вышивания. 
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Как обойти проект по стежкам 
1  В режиме Design выберите Edit > Stitch Edit или нажмите клавишу Esc. 
2  Убедитесь в том, что функция Select Object (Выбрать объект) не 

выбрана, затем нажимайте клавиши со стрелками, чтобы обходить проект 
по одному или по десять стежков. 
 
 
◄ Нажимайте левую или правую клавишу со стрелкой, чтобы 

обойти проект по одному стежку в обратном или прямом 
направлении. 

◄ Нажимайте верхнюю или нижнюю клавишу со стрелкой, чтобы обойти проект по десять стежков в 
обратном или прямом направлении. 

3  Нажимайте клавишу "+" или "-" на клавиатуре, чтобы обойти проект шагами по 100 стежков. Клавишей 
"+" маркер перемещается в прямом направлении, клавишей "-" в обратном направлении. 

 

 
Обход в обратном направлении по 1 стежку 
 
 
Совет: Если вы вышли за пределы видимой области, нажмите клавишу C, чтобы текущий стежок оказался в 
центре экрана. 
 
Обход проекта от начальной до конечной точки 
 
Нажмите клавишу Home, чтобы перейти к начальной точке проекта. 
Нажмите клавишу End, чтобы перейти к конечной точке проекта. 
 
Используйте клавиатурные команды, чтобы быстро переходить к начальной или конечной точке 
последовательности вышивания. См. также Клавиатурные команды BERNINA artista. 
 
Как переходить от начальной до конечной точки проекта  
◄ Для перехода к начальной точке проекта нажмите клавишу Home. 

После этого белый крест установится на первом стежке, а весь проект отображается темно-серым 
цветом. 

◄ Для перехода к конечной точке проекта нажмите клавишу End.  
После этого белый крест установится на конечном стежке, а весь проект отображается с выбранными 
цветами ниток. 

 
Обход по объектам 
Используйте клавиатурные команды для обхода проекта по объектам. Этот технический прием полезен в 
том случае, если вам нужно найти конкретный объект, чтобы удалить его или вставить другой объект в этой 
точке последовательности вышивания.  См. также Клавиатурные команды BERNINA artista. 
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Как обойти проект по объектам 
◄ Выделите объект. 
◄ Чтобы перейти к следующему объекту, нажмите Ctrl + T. 
◄ Чтобы перейти к предыдущему объекту, нажмите Ctrl + T. 
 
Обход проекта по цвету 
Используйте клавиатурные команды для обхода проекта по цвету. См. также Клавиатурные команды 
BERNINA artista. 
 
Как обойти проект по цвету 
◄ Чтобы перейти к предыдущему цвету, нажмите клавишу Page Up. 
◄ Чтобы перейти к следующему цвету, нажмите клавишу Page Down. 
 
Обзор функций обхода проекта 
Чтобы перейти    Нажмите или выберите 
к началу проекта    клавишу Home  
к концу проекта    клавишу End  
на 1 стежок назад    левую клавишу со стрелкой 
на 1 стежок вперед    правую клавишу со стрелкой 
на 10 стежков назад    верхнюю клавишу со стрелкой 
на 10 стежков вперед    нижнюю клавишу со стрелкой 
на 100 стежков вперед    "+" (на клавишном поле) 
на 100 стежков назад    "-" (на клавишном поле) 
к предыдущему цвету    клавишу Page Up  
к следующему цвету    клавишу Page Down  
к следующему выбранному объекту  клавишу Tab 
к предыдущему выбранному объекту  Shift + Tab 
к следующему объекту    Ctrl + T 
к предыдущему объекту    Shift + T 
 
Замедленный просмотр последовательности вышивания отдельных фрагментов 
 
Выберите Slow Redraw в меню View, чтобы видеть последовательность вышивания и цветных фрагментов 
проекта при замедленном перемещении. 
 
Функция Slow Redraw (Медленное перерисовывание) позволяет видеть последовательность вышивания и 
цветных фрагментов проекта при замедленном перемещении. См. также Замедленный просмотр 
последовательности вышивания. 
 
Как просматривать последовательность вышивания отдельных фрагментов в 
замедленном темпе 
1  Выберите View > Slow Redraw. 
 Откроется диалоговое окно Slow Redraw (Медленное 

перерисовывание) 
 
 
2  Используйте ползунок для установки скорости перерисовывания. 
3  Нажмите кнопку Start. 
 Проект будет перерисован на экране в соответствии с последовательностью вышивания. 

 
 
 
 
 
Наполовину вышитый проект  
 
 
 
 
 

4  Нажмите кнопку Cancel для остановки. 
 Остаток проекта перерисован. 
 

Примечание: Функция Slow Redraw не может быть использована с режимом просмотра Artistic View. 
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Просмотр информации о проекте 
BERNINA artista предоставляет информацию о проектах разнообразными способами и в разных форматах. 
Даже перед открытием BERNINA artista или своего проекта вы можете проверить некоторую информацию о 
файлах формата ART непосредственно из Проводника Windows. Вы можете просмотреть детали 
вышивания в диалоговом окне Design Properties (Свойства проекта). Важную информацию о проекте дает 
функция Print Preview (Предварительный просмотр), включая просмотр проекта в целом, размеры 
проекта, последовательность цветов и специальные указания. 
 
Просмотр информации о проекте в Проводнике Windows  
Перед открытием файлов ART вы можете проверить некоторую информацию через Проводник Windows. 
Диалоговое окно Properties (Свойства) позволяет просмотреть проект совместно с информацией о проекте, 
такой как количество стежков и количество остановок для замены цветных ниток. Приводится также общая 
информация о файле – размер файла и дата последнего изменения. 
 
Примечание: Эти же данные появляются в диалоговом окне Open (Открыть) в BERNINA artista. См. также 
Открытие проектов из компьютера. 
 
Как просмотреть информацию о проекте в 
Проводнике Windows  
1  Выберите файл в Проводнике Windows. 
2  Щелкните правой кнопкой мыши по файлу и выберите 

Properties (Свойства) из всплывающего меню. 
 Откроется диалоговое окно Properties (Свойства). 
 
 
 
 
3  Проверьте информацию о проекте или нажмите другую 

закладку для ознакомления с общей информацией о 
файле. 

 
Совет: Закладка Summary позволяет получить ту же 
информацию, которая была введена в закладке Design 
Properties > Summary программы BERNINA artista. 
Подробнее см. в разделе Просмотр информации о 
проекте в BERNINA artista. 

4  Нажмите кнопку ОК. 
 
Просмотр информации о проекте в BERNINA artista. 
 
Используйте функцию Design Properties (меню File), чтобы увидеть детали вышивания проекта. 
 
В диалоговом окне Design Properties (Свойства проекта) вы можете проверить номер версии 
программного обеспечения и другую информацию. Приводятся также детали вышивания. Большинство 
данных в этих полях не подлежат непосредственному изменению. 
 
Как просматривать информацию о проекте в BERNINA artista 
 
 
1  Выберите File > Design Properties. 
 Откроется диалоговое окно Design Properties > 

Design. 
 
 На этой закладке содержится информация о 

высоте и ширине проекта, количестве стежков 
и цветов. Эти данные извлечены из проекта и 
не могут быть изменены. 

2  Выберите закладку Summary, чтобы увидеть 
или ввести информацию о проекте. 
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3  Щелкните на поле и введите любой текст, который поможет вам впоследствии идентифицировать 

проект. Примечание: Информация из этой закладки включена в окно Предварительного просмотра, а 
также в закладку Summary диалогового окна Windows Properties. Подробнее см. в разделах Просмотр 
информации о проекте в Проводнике Windows и Предварительный просмотр проектов. 

4  Нажмите кнопку ОК. 
 
Предварительный просмотр проектов 
 
Нажмите кнопку Print Preview (панель General), чтобы увидеть на экране проект в том виде, в котором он 
может быть распечатан. 
 
Функция Print Preview (Предварительный просмотр) позволяет получить важную информацию о проекте, 
включая просмотр проекта в целом, размеры проекта, последовательность цветов и специальные указания. 
См. также Предварительный просмотр и распечатка проекта. 
 
Как предварительно просмотреть проект 
1  Нажмите кнопку Print Preview (Предварительный просмотр). 
 В окне предварительного просмотра появится изображение проекта. 
 
Нажмите Print, чтобы 
распечатать проект  

Нажмите, 
чтобы показать 
одну или две 
страницы 

Нажмите Close, чтобы вернуться к окну Design  

 

 
 
 
 
 
Информация о проекте 

 Проект появляется в натуральную величину 
 
2  Настройте требуемый вид изображения: 
◄ Для изменения ориентации на бумаге выберите Landscape (Альбомная) или Portrait (Портрет). 
◄ Для изменения отображаемой информации и установки требуемых опций печати выберите Options. 

См. также Настройка опций печати. 
◄ Нажмите Zoom In, чтобы прочитать информацию о проекте или более подробно просмотреть проект. 

Большие проекты могут быть отображены на нескольких страницах. 
◄ Чтобы распечатать проект, нажмите Print. 
◄ Чтобы закрыть окно предварительного просмотра, нажмите Close. 
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Глава 5  
 

 

 

Выбор объектов 
 
 
При работе с проектами вышивки вам необходимо 
разобраться с последовательностью вышивания. Вы можете 
проверить последовательность вышивания проекта путем 
‘обхода’ по стежкам. Вы можете также проверить 
последовательность медленным перерисовыванием проекта 
на экране. 
BERNINA artista предоставляют разнообразные пути для 
выбора объектов, из которых состоит проект. Вы можете 
выбрать все объекты для изменения проекта в целом или 
индивидуальные объекты для более детального 
редактирования. 
В этом разделе описывается, как проверять проекты путем 
обхода. Описывается, как выбирать объекты, используя 
инструменты выбора и клавиатуру. Также показывается, как 
производить выбор во время обхода проекта или с 
использованием функции Color Film. Вы также увидите, как выбирать объекты по конкретному 
цвету. 
 

Выбор всех объектов в проекте 
Выберите все объекты для применения изменения во всем проекте. См. также Клавиатурные команды 
BERNINA artista. 
 
Как выбрать все объекты в проекте 
◄ Выберите Edit > Select All (Выделить все) или нажмите Ctrl + A.  

Вокруг всего проекта появятся маркеры размера. 

 
Не выделен ни один объект        Выделены все объекты 
 
◄ Чтобы отменить выделение, выберите Edit > Deselect All (Отменить выделение всех объектов), или 

нажмите X или Esc. 
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Выбор объектов инструментом Select Object 
Инструмент Select Object (Выбрать объект) предоставляет различные возможности выбора объектов, 
включая "указать и щелкнуть", ограничивающий прямоугольник выделения и – совместно с клавишами 
Shift + Tab – выбор первого/последнего и следующего/предыдущего объекта. См. также Клавиатурные 
команды BERNINA artista. 
 
Выбор объектов методом "указать и щелкнуть" 
 

 
Для выбора объекта используйте инструмент Select Object (панель Design). 
 

Наиболее просто можно выделить объект, если при активированном инструменте Select Object переместить 
на него указатель мыши и нажать левую кнопку. Удерживая нажатыми клавиши Shift и Ctrl, можно выбрать 
несколько объектов. 
 
Как выбирать объекты методом "указать и щелкнуть" 
1  Нажмите кнопку Select Object (Выбрать объект). 
2  Щелкните по объекту, который вы хотите выбрать. 
 Когда вы щелкните по объекту, вокруг него появятся метка-манипулятор выделения. Вы можете 

щелкнуть где-либо в пределах выделения, чтобы перетащить объект. 
 

   
               Щелкните по объекту   
 Удерживая нажатой клавишу Ctrl, щелкните по другому объекту 
 
◄ Для выбора нескольких объектов удерживайте нажатой клавишу Ctrl. 
◄ Для выбора нескольких идущих подряд объектов удерживайте нажатой клавишу Shift. 
 
Совет: Чтобы выбрать объект, находящийся за другим объектом, увеличьте масштаб изображения и 
щелкните по контуру. Альтернативно расположите указатель мыши над объектом, удерживайте нажатой 
клавишу "2" и щелкайте мышью до тех пор, пока объект не будет выделен. С каждым щелчком будет 
выделяться следующий перекрывающий объект. 
 
Выбор объектов ограничивающим прямоугольником 

 
Выберите инструмент Select Object (меню Design) и очертите указателем мыши ограничивающий 
прямоугольник вокруг выделяемого объекта. 
 

При активированном инструменте Select Object (Выбрать объект) вы можете выделять объекты, 
очерчивая вокруг них указателем мыши ограничивающий прямоугольник. 
Как выбирать объекты ограничивающим прямоугольником 
1  Нажмите кнопку Select Object (Выбрать объект). 
2  Очертите указателем мыши ограничивающий прямоугольник вокруг выделяемых объектов. 
 Объекты будут выделены, как только вы отпустите кнопку мыши. 
 

 
Очертите ограничивающий прямоугольник Объекты выделены 
вокруг объектов 
Примечание: До тех пор, пока объекты не будут сгруппированы, после отпускания кнопки мыши 
выделяться будут только те объекты, которые полностью охватываются ограничивающим 
прямоугольником. См. также Группировка объектов. 
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Выбор первого или последнего объекта 
 

Выберите кнопку Select Object (панель Design) и, если ни один объект не выделен, нажмите Tab или 
Shift + Tab, чтобы выделить первый или последний объект. 
 

 
При активированном инструменте Select Object вы можете выделить первый или последний объект в 
последовательности проекта, используя клавишу Tab. 
 
Как выбрать первый или последний объект 
1  Убедитесь в том, что не выбран ни один объект. 
 Подробнее см. в разделе Как отменить выделение объектов. 
2  Нажмите кнопку Select Object (Выбрать объект). 
3  Выполните одну из следующих операций: 

◄ Нажмите клавишу Tab, чтобы выделить первый объект в последовательности вышивания. 
◄ Нажмите комбинацию клавиш Shift + Tab, чтобы выделить последний объект в 

последовательности вышивания. 

Выбор следующего или предыдущего объекта 
 

Выберите кнопку Select Object (панель Design) и нажмите Tab или Shift + Tab, чтобы выделить 
следующий или предыдущий объект. 

 
Если выделен один из объектов, вы можете выбрать объект перед ним или после него в 
последовательности вышивания, используя клавиши Tab или Shift + Tab при активированном 
инструменте Select Object.  
 
Как выбрать следующий или предыдущий объект 
1  Нажмите кнопку Select Object (Выбрать объект). 
2  Щелкните мышью по объекту, чтобы выделить его. 
3  Выполните одну из следующих операций: 

◄ Нажмите клавишу Tab, чтобы выделить следующий объект в последовательности вышивания. 
◄ Нажмите комбинацию клавиш Shift + Tab, чтобы выделить предыдущий объект в 

последовательности вышивания. 

Выбор нескольких последовательно расположенных объектов 
 

Для выделения нескольких последовательно расположенных объектов используйте инструмент 
Select Object (панель Design) совместно с клавишей Shift. 

 
Вы можете выделить несколько последовательно расположенных объектов, удерживая нажатой клавишу 
Shift и щелкая мышью по первому и последнему объектам выделяемого диапазона. 
 
Как выбрать несколько последовательно расположенных объектов 
1  Нажмите кнопку Select Object (Выбрать объект). 
2  Щелкните мышью по первому объекту диапазона и удерживайте нажатой клавишу Shift. 
3  Щелкните мышью по последнему объекту диапазона. 

Будут выделены все объекты в последовательности вышивания между первым и последним 
выбранными объектами. Этот прием помогает узнать, в какой последовательности будет вышиваться 
проект. Подробнее см. в разделе Обход по объектам. 

 
Щелкните по первому объекту         Удерживая нажатой клавишу Shift, щелкните по последнему объекту 
 

39



Глава 5: Выбор объектов 

BERNINA® Artista Designer Plus Версия 4  

 
Выбор объектов инструментом Polygon Select 

40

 
Используйте инструмент Polygon Select, чтобы выделить объекты ограничивающим 
многоугольником. 
 

Как выбирать объекты инструментом Polygon Select 
1  Нажмите кнопку Polygon Select (Выбор многоугольником). 
2  Наметьте базисные точки вокруг объекта или объектов, которые нужно выделить. 
 Выделяемые объекты должны полностью находиться внутри контурной линии. 
3  Нажмите Enter для выделения. 
 

 
Наметьте базисныве точки вокруг выделяемых объектов 

Отмена выделения объектов 
Вы можете отменять все выделения в проекте или удалять отдельные объекты из группы выделенных 
объектов. 
 
Как отменить выделение объектов 
◄ Отменяйте выделения одним из следующих способов: 
◄ Нажмите Esc. 
◄ Выделите другой объект. 
◄ Щелкните мышью на пустом месте фона. 
◄ Выберите Edit > Deselect All. 
◄ Удалите объект из выделения, удерживая нажатой клавишу Ctrl и щелкнув мышью по объекту, 

выделение которого нужно отменить. 
 

Выбор цветных блоков и манипуляция с ними 
 
Нажмите кнопку Color Film (панель General), чтобы выбрать цветные блоки и манипулировать с 
ними. 
 

Функция Color Film выводит на список последовательности вышивания объектов, сгруппированных по 
цвету. Непрерывно следующие друг за другом объекты одного и того же цвета образуют единый "цветной 
блок". Функция Color Film предоставляет простой способ выделять и дублировать объекты в цветных 
блоках. Она дает также возможность вырезать, копировать и вставлять, а также изменять 
последовательность цветных блоков. 
Функция Color Film синхронизирована с окном проекта. Она динамически обновляется в то время, когда вы 
выбираете, изменяете или удаляете объекты или создаете новый объект. 
 
Как выбирать цветные блоки и манипулировать с ними 
1  Нажмите кнопку Color Film. 
 Откроется окно Color Film. 
 

 
 В окне Color Film показаны значки для каждого цветного блока в порядке последовательности 

вышивания. 
2  Щелкните по значку, чтобы выбрать цветной блок. 
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◄ Для выбора нескольких идущих подряд блоков удерживайте нажатой клавишу Shift. 
◄ Для выбора нескольких блоков удерживайте нажатой клавишу Ctrl. 

Вокруг выбранных цветных блоков появятся метки оконтуривания. 
 
Примечание: Функцией Color Film можно выбрать только цветные блоки, но не индивидуальные 
объекты. 

 
 
Выбраны оранжевые зоны 
 
 
 
 
 
 
 
 
 
 
 
 
 
3  Манипулирование цветными блоками при необходимости.  
 Вы можете получить быстрый доступ к командам всплывающего меню для манипуляции цветными 

блоками, щелкнув правой кнопкой мыши по значку цветного блока. 
 

      
◄ Вы можете также вырезать, копировать и вставлять выбранные цветные блоки. 
◄ Вы можете также изменять последовательность вышивания цветных блоков путем перетаскивания 

их в окне Color Film. 
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Глава 6  
Работа с пяльцами 
 
Перед вышиванием на машине материал должен быть 
растянут в пяльцах. Если проект является сложным или не 
подходит для имеющихся в комплекте пялец, вам может 
потребоваться создать собственные пяльцы. Подробнее см. в 
разделе Создание собственных пялец.  
В этом разделе описывается, как устанавливать центр пялец, 
изменять размер пялец, поворачивать пяльцы, создавать и 
редактировать собственные пяльцы. См. также Отображение 
пялец. 

Настройка центра пялец 
 

Нажимайте кнопку Show Hoop (панель General), чтобы включить или отключить показ пялец. 
Щелчок правой кнопкой мыши позволяет изменить настройки пялец. 
 

BERNINA artista всегда обеспечивает расположение проекта в центре пялец, но вы можете при 
необходимости использовать ручную опцию, чтобы оцифровывать проект в другой части пялец. Вы можете 
также изменить положение центра пялец. 

 
Автоматическая центровка        Ручная 

 
 
Как настроить центр пялец 
1  Щелкните правой кнопкой мыши по значку Show 

Hoop (Показать пяльцы). 
 Появится диалоговое окно Options с открытой 

закладкой Hoop (Пяльцы).  
 
 
2  На настроечной панели Position выберите 

способ центровки пялец. 
◄ Automatic Centering (Автоматическая 

центровка): пяльцы перемещаются таким 
образом, что проект всегда находится в 
центре. 
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Пяльцы перемещаются автоматически к центру проекта. 

 
◄ Ручная: пяльцы остаются в своем первоначальном положении.  

Выберите Set Hoop Center (Установить центр пялец), чтобы изменить положение пялец. 
 
 

          
Пяльцы центруются вручную – не перемещаются 

 
3  Нажмите кнопку ОК.  
 Если вы выбрали опцию Set Hoop Center, щелкните в окне проекта, в том месте, где вы хотите поместить 

центр пялец. 

Изменение размеров пялец 
 

Нажимайте кнопку Show Hoop (панель General), чтобы включить или отключить показ пялец. 
Щелчок правой кнопкой мыши позволяет изменить настройки пялец. 
 

Из предоставляемого вам списка пялец с 
разными размерами выберите наименьшие 
пяльцы, которые подходят к вашему 
проекту.  Благодаря этому ткань в время 
вышивания будет оставаться плотно 
натянутой. 
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Как изменить размеры пялец 
1  Щелкните правой кнопкой мыши по значку Show Hoop  
      (Показать пяльцы).  
 Появится диалоговое окно Options с открытой закладкой Hoop  
      (Пяльцы).  
 
 
 
2  Выберите пяльцы из списка Hoop. 
3  Если требуется, выберите опцию установки центра пялец 

вручную (опция Manual) и включите опцию Set Hoop Center 
(Установить центр пялец). 

4  Нажмите кнопку ОК. 
 Если вы выбрали опцию Set Hoop Center, щелкните на точку, в которой вы хотите поместить центр 

пялец. 

Изменение ориентации пялец 
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Нажимайте кнопку Show Hoop (панель General), чтобы включить или отключить показ пялец. 
Щелчок правой кнопкой мыши позволяет изменить настройки пялец. 
 

Вы можете изменить ориентацию пялец, если это нужно, чтобы облегчить оцифровывание.  
 
Примечание: Однако при загрузке проекта в машину, пяльцы в повернутом положении не будут 
идентифицированы. Поэтому перед вышиванием необходимо возвратить пяльцы в первоначальное 
положение. 
 
Как изменить ориентацию пялец 
1  Щелкните правой кнопкой мыши по значку Show 

Hoop (Показать пяльцы). 
 Появится диалоговое окно Options с открытой 

закладкой Hoop (Пяльцы).  
2  Выберите из списка Hoop пяльцы в повернутом 

(rotated) положении.  
 
 
3  Нажмите кнопку ОК. 

 
 
Пяльцы в первоначальном положении  Повернутые пяльцы 

Создание собственных пялец 
 
Если вы используете пяльцы с отсутствующими в списке размерами, вы можете 
создать свои собственные пяльцы и сохранить их для последующего 
использования. Вы можете создавать или редактировать четыре типа пялец – 
прямоугольные, овальные, раздвижные и 3-позиционные. 
 
Создание прямоугольных пялец 
Прямоугольные пяльцы отображаются черными пунктирными линиями. Вы 
можете назначить высоту и ширину прямоугольника. 
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Как создать прямоугольные пяльцы 
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1  Щелкните правой кнопкой мыши по значку Show Hoop 
(Показать пяльцы). 

 Появится диалоговое окно Options с открытой закладкой 
Hoop (Пяльцы).  

         
 
2  Нажмите кнопку New Hoop (Создать новые пяльцы). 
 Откроется диалоговое окно Create/Edit Hoop 

(Создать/Редактировать пяльцы). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
3  В списке Format выберите Rectangle (Прямоугольник). 
4  На панели Dimensions (Размеры) введите высоту (Height) и ширину (Width) прямоугольных пялец. 
5  Нажмите кнопку Save Hoop As (Сохранить пяльцы как) 
 Откроется диалоговое окно Save Hoop As. 
6  Введите имя пялец. 

 
7  Нажмите кнопку ОК. 
 
Создание овальных пялец 
Овальные пяльцы отображаются черным пунктирным контуром. 
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Высота прямоугольника    Общая высота 
 
 
 
 
 
 
 
 
 

Ширина 
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Как создать овальные пяльцы 
1  Щелкните правой кнопкой мыши по значку Show Hoop 

(Показать пяльцы). 
 Появится диалоговое окно Options с открытой закладкой Hoop 

(Пяльцы).  
 
                       
2  Нажмите кнопку New Hoop (Создать новые пяльцы). 
 Откроется диалоговое окно Create/Edit Hoop 

(Создать/Редактировать пяльцы). 

                     
 
3  В списке Format выберите Oval (Овал). 
4  На панели Dimensions (Размеры) введите высоту прямоугольника (Rectangle Height), общую высоту 

(Total Height) и ширину (Width) овальных пялец. 
5  Нажмите кнопку Save Hoop As (Сохранить пяльцы как) 
 Откроется диалоговое окно Save Hoop As. 
6  Введите имя пялец. 

               
 
7  Нажмите кнопку ОК. 
 
Создание раздвижных пялец 
Раздвижные пяльцы являются специальными пяльцами с регулируемыми рамками для приспособления к 
необычным размерам проекта. Эти пяльцы отображаются сплошным черным контуром всех пялец с 
пунктирным контуром для каждого положения пялец. 
 
 
 
 
 
Поле вышивания  Общая высота 
 
 
 
 
 
 
 
 
 
 
                                                         Ширина 
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Как создать раздвижные пяльцы 
1  Щелкните правой кнопкой мыши по значку Show Hoop 

(Показать пяльцы). 
 Появится диалоговое окно Options с открытой закладкой 

Hoop (Пяльцы).  
 
 
 
 
 
 
 
 
2  Нажмите кнопку New Hoop (Создать новые пяльцы). 
 Откроется диалоговое окно Create/Edit Hoop (Создать/Редактировать пяльцы). 

      
 
3  В списке Format выберите Sliding (Раздвижные). 
4  На панели Dimensions (Размеры) введите высоту поля вышивания (Sewing Field), общую высоту (Total 

Height) и ширину (Width) пялец. 
 
 Примечание: Лучше всего вводить в первую очередь общую высоту. Если поле вышивания больше 

принятой по умолчанию общей высоты, то установленный размер уменьшается. 
5  Нажмите кнопку Save Hoop As (Сохранить пяльцы как) 
 Откроется диалоговое окно Save Hoop As. 
6  Введите имя пялец, например Sliding. 
 

         
7 Нажмите кнопку ОК. 
 
Создание собственных 3-позиционных пялец 
3-позиционные пяльцы позволяют вручную разбить проект и вышивать без использования техники 
регистрации. Они отображаются в виде трех оконтуренных пунктиром прямоугольников. Верхний 
прямоугольник зеленый, средний синий и нижний красный. 
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3-позиционные пяльцы имеют раздвижную секцию, которая позволяет разместить три зоны вышивания на 
машине без перезакрепления материала в пяльцах. Раздвижная зона перемещается между 
фиксированными позициями с известными размерами, облегчая регистрацию объектов вышивания в 
каждой позиции. 
 
 
Позиция 1 
Высота 
 
 
Позиция 2   Общая высота 
Высота 
 
 
Позиция 3 
Высота 
 

 
Ширина 

 
Как создать 3-позиционные пяльцы 
1  Щелкните правой кнопкой мыши по значку Show Hoop (Показать пяльцы). 
 Появится диалоговое окно Options с открытой закладкой Hoop (Пяльцы).  

              
 
2  Нажмите кнопку New Hoop (Создать новые пяльцы). 
 Откроется диалоговое окно Create/Edit Hoop (Создать/Редактировать пяльцы). 

            
 
3  В списке Format выберите 3-Position (3-позиционные). 
4  На панели Dimensions (Размеры) введите общую высоту (Total Height), значения высоты для позиций 1, 2 

и 3, а затем ширину пялец (Width). 
 
 Примечание: Лучше всего вводить в первую очередь общую высоту. Если поле вышивания больше 

принятой по умолчанию общей высоты, то установленный размер уменьшается. 
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5  Нажмите кнопку Save Hoop As (Сохранить пяльцы как) 
 Откроется диалоговое окно Save Hoop As. 
6  Введите имя пялец. 
                 
7  Нажмите кнопку ОК. 

Редактирование собственных пялец 
 
При необходимости можно изменять высоту и ширину новых пялец. 
 
Как редактировать собственные пяльцы 
1  Щелкните правой кнопкой мыши по значку Show Hoop 
(Показать пяльцы). 
 Появится диалоговое окно Options с открытой закладкой 
Hoop (Пяльцы).  
             
 
2  В списке Hoop (Пяльцы) выберите пяльцы. 
3  Нажмите кнопку Edit Hoop (Редактировать пяльцы). 
 Откроется диалоговое окно Create/Edit Hoop 
(Создать/Редактировать пяльцы). 
 

      
 
4  Введите новые размеры. 
5  Нажмите кнопку Save Hoop (Сохранить пяльцы). 

Удаление пялец 
 
Если вы удаляете тип пялец, он удаляется навсегда. Можно удалять только собственноручно созданные 
пяльцы. 
 
Как удалить пяльцы 
1  Щелкните правой кнопкой мыши по значку Show Hoop 

(Показать пяльцы). 
 Появится диалоговое окно Options с открытой закладкой 

Hoop (Пяльцы).  
2  Выберите созданные вами пяльцы, которые вы хотите 

удалить. 
    
 
3  Нажмите кнопку Delete Hoop (Удалить пяльцы), а затем 

для подтверждения  кнопку OK. 
 Пяльцы будут удалены. 
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Часть II:  
Основные технические 
приемы оцифровывания 
 

Глава 7  
Методы оцифровывания 
 
В BERNINA artista вы составляете проекты из базовых форм, или 
"вышивальных объектов". Наподобие рисованных объектов, 
вышивальные объекты обладают определенными 
характеристиками, или "свойствами", такими как цвет, размеры, 
положение и т.п. Они обладают также специфичными для вышивок 
свойствами, такими как тип и плотность стежков. 
Наиболее важным свойством объекта вышивки является тип 
стежка. Различные типы стежков подходят для разных форм. 
Подробнее см. в разделе Оконтуривающие и заполняющие стежки. 
Процесс создания вышивальных объектов на экране называется 
"оцифровыванием". Как и при создании проектов в графических 
программах, используют различные инструментальные средства 
оцифровывания. Инструментальные средства оцифровывания в 
BERNINA artista подобны инструментам рисования с той лишь 
разницей, что конечным результатом является вышивальный, а не 
рисованный объект. 
Свойства объекта определяются во время оцифровывания, но они 
могут быть на любой стадии изменены. При создании объекта вышивки вы можете принять 
предлагаемые по умолчанию настройки для отдельного метода оцифровывания или же применить 
другие настройки. Принимаемые по умолчанию стандартные настройки хранятся в шаблоне 
проекта. Вы можете также определить "текущие" свойства, которые будут влиять на все объекты, 
создаваемые в текущем проекте. Подробнее см. в разделе Свойства объекта и шаблоны. 
В настоящем разделе описывается, как оцифровывать объекты основными способами 
оцифровывания. Кроме того, объясняется, как подогнать настройки оцифровывания для получения 
лучших результатов. 

Инструментальные средства оцифровывания 
 
Различные методы оцифровывания, или "инструментальные средства", приспособлены для создания 
различных форм или элементов проекта. 
Методы оцифровывания подразделяются на две большие категории – оконтуривание и заполнение. 
 
Совет: Рисованные объекты могут быть преобразованы в объекты вышивания с использованием инструмента 
BERNINA artista Magic Wand (Волшебная палочка). Подробнее см. в разделе Оцифровывание Волшебной 
палочкой, 
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Выбор инструмента оцифровывания 
 

Используйте инструмент Open Curve (панель Design) для оцифровывания линий. 
 
 
 
Используйте инструмент Closed Curve (панель) Design для оцифровывания фигур неправильной 
формы. 
 
 
Используйте инструмент Circle/Oval (панель Design) для оцифровывания окружности или овала. 
 
 
 
 
Используйте инструмент Rectangle (панель Design) для оцифровывания квадрата или прямоугольника. 
 
 
 
Используйте инструмент Block Digitizing (панель Design) для оцифровывания колонок. 
 

Методы оцифровывания подразделяются на две большие категории – оконтуривание и заполнение. BERNINA 
artista предоставляет различные инструментальные средства для оцифровывания образов – Open Curve 
(Незамкнутая кривая), Closed Curve (Замкнутая кривая), Block Digitizing (Оцифровывание блоков), Circle/Oval 
(Окружность/Овал) и Rectangle (Прямоугольник). Инструмент Open Curve используется для создания 
оконтуривающих фигур. Инструмент Block Digitizing используется для оцифровывания колонок с изменяющейся 
шириной и углом вышивания. Инструменты Closed Curve, Circle/Oval, Rectangle используются для создания 
заполняющих или оконтуривающих фигур. 
 
Базисные точки и контрольные точки 
После выбора инструмента вы оцифровываете фигуры одним и тем же способом, намечая "базисные точки" по 
контуру. В общем случае вы намечаете базисные точки, если: 
◄ изогнутый контур изменят кривизну, 
◄ контур имеет углы, 
◄ контурная линия изменяется от прямой до кривой. 
Вы всегда используете левую кнопку мыши для отметки угловой точки и правую кнопку для отметки точек 
кривой линии. Две точки, намеченные левой кнопкой мыши, всегда соединяются прямой линией. Две точки, 
намеченные правой кнопкой мыши, всегда соединяются изогнутой линией. 
Базисные точки, намеченные вами при оцифровывании фигуры, становятся "контрольными точками" 
выбранного объекта. Контрольные точки, появляющиеся на контурах объекта, используются для 
редактирования или "преобразования" объектов. Такие действия могут включать изменение формы, изменения 
размеров, межсимвольного интервала, изменения точек входа и выхода. 
 
Ключ для контрольных точек 
=  угловая точка 
 
=  точка выхода 
 
=  точка кривой 
 
=  точка входа 
 
=  линия угла наклона стежка 
 
Большинство контрольных точек может быть добавлено, удалено или преобразовано в точки угла или кривой. 
Некоторые контрольные точки имеют специфичные функции и не могут быть удалены, например маркеры точек 
входа. 
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Переключение между методами оцифровывания заполнения и контура 
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Используйте инструмент Outline (панели Stitch and Color) для оцифровывания линий. 
 
 
 
Используйте инструмент Fill (панель Stitch and Color) для оцифровывания фигур. 
 

Вы можете быстро переключаться с заполняющего стежка на оконтуривающий стежок, используя инструменты 
Fill (Заполнение) и Outline (Оконтуривание). См. также Оконтуривающие и заполняющие стежки. 
 
Как переключаться между методами оцифровывания заполнения и контура 
◄ Выберите инструмент оцифровывания и затем перед оцифровыванием нажмите значок Fill или Outline. 

Оцифровывание открытых фигур 
 
Используйте инструмент Open Curve (панель Design) для оцифровывания открытых фигур. 
 
Используйте инструмент Open Curve (Незамкнутая кривая) для оцифровывания открытых фигур 

одинарным/тройным рядом различных стежков. Инструмент Open Curve располагает ряд стежков вдоль 
оцифровываемой линии.  С этим инструментом можно использовать только оконтуривающий стежок. Этот 
инструмент обычно используется для добавления обрамления к проекту. 
При создании объектов используйте левую и правую кнопки мыши для отметки базисных точек, образующих 
контур. Щелчком левой кнопку вводятся угловые точки, щелчком правой кнопки – точки кривой. 

 
Незамкнутые кривые 

 
Как оцифровывать открытые фигуры 
1  Выберите тип стежка Outline  
2  Нажмите кнопку Open Curve (Незамкнутая кривая). 
3  Оцифруйте фигуру, наметив базисные точки вокруг ее контура. 
◄ Щелкайте левой кнопкой мыши для ввода угловых точек. 
◄ Щелкайте правой кнопкой мыши для ввода точек кривой. 

 

 
                        Инструмент Незамкнутая кривая: открытый объект 
 
Совет: Следуйте указаниям в строке состояния, помогающим при оцифровывании. Если вы ошиблись, нажмите 
клавишу Backspace, чтобы удалить последнюю базисную точку, и затем продолжайте оцифровывание. 

Оцифровывание замкнутых фигур 
 

Используйте инструмент Closed Curve (панель Design) для оцифровывания нерегулярных замкнутых 
фигур. 
 

Оцифровывайте сложные фигуры инструментом Closed Curve (Замкнутая кривая). При создании объектов 
используйте левую и правую кнопки мыши для отметки базисных точек, образующих контур. 
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Замкнутая оконтуривающая кривая   Заполненная замкнутая кривая 
 
Как оцифровывать замкнутые кривые 
1  Нажмите кнопку Closed Curve (Замкнутая кривая). 
2  На панели Stitch and Color (Стежок и Цвет) выберите Outline (Оконтуривание) или Fill (Заполнение). 
3  Оцифруйте контур фигуры, наметив базисные точки вокруг контура фигуры. 
 
◄ Щелкайте левой кнопкой мыши для ввода угловых точек. 
◄ Щелкайте правой кнопкой мыши для ввода точек кривой. 

 
Совет: Следуйте указаниям в строке состояния, помогающим при оцифровывании. Если вы ошиблись, нажмите 
клавишу Backspace, чтобы удалить последнюю базисную точку, и затем продолжайте оцифровывание. 
4  Закройте контур фигуры. 

◄ Чтобы закрыть контур тем же типом базисной точки, который был использован в конце оцифровывания, 
- т.е. точкой угла или кривой, - просто нажмите клавишу Enter. 

◄ Чтобы закрыть контур другим типом базисной точки, наметьте последнюю точку над первой и нажмите 
клавишу Enter. 

      
           Инструмент Замкнутая кривая: объект закрыт автоматически 
 
 

Оцифровывание колонок с изменяющейся шириной 
 
Используйте инструмент Block Digitizing (панель Design) для оцифровывания колонок с 
изменяющейся шириной и углом вышивания. 
 

Используйте инструмент Block Digitizing (Оцифровывание блоков) для оцифровывания колонок с 
изменяющейся шириной и углом вышивания. Оцифрованные пары базисных точек определяют контур, а линии, 
соединяющие эти пары, определяют углы вышивания. 
 
Как оцифровывать колонку с изменяющейся шириной. 
1  Щелкните по значку Block Digitizing. 
2  Оцифровывание колонки отметкой базисных точек на противоположных сторонах колонки. 

◄ Щелкайте левой кнопкой мыши для ввода угловых точек. 
◄ Щелкайте правой кнопкой мыши для ввода точек кривой. 

 Наметьте пару точек в том месте, где меняется контур и где вы хотите изменить угол стежка. 
 

 
 
Постепенное изменение угла наклона стежков    Угол наклона стежков остается постоянным 
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Совет: Парные контрольные точки не обязательно должны быть одного и того же типа. Например, одна точка 
может быть угловой, другая – находиться на кривой линии. 
 
Совет: Если вы ошиблись, нажмите клавишу Backspace, чтобы удалить последнюю базисную точку, и затем 
продолжайте оцифровывание. 
3  Когда вы закончите оцифровывание линии: 

◄ Нажмите Enter, чтобы сохранить последний стежок и поместить точку выхода в последней 
оцифрованной вами базисной точке или 

◄ Нажмите клавишу пробела, чтобы пропустить последний стежок и разместить точку выхода на 
противоположной стороне колонки. 

Нажмите клавишу пробела 
 
начало  конец 
 
 
 
 
 
ИЛИ 
 

Нажмите Enter  
 

начало             
 
 
 
 

конец 
 
Совет: Если вы соединяете две колонки, пропустите последний стежок первой колонки, так чтобы точка выхода 
находилась вплотную к точке входа следующей колонки. 

Оцифровывание окружностей и овалов 
 
Используйте инструмент Circle/Oval (панель Design) для оцифровывания окружностей и овалов. 
 

Оцифровывайте окружности и овалы несколькими щелчками мыши. Для окружностей и овалов вы можете 
использовать любой тип заполняющих или оконтуривающих стежков. 
 

 
Одинарные стежки Стежки гладьевого 

валика 
Краеобметочные стежки 

 
Простегивающие стежки Узорные стежки Орнаментные стежки 
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Как оцифровывать окружность или овал 
1  Щелкните по значку Circle/Oval (Окружность/Овал) 
2  Оцифровывание окружности или овала. 

◄ Щелкните для отметки центра окружности или овала. К указателю мыши присоединится контур 
окружности. 

◄ Перемещайте указатель мыши до тех пор, пока контур не достигнет требуемых размеров, затем 
щелкните мышью, чтобы наметить базисную точку радиуса. Эта точка отмечает также точку входа 
стежка. Угол наклона стежка может быть перпендикулярным к линии, соединяющим точку центра и 
базисную точку радиуса. 

◄ Для создания окружности нажмите Enter. 
◄ Для создания овала щелкните еще раз, чтобы наметить точку второго радиуса, и нажмите Enter. 

                  
         Центр Нажмите Enter            Центр Нажмите Enter 
 
Оцифровывание квадратов и прямоугольников 

 
Используйте инструмент Rectangle (панель Design) для оцифровывания квадратов и 
прямоугольников. 
 

Оцифровывайте квадраты и прямоугольники несколькими щелчками мыши. Для квадратов и прямоугольников 
вы можете использовать любой тип заполняющих или оконтуривающих стежков. 
 

 
Одинарные стежки Стежки гладьевого валика Краеобметочные стежки 

 
Простегивающие стежки Узорные стежки Орнаментные стежки 
 
Как оцифровывать квадрат и прямоугольник. 
1  Щелкните по значку Rectangle (Прямоугольник). 
2  Оцифровывание квадрата и прямоугольника. 
◄ Щелкните, чтобы наметить один из углов прямоугольника. 
◄ Перетаскивайте указатель мыши до тех пор, пока контур не достигнет требуемого размера. 
◄ Щелкните еще раз, чтобы определить место противоположного угла прямоугольника/квадрата. 

 
 

◄ Для создания квадрата удерживайте нажатой клавишу Ctrl во время перетаскивания мыши.  
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Глава 8  
 
 
 
 
 
Оконтуривающие и заполняющие 
стежки 
 
Все вышиваемые объекты BERNINA artista имеют определенные 
настройки или "свойства". Некоторые свойства, такие как размер и 
позиция, являются общими для всех. Другие являются 
специфичными для данного типа объекта. Наиболее важным 
свойством является тип стежка. Каждый раз, когда вы создаете 
или модифицируете объект, стежки генерируются в соответствии 
с взаимодействующим типом стежка. Такие настройки, как шаг и 
длина стежков, также могут быть приспособлены к требованиям. 
BERNINA artista предоставляет разнообразные методы 
оцифровывания или "инструменты" для создания объектов 
вышивки. Эти инструменты подразделяются на два больших типа 
– "Оконтуривание" и "Заполнение". Это же относится и к типам 
стежков. Типы оконтуривающих и заполняющих стежков 
определяются во время создания вышивальных форм, но вы 
можете изменять их на любой стадии. 
В этом разделе поясняется, как выбирать основные типы 
оконтуривающих и заполняющих стежков, а также изменять 
настройки стежков для получения наилучших результатов. 
 

Выбор или изменение стежков 
 
BERNINA artista предоставляет вам несколько основных типов оконтуривающих и заполняющих стежков. 
Для специального использования предназначены "художественные" стежки и стежки, имитирующие 
ручное вышивание. См. также Эффекты художественных стежков, Оконтуривание и заполнение узорами и 
Оконтуривание и заполнение рукодельными стежками. 
Различные типы стежков подходят для различных форм. При создании объекта всегда используется 
последний из выбранных типов стежка. Вы можете изменить его на любой стадии. 
 
Совет: Задавайте значения стежка путем изменения текущих свойств в диалоговом окне Object Properties 
(Свойства объекта) перед началом оцифровывания. Подробнее см. в разделе Свойства объекта и 
шаблоны. 
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Выбор оконтуривающих стежков 
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Нажмите кнопку Outline (панель Stitch & Color) для выбора оконтуривающих стежков. 
 

Используйте Single для тонких контурных линий. 
Используйте Triple для толстых контурных линий. 
Используйте Satin для добавления толстой контурной линии к большим формам. 
Используйте Blanket для создания эффекта "гребенки" в длинных узких валиках.  
 
BERNINA artista предлагает основные одинарные, тройные, гладьевые и 
краеобметочные оконтуривающие стежки, а также возможности оконтуривания 
узорными и "рукодельными" стежками. Вы можете изменить их на любой стадии. См. 
также Оконтуривание и заполнение узорами и Оконтуривание и заполнение 
рукодельными стежками. 
 
Как выбрать оконтуривающий стежок 
1  Выделите объект/ы. 
2  Нажмите кнопку Outline (Оконтуривание). 
3  Из открывшегося списка выберите тип стежка. Выбранный тип стежка будет применен к выбранному 

объекту или объектам. Будут использованы текущие настройки. 
 
Выбор заполняющих стежков 
 

Нажмите кнопку Fill (панель Stitch & Color) для выбора заполняющих стежков. 
 

Используйте Satin для узких колонок и форм. 
Используйте Step для заполнения крупных форм с нерегулярными контурами. 
 
BERNINA artista предлагает основные гладьевые и простегивающие заполняющие 
стежки, а также орнаментные, узорные и рукодельные заполняющие стежки. Вы 
можете изменить их на любой стадии. См. также Эффекты художественных стежков, 
Оконтуривание и заполнение узорами и Оконтуривание и заполнение рукодельными 
стежками. 
 
Как выбрать заполняющий стежок 
1  Выделите объект/ы. 
2  Нажмите кнопку Fill (Заполнить). 
3  Из открывшегося списка выберите тип стежка. Выбранный тип стежка будет применен к выбранному 

объекту или объектам. Будут использованы текущие настройки. 

Создание контуров одинарным и тройным оконтуривающим 
стежком 
 
Используйте инструмент Single outline (панель Stitch & Color). чтобы поместить ряд одинарных стежков 
вдоль оцифровываемой линии. 
Используйте инструмент Triple outline (панель Stitch & Color). чтобы поместить ряд тройных стежков вдоль 
оцифровываемой линии. 
 

Нажмите кнопку Object Properties (панели General), чтобы установить длину стежка. 
 

Используйте инструменты Single Outline (Одинарный контур)  и Triple Outline (Тройной контур) для 
оцифровывания линий одинарными или тройными стежками. Инструмент Single Outline располагает вдоль 
оцифровываемой линии одинарный ряд стежков. Инструмент Triple Outline повторяет каждый стежок три 
(или больше) раза для создания более толстой линии.  Эти инструменты обычно используются для 
добавления обрамления к проекту. 
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одинарный контур 
 
 
 
 
 
 
тройной контур 
 
 
 
 
 
Вы можете изменить длину стежка на закладке Outline Stitch (Оконтуривающий стежок) диалогового окна  
Object Properties (Свойства объекта). Как для одинарных, так и для тройных стежков длина стежка 
устанавливается для приспособления к оцифровываемой форме. Если в объекте имеются кривые малого 
радиуса, выбирайте небольшую длину стежка. Для сокращения количества стежков на пологих кривых 
увеличивайте длину стежка. 
 
Примечание: Вы не сможете увидеть на экране различие между одинарным и тройным оконтуривающим 
стежком, так как дополнительные стежки перекрывают друг друга. Чтобы проверить, вышивается ли 
объект тройным стежком, нужно обойти объект по стежкам. Подробнее см. в разделе Обход по стежкам. 
 
Как создавать контуры одинарным и тройным оконтуривающим стежком 
1  Оцифруйте незамкнутую или замкнутую фигуру. 
 Подробнее см. в разделе Методы оцифровывания. 
2  Дважды щелкните по объекту. 
 Откроется закладка Outline Stitch (Оконтуривающий стежок) диалогового окна Object Properties 

(Свойства объекта). 
 
 
 
Выберите Single или Triple 
 
 
 
Введите длину стежка 
 
 
3  Из списка Stitch Type (Тип стежка) выберите Single (Одинарный) или Triple (Тройной).  
                             длина 
одинарный   
 
 
 
 
тройной  
 
 
 
4  В поле Stitch Length введите длину стежка. 
 

длина стежка 
 

 
слишком мало стежков    стежки располагаются  
для воспроизведения кривой   на кривой более плотно 
 

При малом радиусе кривой уменьшите длину стежка, например до 1,8 мм, чтобы стежки плотнее 
располагались на кривой. 
Совет: Вы можете имитировать ручную вышивку одинарными или тройными оконтуривающими 
стежками, установив длину стежка на 4,0 мм. 

5  Нажмите кнопку ОК. 
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Создание контуров стежком гладьевого валика 
 
Используйте инструмент Satin outline (панель Stitch & Color) для оцифровывания обрамления. 
Нажмите кнопку Object Properties (панель General), чтобы установить шаг стежков. 

 
Гладьевый стежок (Satin stitch) может быть использован для оконтуривания или заполнения. Он хорошо 
подходит для вышивания узких гладьевых валиков и форм, когда длина каждого стежка соответствует 
ширине валика или формы. 
 
 
 
 
 
 

Прямой валик 
                     Извилистый валик 
 
Отрегулируйте плотность стежков, назначив фиксированный шаг стежков, или выберите инструмент Auto 
Spacing (Автоматический шаг), который будет рассчитывать требуемый интервал между стежками. 
 
Совет: Задавайте значения стежка путем изменения текущих свойств в диалоговом окне Object Properties 
(Свойства объекта) перед началом оцифровывания. Подробнее см. в разделе Свойства объекта и 
шаблоны. 
 
Подгонка стежка гладьевого валика по шагу и ширине. 

 
Нажмите кнопку Object Properties (панель General), чтобы установить длину и шаг стежков. 
 

Шаг стежка – это расстояние в миллиметрах между двумя точками укола иглы на одной и той же стороне 
валика. При малой ширине валика стежки располагаются плотно, поэтому требуется меньше стежков для 
покрытия ткани. Если валик очень узкий, стежки должны быть менее плотными, поскольку слишком 
большое количество уколов иглой может повредить материал. См. также Подгонка стежка гладьевого 
валика по шагу и ширине. 

 
                Шаг стежка гладьевого валика 
 
Изменение плотности стежков гладьевого заполнения производится путем установки шага стежка в 
диалоговом окне Object Properties. Чем больше интервал между стежками, тем ниже плотность стежков. 
Чем меньше интервал, тем выше плотность стежков. 
 
Как подгонять стежок гладьевого валика по шагу и ширине. 
1  Дважды щелкните по оконтуриваемому объекту. 
 Откроется закладка Outline Stitch (Оконтуривающий стежок) диалоговое окна Object Properties   
     (Свойства объекта). 
 
 
 
 
Выберите Satin 
 
Выберите Manual,  
чтобы изменить шаг  
стежков 
 
 
Введите значения шага  
стежка и ширины строчки 
 
 
2  Выберите Satin (Гладьевый стежок) из списка Stitch Type (Тип стежка) 
3  Выберите опцию Manual (Вручную). 
 
Примечание: Если выбрана опция Auto Spacing, то установка фиксированного шага стежка будет 
игнорирована. Подробнее см. в разделе Применение автоматического интервала для гладьевого валика. 
4  В поле Stitch Spacing (Шаг стежка) введите нужное значение. 

◄ Для увеличения плотности стежков введите меньшее значение. 
◄ Для уменьшения плотности стежков введите большее значение. 
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Шаг стежка 0,6 мм   Шаг стежка 1,0 мм 

5  В поле Satin Width (Ширина гладьевого валика) введите нужную величину. 
6  Нажмите кнопку ОК. 
 
Применение автоматического интервала для гладьевого валика. 

63

 
Нажмите кнопку Object Properties (панели General), чтобы применить функцию Automatic Spacing. 
 
 

Инструмент Automatic Spacing (Автоматический интервал) приспосабливает шаг стежков 
соответственно ширине гладьевого валика. Для изменяющейся ширины объекта функция Automatic 
Spacing изменяет шаг стежков, чтобы обеспечить оптимальную плотность стежков. См. также Подгонка 
стежка гладьевого валика по шагу и ширине. 
 
Как применить автоматический интервал для гладьевого валика. 
1  Дважды щелкните по оконтуриваемому объекту. 
 Откроется закладка Outline Stitch (Оконтуривающий стежок) диалоговое окна Object Properties 
(Свойства объекта). 
 
Выберите Automatic 
 
 
 
 
 
2  Выберите Satin (Гладьевый стежок) из списка Stitch Type (Тип стежка) 
3  Выберите Automatic. 
4  Нажмите кнопку ОК. 

 
Включена функция Auto Spacing         Выключена функция Auto Spacing  
 
Настройка смещения оконтуривающих стежков гладьевого валика  

 
Нажмите кнопку Object Properties (панель General), чтобы настроить смещение стежка. 
 

По умолчанию стежки располагаются по оси оцифровываемой линии. Однако вы можете сместить стежки 
от средней линии. 
 
Как настроить смещение оконтуривающих стежков гладьевого валика  
1  Дважды щелкните по оконтуриваемому объекту. 
 Откроется закладка Outline Stitch (Оконтуривающий стежок) диалоговое окна Object Properties 
(Свойства объекта). 

 
 
 
 
Выберите Center или Offset 
 
 
 

2  Выберите Satin (Гладьевый стежок) из списка Stitch Type (Тип стежка) 
3  Выберите опцию смещения:  

◄ Center (по центру) 
◄ Offset (со смещением) 

 
Совет: Просмотрите, как сместятся стежки при выделении объекта, затем нажмите инструмент Reshape 
(Изменение формы). 
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4  Нажмите кнопку ОК. 

 
Центральное положение гладьевого валика   Смещенное положение гладьевого валика 
 

Создание контуров краеобметочным стежком 
 
Краеобметочный стежок (Blanket stitch) используется для создания длинных, узких колонок с 
"гребенчатым" эффектом. Он часто применяется для обшивки аппликаций. Игла протыкает обе стороны 
колонки, а затем протыкает вторую сторону еще раз, прокладывая продольную нитку. Краеобметочные 
стежки обычно более открыты, чем стежки гладьевого валика. 

 
Прямой валик                                                Извилистый валик 
 
Совет: Задавайте значения стежка путем изменения текущих свойств в диалоговом окне Object Properties 
(Свойства объекта) перед началом оцифровывания. Подробнее см. в разделе Свойства объекта и 
шаблоны. 
 
Настройка шага краеобметочного стежка 
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Нажмите кнопку Object Properties (панель General), чтобы установить шаг стежков. 
 

Вы можете отрегулировать длину стежка и интервал между стежками (шаг стежка). 
 
шаг стежка 
   длина стежка 
 
 
 
 
Как настроить шаг краеобметочного стежка 
1  Дважды щелкните по оконтуриваемому объекту. 
 Откроется закладка Outline Stitch (Оконтуривающий стежок) диалогового окна Object Properties 
(Свойства объекта). 
 
 
 
Введите шаг стежка 
 
 
Введите длину стежка 
 
 
2  Выберите Blanket (Краеобметочный стежок) из списка Stitch Type (Тип стежка) 
3  В поле Stitch Spacing (Шаг стежка) введите нужное значение. 
 
Это значение соответствует расстоянию в миллиметрах между перпендикулярными стежками. 

 
Шаг: 1,0 мм        Шаг: 3,5 мм     Шаг: 2,0 мм 
4  В поле Blanket Width (Длина краеобметочного стежка) введите нужное значение. 

 
Длина стежка: 2,5 мм      Длина стежка: 5 мм                     5  Нажмите кнопку ОК. 
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Регулировка смещения краеобметочного стежка 
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Нажмите кнопку Object Properties (панель General), чтобы настроить смещение краеобметочного 
стежка. 

 
По умолчанию стежки располагаются по оси оцифровываемой линии. Однако вы можете сместить стежки 
от средней линии. 

 
Смещенные краеобметочные      Расположенные по оси линии  
стежки            краеобметочные стежки 
Как настроить смещение краеобметочного стежка 
1  Дважды щелкните по оконтуриваемому объекту. 
 Откроется закладка Outline Stitch (Оконтуривающий стежок) диалогового окна Object Properties 

(Свойства объекта). 
 
 
Выберите Center или Offset   
 
 
 
 
2  Выберите Blanket (Краеобметочный стежок) из списка Stitch Type (Тип стежка) 
3  Выберите опцию смещения:  

◄ Center (по центру) 
◄ Offset (со смещением) 

 
Совет: Просмотрите, как сместятся стежки при выделении объекта, затем нажмите инструмент 
Reshape (Изменение формы). 

4  Нажмите кнопку ОК. 
 
Создание заполнения гладьевым стежком 
 
Используйте опцию Satin (панель Stitch & Color) для применения гладьевых заполняющих стежков к новым 
или выделенным узким колонкам и формам. 
 
Гладьевый заполняющий стежок хорошо подходит для вышивания узких гладьевых валиков и форм, когда 
длина каждого стежка соответствует ширине валика или формы. Гладьевые стежки почти параллельны, 
причем каждый второй стежок имеет небольшой наклон. Поскольку, как правило, уколы иглой не 
прерывают заполнение, гладьевые заполняющие стежки создают высококачественный глянцевитый 
эффект. 

 
Совет: Если колонка слишком широка, стежки могут быть рыхлыми и не обеспечить должное покрытие 
материала. Если нужно увеличить размер проекта, используйте функцию Satin Special. Благодаря этому 
длина стежка будет увеличиваться автоматически при увеличении проекта. 
 
Регулировка шага гладьевого заполняющего стежка 
 

Нажмите кнопку Object Properties (панель General), чтобы установить шаг гладьевых стежков. 
 

Шаг стежка – это расстояние в миллиметрах между двумя точками укола иглы на одной и той же стороне 
колонки. При малой ширине колонки стежки располагаются плотно, поэтому требуется меньше стежков 
для покрытия ткани. Если колонка очень узкая, стежки должны быть менее плотными, поскольку слишком 
большое количество уколов иглой может повредить материал. См. также Сохранение длинных стежков 
функцией Auto Jump. 
 

Шаг гладьевого стежка  
 

Ширина 
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Изменение плотности стежков гладьевого заполнения производится путем установки шага стежка в 
диалоговом окне Object Properties. Чем больше интервал, тем меньше плотность стежков. Чем меньше 
интервал, тем выше плотность стежков. Вы можете назначить фиксированный шаг стежков, или выберать 
инструмент Auto Spacing (Автоматический шаг), который будет рассчитывать требуемый интервал между 
стежками.  Функция Auto Spacing автоматические регулирует интервал между стежками при изменении 
ширины колонки. 
 
Как регулировать шаг гладьевого заполняющего стежка 
1  Дважды щелкните по заполняемому объекту. 
 Откроется закладка Outline Stitch (Заполняющий стежок) диалогового окна Object Properties (Свойства 

объекта). 
 
 
Выберите Satin 
 
Выберите способ   
назначения шага стежка 
 
 
2  Выберите Satin из списка Stitch Type, если гладьевый стежок еще не был выбран. 
3  Выберите опцию Manual (Вручную). 
4  Введите в поле Stitch Spacing требуемый шаг стежка. 

◄ Для увеличения плотности стежков введите меньшее значение. 
◄ Для уменьшения плотности стежков введите большее значение. 

      
        Шаг стежка 1,0 мм     Шаг стежка 1,8 мм 
 
5  Выберите функцию Auto Jump (Автоматический переход), чтобы контролировать длинные гладьевые 

стежки. 
 См. также Сохранение длинных стежков функцией Auto Jump. 
6  Нажмите кнопку ОК. 
 
Применение автоматического интервала для гладьевого заполнения 

 
Нажмите кнопку Object Properties (панель General), чтобы установить автоматический интервал для 
гладьевых стежков. 
 

Функция автоматического интервала регулирует шаг гладьевых стежков в соответствии с шириной 
колонки. См. также Сохранение длинных стежков функцией Auto Jump. 
 
Как применить автоматический интервал для гладьевого заполнения 
1  Дважды щелкните по заполняемому объекту. 
 Откроется закладка Outline Stitch (Заполняющий стежок) диалогового окна Object Properties (Свойства 

объекта). 
 
 
 
 
 
Выберите Automatic 
 
 
2  Выберите Satin из списка Stitch Type, если гладьевый стежок еще не был выбран. 
3  Выберите Automatic. 
 
Автоматический интервал 
 

Ручной выбор интервала 
 

        
Различный интервал в 
зависимости от формы объекта 

Интервал остается одинаковым для всего 
объекта 

4  Нажмите кнопку ОК. 
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Создание заполнения простегивающим стежком 
 
Различные типы стежков подходят для различных форм. BERNINA artista предлагает основные гладьевые 
и простегивающие заполняющие стежки, а также орнаментные и рукодельные заполняющие стежки. Эти 
стежки доступны из панели инструментов Stitch & Color (Стежок и Цвет). Имеется также выделенная для 
этого панель Craft Stitch (Рукодельные стежки). 
 

            
Заполнение простегивающими стежками состоит из рядов прямых стежков, подходящих для заполнения 
больших объектов нерегулярной формы. Стежки располагаются в обратном и прямом направлениях 
поперек заполняемой формы. Заполнение может быть однородным или узорчатым. Вы можете сделать 
выбор из различных образцов. Вы можете также регулировать шаг и длину стежков. 
 
Совет: Задавайте значения стежка путем изменения текущих свойств в диалоговом окне Object Properties 
(Свойства объекта) перед началом оцифровывания. Подробнее см. в разделе Свойства объекта и 
шаблоны. 
 
Выбор узоров простегивающих 
стежков 
С заполняющими простегивающими стежками вы 
можете выбирать узоры, образуемые уколами 
иглы. По умолчанию предлагается узор (№ 1), 
предназначенный для создания плоской и гладкой 
текстуры, сходной с поверхностью шерстяной 
ткани. 
        
Имеются на выбор другие виды узоров. 
Поэкспериментируйте, чтобы найти наилучший 
узор для своего проекта. Подробнее см. в разделе 
Образцы заполнения простегивающими стежками. 
 
Как выбирать узоры заполнения простегивающими стежками 
1  Дважды щелкните по заполняемому объекту. 
 Откроется закладка Outline Stitch (Заполняющий стежок) диалогового окна Object Properties (Свойства 
объекта). 
 
 
Выберите узор заполнения 
 
 

 
2  Выберите Step из списка Stitch Type, если 
простегивающий стежок еще не был выбран. 
3  Выберите узор. 
 Появится обзор образцов узоров. 
4  Нажмите кнопку ОК. 
 
    
 
 
 
 
 
Регулировка шага простегивающего 
заполняющего стежка 
Для простегивающих стежков плотность определяется расстоянием между рядами стежков. Настройка 
интервала – это расстояние между двумя передними рядами. См. также Сохранение длинных стежков 
функцией Auto Jump. 
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   шаг стежка 
    
 
 

длина стежка 
вперед 
 
назад 
 
 
Как регулировать шаг простегивающего заполняющего стежка 
1  Дважды щелкните по заполняемому объекту. 
 Откроется закладка Outline Stitch (Заполняющий стежок) диалогового окна Object Properties (Свойства 
объекта). 
 
 
 
Введите шаг стежка 
 
 
 
2  Выберите Step из списка Stitch Type, если простегивающий стежок еще не был выбран. 
3  В поле Stitch Spacing (Шаг стежка) введите новое нужное значение. 
 Это значение соответствует расстоянию между каждым передним рядом стежков. 

◄ Для увеличения плотности стежков введите меньшее значение. 
◄ Для увеличения плотности стежков введите меньшее значение. 

           
Шаг стежка: 1,2 мм   Шаг стежка: 0,7 мм 

 
4  Нажмите кнопку ОК. 
 
Регулировка длины простегивающего заполняющего стежка 
Определите длину стежка, генерируемую для объекта простегивания. Длина стежка незначительно 
изменяется в заполняемом объекте, благодаря чему в углах фигуры не образуются мелкие стежки.  
 
Как регулировать длину простегивающего заполняющего стежка 
1  Дважды щелкните по заполняемому объекту. 
 Откроется закладка Outline Stitch (Заполняющий стежок) диалогового окна Object Properties (Свойства 
объекта). 
 
 
 
 
 
Введите длину стежка   
 
 
 
2  Выберите Step из списка Stitch Type, если простегивающий стежок еще не был выбран. 
 
3  В поле Stitch Length (Длина стежка), введите требуемое вам значение. 
 

          
     Длина стежка: 5,0 мм    Длина стежка: 2,0 мм 

 
4  Нажмите кнопку ОК. 
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Глава 9  
 
 
 
 
 
 
 
 

Свойства объекта и шаблоны 
 
Свойствами объектов вышивания определяются общие характеристики, такие как размер и 
положение, а также специфические вышивальные характеристики, такие как тип и плотность 
стежков. Специфичные настройки стежка определяют. каким образом будут воспроизводиться 
стежки при изменение формы, преобразовании или изменении размеров объекта. 
При создании объекта вышивки вы можете принять предлагаемые по умолчанию настройки для 
отдельного метода оцифровывания или же применить другие настройки. Принимаемые по 
умолчанию стандартные настройки хранятся в шаблоне проекта. Вы можете также определить 
"текущие" свойства, которые будут влиять на все объекты, создаваемые в текущем проекте. 
В этом разделе поясняется, как можно изменять свойства объекта в вашем проекте, а также как 
применять, создавать и сохранять стили и шаблоны в BERNINA artista. 
 

Применение свойств объекта и управление ими 
 
BERNINA artista сохраняет три набора свойств объекта: стандартный, текущий и существующий. 
 
Примечание: Некоторые свойства объекта могут быть модифицированы на экране; например, вы можете 
изменять свойства размера путем перетаскивания меток – манипуляторов выделения. Другие свойства, 
такие как шаг или длина стежка, изменяются в диалоговом окне Object Properties (Свойства объекта). 
 
Стандартные свойства объекта 
Стандартные свойства объекта являются свойствами, сохраняемыми в шаблоне проекта, и становятся 
начальными настройками, используемыми при создании нового проекта, основанного на этом шаблоне. 
 
Текущие свойства объекта 
Текущие свойства объекта – это настройки, используемые для создания новых объектов. До тех пор, пока 
вы не измените эти настройки, они остаются теми же, которые сохраняются по умолчанию в шаблоне. Вы, 
как правило, изменяете их для экономии времени при оцифровывании. Например, вы можете задавать 
настройку шага простегивающего стежка для использования специфичной плотности для новых 
создаваемых вами простегиваемых объектов. 

69



Глава 9: Свойства объекта и шаблоны 

BERNINA® Artista Designer Plus Версия 4  

Примечание: Изменение затрагивает новые объекты, но не сам шаблон. Для применения изменений ко 
всем новым проектам, основанным на текущем шаблоне, вам нужно изменить стандартные (default), -- но 
не текущие (current) – настройки. 
 
Свойства существующих объектов 
Свойства существующих объектов – это настройки, сохраняемые в каждом объекте в проекте. Вы можете 
сделать свойства выбранного объекта новыми текущими или стандартными свойствами. Вы можете также 
применить текущие свойства к существующим объектам. 
 
Настройка текущих свойств объекта 
 
Используйте функцию Object Properties (меню Settings) для настройки свойств объекта. 
 
При изменении текущих (current) свойств объекта новые настройки автоматически применяются к любым 
новым объектам, создаваемым в текущем проекте. Вы можете также применить текущие свойства к 
существующим объектам. Перед началом вы можете приспособить текущие свойства объекта к новым 
настройкам. 
 
Как настроить текущие свойства объекта 
1  Выберите Settings (Настройки) > Object Properties (Свойства объекта). 
 Откроется диалоговое окно Object Properties (Свойства объекта). 
 

 
Выберите закладку 

 
 
 
 

Измените настройки 
 
 
 
 
 Закладки отображены в верхней части диалогового окна Object Properties. Они обеспечивают доступ ко 

всем возможным настройкам свойств объекта. 
2  Щелкните по закладке, чтобы увидеть текущие настройки и изменить их по своему желанию. 
3  Нажмите кнопку ОК. 
 
Изменение свойств выбранных объектов 
 
Вы можете изменять свойства выбранного объекта или объектов. Например, если вы увеличите проект, 
вы сможете захотеть вышить некоторые объекты с заполнением простегивающими , а не гладьевыми 
стежками, чтобы получить более полное покрытие. Если вы выбрали больше одного объекта, в 
диалоговом окне Object Properties будут активными только те закладки, в которых находятся настройки, 
действительные для всех выделенных объектов.  

     
         Измененные значения выбранных объектов 
 
Если выбранные объекты имеют различные текущие значения для одних и тех же настроек, 
соответствующее поле будет пустым. Если вы введете новое значения, оно будет применено для всех 
объектов. 
 
Примечание: Изменение свойств существующих объектов не затрагивает текущие или стандартные 
настройки, а также любые не выделенные в данный момент объекты. 
 
Как изменять свойства выбранных объектов 
1  Выберите объект или объекты, свойства которых вы хотите изменить. 
2  Дважды щелкните по объекту. 
 Откроется диалоговое окно Object Properties (Свойства объекта). 
3  Выберите нужную вам закладку и измените по своему желанию настройки. 
4  Нажмите кнопку ОК. 
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Изменение стандартных свойств объекта 
 
Вы можете изменять стандартные свойства объекта в любое время путем сохранения свойств объекта, с 
которым вы работаете с текущим шаблоном. Сохраняются только настройки для этого объекта. Другие 
свойства остаются с текущими настройками. Например, если вы делаете свойства выбранного гладьевого 
объекта стандартными, стандартные настройки Fancy Fill (Заполнение орнаментными стежками) не 
будут изменены. 

             
Применен стандартный шаг   Применено новое значение 
гладьевого стежка     шага гладьевого стежка 

   
Примечание: Изменение затрагивают все новые проекты, создаваемые с этим шаблоном. Если вы хотите 
применить изменения к проекту, над которым вы работаете, измените текущие (current), но не 
стандартные (default) настройки. Подробнее см. в разделе Настройка текущих свойств объекта. 
 
Как изменять стандартные свойства объекта 
1  Выберите объект (или объекты), на основе которого вы хотите создать стандартные свойства. 
2  Дважды щелкните, чтобы открыть диалоговое окно Object Properties (Свойства объекта). 

 
 
 
 
 
Измените настройки 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Нажмите кнопку Save 
 
3  Выберите нужную вам закладку и измените по своему желанию настройки. 
4  Нажмите кнопку Save (Сохранить). 
 
Свойства объекта сохраняются в текущем шаблоне и будут применены к любым новым объектам в любом 
проекте, основанном на этом шаблоне.  
 
Примечание: Вы можете также создать новый шаблон, используя измененные свойства объекта в 
качестве стандартных. Подробнее см. в разделе Управление шаблонами проекта. 
 

Управление шаблонами проекта 
 
Шаблоны – это специальные файлы, используемые для сохранения стилей и 
стандартных, применяемых по умолчанию настроек. Используйте шаблоны, когда 
вы оцифровываете наиболее часто применяемые типы проектов, чтобы не 
устанавливать текущие свойства каждый раз заново. Например, шаблон может 
содержать стандартные объекты и образец текста. Он может просто содержать 
предпочитаемые настройки стежков, шрифт текста и его размер, в также набор 
цветов в качестве текущих свойств. Или в нем может быть задана специальная 
плотность стежков, компенсация стягивания или набор стабилизирующих стежков, 
подходящих для различных тканей. 

Часто используемый цвет  
фона может быть сохранен в шаблоне 
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Когда вы начинаете новый проект из меню File, в диалоговом окне New появляется список имеющихся 
шаблонов. Подробнее см. в разделе Создание новых проектов с шаблонами пользователя. 
Шаблон NORMAL является стандартным шаблоном, поставляемым с ПО BERNINA artista. Он содержит 
текущие свойства объекта. Если необходимо, вы можете вернуться к оригинальному шаблону NORMAL 
после его модификации. Подробнее см. в разделе Возвращение к шаблону NORMAL. 
 
Создание шаблонов проекта 
Вы можете создавать шаблоны из проектов, содержащих требуемые объекты и свойства объектов. Просто 
сохраните в качестве шаблона проект или его элементы. Файлы шаблонов выглядят так же, как файлы 
проектов, но имеют расширение AMT. 
Будьте уверены в том, что вы выбрали имя для нового шаблона перед сохранением изменений. Если вы 
сделали изменения в ваших настройках Options (Опции) > Background (Фон) – и нажали кнопку Save 
(Сохранить), -- то изменения будут сохранены в используемом шаблоне. 
 
Примечание: Вы не сможете непредумышленно перезаписать шаблоны. Каждый раз, когда вы создаете 
новый проект на основе шаблона, BERNINA artista открывает дубликат шаблона. Когда вы сохраняете 
проект в первый раз, открывается диалоговое окно Save As (Сохранить как), так что вы можете сохранить 
шаблон под новым именем. 
 
Как создать шаблон проекта 
1  Начните новый проект или откройте существующий. 
2  Настройте по своему желанию свойства объекта, стили и эффекты. 
3  Добавьте объекты и текст, которые вы хотите сохранить в шаблоне. 
 

Совет: Вы можете ввести в шаблон базовые линии текста, они помогут включить образец текста. Вы 
можете перезаписать образец текста при использовании шаблона. 

4  Выберите File (Файл)> Save As (Сохранить как). 
 Откроется диалоговое окно Save As. 
 
 
 
 
 
 
 
 
 
 
 
 
Введите имя  
шаблона 
 
 
 
 
 
 

Выберите Design Templates (AMT) 
5  Из открывшегося списка диалогового окна Save as выберите Design Templates (Шаблоны проектов) с 

расширением AMT. 
 BERNINA artista автоматически откроет папку artista\template. Шаблоны проектов должны сохраняться в 

этой парке, в противном случае они не появятся в списке шаблонов при создании нового проекта. 
6  Введите имя шаблона в поле File name (Имя файла). 
7  Нажмите кнопку Save (Сохранить). 
 
Изменение шаблонов проекта 
 
Вы можете изменять шаблоны таким же образом, как нормальный проект. Изменения применимы только 
для будущего использования шаблона. Существующие проекты, основанные на измененном шаблоне, не 
затрагиваются. 
 
Примечание: Удаление шаблонов производится тем же путем, что и другие файлы ОС Windows, с 
использованием Проводника Windows. Шаблоны размещаются в папке artista\template. 
 
Как изменять шаблоны проекта 
1  Выберите File > Open. 
 Откроется диалоговое окно Open. 
2  Перейдите к папке artista\template, затем в открывшемся списке Files of type (Тип файлов) выберите 
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Templates (AMT). 
 Появятся имеющиеся файлы шаблонов. 
3  Выберите шаблон, который вы хотите изменить, и нажмите кнопку 

Open (Открыть).  
 
4  Измените, как вам требуется, свойства объекта, стили и другие 

настройки. 
 

         
Текст, добавленный к шаблону, для отображения к каждом проекте 

 
5  Выберите File (Файл)> Save As (Сохранить как). 
 Откроется диалоговое окно Save As. 
6  Выберите место расположения папки artista\template. 
7  Из открывшегося списка Save as type (Сохранить как тип).  
 

Совет: Для создания нового шаблона, основанного модифицированном шаблоне, введите новое имя 
файла и нажмите кнопку Save. 

8  Нажмите кнопку ОК для подтверждения. 
 Измененный шаблон готов для использования. 

      
  Проект 1        Проект 2 

 
Сохранение текущих свойств в шаблоне 
 
Вы можете просто сохранить текущие свойства объекта в текущем шаблоне. См. также Применение 
свойств объекта и управление ими. 
 
Как сохранить текущие свойства в шаблоне 
1  Откройте диалоговое окно Object Properties (Свойства объекта). 

◄ Для использования текущих свойства объекта отмените выделение всех объектов и затем 
нажмите на кнопку инструмента Object Properties (Свойства объекта). 

◄ Для использования свойств для конкретного объекта выберите объект и дважды щелкните по 
нему. 

2  Измените настройки свойств объекта, как вам требуется. 
3  Нажмите кнопку Save (Сохранить). 
 Появится сообщение о подтверждении. 
 

Примечание: В шаблоне сохраняются только текущие свойства объекта, но не объекты или другие 
настройки в проекте. 

4  Нажмите кнопку OK, чтобы обновить шаблон. 
5  Нажмите кнопку OK, чтобы возвратиться к окну проекта.  
 Новые настройки сохраняются в шаблоне, на основе которого был создан проект, и доступны для 

использования. 
 
Возвращение к шаблону NORMAL 
 
Если вы изменили шаблон NORMAL, поставленный с ПО BERNINA artista, вы можете вернуться к его 
оригинальной версии. Первоначальная копия всегда сохраняется, так что шаблон NORMAL может быть 
восстановлен. 
 
Как возвратится к шаблону NORMAL 
1  Закройте BERNINA artista. 
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2  Нажмите на панели задач Windows кнопку Пуск (Start) и выберите Программы (Programs) > BERNINA 
artista > Revert. 

 Откроется диалоговое окно Revert to Factory Template (Возврат к оригинальному шаблону)  
 
       

Нажать кнопку ОК 
 
 
 
                 Выбор шаблонов 
 
 
 
 
 
3  Выберите опцию Templates (Шаблоны) и нажмите кнопку OK. 
 Оригинальные настройки шаблона NORMAL будут восстановлены. 
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Глава 10  
 
 
 
 
 
Цвета ниток и таблицы ниток 
 
При оцифровывании вы выбираете в окне проекта цвета ниток из 
палитры цветов для каждого создаваемого объекта. Цветовая 
палитра содержит набор цветов ниток, специфицированный для 
каждого проекта. Эта цветовая схема представляет собой 
фактические цвета ниток, с которыми будет вышит проект. 
Вы можете предварительно просматривать проект в различных 
цветах на разных материалах. В действительности, вы можете 
просмотреть разнообразные цветовые схемы. Вы можете также 
распечатать различные цветовые схемы, разные цвета фона и 
пиктограммы цветных блоков. 
Для каждой цветовой схемы вы можете выбрать цвета из 
фирменных таблиц ниток, содержащих диапазон цветов, от 
различных производителей ниток или выбрать другие нитки. Для экономии времени при 
настройке новых цветовых схем вы можете создать собственные таблицы ниток, используя 
наиболее части применяемые цвета. Вы можете добавлять, редактировать и удалять нитки из 
таблицы ниток или переименовывать или удалять сами таблицы. В BERNINA artista вы можете 
искать нужные вам нитки по различным критериям. 
В этом разделе описывается, как выбирать цвета из цветовой палитры. Здесь также 
поясняется, как определять свои собственные цвета ниток и таблицы. 
 

Изменение цвета ниток 
 
Новые объекты оцифровываются с использованием выбранного цвета в цветовой панели. Вы можете 
изменить цвет перед каждым оцифровыванием. Если нужного вам цвета нет в цветовой палитре, вам 
может потребоваться добавить его. Подробнее см. в разделе Добавление собственных цветов в таблицу 
ниток. 
 
Примечание: Вследствие различий в характеристиках мониторов и видеокарт компьютера цвета, 
отображаемые на экране, следует считать приблизительными. Нитки должны быть всегда подобраны 
соответствующей физической цветовой карте. 

 
Текущий цвет 
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Выбор нового текущего цвета 
 
При оцифровывании нового объекта он автоматически принимает цвет, выбранный в цветовой 
палитре. Это "текущий" цвет. 
 
Как выбрать новый текущий цвет 
◄ Отмените выделение всех объектов и затем выберите цвет из цветовой палитры.  

Этот цвет становится текущим для всех новых объектов. 
 
Изменение цвета выбранных объектов 
 
Изменить цвет одного или нескольких выбранных объектов в 
вашем проекте можно в любое время. 
 
       
Как изменить цвет выбранного объекта 
1  Выберите объект (или объекты), цвет которого вы хотите 
изменить. 

      
Выберите цвет из цветовой палитры 

 
2  Выберите цвет из цветовой палитры. 
 Объект появится в новом цвете. 
 

Подбор цветов ниток 
 
В BERNINA artista вы можете вручную найти нужные вам нитки по различным критериям. Приведение в 
соответствие цвета нитки позволит вам найти и изменить цвет нитки, основанный на близком 
соответствии с одной или несколькими таблицами ниток. 
 
Поиск типов ниток 
 
Для поиска нитки выберите Thread Colors из меню Settings. 
 
Вы можете найти нитку по коду или описанию в диалоговом окне Thread Colors (Цвета ниток). 
 
Как найти тип нитки 
1  Выберите Settings (Настройки) > Thread Colors (Цвета 
ниток). 
 Откроется закладка Thread Colors диалогового окна Design 
Properties (Свойства проекта). 
 
 
 
 
 

              Выбор таблицы ниток 
 
 
 

                             Подбор кода 
 
 
 

             Ввод поисковой строки 
   
 

Выбор критерия нитки 
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2  Выберите таблицу ниток, чтобы включить в поиск из списка Thread Charts (Таблицы ниток). 
3  Выберите функцию поиска – Code (Код) или Description (Описание). 
 Код – это идентификационный номер цвета нитки в бренде. 
4  В поле Search (Поиск)  введите первые несколько символов требуемого кода или описания. 
 Система разыщет наиболее близкое соответствие и отобразит его в списке цветов нитки. 
 
Подбор ниток из различных таблиц 
 
Для подбора ниток из различных таблиц выберите Thread Colors (меню Settings). 
 
Вы можете найти и изменить цвет нитки, основанный на близком соответствии с одной или несколькими 
таблицами ниток. Вы можете также использовать этот метод для изменения цвета всех объектов. 
Например, изменить светло-зеленый цвет всех объектов на темно-зеленый цвет. 
 
Как подбирать нитки из различных таблиц 
1  Выберите Settings (Настройки) > Thread Colors (Цвета ниток). 
 Откроется закладка Thread Colors диалогового окна Design Properties (Свойства проекта). 
 
 
 
 
 
 
        Выбор цвета для подбора 
 
 
 
  
           Выбор таблицы ниток 
 
 
 
 
Выбор цвета для назначения 
 
 
 
2  Выберите цвет для подбора 
3  Выберите наиболее подходящую нитку и назначьте ее для палитры ниток, нажав кнопку Assign 

(Назначить). 
 
 
 
 
 
 
 
 
Назначаемый цвет 
   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Нажмите Assign 

4  Повторяйте эту операцию до тех пор, пока не будут подобраны все цвета, которые вы хотите 
использовать в проекте. 
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Оригинальные  Оранжевый цвет  Назначен другой  
цвета проекта    заменен желтым  зеленый цвет 

 
5  Нажмите кнопку ОК. 
 Система назначит проекту выбранные цвета ниток. 

Создание собственных таблиц ниток 
 
Для создания новых таблиц ниток выберите Thread Colors (меню Settings). 
 
Таблицы ниток – это списки предварительно определенных цветов ниток. Они могут быть основаны на 
фирменных таблицах ниток или на составленных вами таблицах. 
 
Создание новых таблиц ниток 
При создании таблицы ниток вы создаете набор цветов для использования в вашем проекте. 
 
Как создать таблицу ниток 
1  Выберите Settings (Настройки) > Thread Colors (Цвета ниток). 
 Откроется закладка Thread Colors диалогового окна Design Properties (Свойства проекта). 
 

 
Нажмите Modify Charts 
 
 
 
 
 
 
 

2  Нажмите кнопку Modify Charts (Изменить таблицы). 
 Откроется диалоговое окно Modify Thread Chart (Изменение таблицы ниток). 
 

Нажмите New 

    
3  Нажмите кнопку New (Новый). 
 Откроется диалоговое окно New Thread Chart (Новая таблица ниток). 
 

     
   Введите имя таблицы 

 
4  Введите имя таблицы и нажмите OK. 

Примечание: При присвоении имени для ваших собственных цветовых таблиц или отредактированных 
цветовых таблиц не используйте символы или знаки препинания, такие как запятые.  
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Вы возвратитесь к диалоговому окну Modify Thread Chart. Новая таблица создана и готова для 
добавления цветов ниток. 

5  Нажмите кнопку Add (Добавить), чтобы открыть окно Add Thread (Добавить нитку). 
 Подробнее см. в разделе Добавление собственных цветов в таблицу ниток. 

      
6  Нажмите кнопку Copy From (Скопировать из), чтобы добавить цвета из существующей таблицы. 
 Подробнее см. в разделе Копирование цветов из таблицы в таблицу. 
7  Нажмите кнопку ОК. 
 Новая таблица создана и готова для использования. 
 

Копирование цветов из таблицы в таблицу 
Вы можете копировать цвета из одной таблицы ниток в другую для создания собственных таблиц из 
существующих цветов. 
 

Как копировать цвета из таблицы в таблицу 
1  Откройте диалоговое окно Modify Thread Chart (Изменение таблицы ниток). 
 Подробнее см. в разделе Создание новых таблиц ниток. 

Выбор таблицы ниток 

    
              Нажмите Copy From  
2  Выберите таблицу из списка Thread Chart 
(Таблица ниток) > Name (Имя) 
3  Нажмите кнопку Copy From… 
(Скопировать из …) 
 Откроется диалоговое окно Copy From. 
   4  Из списка Name выберите таблицу ниток, 
содержащий цвет, который вы хотите 
копировать. 
5  Выберите цвет, который вы хотите 

копировать, затем нажмите OK. 
 Цвет будет скопирован в таблицу ниток и 

появится в конце списка. 
 
Добавление собственных цветов в таблицу ниток 
Вы можете добавлять цвета в таблицы ниток из других таблиц или самостоятельно смешанных цветов,  
 
Как добавить собственные цвета в таблицу ниток 
1  Откройте диалоговое окно Modify Thread Chart (Изменение таблицы ниток). 
 Подробнее см. в разделе Создание новых таблиц ниток. 
2  Нажмите кнопку Add, чтобы добавить собственные цвета. 
 Откроется диалоговое окно Add Thread (Добавить нитку). 
3  Смешайте отображаемый цвет нитки. 
 Подробнее см. в разделе Смешивание ваших собственных таблиц ниток. 
4  Введите код, бренд и опишите детали для нового цвета нитки. 
 Код – это идентификационный номер цвета нитки в бренде. 
5  Нажмите кнопку ОК. 
 Новый цвет появится в списке Threads (Нитки). 

79



Глава 10: Цвета ниток и таблицы ниток 

BERNINA® Artista Designer Plus Версия 4  

Смешивание ваших собственных цветов ниток 
Вы можете изменить цвет, который отображается для частичной нитки или создайте новые цвета ниток, 
используя диалоговое окно Color (Цвет). 
 
Как смешивать ваши собственные цвета ниток 
1  В диалоговом окне Add Thread (Доьавить нитку) или Edit Thread (Редактировать нитку). нажмите 

кнопку Mix (Смешать). 
◄ Подробнее см. в разделе Добавление собственных цветов в таблицу ниток. 
◄ Подробнее см. в разделе Изменение характеристик нитки. 

 Откроется окно Color (Цвет).. 
 
 
 
 
 
Передвиньте ползунок  
для регулировки яркости цвета 
 
 
 
 
 
 

2  Из таблицы Basic colors (Основные цвета) выберите цвет, который ближе всего подходит к нужному 
вам цвету. 

3  Щелкните мышью и перетащите перекрестие нитей по спектру цветов, чтобы получить требуемый вам 
цвет. 

4  Передвиньте ползунок на правой стороне окна цветового спектра, чтобы отрегулировать яркость 
цвета. 

 В правом нижнем углу диалогового окна Color появятся значения HLS (Цвет-Яркость-Насыщенность) и 
RGB (Зеленый, Красный, Синий). Введите эти значения для точного определения цветов. 

5  После смешивания требуемого цвета нажмите кнопку Add to Custom Colors (Добавить к 
пользовательским цветам). 

6  Нажмите кнопку ОК. 
 Новый цвет появится в окне просмотра Color (Цвет). 

Изменение таблиц ниток 
 
Обновление существующих таблиц ниток путем изменения характеристик ниток или удаления отдельных 
ниток. Вы можете также переименовывать или удалять таблицы ниток. 
 
Изменение характеристик нитки 
Изменение кода, бренда или описания существующей нитки. 
 
Как изменить характеристики нитки 
1  Откройте диалоговое окно Modify Thread Chart (Изменение таблицы ниток). 
 Подробнее см. в разделе Создание новых 
таблиц ниток. 

Выбор таблицы ниток 
 
 
 
 
 
 

Выберите нитку для  
изменения 

2  Из списка Name (Имя) выберите таблицу для 
изменения. 
3  Из списка Threads (Нитки) выберите нитку для 
изменения. 
4  Нажмите кнопку Edit (Редактировать). 
 Откроется диалоговое окно Edit Thread (Редактировать нитку). 
5  Измените характеристики нитки, как вам требуется. 
 Подробнее см. в разделе Добавление собственных цветов в таблицу ниток. 
6  Нажмите кнопку ОК. 
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Удаление ниток из таблиц 
 
Для удаления ниток из таблиц выберите Thread Colors (меню Settings). 
 
Вы можете легко удалить ненужные цветные нитки из таблицы ниток, используя диалоговое окно Modify 
Charts (Изменить таблицы). 
 
Как удалять нитки из таблиц 
1  Откройте диалоговое окно Modify Thread Chart (Изменение таблицы ниток). 
 Подробнее см. в разделе Создание новых таблиц ниток. 
 
 
 
 
 
 

Нажать для удаления  
выбранного цвета 

 
 

Нажать для удаления  
ВСЕХ цветов 

 
 
2  Из списка Name (Имя) выберите таблицу для изменения. 
3  Из списка Threads (Нитки) выберите нитку (или нитки) для удаления.  
4  Нажмите кнопку Remove (Удалить). 
 Появится требование подтвердить удаление. 
5  Нажмите Yes (Да). 
 
Совет: Для удаления всех ниток из таблицы нажмите кнопку Clear All (Удалить все). 
 
Переименование таблиц ниток 
 
Для переименования таблиц ниток выберите Thread Colors (меню Settings). 
 
Для переименования таблиц ниток используйте диалоговое окно Modify Thread Chart (Изменение таблицы 
ниток). 
 
Совет: Выбирайте имена, которые помогут вам вспомнить, какая таблица вам требуется, или таким 
образом, чтобы наиболее часто используемые таблицы находились в верхней части списка. 
 
Как переименовывать таблицы ниток 
1  Откройте диалоговое окно Modify Thread Chart (Изменение таблицы ниток). 
 Подробнее см. в разделе Создание новых таблиц ниток. 

 
Выбор таблицы ниток   Нажать для изменения имени 

 
2  Из списка Name (Имя) выберите таблицу для изменения. 
3  Нажмите кнопку Rename (Переименовать). 
 Откроется диалоговое окно Rename Thread Chart (Переименовать таблицу ниток). 

 
Измените имя таблицы 

 
4  Введите новое имя для таблицы ниток, затем нажмите OK. 
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Удаление таблиц ниток 
 
Для удаления таблиц ниток выберите Thread Colors (меню Settings). 
Для удаления ненужных таблиц ниток используйте диалоговое окно Modify Thread Chart (Изменение 
таблицы ниток). 
Примечание: Соблюдайте осторожность при удалении таблиц ниток. Если вы удалите по ошибке нужную 
таблицу, то вам потребуется перезапустить BERNINA artista, чтобы восстановить ее. 
 
Как удалять таблицы ниток 
1  Откройте диалоговое окно Modify Thread Chart (Изменение таблицы ниток). 
 Подробнее см. в разделе Создание новых таблиц ниток. 

 
Выбор таблицы ниток     Нажать для удаления выбранной таблицы 

2  Из списка Name (Имя) выберите таблицу для удаления. 
3  Нажмите кнопку Delete (Удалить). 
 Появится требование подтвердить удаление. 
4  Нажмите Yes (Да). 

Изменение цветов фона или ткани 
 
Для изменения цвета фона или ткани выберите функцию Fabric Display (меню Settings). 
 
Цвета фона и ткани определяют "свойства проекта" 
в большей мере, чем настройки отображения.  Это 
объясняется тем, что фон является составной 
частью проекта. 
BERNINA artista дает возможность выбирать цвет 
фона в окне проекта, чтобы согласовать его с 
цветом вашей ткани. Или же можно выбрать фон 
ткани для более реалистичного вида и 
воспроизведения. Фон сохраняется вместе с 
проектом. 

желтый фон      фон джинсовой ткани 
Как изменить цвет фона или ткани 
1  Выберите Settings (Настройки) > Fabric Display (Отображение ткани).. 
 Откроется диалоговое окно Display (Отобразить). 
 
Примечание: Вы можете также получить доступ к этому окну, использовав Settings > Thread Colors и 
выбрав BKG из списка цветов. 
Выбор для изменения цвета фона 

 
   
 
Нажать для выбора нового цвета 
 
 
 
 

2  Выберите окно проекта с типом фона. 
◄ Color (Цвет):  используется выбранный цвет. 
◄ Fabric (Ткань): используется образ ткани. 

3  Выберите для использования цвет или ткань. 
◄ Для выбора цвета фона нажмите Edit. Выберите цвет в диалоговом окне Color и нажмите OK. 
◄ Для выбора ткани нажмите Browse (Обзор). Выберите цвет в диалоговом окне Load Picture 

(Загрузить рисунок) и нажмите OK. 
Ткани расположены в папке :/artista/fabrics. 
Вы можете расположить растровый рисунок ткани по центру окна проекта или образовать "плиточную 
кладку". Если растровый рисунок достаточно большой, выберите Center. В противном случае выберите 
Tile (Плиточная кладка). 

4  Нажмите кнопку ОК. 
 Фон сохраняется вместе с проектом. 
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Часть III  
Оцифровывание по 
художественному 
оригиналу 
 

Глава 11  
Оцифровывание с оригиналом 
 
Рисунок в растровом или векторном формате может быть 
загружен, скопирован или отсканирован в BERNINA artista 
для использования в качестве оцифровываемого оригинала 
или трафарета. Можно также импортировать также 
текстурированный фон, чтобы увидеть, как будет выглядеть 
вышивка на реальной ткани. Может быть использован почти 
любой рисунок – фотография, журнальные иллюстрации, 
графические файлы и даже образцы ткани. 
Из BERNINA artista вы можете открыть изображения в 
графических программах MS Paint, Corel PHOTO-PAINT® или 
Paint Shop Pro™. Обновленные таким образом изображения 
автоматически реимпортируются в BERNINA artista. 
В этом разделе описывается, как подбирать подходящие 
рисунки для целей оцифровывания, а также, как 
сканировать их в BERNINA artista. Кроме того, поясняется, 
как оцифровывать рисунки, используя оригинал-трафарет, и 
как отображать их на экране и скрывать во время 
оцифровывания. 
 

Использование оригиналов-трафаретов 
 
Оригиналы могут быть использованы в качестве трафарета при ручном оцифровывании. Альтернативно 
функции полуавтоматического и автоматического оцифровывания BERNINA artista могут конвертировать 
растровые рисунки в проекты вышивки. В общем случае оригиналы-трафареты помогают вам: 
◄ Оцифровывать объекты вручную.  

Калькировать контуры и линии по трафарету, используя подходящий инструмент оцифровывания. 
Подробнее см. в разделе Методы оцифровывания. 

◄ Автоматическое оцифровывание контуров производится функцией Magic Wand (Волшебная палочка).  
Вы выбираете контур и Magic Wand автоматически определяет требуемые стежки. 

◄ Автоматическое оцифровывание сложных рисунков производится функцией Auto Digitizer.  
Вы выбираете изображение и Auto Digitizer автоматически определяет контуры и стежки, требуемые 
для оцифровывания проекта. Подробнее см. в разделе Оцифровывание функцией Auto Digitizer. 

 Оцифровывание фотографий производится функцией PhotoSnap.  
Вы снова выбираете изображение и PhotoSnap автоматически определяет контуры и стежки, 
требуемые для оцифровывания проекта. Подробнее см. в разделе Создание проектов вышивки по 
фотографиям. 
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Выбор рисунка для оцифровывания 
 
Имеется две большие категории графических файлов: 
◄ Векторные рисунки: Они состоят из контуров, которые могут быть цветными и могут иметь цветное 

заполнение. Векторные контуры остаются тонкими и чистыми даже при большом коэффициенте 
увеличения, так что они могут оцифровываться достаточно точно. 

◄ Растровые рисунки: Они состоят из цветных точек, или пикселей. При увеличении на малой площади 
контуры становятся разорванными и отображаются как серий цветных квадратиков, или пикселей. 

Для создания высококачественной вышивки вам нужно подобрать подходящий рисунок. Как для ручного, 
так и для автоматического оцифровывания лучше всего подходит "чистый" рисунок с ограниченным 
количеством чистых цветов и хорошо проработанными контурами. В BERNINA artista вы можете назначит 
общие свойства, такие как размер и положение. Вы можете также расположить и трансформировать 
рисунок таким же образом, как проекты вышивки. См. также Поддерживаемые форматы рисунков и 
изображений. 
 
Векторные рисунки 
Векторные рисунки могут быть загружены в 
BERNINA artista для использования в качестве 
оцифровываемых трафаретов. Они автоматически 
конвертируются в растровые изображения. 
      

 
 
 

Рисунок  После оцифровывания 
инструментом Magic Wand  

Растровые рисунки 
Растровые изображения могут быть загружены или отсканированы в BERNINA artista для использования в 
качестве оцифровываемых трафаретов. Как для ручного, так и для автоматического оцифровывания 
лучше всего подходят "чистые" рисунки, иногда рассматриваемые как карикатуры или шаржи. Такие 
рисунки имеют ограниченное количество чистых цветов, которые в свою очередь имеют четко очерченные 
контуры. Идеальными являются рисунки: 
◄ четко определенные, когда каждая фигура выполнена пикселями одного и того же цвета. 
◄ четко разделенные на блоки, когда каждая фигура имеет "вышиваемый" размер, по меньшей мере 1 

кв. мм. 
◄ сохраненные с насыщенностью цвета по меньшей мере 256 цветов (8 бит) или предпочтительно 

миллионами цветов (16 бит). (При загрузке изображений в BERNINA artista насыщенность цвета 
автоматически сокращается до 256 цветов или меньше.) 

 
Совет: После загрузки в BERNINA artista вы можете изменять размеры и трансформировать растровые 
изображения. Однако, если нужно изменить размеры или повернуть изображение, то лучше делать это во 
время сканирования. Последующее изменение размера может разрушить изображение. 
 
Автоматическое оцифровывание 
Функции автоматического оцифровывания BERNINA artista -- Auto Digitizer и Magic Wand – обеспечивают 
наилучшие результаты с изображениями, которые можно найти в библиотеке графических файлов или 
которые создаются по эскизам в пакете графических программ. Подробнее см. в разделах 
Автоматическое оцифровывание контуров функцией Magic Wand и Оцифровывание функцией Auto 
Digitizer. 
 
Функции автоматического оцифровывания могут работать с изображениями из других источников, но они 
требуют большей или меньшей подготовки. Это объясняется тем, что наиболее доступные изображения 
не выполнены в чистых цветах. Сканирование вызывает шумы (помехи), в то время как графические 
программы выполняют "сглаживание", чтобы улучшить качество печати изображения. 
Автоматическое оцифровывание менее эффективно с фотографическими изображениями, которые могут 
содержать много размытых цветов и сложных форм. Однако на фотографиях вы можете обработать 
формы, которые вы хотите вышить, удалив ненужные детали. Альтернативно можно использовать 
PhotoSnap для создания проектов вышивки из отсканированных фотографий.  
 
Отсканированные изображения 
Изображения, отсканированные с бумажных оригиналов или существующих 
вышивок обычно содержат множество "шумовых" помех. В то время как они 
могут быть использованы для автоматического оцифровывания, опять-таки, 
более лучшие результаты получаются при использовании относительно 
чистых изображений, содержащих блоки с чистыми цветами. Как правило, в 
эту категорию входят логотипы и простые рисунки, отсканированные с 
визитных карточек, шапок фирменных бланков, книг, журналов и т.п.  

Изображение, содержащее помехи сканирования 
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Загрязненные изображения обычно требуют подготовки, заключающейся в уменьшении количества цветов 
и повышении резкости контуров. Подробнее см. в разделе Подготовка изображений для автоматического 
оцифровывания. 
 
Изображения со сглаженными цветовыми переходами  
Сглаживание цветовых переходов – это программная техника, комбинирующая существующие цвета 
шахматным расположением пикселей. Она обычно используется для имитации цветов, смешиваемых из 
изображаемой гаммы. 
 

     
блоки со сглаженными цветовыми переходами 

 
Наподобие "загрязненных" изображений, изображения со сглаженными цветовыми переходами перед 
использованием требуют уменьшения количества цветов. Однако имейте в виду, что в то время как 
программное обеспечение отлично работает при обработке сглаженных цветовых переходов с четко 
определенными контурами, оно мало подходит для работы с изображениями, не имеющими четких 
контуров. Подробнее см. в разделе Подготовка изображений для автоматического оцифровывания. 
 
Изображения со сглаженными контурами 
Сглаживание контуров – это программная техника, подобная сглаживанию 
цветовых переходов, которая используется для смягчения жестких 
контуров, если цветовые блоки пересекаются. Она создает сглаженные 
контуры путем "размывания" пикселей при соединении цветов. 
 

       Сглаженные контуры 
 
Если техника размывания сознательно используется для размывания 
контуров, то перед автоматическим оцифровыванием следует увеличить их 
резкость. Подробнее см. в разделе Подготовка изображений для 
автоматического оцифровывания. 
 

Сканирование изображений в BERNINA artista 
 
Если у вас имеется готовое изображение, вы можете отсканировать его сканером, совместимым с 
протоколом TWAIN, используя сканирующие функции BERNINA artista. Важно правильно отсканировать 
ваше изображение, если вы намерены использовать одну из функций автоматического оцифровывания; 
качество отсканированного изображения повлияет на качество окончательного проекта вышивки. 
 

Г  
Хорошее изображение:     Плохое изображение 

хорошее качество вышивки:     плохое качество вышивки 
 
Подготовка оригинала для сканирования 
Для создания проекта вышивки, в большей или меньшей степени, вам не требуется каждая деталь 
изображения. Вы используете "структуру" изображения в большей мере, чем тонкие детали текстуры и 
цвета. 
Для упрощения оригинала вы можете накрыть его калькой и перенести на нее только наиболее 
существенные контуры и линии, которые будут заполнены стежками. При сканировании наложите на 
кальку с эскизом лист белой бумаги. 
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оригинальный рисунок    вычерчены требуемые детали 

 
Блестящие поверхности, такие как глянцевые фотографии, не могут быть хорошо отсканированы. Их 
следует накрывать чертежной калькой. Если оригинал имеет очень светлые цвета, обведите контуры 
тонким черным фломастером. 
 
Разрешение сканирования 
Для большинства сканеров требуется вводить информацию о требуемом разрешении сканирования. 
Величина разрешения определяет количество точек на дюйм (dpi), используемых для создания 
отсканированного изображения.  Чем выше разрешение, тем чище изображение, но тем больше файл. 
Для оцифровывания используйте изображения, отсканированные с разрешением не выше 300 dpi. 
Разрешения 72 dpi (разрешение экрана) обычно вполне достаточно. В общем случае, чем меньше 
оригинал и/или чем больше в нем деталей, тем выше должно быть разрешение. Для ориентировки можно 
использовать данные следующей таблицы. 
 
Тип оригинала Разрешение сканирования 
Визитные карточки, шапки фирменных бланков 150 - 300 dpi 
Выполненные вручную эскизы 150 - 300 dpi 
Фотографии и образы 150 - 300 dpi 
Штриховые рисунки 72 - 150 dpi 
 
Цветовой режим 
Для большинства сканеров требуется также вводить информацию о требуемом цветовом режиме. 
Вначале определите, с каким изображением вы имеете дело – со штриховым рисунком (черно-белым), 
эскизом, цветным рисунком, черно-белой или цветной фотографией, - а затем выбирайте подходящий 
режим. Черно-белый режим создает файлы наименьшего размера. Цветные фотографии и режим 
градации серой шкалы создают изображения с 256 цветами, сохраняемые в файлах подобного размера. 
Режимы ‘RGB’, ‘True Color’ (‘Истинный цвет’) или  ‘миллион цветов’ создают изображения с 16,7 млн 
цветов, сохраняемые в файлах наибольшего размера. Пользуйтесь приводимой ниже таблицей, чтобы 
определить, какой из режимов вам нужен для вашего оригинала. 
Примечание: Обратите внимание, что в вашем сканере могут использоваться другие обозначения 
режимов. 
 
Вид оригинала Пример Описание Рекомендуемый 

цветовой режим * 
Количество 
цветов в 
отсканированно
м изображении 

Штриховой рисунок 

 

Два цвета – обычно 
черный и белый 

Черно/белый рисунок 
Штриховой рисунок 

2  
2 

Эскиз/Набросок 

 

Рисунок или эскиз с 
градацией серого 

Градация серого 
Штриховой рисунок 

256  
2 

Черно-белая 
фотография 

 

Градация серого Черно/белое фото 
Градация серого 

256  
256 

Цветная фотография 

 

Много цветов Цвет RGB  
Цветное фото 

16 миллионов 
256 

Цветной рисунок 

 

Два цвета или больше Цвет RGB  
Миллионы цветов 
Цветной рисунок 

16 миллионов 
16 миллионов 
2 - 256 

* Различные ПО сканеров используют различные обозначения для одних и тех же режимов. 
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Советы по сканированию 
◄ Не сканируйте штриховые рисунки в режиме градации серого; в таком режиме получаются размытые 

кромки. 
◄ Цветные иллюстрации лучше сканировать в режиме RGB (миллион цветов), чем в режиме 256 цветов. 

Вы не сможете заметить различия на экране. В действительности, изображение в 256 цветов может 
выглядеть лучше изображения RGB. Однако BERNINA artista конвертирует все изображения в 256 
или меньше цветов при загрузке. Программа использует дополнительную информацию для создания 
лучшего изображения, чем если бы оригинал был отсканирован в режиме 256 цветов. 

 

    
   Отсканировано в режиме  Отсканировано в режиме  
   256 цветов      RGB (миллион цветов) 
◄ Не сканируйте цветные изображения в режиме CMYK, поскольку этот режим используется для 

изображений, которые должны быть распечатаны и в которых имеются цвета, отличающиеся от 
палитры RGB. 

◄ Если требуется изменить размер изображения, то делайте это во время сканирования. Последующее 
изменение размера может разрушить изображение. 

 
Повышение четкости 
Некоторые программы сканирования позволяют применять функцию повышения четкости 
отсканированного изображения. Эта функция компенсирует легкое размывание отсканированного 
изображения, обусловленное различиями между цветами оригинала. Функция повышения четкости 
выделяет эти различия, которые делают края изображения более определенными. При этом количество 
деталей изображения не увеличивается, они лишь становятся более различимыми. В общем случае 
используйте функцию повышения четкости для изображений с хорошо выделенными контурами. Не 
используйте ее для изображений, не имеющих контуров. 
 

      
Отсканировано с      Отсканировано без 
повышением четкости    повышения четкости 
 

 
Сканирование растровых изображений 

 
Используйте функцию Scan Picture (меню Picture) для сканирования в BERNINA artista. 

 
Вы можете сканировать непосредственно в BERNINA artista для использования в качестве 
оцифровываемых трафаретов. Вы можете также сканировать в ваш собственный текстурированный фон, 
чтобы увидеть, как будет выглядеть вышивка на реальной ткани. Ткани могут быть отсканированы, чтобы 
получить полный отцентрованный фон вашего проекта или фон в виде небольших образцов, 
расположенных, как плиточная кладка, заполняющая экран. См. также Изменение цветов фона или ткани. 
Сканирующие функции BERNINA artista позволяют вам использовать большинство совместимых с 
протоколом TWAIN сканеров. Вы можете использовать любое ПО сканера, если оно способно сохранять 
изображения в одном из совместимых форматов. 
 
Как сканировать растровые изображения 
1  Установите ваш сканер. 
 Подробнее см. в разделе Настройка сканера. 
2  Подготовьте оригинал для сканирования 
 Подробнее см. в разделе Подготовка оригинала для сканирования. 
3  Создайте новый файл или откройте проект, в который вы хотите загрузить отсканированный рисунок. 
4  Нажмите кнопку Scan Picture (Сканировать рисунок). 
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 Откроется ваша программа сканирования. 
5  Выберите режим сканирования и разрешение. 
 Подробнее см. в разделах Разрешение сканирования и Цветовой режим. 
 

Совет: Если вы сканируете ткань для фона, установите сканирование на 256 цветов, 100 % и 72 dpi. 
Такие настройки позволят получить файл небольшого размера, который будет хорошо отображаться 
на экране, не занимая много места на жестком диске или в памяти компьютера. 

 
6  Просмотрите изображение в программе сканирования. 
7  Выберите зону сканирования и отсканируйте изображение. 
8  Сохраните рисунок в совместимом графическом формате в папке My Designs. 
 Подробнее см. в разделе Поддерживаемые форматы рисунков и изображений. 
 

Примечание: Отсканированные оригиналы являются растровыми изображениями и должны 
сохраняться отдельно от файлов проектов или они будут удалены при закрытии проекта. Подробнее 
см. в разделе Сохранение оригиналов в отдельных файлах. 

 

Редактирование изображений в пакете графических программ  
 

Используйте функцию Touch Up Picture (меню Picture), чтобы редактировать изображение в 
пакете графических программ. 

 
Иногда вам потребуется редактировать изображения в графической программе. Вы можете обычно 
сделать это, чтобы удалить фон, залить цветом определенные зоны или добавить контуры, заполнить 
пробелы или усилить контуры. Из BERNINA artista вы можете открыть изображения в графических 
программах Paint, Photopaint или Paint Shop Pro. Изображения обновляются и автоматически 
реимпортируются в BERNINA artista. 
Имеется много графических программ, которые помогут вам улучшить отсканированное изображение. 
Наиболее простой из них является программа Paint. Она входит в пакет приложений ОС Windows и может 
работать со многими форматами или цветовыми преобразованиями. Наиболее сложными являются 
профессиональные программы, такие как программа Corel Photo Paint. Такие программы могут делать 
почти все, но они слишком дорогие для использования от случая к случаю. Отличным компромиссом 
является программа Paint Shop Pro, которая обладает многими функциями программ высшего уровня, но 
намного меньше стоит. 
 
Как редактировать изображения в пакете графических 
программ  
1  В режиме Picture нажмите кнопку Load Picture (Загрузить рисунок).  
2  Выберите изображение. 
 

Используя графическую программу,  
чтобы вырезать часть, которую нужно  
вышить 

 
3  Нажмите кнопку Touch Up Picture (Отделка рисунка) и выберите 

графическую программу. 
 Изображение откроется в графической программе. 
4  Отредактируйте изображение и сохраните его. 
 

 
кадрирование изображения    удаление фона   добавление контуров 
 
5  Выберите File (Файл) > Update Design1 (Обновить проект Design1). 
 Изображение отобразится в BERNINA artista на заштрихованном фоне. Это означает, что оно все еще 

открыто в графической программе. 
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Г 
 
 
изображение все еще открыто  
в графической программе 
 
 
 
 
 
 
 
Примечание: Выберите File > Exit & Return <Filename>, чтобы выйти из графической программы и увидеть 
обновленное изображение в BERNINA artista. Заштрихованный фон исчезнет. 
 

Оцифровывание с оригиналом 
 
Растровые и векторные рисунки могут быть загружены в BERNINA artista для использования в качестве 
оцифровываемых трафаретов. Растровые изображения могут быть также отсканированы 
непосредственно в BERNINA artista. После загрузки в BERNINA artista вы можете изменять их  размеры и 
трансформировать. Однако, если нужно изменить размеры или повернуть изображение, то лучше делать 
это во время сканирования. Последующее изменение размера может разрушить изображение. См. также 
Расположение и трансформация объектов. 

    
   отсканированный рисунок     автоматически оцифрованный рисунок 
 
Как для ручного, так и для автоматического оцифровывания лучше всего подходят "чистые" рисунки, 
иногда рассматриваемые как карикатуры или шаржи. Сканирование вызывает шумы (помехи), в то время 
как графические программы выполняют "сглаживание", чтобы улучшить качество печати изображения. См. 
также Подготовка изображений для автоматического оцифровывания. 
 
Загрузка растровых и векторных рисунков 

 
Используйте функцию Load Picture (меню Picture) для загрузки изображения в качестве 
оцифровываемого трафарета. 

 
Вы можете загружать растровые изображения в различных форматах для использования в качестве 
оцифровываемых трафаретов. Подробнее см. в разделе Поддерживаемые форматы рисунков и 
изображений. 
 
Примечание: При загрузке в BERNINA artista векторные рисунки конвертируются в растровые 
изображения. 
 
Как загружать растровые или векторные изображения 
1  Выберите режим Picture. 
2  Нажмите кнопку Load Picture (Загрузить рисунок). 
 Откроется диалоговое окно Open. 
Выберите папку 

 
Выберите требуемый формат 
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3  Выберите папку из списка Look In. 
4  Выберите тип файла из списка Files of Type (например, BMP). 
5  Выберите файл, который вы хотите загрузить. 
 
Совет: Проставьте флажок в окошке Preview, чтобы просмотреть выбранный файл. 
 
 
6  Нажмите кнопку Open (Открыть). 
7  Расположите рисунок в середине пялец, если это необходимо. 

Используйте перекрестие нитей на рисунке в качестве направляющей и совместите центр рисунка с 
меткой середины пялец. 

 
Сохранение оригиналов в отдельных файлах. 

 
Используйте функцию Save Picture (меню Picture) для сохранения оригинала в отдельном файле. 
 

Если вы сохраняете проект, содержащий оцифровываемый оригинал, то ссылка на графический файл 
сохраняется вместе с информацией о его положении в проекте. Когда вы вновь открываете проект, то 
графический файл перезагружается. Если вы масштабируете или трансформируете трафарет, вам 
потребуется сохранить его в отдельном файле, иначе изменения будут утеряны. 
 
Примечание: Изображения, которые вы отсканировали из BERNINA artista должны быть сохранены таким 
же образом, в противном случае оно будет удалено при закрытии проекта. 
 
Как сохранять оригиналы в отдельных файлах. 
1  Выберите режим Picture. 
2  Выберите оригинал. 
3  Нажмите кнопку Save Picture (Сохранить рисунок). 
4  В поле Save In (Сохранить в) выберите папку, затем из списка File Type (Тип файла) выберите 

формат.  
5  Введите новое имя файла и нажмите Save (Сохранить). 

        Выберите папку 
 
 
 
 
 
 
 
 
 
         Введите имя файла 
 
 
 
 
 

  Выберите требуемый формат 
 

При сохранении проекта ссылка обновляется, чтобы можно было использовать новый файл с 
изображением. 

 
Отображение или скрытие оцифровываемого трафарета 

 
Используйте функцию Show Picture (панель General), чтобы отображать на экране или скрывать 
оцифровываемый трафарет. 
 

Вы можете отображать оригинал во время оцифровывания или временно скрыть его. Скрытие оригинала-
трафарета не означает его удаления из проекта. 
 
Примечание: Изображение становится блеклым, если выбрана функция Dim Picture (Затемнить 
рисунок). 
 
Как просматривать или скрывать оцифровываемый трафарет 
◄ В режиме Design View (Просмотр проекта): 
◄ Нажмите кнопку Show Picture (Показать рисунок). 

Выбранные трафареты становятся видимыми. 
◄ Чтобы скрыть трафарет, нажмите кнопку Show Picture еще раз.  
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с включенной функцией    с отключенной функцией 
Show Picture       Show Picture  
 
 
 
Затемнение оригинала-трафарета 

 
Нажмите кнопку Dim Picture (панель Picture), чтобы затемнить (сделать блеклым) изображение. 
 

Вы можете затемнять оригиналы-трафареты, чтобы было легче видеть стежки, если они имеют тот же 
цвет, что и изображение. 
 
Как сделать блеклым оригинал-трафарет 
◄ Нажмите кнопку Dim Picture (Затемнить рисунок). 
 

    
Исходный растровый образ.  Затемненный растровый образ 
 
Примечание: Чтобы возвратиться к полноцветному изображению, нажмите кнопку Dim Picture еще раз. 
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Глава 12  
 
Обработка изображений для 
автоматического 
оцифровывания 
 
BERNINA artista поддерживает автоматическое и 
полуавтоматическое оцифровывание растровых изображений. 
Качество результирующего проекта в значительной мере зависит 
от типа и качества оригинального изображения. Чтобы сделать 
растровые изображения более пригодными для автоматического 
оцифровывания, BERNINA artista также обладает возможностями 
обработки изображений и связи с графическими программами. 
В этом разделе описывается, как подготавливать изображения 
для автоматического оцифровывания. Здесь также объясняется, 
как подготавливать оконтуренные и не оконтуренные 
изображения. 
 

Подготовка изображений для автоматического оцифровывания. 
 
Перед применением автоматического оцифровывания вам часто требуется улучшить или "очистить" 
оригинал. Для эффективной работы инструментов Auto Digitizer и Magic Wand требуются изображения с 
чистыми цветами. Вы можете улучшить изображение как инструментами редактирования растровых 
образом в графических программах, так и инструментами обработки изображений, входящими в BERNINA 
artista. В действительности программное обеспечение не позволит применить Auto Digitizer, пока 
изображение не будет должным образом обработано. 
 
Оконтуренные и не оконтуренные изображения 
Перед подготовкой изображения вам нужно узнать, с каким типом изображения вы имеете дело.  Для 
целей автоматического оцифровывания изображения делятся на две категории – оконтуренные и не 
оконтуренные. Оконтуренные изображения в идеале имеют сплошной черный контур вокруг каждой 
цветной зоны. Не оконтуренные изображения в идеале состоят из сплошных цветовых зон. Оконтуренные 
и не оконтуренные изображения требуют различных методов подготовки. 

   
Изображение с контурами   Изображение без контуров 

Очистка изображения 
На практике очистка отсканированных изображений может выполняться одним или комбинацией из 
нескольких технических средств: 

◄ сокращением количества цветов 
◄ добавлением или акцентированием контуров 
◄ удалением "шума", сглаживанием цветовых переходов или контуров 
◄ удалением ненужных деталей 
◄ кадрированием секций 
◄ удалением фона 
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Снижение цветности 
Иногда изображение выглядит достаточно четким, но во время сканирования или в графической 
программе к нему добавляются дополнительные цвета. Снижение цветности означает уменьшение 
фактического количества цветов изображения для устранения ненужных деталей и приведения каждого 
блока к единому цвету. Снижение цветности вызывает также очистку изображения с удалением шума 
(нежелательных крапинок) и сглаживанием переходов между пикселями, если это необходимо. Это, в 
свою очередь, сводит к минимуму число обрезок и изменений цветов, требуемых в окончательном проекте 
вышивки. Снижение цветности в не оконтуренных изображениях выполняется инструментом Artwork 
Preparation (Подготовка изображения), а оконтуренных изображений – инструментом Outlined Artwork 
Preparation (Подготовка оконтуренных изображений). 
Снижение цветности следует применять лишь в том случае, если потеря детали не приведет к искажению 
форм изображения. Перед снижением цветности цветовые зоны изображения (см. рисунок внизу) 
содержат много цветов. После снижения цветности каждая зона окрашена единым цветом. Детали 
сохраняются. 

   
      изображение до снижения   изображение после снижения 

цветности        цветности 
 
Если у вас отсканированные изображения, убедитесь, что они отсканированы правильно. Подробнее см. в 
разделе Сканирование изображения в программу BERNINA artista. 

 
Изображение отсканировано    Изображение отсканировано 
в цветовом режиме RGB     в режиме 256 цветов 
 
Имейте в виду, что инструмент Artwork Preparation хорошо пригоден для удаления шума (нежелательных 
крапинок) и сглаживания зазубрин в кривых линиях, но недостаточно хорошо пригоден для обработки 
размытых цветов в не оконтуренных изображениях. В противоположность этому, инструмент Outlined 
Artwork Preparation превосходно подходит для обработки размытых цветов, как и усреднения пикселей в 
определенном контуре. 

 
 
 
 
 
Инструмент Artwork Preparation использован с  
оконтуренным изображением – размытые цветные  
блоки очищены не полностью, края зазубрены. 
 
 

 
 
Инструмент Outlined Artwork Preparation  
использован с оконтуренным изображением  
– размытые цветные блоки хорошо очищены ,  
края четкие. 
 
 
 
Повышение четкости контура 
Повышение четкости контура означает более четкое определение контуров, ограничивающих 
определенные цветовые блоки или формы оригинала. Эти контуры могут быть расплывчатыми уже в 
оригинале или сделаться нечеткими в процессе сканирования. Повышение четкости контуров важно для 
автоматического оцифровывания, поскольку программе становится легче идентифицировать 
определенные зоны, которые становятся объектами вышивки в окончательном проекте. 
Примечание: Функция повышения четкости контуров работает только в том случае, если в изображении 
имеются черные или темные контуры. 

96



Глава 12: Обработка изображений для автоматического оцифровывания 

BERNINA® Artista Designer Plus Версия 4 

      
     Изображение до повышения     Изображение после повышения 
     четкости контуров                      четкости контуров 
 
Некоторые изображения имеют сплошные контуры, но они могут быть расплывчатыми или 
незавершенными. Поэтому такие контуры должны быть выправлены инструментами подготовки 
изображений BERNINA artista или графических программ. Подробнее см. в разделе Редактирование 
изображений в пакете графических программ. 
 
Фильтрация шума 
Фильтрация шума означает восстановление сплошных цветовых блоков оригинала в отсканированном 
изображении. Это достигается слиянием различных цветовых оттенков в сплошной цвет. Фильтрация 
шума важна для автоматического оцифровывания, поскольку программе становится легче 
идентифицировать определенные цветовые зоны, которые становятся объектами вышивки в 
окончательном проекте. Эта функция очищает также размытые или пестрые цветовые зоны . 
 

      
    Изображение до удаления   Изображение после удаления 
    шума, пестрый цвет    шума, сплошные цвета 
 
 
Инструменты подготовки изображений 
Используйте инструменты подготовки изображений для подготовки изображений к автоматическому 
оцифровыванию. Ваш выбор инструмента зависит от вида изображения. Имеются три инструмента: 
 
Инструмент Назначение Возможности 
Edit Image 
Правка 
изображения 

Связь с графической 
программой, например 
Paint Shop Pro, для правки 
изображения вне BERNINA 
artista 

Позволяет кадрировать изображение, повышать 
четкость, изменять цветность, добавлять 
контуры, удалять шум. 

Artwork  
Preparation 
Подготовка 
изображения 

Подготовка любого не 
оконтуренного 
изображения 

Позволяет снизить цветность до назначенного 
числа цветов: Автоматически: 
•  сокращает каждый блок до единого цвета 
•  удаляет зазубрины в кривых линиях, шум и 
размывы цвета 

•  удаляет цвета меньшие, чем назначенная 
область 

Outlined Artwork 
Preparation 
Подготовка 
оконтуренных 
изображений 

Подготовка оконтуренных 
изображений 

Позволяет отрегулировать светлость или 
темноту контуров.  Автоматически:  
•  усредняет цветность каждого оконтуренного 
блока в единый цвет 

•  удаляет зазубрины в кривых линиях, шум и 
размывы цвета 

•  повышает четкость контуров 
 
Примечание: Даже если изображение кажется вам готовым для вышивания после загрузки в ПО, оно 
нуждается в обработке перед преобразованием. Программное обеспечение не позволит вам применить 
автоматическое оцифровывание без предварительной обработки изображения. 
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Использование инструментов подготовки изображения 
Важно использовать правильные инструменты подготовки для вашего изображения. Приводимый ниже 
пример показывает изображение с расплывчатыми контурами. Если используется инструмент Outlined 
Artwork Preparation, контуры могут быть сделаны более темными и четкими, что улучшает качество 
вышивки. В противоположность этому, использование инструмента Artwork Preparation перед вышиванием 
создает менее качественные проекты вышивки. 
 

                           
          Зоны не сплошного цвета Использован инструмент Artwork 

Preparation – некоторые зоны 
вышивания загрязнены или пропущены, 
цветность снижена слишком сильно 

                             
Изображение со сплошной цветностью Использован инструмент Outlined 

Artwork Preparation – улучшено 
распознавание вышиваемых форм и 
цветов 

 
Перед использованием инструмента Outlined Artwork Preparation убедитесь в том, что изображение 
содержит сплошные контуры. Если имеются пробелы, отдельные цветовые зоны будут сливаться. 
 

           
 
 
            Контуры не    
            завершены 

Использован инструмент 
Outlined Artwork 
Preparation  

 
 
Цвет "протекает" через 
пробелы контура 

 
Если вам нужно добавить контуры, заполнить пробелы или повысить четкость контуров, то вам 
потребуется сделать это вручную перед сканированием оригинала. Или вы можете сделать это после 
сканирования в графической программе. Подробнее см. в разделе Редактирование изображений в пакете 
графических программ. 
 
Совет: Попытайтесь сделать контуры более темными, используя появляющийся движок контура. 
 

     
 
 
Контур изображения 
завершен в графической 
программе 

Использован 
инструмент 
Outlined 
Artwork 
Preparation  

 
 
Четкость контуров повышена 
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Обзор способов подготовки изображения 
Действие Оконтуренное 

изображение 
Не оконтуренное 
изображение 

Фотография 

Сканирование оригинала •  Сканирование в 
режиме RGB  

•  Повышение четкости  

•  Сканирование в 
режиме RGB  

•  Без повышения 
четкости  

Сканирование в режиме RGB  

Сканирование штриховых 
рисунков 

Сканирование в режиме 
двух цветов 

- - 

Отделка изображения в 
графической программе 

•  Обрезка 
•  Добавление или 
правка контуров 

•  Правка цветности 
•  Удаление шума 

•  Обрезка 
•  Правка форм 
изображения 

•  Правка цветности 
•  Удаление шума 

•  Обрезка 
•  Конвертирование в шкалу 
серого 

•  Удаление фона 
•  Осветление или затемнение 
•  Регулировка контраста 

Использование инструмента 
Outlined Artwork Preparation в 
BERNINA artista 

Повышение четкости 
контуров и удаление 
шума 

- - 

Использование инструмента 
Reduce Colors в BERNINA 
artista 

- Снижение цветности и 
удаление шума 

- 

Оцифровывание •  Вручную 
•  Инструментом Magic 

Wand 
•  Инструментом Auto 

Digitizer 

•  Вручную 
•  Инструментом Magic 

Wand 
•  Инструментом Auto 

Digitizer 

В программе PhotoSnap 

 

Подготовка не оконтуренных изображений 
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Используйте инструмент Artwork Preparation (панель Picture), чтобы понизить цветность и удалить 
шум (нежелательные крапинки) из изображения. 

 
Используйте инструмент Artwork Preparation для подготовки не оконтуренных изображений к 
автоматическому оцифровыванию. Инструмент автоматически уменьшает число цветных блоков в 
растровых изображениях, удаляя зазубрины в кривых линиях и шум. Вы можете позволить программе 
самостоятельно уменьшить число цветов или задать заранее их желаемое количество. Последнее 
полезно в том случае, если вы хотите согласовать цвета проекта с имеющимися у вас цветными нитками. 
 
Совет: В зависимости от качества отсканированного изображения вам может потребоваться выправить их 
вручную перед обработкой в BERNINA artista. Вы можете сделать это, чтобы удалить фон, залить цветом 
определенные зоны или контуры, заполнить пробелы, добавить или усилить контуры. Подробнее см. в 
разделе Редактирование изображений в пакете графических программ. 

      
Использован инструмент                Оцифрованнное изображение 
Artwork Preparation  

 
Как подготавливать не оконтуренные изображения 
1  В режиме Picture используйте функцию Load Picture (Загрузить рисунок).  
 Подробнее см. в разделе Загрузка растровых и векторных рисунков. 
 
 
2  Выберите изображение.  
 
 
3  Нажмите кнопку Artwork Preparation. 
 Откроется диалоговое окно Artwork Preparation (Подготовка изображения) 
 Изображение появится в панели просмотра. 
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Проверьте число цветов  
в изображении 
 
Введите число цветов 

 
4  Проверьте, сколько цветов имеется в изображении. 
 Это число указывается в поле Available Colors (Наличные цвета). Если представляется, что цветов 

слишком много, то это может быть вызвано шумом. 
5  Введите нужное вам число цветов. 
 Вы можете принять число цветов, предлагаемое BERNINA artista, или изменить его. 

   
Сокращено до 3 цветов Сокращено до 2 цветов 

 
6  Нажмите OK, чтобы принять изменения. 
7  Нажмите Save Picture, чтобы сохранить изменения. 

Подготовка оконтуренных изображений 
 
Используйте инструмент Outlined Artwork Preparation (панель Picture), чтобы повысить четкость 
контуров и уменьшить шум в оконтуренном изображении. 
 

Используйте инструмент Outlined Artwork Preparation для подготовки оконтуренных изображений к 
автоматическому оцифровыванию. Этот инструмент автоматически повышает четкость контуров и 
уменьшает шум. Зоны, входящие в черный контур, окрашиваются в единый цвет. Повышение четкости 
контура облегчает программе распознавать определенные зоны изображения. Эти зоны становятся 
объектами вышивки в окончательном проекте. Используйте этот инструмент в тех случаях, когда контуры 
являются смазанными, зазубренными, расплывчатыми или неопределенными.  

    
     Изображение со единообразной,    Оцифрованное изображение 
     сплошной цветностью 
 
Совет: В зависимости от качества отсканированного изображения вам может потребоваться выправить их 
вручную перед обработкой в BERNINA artista. Вы можете сделать это, чтобы кадрировать изображение, 
удалить фон, залить цветом определенные зоны, заполнить пробелы, добавить или усилить контуры. 
Подробнее см. в разделе Редактирование изображений в пакете графических программ. 
 
Как подготавливать оконтуренные изображения 
1  В режиме Picture нажмите кнопку Load Picture (Загрузить рисунок).  
2  Выберите изображение. 
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увеличенная зона 

3  Нажмите кнопку Outlined Artwork Preparation. 
Откроется диалоговое окно Outlined Artwork Preparation (Подготовка оконтуренного изображения)  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Настройка отображения  
контура 

 
 

 
  

 Нажать, чтобы увидеть   Количество цветов в изображении 
результаты удаления шума 

 
Изображение появится в панели просмотра. В поле Available Colors (Наличные цвета) показывается 
число цветов в изображении. 

4  Перемещая движок, установите желаемую контрастность  
      контура. 

Этим будет вызван черно-белый просмотр обнаруженных 
контуров. 

 
 
 
 
 
 
 
 
 
 
 

Перемещайте движок  
для повышения четкости  

контура и удаления крапинок 
 
 

Совет: Переместите движок вправо до тех пор, пока контуры не станут слишком темными, после этого 
медленно перемещайте движок влево. Остановитесь, когда в изображении будут показаны все 
контуры, как вам требуется. 

5  Нажмите Show Color Area (Показать 
цветную зону), чтобы увидеть обновленное 
изображение. 

 
               
 
 
 

              Движок перемещается влево,   Движок перемещается вправо, 
             контуры светлеют      контуры темнеют 
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6  Нажмите OK, чтобы принять изменения. 
7  Нажмите Save Picture, чтобы сохранить изменения. 

Правка изображений перед использованием 
 
BERNINA artista позволяет вам кадрировать изображения перед использованием. Из BERNINA artista вы 
можете также открывать изображения непосредственно в других графических программах. Обновленные 
таким образом изображения автоматически реимпортируются в BERNINA artista. 
 
Кадрирование изображений для оцифровывания 
 
Используйте функцию Crop Image (Кадрировать изображение) в меню Edit, чтобы обрезать изображение. 
Используйте функцию Crop Image with Curve (Кадрировать изображение кривой линией) в меню Edit, 
чтобы кадрировать изображение в произвольной форме. 
 
Перед использованием растрового рисунка для целей оцифровывания обрежьте его, чтобы удалить 
ненужные детали и сэкономить время, требуемое для обработки. 
 
Как кадрировать изображения для оцифровывания 
1  В режиме Picture используйте функцию Load Picture (Загрузить 

рисунок).  
2  Выберите изображение. 
3  Выберите инструмент кадрирования. 

◄ Выберите Edit > Crop Image > Rectangle, чтобы обрезать 
изображение в форме прямоугольника. 
                    
◄ Выберите Edit > Crop Image > Oval, чтобы обрезать изображение 
в форме овала.  
                     

 
◄  
◄ Выберите Edit > Crop Image > Heart, чтобы обрезать изображение 
в форме сердца.  

 
 
 
 
 
 
 
                 

◄ Выберите Edit > Crop Image > Star, чтобы обрезать изображение в 
форме звезды. 

Щелкните и перетащите форму обрезки вокруг нужной вам части 
изображения. 

 
                 
 
 
 
 

◄ Выберите Edit > Crop Image > Curve, чтобы обрезать изображение 
в произвольной форме. 

Наметьте точки, чтобы создать форму обрезки вокруг нужной вам 
части изображения и нажмите Enter. 

 
Совет: Используйте указания в строке подсказки. BERNINA artista 
кадрирует зону внутри кадрирующего прямо- или многоугольника. 
Этот процесс может занять определенное время. 
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Изменение формы кадрированных изображений 
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Нажмите Reshape Cropping Outlines (Изменить форму контура кадра) на панели инструментов 
Picture, чтобы кадрировать изображение в произвольной форме. 

 
После обрезки изображения вы можете изменить форму и трансформировать контуры кадрирования 
таким же образом, как вы изменяете форму и трансформируете текстовые объекты. Вы можете также 
использовать этот инструмент для перемещения контуров кадра. 
 
Примечание: Пиксели за пределами обрезанной зоны становятся блеклыми, так что становится легко 
увидеть кадрированную зону. 
 
Как изменять форму кадрированных изображений 
1  Нажмите Load Picture, чтобы загрузить изображение. 
2  Выберите изображение. 
             
 
 
 
 
 
 
3  Нажмите кнопку Reshape Cropping Outlines (Изменить форму 

контуров кадра). 
На изображении отобразится контур обрезки с контрольными 
точками изменения формы. 

 
              
 
 
 
4  Переместите контрольные точки, чтобы изменить форму и нажмите 

Enter, затем Esc, чтобы завершить операцию. 
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Глава 13  
 
 
 
Автоматическое 
оцифровывание 
 
Инструмент Magic Wand (Волшебная палочка) полезен для создания 
объектов вышивки из отсканированных изображений, которые не 
требуют особых художественных эффектов или специфичных знаний в 
области вышивания. Это поможет вам сохранить больше времени на 
обработку в действительности сложных зон вашего проекта. 
Программа BERNINA artista Auto Digitizer автоматически преобразует 
изображение в полностью оцифрованную форму с небольшими вашим 
вмешательством или совсем без вмешательства. Могут быть 
использованы различные формы оригинала – как растровые, так и 
векторные – и разнообразные уровни "участия" пользователя в 
процессе. 
Применяя Auto Digitizer, начинающие пользователи могут быстро и легко создавать несложные 
проекты. Равным образом, опытные пользователи могут повысить свою производительность 
при работе с простыми проектами. PhotoSnap используется для создания проектов вышивки по 
фотографиям и другим оригиналам.  
В этом разделе описывается, как автоматически преобразовывать растровые изображения в 
проекты вышивки. Здесь также объясняется, как автоматически оцифровывать формы, 
используя Magic Wand и Auto Digitizer. 
 

Оцифровывание инструментом Magic Wand 
 
Инструмент Magic Wand (Волшебная палочка) используется для автоматического оцифровывания форм в 
растровых изображениях. 
 
Примечание: Даже если изображение кажется вам готовым для вышивания после загрузки в ПО, оно 
нуждается в обработке перед преобразованием. Программное обеспечение не позволит вам применить 
автоматическое оцифровывание без предварительной обработки изображения. Подробнее см. в разделе 
Обработка изображений для автоматического оцифровывания. 
 
 
Оцифровывание заполненных форм инструментом Magic Wand 

 
Используйте инструмент Magic Wand (панель Design) для оцифровывания форм изображения. 

 
Если вам нужно заполнить объект, то перед использованием Magic Wand (Волшебная палочка) выберите 
Fill Stitch (Заполняющие стежки) на панели инструментов Stitch and Color (Стежок и Цвет). Вам может 
потребоваться добавить стабилизирующие стежки к вашей вышивке. Подробнее см. в разделе 
Упрочнение и стабилизация ткани стабилизирующими стежками. 
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Как оцифровывать заполненные формы инструментом Magic Wand 
1  В режиме Picture отсканируйте или загрузите изображение. 

Подробнее см. в разделе Сканирование изображения в программу 
BERNINA artista. 

 
     

         Загруженное изображение 
 
 
2  Выберите изображение и обработайте его. 

Подробнее см. в разделе Подготовка изображений для автоматического оцифровывания. 
3  В окне Design View (Просмотр проекта) выберите цвета ниток из панели инструментов Stitch and Color 

(Стежок и Цвет). 
4  Выберите тип стежков Fill Stitch (Заполняющий стежок) из панели Stitch and Color. 
 

Совет: Если вы хотите заполнить и оконтурить форму, то вам нужно создать два объекта, один с 
заполняющими стежками и второй с оконтуривающими стежками. 

5  Нажмите кнопку Magic Wand. 
BERNINA artista предложит вам щелкнуть в нужную зону. 

6  Щелкните на форме, которую вы хотите оцифровать.. 
7  Нажмите Enter. 

Форма будет заполнена заполняющими стежками. 

 
щелкните на зоне    зона заполниться стежками 

 
8  Оцифруйте таким же образом другие подлежащие заполнению зоны, изменяя по необходимости цвет 

ниток и тип стежка. 
 
Изменены тип стежка и цвет 
 
 
 
 
 
9  Проверьте проект в окне Artistic View (Художественный Просмотр). 
 
       Оцифрованы все зоны    
 
 
 
 
 
 

Примечание: Генерация стежков производится в соответствии с текущими 
настройками стежка. Возможно появление переходов, если длина стежка превышает установленные 
стандартные настройки. 

 
 
Оцифровывание контуров инструментом Magic Wand 

 
Используйте инструмент Magic Wand (панель Design) для оцифровывания форм изображения. 

 
Если вам нужно оконтурить объект, то перед использованием Волшебной палочки (Magic Wand) выберите 
Outline Stitch (Оконтуривающий стежок). 
 
Как оцифровывать контуры инструментом Magic Wand 
1  В режиме Picture отсканируйте или загрузите изображение. 

Подробнее см. в разделе Сканирование изображения в программу BERNINA artista. 
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Загруженное изображение 

 
 
 
 
 

2  Выберите изображение и обработайте его. 
Подробнее см. в разделе Подготовка изображений для автоматического оцифровывания. 

3  В окне Design View (Просмотр проекта) выберите цвета ниток из панели инструментов Stitch and Color 
(Стежок и Цвет). 

4  Выберите тип стежков Outline Stitch (Оконтуривающий стежок) из панели Stitch and Color. 
 

Совет: Если вы хотите заполнить и оконтурить форму, то вам нужно создать два объекта, один с 
заполняющими стежками и второй с оконтуривающими стежками. 

5  Нажмите кнопку Magic Wand. 
6  Щелкните по контуру. 
7  Нажмите Enter. 

Объект обведен оконтуривающими стежками. 

         
Щелкните по контуру   Оконтурено гладьевым стежком 

 
8  Оцифруйте таким же образом другие подлежащие оконтуриванию зоны, изменяя по необходимости 

цвет ниток и тип стежка. 

            
Цвет контура изменен  Изменен тип оконтуривающего стежка 

 
9  Проверьте проект в окне Artistic View (Художественный Просмотр). 

            
Завершенный проект   Оцифрованы только контуры 

Примечание: Генерация стежков производится в соответствии с текущими настройками стежка. 
Возможно появление переходов, если длина стежка превышает установленные стандартные 
настройки. 

              
Ширина гладьевого валика:      Ширина гладьевого валика: 
2,5 мм с отдельными переходами    1,0 мм БЕЗ переходов 
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Оцифровывание инструментом Auto Digitizer 
 
Обладая расширенными по сравнению с технологией Magic Wand функциями, инструмент Auto Digitizer 
распознает формы в оригинальном изображении и самостоятельно принимает решения о применении 
наиболее подходящих типов стежка. Также определяется последовательность вышивания на основе 
соединения. Изображение подвергается эффективной "пакетной обработке" для создания многих 
объектов вышивки, из которых состоит проект. Auto Digitizer позволит вам до некоторой степени 
контролировать, как преобразуется изображение во время преобразования. Вы можете пропустить 
выбранные цвета и назначить типы стежков. Создав проект, вы всегда можете выправить окончательный 
результат, используя имеющуюся технологию оцифровывания. Смотри также Методы оцифровывания. Не 
забывайте о применении стабилизирующих стежков, кроме того, вам может потребоваться изменить 
форму некоторых объектов. Подробнее см. в разделе Выбор стабилизирующих стежков. 
 
Примечание: Даже если изображение кажется вам готовым для вышивания после загрузки в ПО, оно 
нуждается в обработке перед преобразованием. Программное обеспечение не позволит вам применить 
автоматическое оцифровывание без предварительной обработки изображения. Подробнее см. в разделе 
Обработка изображений для автоматического оцифровывания. 
 
Создание проектов вышивки инструментом Auto Digitizer 
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Используйте инструмент Auto Digitizer (панель Design) для создания проектов вышивки 
непосредственно по импортированному изображению. 

 
По существу, создание проекта вышивки функцией Auto Digitizer заключается в том, что вам нужно 
выделить изображение, которое вы хотите преобразовать, и щелкнуть по нему инструментом Auto 
Digitizer. Однако имеются некоторые настройки, которые вы можете изменить, чтобы оптимизировать 
процесс преобразования для конкретных проектов. 
В одно и то же время можно выделить только одно изображение. Команда отменяется, если в выделенной 
зоне находится больше одного изображения. 
 
Примечание: При использовании Auto Digitizer выберите компенсацию стягивания (Pull Compensation), 
установленную на 0,4 мм. 
 
Как создавать проекты вышивки инструментом Auto Digitizer 
1  В режиме Picture отсканируйте или загрузите изображение. 

Подробнее см. в разделе Сканирование изображения в программу 
BERNINA artista. 

         
2  Выберите изображение и обработайте его. 

Подробнее см. в разделе Обработка изображений для автоматического 
оцифровывания. 

3  Щелкните по значку Auto Digitizing. 
Откроется диалоговое окно Auto Digitizer. 

 
 
 

Размеры проекта 
 
 

Количество цветных ниток 
 
 
 
 
 

Выбор опций вышивания 
 
 
 

Нажать для показа пропускаемых цветов 
 
 
 
В верхней части окна появляется информация об изображении, включая размеры по высоте и ширине и 
количество цветов в изображения. 
4  Выберите типы стежков для заполнения и оконтуривания. 
5  Нажмите кнопку Omitted Colors (Пропустить Цвета), чтобы выбрать цвета, исключаемые из 

процесса автоматического размещения стежков. 
◄ Для выбора нескольких цветов удерживайте нажатой клавишу Ctrl. 
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◄ Для выбора нескольких идущих подряд цветов удерживайте нажатой клавишу Shift. 
 
 
 
 
Выберите для пропуска 
 
 
 
 
 
 
 
 
 
 

6  Нажмите кнопку ОК. 
Auto Digitizer преобразует изображение в объекты вышивки и генерирует стежки.   

   
Пропущен белый фон   Пропущены некоторые цвета 

 
Программа подбирает цвета из существующей палитры. Если вам кажется, что в проекте 
конвертированные цвета на экране отображаются неправильно, проверьте, установлен ли ваш 
монитор на 16-битовую насыщенность цвета, и убедитесь в том, что вы выбрали подходящую таблицу 
ниток. 
 

Настройка заполняющих стежков 
Auto Digitizer позволяет выбирать настройки заполняющих стежков. 
         

       Выбраны только цвета заполнения 
 
Как настроить заполняющие стежки 
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1  Щелкните по значку Auto Digitizer и выберите обработанное 
изображение.  

 Откроется диалоговое окно Auto Digitizer. 
 
 
 
 
 
 

 
Выбор стиля  

стежков заполнения   
 
 
 
 
2  Выберите из списка стиль заполняющих стежков. 

◄ Auto: программа выбирает сама наилучший тип   
       стежка. 
◄ Step: простегивающий стежок – подходит для большинства зон 
◄ Satin: гладьевый стежок – подходит для узких выделяющихся зон. 

 
Примечание: Не используйте гладьевый заполняющий стежок для зон, в которых длина стежка 
превышает 7 мм. См. также Сохранение длинных стежков функцией Auto Jump. 
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Гладьевый заполняющий    Созданы переходные стежки 
стежок не подходит 

 
3  Нажмите кнопку ОК. 
 Auto Digitizer преобразует изображение в объекты вышивки и генерирует стежки.  

        
Заполнение: Step =     Заполнение: Auto = 
Простегивающий стежок    Автоматический выбор 

 
Настройка оконтуривающих стежков 
Auto Digitizer позволяет выбирать настройки оконтуривающих стежков. 

Выбран только цвет контура 
 
 
 
Как настроить оконтуривающие стежки 
1  Щелкните по значку Auto Digitizer и выберите обработанное 

изображение.  
 Откроется диалоговое окно Auto Digitizer. 
 
       
 
 
 
 
 
 
 

Выбор стиля стежков  
2  Выберите из списка стиль стежков. 
◄ Satin: гладьевый стежок – наиболее подходит для толстых линий 

или узких форм с изменяющейся шириной. 
◄ Double Run: двойной обход – наиболее подходит для тонкий линий. 
◄ Satin Line: гладьевый валик – наиболее подходит для толстых линий. 
3  Нажмите кнопку ОК. 
 
Auto Digitizer преобразует изображение в объекты вышивки и генерирует стежки.  

                 
В поле Details: Satin    В поле Details: Double Run 

 

Оцифровывание фотографий функцией PhotoSnap 
 
Функция PhotoSnap является техническим средством создания проектов вышивки 
непосредственно по фотографиям и другим растровым изображениям. Проекты 
PhotoSnap состоят из рядов гладьевых стежков с изменяющимся шагом. 
 
Совет: Для получения лучших результатов используйте изображения с хорошо 
выделенными формами или постоянно изменяющимися оттенками. 
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Создание проектов вышивки по фотографиям 
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Используйте инструмент PhotoSnap (панель Design) для создания проектов вышивки 
непосредственно по фотографиям. 

 
PhotoSnap используется для создания проектов вышивки по фотографиям и 
другим оригиналам.  Проекты PhotoSnap состоят из рядов гладьевых стежков 
с изменяющимся шагом. Получаемый эффект напоминает распечатку 
построчно-печатающего принтера. 
 
    

С добавлением бордюра и текста 
 
Как создать проекты вышивки по фотографиям 
1  В режиме Picture загрузите файл с растровым изображением и измените 

по желанию размер. 
Подробнее см. в разделе Загрузка растровых и векторных рисунков. 

 
     
2  В режиме Picture выделите растровый образ и затем щелкните по значку 

PhotoSnap. 
Откроется закладка PhotoSnap  диалогового окна Object Properties 
(Свойства объекта). 

 
       
 
 
 
             Выберите нужное  
             разрешение 
 
 
 
3  На панели Resolution (Разрешение) выберите требуемое разрешение: 

◄ Coarse = Грубое 
◄ Medium = Среднее 
◄ Fine = Тонкое 

 
 

               
Грубое     Тонкое 

 
4  На панели Background Fabric (Фон ткани) выберите нужную опцию. 
◄ Light = Светлый: применяется значение Max Width к наиболее светлой части изображения. 
◄ Dark = Темный: применяется значение Max Width к наиболее темной части изображения. 

                  
Светлый фон    Темный фон 

 
Совет: Обычно выбираемая вами опция зависит от того, является ли ткань светлой или темной. 
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5  На панели Fill Angle (Угол заполнения) при необходимости выберите угол стежков. 
 

Угол заполнения 45°  
 
Опция Fill Angle определяет угол направления строчек. 
6  На закладке Fill Stitch (Заполняющий стежок) выберите, если нужно, параметры стежка.  
7  Нажмите кнопку ОК. 

BERNINA artista выполнит генерацию стежков. Этот процесс может занять определенное время. 
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Часть IV  
Изменение проектов 
 
 
 
 

Глава 14  
Комбинирование и изменение 
последовательности объектов 
 
BERNINA artista позволяет быстро дополнять проекты путем 
дублирования и копирования существующих объектов. Также имеется 
возможность комбинировать проекты, вставляя содержимое одного 
файла в другой. 
При работе с проектами вышивки вам необходимо разобраться с 
последовательностью вышивания. Вы можете проверить 
последовательность вышивания проекта путем ‘обхода’ по стежкам. Вы 
можете также проверить последовательность медленным 
перерисовыванием проекта на экране. Последовательность вышивания обычно определяется 
порядком оцифровывания проекта. Однако имеется много способов изменения 
последовательности вышивания. 
В этом разделе описывается, каким образом можно комбинировать объекты и проекты путем 
копирования и вставки, дублирования и вставки объектов. Также объясняется, как "обходить" 
по стежкам проект, а также как изменять последовательность вышивания объектов путем 
вырезки и вставки, по цвету и функцией Color Film. 
 

Комбинирование объектов 
 
Проект или объекты проекта можно копировать или вырезать и загружать в буфер обмена Windows для 
временного сохранения. Содержимое буфера обмена может быть вставлено любое число раз в один и тот 
же или в другой проект, до тех пор. Вы можете также вырезать, копировать и вставлять текстовые объекты 
в проекты и между проектами. 
 
Копирование и вставка объектов 

 
Нажмите кнопку Copy (панель General), чтобы копировать выделенные объекты в буфер обмена. 
 
 
Нажмите кнопку Paste (панель General), чтобы вставить скопированные объекты в проект.   
 

Вы можете копировать объекты, чтобы создавать многократно воспроизводимые идентичные объекты или 
вставлять объекты из других проектов. 
 
Примечание: Вы можете также удалять объекты из проекта, пользуясь командой Cut (Вырезать), и 
вставлять их обратно. Команды Cut и Paste изменяют последовательность вышивания в проекте. 
Подробнее см. в разделе Изменение последовательности вышивания объектов командами Cut и Paste. 
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Как копировать и вставлять объекты 
1 Выделите объект (или объекты) для копирования. 
2 Нажмите кнопку Copy (Копировать). 
 Выделенный объект будет скопирован в буфер обмена. 
3 Перейдите к позиции в последовательности вышивания, в которую вы хотите вставить объект. 

Подробнее см. в разделе Обход по стежкам. Вы можете вставить объект между другими объектами в 
последовательности вышивания. 

4 Нажмите кнопку Paste (Вставить). 

       
Лепестки скопированы и вставлены 

 
Примечание: Объект будет вставлен точно в верхнюю часть оригинального объекта. Щелкните 
мышью и перетащите объект перед отменой выделения. Объект будет оставаться в буфере обмена и 
может быть неоднократно вставлен до тех пор, пока не последует следующая команда Copy 
(Копировать) или Cut (Вырезать).  
 
Внимание: Убедитесь в том, что имеется только одна копия объекта в одной и той же позиции. Если 
объект вставлен дважды в одну и ту же позицию, то он будет вышит дважды. 

        
Дублирование объектов 
 
Выберите команду Duplicate (меню Edit), чтобы дублировать выделенные объекты. 
 
Предпочтительнее дублировать объекты, чем копировать. При дублировании объекта он не копируется в 
буфер обмена. Этим вы сохраняете буфер обмена для вырезки или копирования других объектов. 

     
Как дублировать объекты 
1 Перейдите к позиции в последовательности вышивания, в которую вы хотите поместить объект. 

Подробнее см. в разделе Обход по стежкам. 
 Вы можете поместить объект между другими объектами в последовательности вышивания. 
2 Выделите объект (или объекты) для дублирования. 
3 Выберите Edit > Duplicate. 
 Дублированный объект помещен непосредственно в верхней части оригинального объекта в 

назначенной позиции последовательности вышивания. Не забудьте щелкнуть мышью и перетащить 
объект перед отменой выделения. 

 
Удаление объектов 
 
Выберите команду Delete (меню Edit), чтобы удалить выделенные объекты. 
 
Удалять объекты можно различными методами. 
 
 
Как удалять объекты 
◄ Выделите объект (или объекты) для удаления и  

◄ Нажмите Delete или 
◄ Выберите Edit > Delete. 
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Комбинирование проектов 
 
Для комбинирования проектов выберите команду Insert Design (меню File). 
 
BERNINA artista позволяет вставить один проект в другой. Два или больше проектов могут быть затем 
сохранены в комбинированном проекте. 
Если вы вставляете один проект в другой, две цветовые палитры комбинируются. Цвета с одними и теми 
же значениями RGB автоматически идентифицируются как имеющие один и тот же цвет ниток. Если вы 
хотите сохранить их как отдельные цвета, то вам нужно изменить один или другой цвет перед слиянием. 

      
Как комбинировать проекты 
1 Откройте первый проект. 
2 Перейдите к позиции в последовательности вышивания, в которую вы хотите вставить проект. 

Подробнее см. в разделе Обход по стежкам.  
3 Выберите File (Файл) > Insert Design (Вставить Проект). 
 Откроется диалоговое окно Open. 
4 Из открывшегося списка Look In выберите папку, в которой сохраняется проект, который вы хотите 

вставить, и выберите требуемый формат из списка Files of type. 
5 Выберите файл с нужным вам проектом и нажмите Open. 
 Проект будет вставлен в текущую позицию иглы. 
6  Переместите второй проект в нужное вам положение. 
 Подробнее см. в разделе Позиционирование объектов перетаскиванием мышью. 
 

Совет: Чтобы гарантировать, что все объекты вставляемого проекта будут связаны между собой, 
сгруппируйте проект во время работы с ним. Подробнее см. в разделе Группирование объектов. 

7  Сохраните комбинированный проект под оригинальным или измененным именем. 
 

     
Вставленные вами проекты скомбинированы в единый проект. 
 
Глава 14: Комбинирование и изменение последовательности объектов 
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Соединение объектов вышивки 
 
Объекты проекта связываются соединительными стежками. Они могут быть 
закрепляющими или переходными. Настройки применяются автоматически, чтобы 
генерировать соединительные и закрепляющие стежки. 
По умолчанию в BERNINA artista соединительные стежки являются "переходами", когда 
при перемещении пялец игла не втыкается в ткань. В идеале вы должны так планировать 
вышивку, чтобы соединительные стежки позже перекрывались другими элементами 
проекта. Если соединительные стежки не перекрываются, то после вышивания проекта 
они должны быть обрезаны. Соединительные стежки генерируются автоматически, но вы 
можете изменить последовательность вышивания объектов или изменить положение 
начальной и конечной точек, чтобы свести к минимуму число обрезаемых ниток. 
Начальные и конечные закрепительные стежки являются дополнительными стежками, 
добавляемыми до и после длинных переходов и изменений цвета, чтобы при остановке 
стежки не распускались. 
Переходные стежки являются сметочными стежками, соединяющими части внутри 
объекта. Они перекрываются верхними стежками. 
 
Типы соединительных стежков 
Они могут быть закрепляющими или переходными. Соединительные стежки отображаются 
только в режиме Design View, в режиме просмотра Artistic View они скрыты. Короткие 
переходы показываются сплошной линией, длинные переходы – пунктирными. Изменения 
цвета показываются штрихпунктирной линией. Соединительные стежки вставляются в 
проект автоматически. 
 
Совет: Нажмите Shift + C, чтобы увидеть скрытые соединительные стежки в режиме 
просмотра Design View. 
 
Короткий проходной  
соединительный стежок  
(сплошная линия) 
 
Длинный проходной  
соединительный стежок  
(пунктирная линия) 
 
Соединительный стежок,  
показывающий изменение  
цвета 
 
Переходной стежок 
 
 
Проходные стежки 
Проходные стежки связывают объекты в проекте и отображаются на экране пунктирными линиями. При 
выполнении проходного стежка пяльцы перемещаются от одной части проекта к другой без прокола 
материала иглой. Нитки проходного стежка, как правило, необходимо обрезать. 
Соединительные проходные стежки отображаются в режиме Design пунктирной или сплошной линией. 
Сплошная линия используется для коротких переходов. 

        
Короткий переход: сплошная линия 

 
Пунктирные линии используются при изменении цвета или при длинном (более 12, 7 мм) переходе. 

118



Глава 14: Комбинирование и изменение последовательности объектов 

BERNINA® Artista Designer Plus Версия 4 

 

            
 Длинный переход: пунктирная линия 

 

                
Изменение цвета: штрихпунктирная линия. 

 
При длинных проходных соединительных стежках игла протыкает материал через каждые 7 мм. Из-за 
этого машина останавливается несколько раз во время медленного перемещения пялец к следующей 
точке прокола иглой.  Проходные соединительные стежки не отображаются в режиме просмотра Artistic 
View. 
 
Примечание: По умолчанию длина проходного соединительного стежка та же, что установлена для 
функции Auto Jump. 

        
Соединительные стежки, отображенные в режиме Design View 

      
Отрегулировано положение начальных и конечных точек: меньше соединительных стежков 

        
Соединительные стежки НЕ отображаются в режиме просмотра Artistic View 
 
Начальные закрепляющие стежки 
Начальные закрепляющие стежки автоматически вставляются в начале объектов, чтобы предотвратить 
распускание стежков. Они вставляются внутри объекта на втором рабочем стежке. 
 
 
Закрепление стежков  
в начале объекта 
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Начальные закрепляющие стежки автоматически добавляются, если предыдущий переход длиннее 3 мм 
(2 мм для текстовых объектов) и после изменения цвета. 
 
Совет: Обойдите проект по одному стежку, чтобы проверить наличие начальных закрепляющих стежков. 
 
Закрепления двумя стежками 
 
 
 
 
 
Конечные закрепляющие стежки 
При переходах требуется закрепить стежок, так чтобы можно было обрезать нитку, не опасаясь 
распускания стежков. Конечные закрепляющие стежки автоматически добавляются, если следующий 
переход длиннее 3 мм (2 мм для текстовых объектов) и перед изменением цвета. 
 

Начальные закрепляющие стежки 
 

 
 

Конечные закрепляющие стежки 
 
 
Совет: Обойдите проект по одному стежку, чтобы проверить наличие конечных закрепляющих стежков. 
 
Переходные стежки 
Переходные стежки добавляются, когда игле нужно перейти между точками внутри объектами, строчка 
переходного стежка находится под основными стежками. Эти стежки выполняются в действительности, 
так что вам требуется удостовериться, что они перекрываются верхними основными стежками. 

    
Переходной стежок Строчка переходного  Начальная точка изменена, 

стежка видна  в    переходных стежков НЕТ 
режиме Artistic View 

   
 
Вы можете свести число переходных стежков к минимуму при правильном выборе положения начальной и 
конечной точек каждого объекта. 

Изменение последовательности вышивания объектов 
 
Объекты вышивки в проекте образуют последовательность вышивания. Первоначально объекты 
вышиваются в том порядке, в котором они создаются. Вы можете изменить положение выделенного 
объекта, вырезав его и затем вставив где-либо в последовательности или использовав команду 
Resequence (Изменить последовательность). Вы можете также изменить последовательность объектов, 
используя инструмент Color Film. 
 
Изменение последовательности объектов вырезкой и вставкой 
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Нажмите Cut (панель General), чтобы вырезать объект или объекты с помещение в буфер обмена. 
 
Нажмите Paste (панель General), чтобы вставить скопированные объекты в проект.  
 

Вы можете изменить последовательность объектов путем вырезания объекта из проекта и вставить его в 
другое место последовательности. Это не внесет изменений в физическое расположение объекта. 
 
Как изменять последовательность объектов вырезкой и вставкой 
1 Выделите объект (или объекты) для изменения последовательности. 
2 Нажмите кнопку Cut (Вырезать). 
 Выделенный объект будет удален из проекта и помещен в буфер обмена. 
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Неправильная     Выделенный и вырезанный 
последовательность  объект будет изменен 

 
3 Перейдите к точке в последовательности вышивания, в которую вы хотите поместить объект. 

Подробнее см. в разделе Обход по стежкам. 
 Вы можете вставить объект между другими объектами в последовательности или "вмонтировать" 

вырезанный объект внутри другого объекта. 
 Если текущее положение маркера иглы находится в конце проекта, объект будет вставлен в конце 

последовательности. 
4 Нажмите кнопку Paste (Вставить). 

     
Перейдите к концу проекта  Вставьте объект  

 
 Объект будет вставлен в конец проекта. 
 
 Примечание: Объект будет оставаться в буфере обмена и может быть неоднократно вставлен до тех 

пор, пока не последует следующая команда Copy (Копировать) или Cut (Вырезать).  
 
Изменение последовательности выделенных объектов 
 
Выберите команду Sequence As Selected (меню Arrange), чтобы изменить последовательность 
выделенных объектов. 
 
Вы можете изменить последовательность объектов путем их выделения в порядке требуемой 
последовательности вышивания. 
 
Как изменить последовательность выделенных объектов 
1 Выделите первый объект в диапазоне объектов, последовательность которых вы хотите изменить. 
2 Удерживая нажатой клавишу Ctrl, последовательно выберите объекты в порядке изменения 

последовательности.   
 
 Примечание: Выбирайте каждый объект в том порядке, в котором вы хотите их вышивать. 
3 Когда объекты еще остаются выделенными, выберите команду Arrange (Расположение) > Sequence As 

Selected (Последовательность в порядке выделения). 
 Теперь последовательность объектов будет соответствующей порядку из выделения. 

       
   Неправильная     Правильная  
последовательность   последовательность 

Изменение последовательности объектов по цвету 
 
Выберите команду Sequence By Color (меню Arrange), чтобы изменить последовательность объектов по 
цвету. 
 
Вы можете изменить последовательность объектов по цвету. Таким образом, вы уменьшите количество 
цветовых переходов в проекте.   
 
Как изменить последовательность объектов по цвету 
1 Выберите объекты для изменения последовательности. 
2 Выберите команду Arrange > Sequence By Color. 
 Откроется диалоговое окно Sequence By Color (Последовательность по цвету) со списком цветов в 

выбранных объектах. 
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3 Выберите цвет и нажмите Move Up (Переместить вверх) или Move Down (Переместить 

вниз), чтобы изменить его положение в последовательности.  
4 Нажмите кнопку ОК. 

     
Черный цвет первый   Черный цвет последний 

 
Изменение последовательности объектов инструментом Color Film 
 
Выберите команду Sequence to Start (меню Arrange), чтобы поместить выделенный объект в начало 
последовательности вышивания.  
Выберите команду Sequence to End (меню Arrange), чтобы изменить последовательность выделенного 
объекта в конце последовательности вышивания.  

 
Вы можете изменить последовательность объектов путем изменения их положения в окне Color 
Film. 

 
Как изменить последовательность объектов инструментом Color Film 
1 Нажмите кнопку Color Film. 
2 В окне Color Film выберите объекты для изменения последовательности. 

      
Перетащите значок в новое положение 

 
3 Перетащите выделенные объекты, чтобы изменить их расположение в окне Color Film. 

     
Перетащите значок в новое положение 

 
Изменение последовательности объектов в начале или конце 
 
Вы можете изменить последовательность объектов, выделив их и расположив в начале или конце 
последовательности вышивания. 
 
Как изменить последовательность объектов в начале или конце 
◄ Выделите объект. 
◄ Выберите команду Arrange > Sequence to Start. 
 Последовательность вышивания проекта изменяется при размещении выделенного объекта в начало 
последовательности. 
◄ Выберите команду Arrange > Sequence to End. 
 Последовательность вышивания проекта изменяется при размещении выделенного объекта в конец 
последовательности. 
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Используйте инструмент Blackwork Run (панель Craft Stitch) для автоматического назначения 
последовательности выделенных объектов вышивки. 

 
Функция Blackwork Run позволяет оцифровывать похожие друг на друга объекты, – например, пальцы 
руки или части листа, – не задумываясь о наиболее эффективных последовательности и соединениях. 
Функция Blackwork Run предназначена для использования с контурами, создающими перекрывающие 
объекты. Применяйте Blackwork Run для соединения выделенных контуров, чтобы образовать единый 
"контур с автоматической последовательностью". Все контуры компонента сгруппированы и выделяются 
как единое целое. 
 
Свойства объектов с автоматически установленной последовательностью 
Функция Blackwork Run работает с контурами вышивки, состоящими из линий, созданных одним или 
комбинацией следующих инструментов Open Curve (Незамкнутая кривая), Closed Curve (Замкнутая 
кривая), Circle/Oval (Окружность/Овал), или Rectangle (Прямоугольник), которые используют одинарный 
или тройной контур, простегивающий стежок или стежок "назад в иголку". Контуры, выполненные 
узорными стежками (Pattern Run) не могут быть использованы.  Для автоматической последовательности 
может быть использован только один из типов стежков, оконтуривающий выделенный объект. 
Назначается тот тип стежка, который использован в первом выбранном объекте. Также используются те 
эффекты вышивания, которые были выбраны в первом выделенном объекте. 
 
Примечание: Если для автоматической последовательности были выбраны разнородные объекты, то те 
объекты, еоторые не могут быть включены в автоматическую последовательность, пропускаются. 
 
Правка объектов автоматической последовательности 
Объекты автоматической последовательности можно редактировать. Они могут быть изменены по форме. 
Имеется только одна точка входа и одна точка выхода, но все компоненты объектов имеют 
индивидуальные точки изменения формы. К свойствам объекта автоматической последовательности 
можно получить доступ через диалоговое окно Object Properties (Свойства объекта). Типы стежков можно 
переназначать через панель инструментов. 
 
Применение автоматической последовательности 
 

Используйте инструмент Blackwork Run (панель Craft Stitch) для автоматического назначения 

последовательности выделенных объектов вышивки. 
 
Применяйте инструмент Blackwork Run к выделенным 
объектам. Они становятся единым объектом 
автоматической последовательности. 
 
      
 
 
 
 
Как применять автоматическую 
последовательность 
1 Выделите объекты. 
 
Примечание: Эта функция применима только в 
том случае, если выбрано больше одного объекта 
подходящего типа. 
 
 
    

Длинные соединительные стежки между отдельными 
объектами 

 
2 Нажмите на значок Blackwork Run. 
 BERNINA artista подскажет вам, как 

оцифровывать точку входа. 
3 Оцифруйте точку входа или нажмите Enter, чтобы принять стандартные настройки.  
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Последовательность объектов изменена, количество соединительных стежков уменьшилось 

 
 Стежки будут воспроизведены. Объекты объединены в группу и принимают тип и цвет стежка первого 

оцифрованного объекта. 
4 Обойдите объект автоматической последовательности для проверки. 
 
 

124



Глава 15: Расположение и трансформация объектов 
 

Глава 15  
 
 

Расположение и 
трансформация объектов 
 
BERNINA artista позволяет изменять положение, размер и ориентацию 
объектов в проекте путем их перемещения, изменения размеров и 
трансформации. Объедините объекты в группу, чтобы выполнить их 
изменение одной командой. Вы можете модифицировать объекты 
непосредственно на экране или через диалоговое окно Object Properties 
(Свойства объекта). 
В этом разделе описывается, как позиционировать объекты, как 
объединить объекты в группу, а также как изменять размеры, изменять 
наклон и зеркально отображать объекты. Также объясняется, как 
создавать многократные копии в форме венка, используя функцию 
Mirror Merge. 
Возможность изменения размера и качество вышивки по проекту в 
конечном счете зависит от формата первоисточника – ART Grade A, ART Grade B, ART Grade C 
или ART Grade D. Только проекты в "родном" формате ART Grade A содержат полный набор 
информации, требуемой для 100%-ного совершенства масштабирования и трансформации. 
Подробнее см. в разделе Форматы проектов вышивки. 
 

Позиционирование объектов 
 
Позиционируйте объекты в вашем проекте, используя мышь для перетаскивания их в новое положение, 
перемещая клавишами со стрелками или назначая координаты X:Y в диалоговом окне Object Properties. 
 
Позиционирование объектов перетаскиванием мышью 
Наиболее простым способом перемещения объекта в вашем проекте является перетаскивание его 
мышью. Используйте клавиши со стрелками для "подталкивания" объекта к нужной позиции. 
 
Как позиционировать объекты перетаскиванием мышью 
1  Выберите объект/ы для перемещения. 
2  Перетащите мышью объект в новое положение. 

 
 
 
 
Курсор в виде перекрести в центре объекта 
 
 
 
 
 

3  Для более точного позиционирования нажимайте клавиши со стрелками, чтобы "подтолкнуть" объект к 
требуемой позиции. 
Совет: Увеличьте масштаб изображения, чтобы было легче выполнять малейшие перемещения. 
Размеры объекта на экране изменяются в зависимости от текущего масштаба. Чем больше масштаб, 
тем на меньшее расстояние можно перемещать объект. 
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Позиционирование объектов с использованием свойств объекта 
Вы можете позиционировать выбранные объекты по отношению к центру проекта вводом координат X:Y в 
диалоговом окне Object Properties (Выбор объекта). 
 
Как позиционировать объекты с использованием свойств объекта 
1  Выберите объект/ы для перемещения. 
2  Дважды щелкните по проекту, чтобы открыть диалоговое окно Object Properties, и выберите закладку 

General. 
 
      
 
Введите новые координаты 
 
 
 

3  В полях Position введите новые координаты объекта. 
4  Нажмите кнопку ОК. 
 Центр объекта переместится в точку ч назначенными вами координатами. 
 

Группировка и разгруппировка объектов 
 
Если вы сгруппировали объекты, вы можете одной командой применить изменение ко всем объектам, что 
позволяет экономить время и гарантирует, что изменение проведено во всех объектах. 
 
Группировка объектов 

 
Щелкните по значку Group (панель Arrange), чтобы сгруппировать выделенные объекты. 
 

Вы можете объединить в группу выбранные объекты или весь проект, чтобы сохранять связи между 
объектами во время перемещения, изменения размеров и трансформации. 
 
Как сгруппировать объекты 
1  Выберите объекты для объединения в группу. 
2  Нажмите кнопку Group (Объединить в группу). 
 

Выделение, перемещение или  
трансформирование сгруппированных  

объектов как единого объекта 
 
 
Выбранные объекты объединяются в группу. Группа может быть выделена, перемещена, изменена по 
размеру как единый объект. 
 
Совет: Чтобы выделить группу с ограничивающим контуром, просто перетащите контур над одним из 
объектов, и вся группа будет выделена. См. также Выбор объектов ограничивающим прямоугольником. 
 
Разгруппирование объектов 
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Щелкните по значку Ungroup (панель Arrange), чтобы разгруппировать выделенные объекты. 
 

Если вы завершили изменения в группе, вы можете разгруппировать их и работать индивидуально с 
каждым объектом. 
 
 
Примечание: Вам нужно разгруппировать объекты, перед тем как устанавливать параметры вышивания в 
любом из индивидуальных объектов в группе. 
 
Как разгруппировать объекты 
1  Выберите группу объектов. 
2  Нажмите кнопку Ungroup (Разгруппировать). 
 

Разгруппированные  
объекты можно выделять  

индивидуально 
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Объекты будут разгруппированы, и входившие в группу объекты можно будет выделять 
индивидуально. 

 
Выравнивание объектов 
 

Для выбора объекта используйте инструмент Select Object (Выбрать объект) на панели Design. 
 
 
Щелкните по значку Align Left Vertical (Выровнять слева по вертикали) на панели Arrange, чтобы 
выровнять объекты по их левым сторонам. 
 
Щелкните по значку Align Centers Vertical (Выровнять средние линии по вертикали) на панели 
Arrange, чтобы выровнять объекты по их средним линиям. 
 
 
Щелкните по значку Align Right Vertical (Выровнять справа по вертикали) на панели Arrange, чтобы 
выровнять объекты по их правым сторонам. 
 
 
Щелкните по значку Align Top Horizontal (Выровнять верхние стороны по горизонтали) на панели 
Arrange, чтобы выровнять объекты по их верхним сторонам. 
 
Щелкните по значку Align Centers Horizontal (Выровнять средние линии по горизонтали) на панели 
Arrange, чтобы выровнять объекты по их средним линиям. 

 
Щелкните по значку Align Bottom (Выровнять нижние стороны) на панели Arrange, чтобы выровнять 
объекты по их нижним сторонам. 
 
Щелкните по значку Align Centers (Выровнять центры) на панели Arrange, чтобы выровнять 
выделенные объекты по их центрам. 

 
BERNINA artista позволяет выравнивать объекты, чтобы позиционировать их по отношению друг к другу. 
Вы можете выравнивать выбранный объект по левому, правому, верхнему или нижнему краю или по 
центру.  
 
Как выравнивать объекты 
1  Выберите объекты, которые вы хотите выровнять. 
2  Выберите объекты, которые вы хотите выровнять совместно. 
 

Примечание: Объекты выравниваются с последним выбранным 
объектом. 

3  Щелкните по одному из значков выравнивания на панели Arrange 
(Расположение). 
 

Выравнивание по центрам 
 
 
 
 
 

Выравнивание по нижнему краю Выравнивание по левому краю. 
 

Изменение размеров объектов 
 
Вы можете изменять размеры объектов путем перетаскивания меток – манипуляторов выделения или 
назначением точных размеров в диалоговом окне Object Properties (Свойства объекта). При изменении 
размеров объекта изменяется количество стежков для сохранения интервала между стежками. 
 
Примечание: Только проекты в "родном" формате ART содержат полный набор информации, требуемой 
для 100%-ного совершенства масштабирования и трансформации. 
 
Изменение размеров объектов инструментом Scale by 20% Down/Up 
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 Щелкните по значку Scale by 20% Down/Up (панель Design), чтобы изменить размеры объектов  
на 20 %. 

Используйте эту технику, если вы хотите быстро выполнить изменения, которые не требуют особой 
точности. 
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уменьшение на 20 % оригинальный размер  увеличение на 20 % 

 
Как изменять размеры объектов инструментом Scale by 20% Down/Up 
1  Выделите объект/ы. 

Совет: См. раздел Выбор нескольких последовательно расположенных объектов для быстрого 
выделения нескольких или всех объектов проекта. 

2  Щелкните по значку Scale by 20% Down/Up. 
◄ Щелкните левой кнопкой мыши, чтобы уменьшить проект на 20 %. 
◄ Щелкните правой кнопкой мыши, чтобы увеличить проект на 20 %. 

 
Изменение размеров объектов перетаскиванием мышью 
 
Вы можете изменить высоту и ширину объекта или пропорционально изменять размеры объекта, 
используя маркеры – манипуляторы выделения. Изменяйте объекты индивидуально или выберите 
несколько объектов для одновременного изменения. 
 
Как изменять размеры объектов перетаскиванием мышью 
1  Выберите объект/ы для изменения размеров. 
 Вокруг выделенного объекта появятся восемь меток – манипуляторов выделения. 
2  Перетащите мышью манипулятор, чтобы изменить размер объекта 

    
Перетащить    Shift + Перетащить 

  пропорциональное   пропорциональное изменение  
изменение размеров   размеров относительно центра 

 
◄ Для пропорционального изменения высоты и 

ширины используйте угловые маркеры 
 
 

Изменение по вертикали 
 
 

◄ Для изменения высоты используйте верхний средний 
или нижний средний маркеры. 

  
Изменение по горизонтали 

 
 

◄ Для изменения ширины используйте средние 
боковые маркеры. 

 
 
 
 
 
           

 
Изменения по вертикали       Изменения по горизонтали 
в обоих направлениях       в обоих направлениях 
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Совет: Для изменения размеров относительно центра во время перетаскивания маркера удерживайте 
нажатой клавишу Shift. 

 
Изменение размеров объектов с использованием свойств объекта 
Вы можете изменять высоту и ширину выбранных объектов или всего проекта, используя свойства 
объекта. 
 
Внимание: Если вы изменяете проект больше чем на 5 %, изменения плотности стежков может повлиять 
на качество вышивки проекта. См. также Форматы проектов вышивки. 
 
Как изменять размеры объектов с использованием свойств объекта 
1  Выберите объект/ы для изменения размеров. 
2  Дважды щелкните по проекту, чтобы открыть диалоговое окно Object Properties, и выберите закладку 

General. 
3  На панели Dimensions (Размеры) измените размеры по своему выбору. Альтернативно: 

◄ введите точные значения высоты (Height) и ширины (Width) или  
◄ введите новые значения высоты и ширины в качестве процентного отношения к текущим 

размерам. 
 

Введите размеры  в виде 
абсолютных или процентных 

величинах 
 
4  Нажмите кнопку ОК. 

    
150%-ное   оригинальный  80%-ное уменьшение 
увеличение  размер    высоты 
высоты        140%-ное увеличение ширины 
 
Примечание: После изменения размеров размеры нового объекта устанавливаются на 100 %.  

Вращение объектов 
Вы можете поворачивать объекты непосредственно на экране, щелкнув по значку Rotate CCW/CW 
(Поворот против часовой стрелке/по часовой стрелке) или назначив угол поворота в диалоговом окне 
Object Properties (Свойства объекта). 
 
Вращение объектов перетаскиванием мышью 
При выделении объекта на его крайних точках появляются метки – манипуляторы выделения. Если вы 
щелкните по объекту еще раз, то эти метки преобразуются в маркеры вращения. 
 
Как поворачивать объекты перетаскиванием мышью 
1  Выберите объект/ы для поворота. 
2  Щелкните по объекту еще раз. 
 На углах объекта появятся маркеры вращения, а в его центре отобразится местоположение анкера. 
       маркер наклона 

      
маркер вращения  
      
местоположение анкера 
 
 
 
 
 
 

первым щелчком   после второго щелчка 
отображаются    появляются маркеры вращения 
маркеры выделения 
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 Внимание: Если второй щелчок последует за первым слишком быстро, откроется диалоговое окно 

Object Properties. 
3  При необходимости перетащите анкер вращения в другое положение. 
4  Щелкните по маркеру вращения и перетащите его по часовой стрелке или против часовой стрелки. Во 

время поворота появляется контур и перекрестие. 

      
Перетащите угол,   Перетащите анкера  Перетащите угол, чтобы  
чтобы повернуть   местоположение   повернуть объект вокруг анкера. 
объект вокруг анкера. 

 
Вращение объектов инструментом Rotate CCW/CW 
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 Щелкните левой кнопкой по значку Rotate CCW/CW (панель Design), чтобы повернуть объект или 
проект на 45° по часовой стрелке. 

Щелкните правой кнопкой по значку Rotate CCW/CW (панель Design), чтобы повернуть объект или проект 
на 45° против часовой стрелки. 
 
Используйте инструмент Rotate CCW/CW (Поворот против часовой стрелке/по часовой стрелке) на 
панели Design, чтобы поворачивать объекты на 45° в обоих направлениях. 
 
Как вращать объекты инструментом Rotate CCW/CW 
1  Выберите один или несколько объектов инструментом Select Object (Выбор объекта). 
2  Щелкните по значку Rotate CCW/CW на панели инструментов.  

◄ Щелчок правой кнопкой – поворот на 45° по часовой стрелке. 
◄ Щелчок левой кнопкой – поворот на 45° против часовой стрелке. 

 
Вращение объектов с использованием свойств объекта 
 
Вы можете повернуть выбранные объекты путем ввода точного значения угла поворота в диалоговом окне 
Object Properties. 
 
Как вращать объекты с использованием свойств объекта 
1  Выберите объект/ы для поворота. 
2  Дважды щелкните по проекту, чтобы открыть диалоговое окно Object Properties, и выберите закладку 

General. 
3  В поле Rotate By (Повернуть на), введите требуемое вам значение угла поворота. 
4  Нажмите кнопку ОК. 

  
 
 
Введите угол поворота 
 
 
 

Перекос объектов 
Вы можете придавать объектам нужный угол перекоса непосредственно на экране или путем ввода угла 
перекоса в диалоговом окне Object Properties. 
 
Перекос объектов перетаскиванием мышью 
Вы можете перекосить объект относительно горизонтальной 
линии, щелкнув по маркеру перекоса и перетащим его на 
требуемый угол. 

Перекос объекта  
перетаскиванием мышью 

Как перекосить объекты перетаскиванием мышью 
1  Выберите объект/ы для перекоса. 
2  Щелкните по объекту еще раз. 
 Вокруг объекта появятся маркеры поворота и перекоса. Маркеры перекоса имеют форму ромба и 

появляются в средних точках верхнего и нижнего края объекта. 
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3  Перетащите маркер перекоса влево или вправо. 
 Объект будет перекошен в горизонтальном направлении. Контур и 

перекрестие покажут изменение формы объекта. 
Перетащите маркер перекоса  

влево или вправо. 
 

Перекос объектов с использованием свойств объекта 
Вы можете перекашивать выбранные объекты путем ввода точного значения угла перекоса в диалоговом 
окне Object Properties. 
 
Перекос на 30°  
с использованием  свойств объекта 
 
 
 
 
Как перекашивать объекты с использованием свойств объекта 
1  Выберите объект/ы для перекоса. 
2  Дважды щелкните по объекту, чтобы открыть диалоговое окно Object Properties, и выберите закладку 

General. 
3  В поле Skew By (Перекос на), введите требуемое вам значение угла перекоса. 
4  Нажмите кнопку ОК. 

 
 
 
Введите угол перекоса 
 

 

Перевод объектов в зеркальное отображение 
 
Вы можете зеркально отображать объекты, переворачивая их по горизонтали или по вертикали, используя 
инструменты Mirror в диалоговом окне Object Properties (Свойства объекта). 
 
оригинальный объект          зеркальное отображение по горизонтали (X) 

                                      
зеркальное отображение по вертикали (Y) зеркальное отображение по горизонтали и вертикали (X и Y) 
 
Перевод объектов в зеркальное отображение с использованием инструментов 
Mirror Horizontal или Mirror Vertical 

 
Щелкните по кнопке Mirror Horizontal (панель Design), чтобы перевернуть объект на горизонтальной 
оси. 
 
Щелкните по кнопке Mirror Vertical (панель Design), чтобы перевернуть объект на вертикальной оси. 
 

Вы можете зеркально переворачивать объекты на горизонтальной или вертикальной оси, используя 
инструмент Mirror Horizontal или Mirror Vertical. 
 
Как переводить объекты в зеркальное отображение с использованием инструментов 
Mirror Horizontal или Mirror Vertical 
1  Выберите объект/ы для зеркального переворачивания. 
2  Щелкните по значку Mirror Horizontal, чтобы перевернуть объект по горизонтали, или Mirror Vertical,  

чтобы перевернуть объект по вертикали. 
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Зеркальное переворачивание объектов с использованием свойств объекта 
Вы можете зеркально переворачивать объекты по горизонтали или по вертикали, используя диалоговое 
окно Object Properties (Свойства объекта). 
 
Как переворачивать объекты с использованием свойств объекта 
1  Выберите объект/ы для зеркального переворачивания. 
2  Дважды щелкните по объекту, чтобы открыть диалоговое окно Object Properties, и выберите закладку 

General. 
3  На панели Mirror выберите In X или In Y. 

◄ При выборе In X объект перевернется по горизонтали  
◄ При выборе In Y объект перевернется по вертикали. 

 
 
 
Переворот по горизонтали 
 
Переворот по вертикали 
 
 
Совет: Проставьте флажки в обоих окошках, чтобы одновременно перевернуть объект по горизонтали и 
вертикали. 
4  Нажмите кнопку ОК. 
 
Зеркальное переворачивание с дублированием объектов 

 
Используйте инструмент Mirror Merge Horizontal (панель Arrange) для дублирования объекта по 
горизонтали. 
 
Используйте инструмент Mirror Merge Vertical (панель Arrange) для дублирования объекта по 
вертикали. 
 
Используйте инструмент Mirror Merge Horizontal/Vertical (панель Arrange) для дублирования объекта 
как по горизонтали, так и по вертикали. 
 

Инструменты Mirror-Merge (Зеркальное переворачивание-Дублирование) позволяют дублировать и 
преобразовывать объекты и объединять их в единый объект.  
 

оригинальный проект  

             
Как зеркально переворачивать и дублировать объекты 
1  Выделите объект/ы. 
2  Выберите инструмент Mirror-Merge  

◄ Mirror-Merge Horizontal 

         
 

◄ Mirror-Merge Vertical 
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◄ Mirror-Merge Horizontal/Vertical 

       
3  Переместите базисную линию в положение, в которое вы хотите добавить перевернутый объект и 

щелкните, чтобы наметить местоположение анкера. 
 Указатель мыши соединяется с базисной линией. При перемещении указателя вокруг объекта, 

зеркально перевернутый объект также перемещается. 
 Копия объекта помещается как зеркально перевернутое изображение оригинала. 
 

Примечание: Если перевернутая копия перекрывает оригинальный объект, то появится вопрос, хотите 
ли вы объединить объекты. 

 
Создание венков 
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Используйте инструмент Wreath (панель Arrange), чтобы многократно дублировать объекты вокруг 
центральной точки. 
 
Используйте инструмент Kaleidoscope (панель Arrange, чтобы расположить  зеркально 
отображенные объекты вокруг центральной оси. 

 
Инструмент Wreath (Венок) многократно дублирует объекты вокруг центральной точки. Инструментом 
Kaleidoscope (Калейдоскоп) работают совместно с инструментом Wreath для расположения зеркально 
перевернутых объектов вокруг центральной оси.  Поскольку объект зеркально переворачивается, функция 
Kaleidoscope действует только с четным количеством объектов.  

         
6-точечный венок с              6-точечный венок с  

отключенной функцией Kaleidoscope       включенной функцией Kaleidoscope 
Как создать венок 
1  Выделите объект/ы. 
2  Нажмите кнопку Wreath (Венок). 
3  Введите число точек венка.  
 
 Примечание: Для активирования функции Kaleidoscope вводите четные числа. 
4  Нажмите кнопку Kaleidoscope, если это необходимо. 
5  Нажмите Enter. 
6  Переместите базисную линию к центру венка и щелкните, чтобы наметить местоположение анкера. 
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Совет: Удерживайте нажатой клавишу Ctrl, чтобы линий проходила под углом 45°. 
 
 
 
Переместите указатель мыши  
для установления центральной точки. 
 
 
Указатель мыши соединяется с базисной линией. При перемещении 
указателя вокруг объекта, зеркально перевернутый объект также 
перемещается. 
Объекты копируются и размещаются вокруг центральной точки. 
 

Примечание: Если перевернутая копия перекрывает оригинальный объект, то появится вопрос, хотите 
ли вы объединить объекты. 

 
8-точечный венок с центром, намеченным ниже оригинального объекта 

      
8-точечный венок с центром, намеченным выше оригинального объекта 
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Глава 16  
 
 
 
Изменение формы и правка 
объектов 
 
BERNINA artista позволяет изменять форму объекта, угла 
стежков точки входа и выхода с помощью контрольных точек. 
Линии наклона стежков маркеры входа и выхода появляются 
вокруг выбранных объектов. Контрольные точки слегка 
различаются в зависимости от типа объекта. 
Рекомендуется перед началом изменения любого проекта 
сохранить его копию под новым именем и хранить оригинал 
для случая, если вы захотите отказаться от всех изменений и 
начать снова. 
В этом разделе объясняется, как изменять форму объектов контрольными точками, изменять 
форму окружностей, устанавливать угол наклона стежков – включая сложные углы наклона – и 
изменять точки входа и выхода. 
 

Изменение формы объектов 
 
Используйте инструмент Reshape Object (панель Design) для установки контрольных точек 
выбранных объектов. 
 

Вы можете изменять форму объекта, выбрав его инструментом Reshape Object (Изменение формы 
объекта) и перемещая, добавляя или удаляя контрольные точки на контуре. Для некоторых объектов вы 
можете также заменять угловые контрольные точки на контрольные точки кривых. 
 
Примечание: Инструмент Reshape дает возможность изменять формы, не оказывая влияния на угол 
стежков. 
 
Изменение формы объектов с использованием контрольных точек 

 
Используйте инструмент Reshape Object (панель Design) для отображения на экране контрольных 
точек выбранных объектов. 

 
Изменяйте форму объектов, выбирая их инструментом Reshape Object (Изменение формы объекта) и 
манипулируя появившимися контрольными точками. 
 
Как измененять формы объектов с использованием контрольных точек 
1  Выделите объект. 
2  Нажмите кнопку Reshape Object (Изменение формы объекта). 
 Вокруг объекта появятся контрольные точки. 
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точка входа 
 
контрольная точка кривой 
 
 
 
угловая контрольная точка 
 
 
 
 
точка выхода 
 

3  Измените контур путем добавления, удаления или перемещения контрольных точек в зависимости от 
типа объекта и требуемых изменений. 

4  Измените точки входа и выхода и угол стежков по своему желанию. 
5  Нажмите OK, чтобы принять изменения. 
 Совет: Нажмите клавишу Esc, чтобы отменить выделение инструментом Reshape. 
 
Выбор контрольных точек 
Контрольные тоски могут быть выбраны индивидуально или совместно для изменения положения или 
модификации. 
 
Как выбирать контрольные точки 
1  Выделите объект. 
2  Нажмите кнопку Reshape Object (Изменение формы объекта). 

◄ Щелкните, чтобы выбрать единичную контрольную точку. 

 
◄ Удерживая клавишу Ctrl, щелкните, чтобы выбрать несколько контрольных точек.  

 
◄ Щелкните и обведите ограничивающий прямоугольник вокруг группы контрольных точек, чтобы 

выбрать их. 

           
Перемещение контрольных точек 
Вы можете перемещать контрольные точки, чтобы изменить форму контура. 
 
Как перемещать контрольные точки 
1  Выделите объект. 
2  Нажмите кнопку Reshape Object (Изменение формы 
объекта). 

◄ Перетащите контрольную точку в новое положение. 
◄ Подобным же образом перетащите несколько точек в 

новое положение. 
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Добавление контрольных точек 
 
Используйте инструмент Reshape Object (панель Design) для добавления контрольных точек. 

 
Вы можете добавлять контрольные точки на контуре объекта выбранным инструментом Reshape Object. 
 
Примечание: Вы не можете добавлять контрольные точки к объектам, созданным инструментом Circle 
(Окружность). 
 
Как добавлять контрольные точки 
1  Выделите объект. 
2  Нажмите кнопку Reshape Object (Изменение формы объекта). 
3  Установите указатель мыши в том месте, где вы хотите добавить контрольную точку. 
4  Щелкните, чтобы добавить контрольную точку: 

◄ левой кнопкой, чтобы добавить угловую точку: 
◄ правой кнопкой, чтобы добавить точку кривой. 

 
 
 
 
Щелчок правой кнопкой мыши 
 
 
 
 
Щелчок левой кнопкой мыши 
 
 
 
 

5  Определите положение новой контрольной точки, перемещая ее по контуру объекта. 
 
Изменение контрольных точек 
Изменение формы объекта выполняется путем преобразования угловых контрольных точек в точки кривой 
и наоборот. 
 
Примечание: Вы не можете изменять контрольные точки объектов, созданных инструментом Circle 
(Окружность). См. также Изменение формы объектов окружности. 
 
Как изменять контрольные точки 
1  Выделите объект. 
2  Нажмите кнопку Reshape Object (Изменение формы объекта). 
3  Выберите контрольную точку. 
4  Нажмите клавишу пробела. 

          
 
Удаление контрольных точек 
Удаляйте нежелательные контрольные точки для изменения контура 
 
Как удалять контрольные точки 
1  Выделите объект. 
2  Нажмите кнопку Reshape Object (Изменение формы объекта). 
3  Выберите контрольную точку или точки. 
4  Нажмите кнопку Delete. 
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Примечание: Если у объекта имеется только две контрольных точки, то при удалении одной из них 
удаляется весь объект. 

Изменение формы объектов окружности 
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Используйте инструмент Reshape Object (панель Design) для изменения формы объектов 
окружности. 

 
Для объектов, созданных инструментом Circle (Окружность), изменение формы производится только 
контрольными точками. В таких объектах вы не можете добавлять, изменять или удалять контрольные 
точки. Объекты окружности можно преобразовывать из окружности в овал инструментом Reshape Object. 
Объекты окружности имеют две контрольные точки изменения формы (используемые для изменения 
радиуса и ориентации объекта), центральную точку (используемую для изменения положения) и точку 
входа стежка. 
 
   точка входа 
 
 
 
 
 
точка центра  контрольная точка 
    

угол стежка 
 
 
 
Как изменять форму объектов окружности 
1  Выберите объект окружности. 
2  Нажмите кнопку Reshape Object (Изменение формы объекта). 
 
 Совет: Для перемещения окружности щелкните по контрольной точке в центре окружности и 

перетащите ее в новое положение. 
3  Щелкните по контрольной точке на контуре окружности и перетащите ее для изменения формы 
контура. 

◄ Для изменения формы без изменения ориентации используйте контрольную точку на вершине 
объекта. 

◄ Для изменения формы и вращения объекта 
вокруг центральной точки используйте боковую 
контрольную точку. 

        
 

 
 
 

 
контрольные точки изменения формы  



Глава 16: Изменение формы и правка объектов 
 

BERNINA® Artista Designer Plus Версия 4 

         
4  Нажмите Enter. 
 

Совет: Для изменения размера окружности без превращения ее в овал выберите ее инструментом 
Select Object (Выбор объекта) и используйте угловые маркеры выделения, чтобы изменить размер. 

 
 
 
 
 

Изменение размера с  
использованием угловых  
маркеров выделения 

 
 
 
Подгонка углов наклона стежков 
 
Настройка угла наклона стежков зависит от типа объекта, с которым вы работаете. Для заполняемых 
объектов вы можете назначить угол наклона стежка для всего объекта. Альтернативно вы можете 
добавить сложные углы наклона стежков инструментом Stitch Angles. Вы можете также установить угол 
наклона стежка, используйте инструмент Reshape Object. 
 
Примечание: Вы можете изменить угол наклона стежков объекта окружности, перемещая точку ввода 
стежков. 
 
Подгонка углов наклона стежков с использованием свойств объекта 
Вы можете изменить угол наклона стежка заполняемых объектов, используя свойства объекта. 
 

       
Как подогнать углы наклона стежков с использованием свойств объекта 
1  Выберите объект и дважды щелкните по нему. 
 Откроется диалоговое окно Object Properties (Свойства объекта). 
2  Выберите закладку Stitch Angle (Угол наклона стежка). 
 
 
 
Введите требуемый угол  
наклона стежка 
 
 
 
3  В поле Angle (Угол) введите требуемый угол наклона стежка. 

       
Угол: 90°       Угол: 0° 

4  Нажмите кнопку ОК. 
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Подгонка углов наклона стежков на экране 
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Используйте инструмент Reshape Object (панель Design) для отображения на экране контрольных 
точек и линий угла наклона стежков выбранных объектов. 

 
Вы можете изменить угол наклона стежка заполняемых объектов, используя функцию Reshape Object 
(Изменение формы объекта). 
 
Как подогнать углы наклона стежков на экране 
1  Выберите объект с заполнением. 
2  Нажмите кнопку Reshape Object (Изменение 

формы объекта). 
 Появятся контрольные точки вместе с линией угла 

наклона стежков. 
        
 
3  Перетащите мышью эту линию, как вам требуется. 
 
 Совет: При перемещении указателя мыши над точкой угла наклона на экране появляется 

всплывающая подсказка с углом наклона стежков выбранного объекта. 
4  Нажмите Enter. 
 
 Совет: Для установки точного угла наклона стежков используйте свойства объекта. Подробнее см. в 

разделе Подгонка углоа наклона стежка с использованием свойств объекта. 
 
Настройка сложных углов наклона стежков 

 
Используйте инструмент Stitch Angles (панель Stitch and Color), чтобы настроить сложные углы 
наклона стежков для новых или выбранных объектов. 

 
Углы наклона стежков объектов с заполнением все модифицируются тем же способом. Сложные углы 
наклона стежков могут быть добавлены инструментом Stitch Angles.  

             
одинаковый угол наклона стежков       сложные углы наклона стежков 

 
Совет: Инструментом Reshape (Изменить форму) вы можете добавить индивидуальные контрольные 
точки без воздействия на углы наклона стежков. Подробнее см. в разделе Изменение формы объектов. 
 
Как настраивать сложные углы наклона стежков 
1  Выберите объект с заполнением. 

 
2  Щелкните по значку Stitch Angles. 
 Вам будет предложено ввести углы наклона стежков.  
3  Назначьте такие углы наклона, чтобы стежки пересекали две 

стороны объекта. Убедитесь в том, что они не пересекают 
друг друга. 

    
 

 
 
 
 

введенные углы наклона стежков 
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Внимание: Новые линии стежков не должны пересекать существующие линии стежков, в противном 
случае появится сообщение об ошибке. Нажмите клавишу пробела Backspace для удаления. 
4  Вводите точки угла 1 и 2 до столько раз, сколько требуется для создания эффекта "переворачивания" 

заполнения. 
5  Нажмите Enter. 

   измененные углы наклона 

     
6  Выберите и подгоните контрольные точки для изменения формы объекта по своему желанию. 
 Стежки объекта оцифровываются заново с новыми углами. 
 
Подгонка сложных углов наклона стежков 
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Используйте инструмент Reshape Object (панель Design) для подгонки  точек входа и выхода 
выбранных объектов. 
 

BERNINA artista позволяет подгонять сложные углы наклона стежков оцифровываемых объектов. 
 
Как подгонять сложные углы наклона стежков 
1  Выберите объект с заполнением. 

          
 
2  Нажмите кнопку Reshape Object (Изменение формы объекта). 
 Появится требование выбрать и переместить контрольные точки. 

 
подогнанные углы наклона стежков 

 
3  Нажмите Enter. 
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Изменение точек входа и выхода 
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Используйте инструмент Reshape Object (панель Design) для подгонки  точек входа и выхода 
выбранных объектов. 

 
Вы можете изменять точки входа и выхода стежков индивидуальных объектов. Это делается для 
помещения точки входа следующих связанных объектов для уменьшения длины соединительных стежков 
или для уменьшения количества переходных стежков. 
 
Примечание: В объектах окружности угол наклона стежков перпендикулярен линии, соединяющей точку 
входа с центром окружности. Таким образом, при изменении точке входа стежка в объекте окружности 
изменяется угол наклона стежка. 
 
Как изменять точки входа и выхода 
1  Выделите объект. 
2  Нажмите кнопку Reshape Object (Изменение формы объекта). 
 Появятся контрольные точки, включая точки входа и выхода. 
 
            точка входа 
 
 
 
 
 
 
      длинный переходной  
      стежок 
      точка выхода 
 

Примечание: В объектах окружности появляется точка входа. 
3  Выберите точку входа или выхода, как вам нужно, и перетащите ее в другое положение на контуре 

объекта. 
4  Нажмите Enter. 
 
 
 
 
 
          точка входа   точка выхода 
  
 
 

изменены  
точки входа и выхода 
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Глава 17  
 
 
 
 
 
 
 
 
 
 
 
 
 

Редактирование стежков 
 
BERNINA artista автоматически генерирует стежки в 
соответствии с контуром проекта и свойствами. Это означает, 
что вы можете преобразовывать проекты BERNINA artista и 
изменять их формы без изменения плотности или качества 
стежков. 
Но BERNINA artista позволяет также редактировать 
индивидуальные стежки. Вам просто нужно выбрать стежок, как 
и любой другой объект, и переместить по своему желанию точку 
укола иглой. Например, вы можете вставлять стежки в объект, 
чтобы заполнить пробелы. Вы можете переместить или удалить 
индивидуальные стежки или группы выбранных стежков. 
В частности, это может потребоваться при работе с файлами стежков, которые не содержат 
данных о контуре проекта. Однако, если это возможно, редактируйте свойства объекта раньше, 
чем индивидуальные стежки. См. также Форматы проектов вышивки. 
В этом разделе объясняется, как выбирать и редактировать стежки. 
 

Выбор стежков 
 
Функция Stitch Edit (Редактирование стежков) позволяет выбирать отдельные стежки или диапазон 
стежков путем выбора их точек укола иглой или оконтуривающим прямоугольником. Выбранные стежки 
выделяются другим цветом. 
 
Выбор стежков по точке укола иглой 
 
Используйте команду Stitch Edit (меню Edit), чтобы выбрать индивидуальные стежки для редактирования. 
 
Вы можете выбрать индивидуальные стежки в режиме Stitch Edit (Редактирование стежка) путем выбора 
их точек укола иглой. 
 
Совет: Увеличьте масштаб изображения, чтобы можно было легче выбирать точки укола иглой. 
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Как выбирать стежки по точке укола иглой 
1 Выберите Edit > Stitch Edit. 

Совет: Нажмите E на клавиатуре, чтобы перейти в режим Stitch Edit. 
2 Щелкните по точке укола иглой. 

Цвет точки укола иглой изменится, а маркер положения иглы переместится на выбранный стежок. Все 
стежки за маркером положения иглы в последовательности вышивания будут отображены черным 
цветом. 

     выбранный стежок   Удерживайте клавишу Shift,  
чтобы выбрать диапазон стежков 
 
 
 
 
 
 
 
 
 
 

 
Для выбора диапазона стежков удерживайте нажатой клавишу Shift. 
◄ Для выбора нескольких стежков удерживайте нажатой клавишу Ctrl. 

 
Выбор стежков ограничивающим прямоугольником 
 
Используйте команду Stitch Edit (меню Edit), чтобы выбрать стежки ограничивающим прямоугольником. 
 
Вы можете быстро выбрать все стежки в группе, обведя вокруг него ограничивающий прямоугольник. 
 
Как выбирать стежки ограничивающим прямоугольником 
1 Выберите Edit > Stitch Edit. 
2 Очертите указателем мыши ограничивающий прямоугольник вокруг выделяемых стежков. 

Стежки будут выделены, как только вы отпустите кнопку мыши. 

                
ограничивающий прямоугольник  стежки выделены 

Вставка стежков 
Используйте команду Stitch Edit (меню Edit), чтобы вставить стежки в объект. 
 
Вы можете вставлять стежки в объект, чтобы заполнить пробелы. Вставленные стежки являются 
обоснованной частью объекта (в большей мере, чем независимые объекты). Однако они могут быть 
удалены, если происходит регенерация стежков. Если это возможно, лучше редактируйте свойства 
объекта, чем индивидуальные стежки. Например, чтобы увеличить плотность стежков, лучше уменьшить 
интервал между стежками. чем вставлять стежки. 
 
Как вставлять стежки 
1 Выберите Edit > Stitch Edit. 
2 Увеличьте масштаб изображения той зоны, которую вы хотите редактировать. 
3 Выберите точку укола иглой. 

      
 
 Цвет стежка изменится, а маркер положения иглы переместится на выбранный стежок. 
4 Переместите указатель мыши в то место, куда вы хотите вставить стежок, и щелкните правой кнопкой 

мыши. 
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Щелкните правой кнопкой мыши, чтобы вставить новый стежок 

 
5  Переместите мышь в то место, куда вы хотите вставить стежок, и щелкните правой кнопкой мыши. 

          
Щелкните правой кнопкой мыши, чтобы вставить новый стежок 

 
6  Продолжайте щелкать правой кнопкой мыши по мере необходимости. 
 

Перемещение стежков 
 
Используйте команду Stitch Edit (меню Edit), чтобы выбрать индивидуальные стежки для перемещения. 
 
Вы можете перемещать индивидуальные стежки или группы стежков. 
 
Внимание: Если стежки объекта по любой причине регенерируются, все функции редактирования стежков 
теряются. Если это возможно, лучше изменять форму объекта, чем перемещать индивидуальные стежки. 
Подробнее см. в разделе Изменение формы и правка объектов. 
 
Как перемещать стежки 
1 Выберите Edit > Stitch Edit. 
2 Выберите стежки и перетащите их мышью в новое положение. 

Новое положение будет отображено теневым контуром. 
 
 
Перетащите стежок  
в новое положение 
 
выбранные стежки 
теневой контур 
 
3 Нажмите Enter. 

Удаление стежков 
 
Используйте команду Stitch Edit (меню Edit), чтобы выбрать индивидуальные стежки для удаления. 
 
Вы можете удалять индивидуальные стежки или группы стежков. 
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Внимание: Если стежки объекта по любой причине регенерируются, все функции редактирования стежков 
теряются. Если это возможно, лучше редактируйте свойства объекта, чем индивидуальные стежки. 
Подробнее см. в разделах Регулировка шага гладьевого заполняющего стежка и Сохранение длинных 
стежков функцией Auto Jump. 
 
Как удалять стежки 
1 Выберите Edit > Stitch Edit. 
2 Выберите стежок или стежки 
3 Нажмите клавишу Delete. 
              

 
 
 

стежки выделены         стежки удалены 
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Часть V  
Вышивание текстов 
 

Глава 18  
Основные сведения о 
текстовых объектах 
 
Текстовые объекты добавляются к проекту быстро и легко или на 
экране с использованием текущих настроек, или через диалоговое окно 
Object Properties - Lettering. Тексты можно редактировать 
непосредственно на экране или в диалоговом окне. Вы можете 
применять форматирование текстовых объектов таким же образом, как 
при работе в текстовом редакторе, включая придание тексту курсивного 
или полужирного начертания или выравнивание по левому или правому 
краю. В вашем распоряжении находится как интерактивная, так и 
цифровая техника для изменения размеров текста и интервала между 
буквами. Подробнее см. в разделе Примеры алфавитов. 
В этом разделе описывается, как добавлять и редактировать тексты, изменять установки 
форматирования, подгонять размеры букв и интервал между буквами. 
 

Добавление текста к проектам вышивки  
 
Вы можете добавлять текст в проект, набирая его непосредственно в окне проекта или вводя его в 
диалоговом окне Object Properties – Lettering. 
 
Создание текстовых объектов на экране 

 
Используйте инструмент Lettering (панель Design) для добавления текста непосредственно на 
экране. 
 

Нет особой необходимости вставлять буквы в определенную зону, вы можете печатать их 
непосредственно на экране. Вы можете также редактировать текстовые объекты непосредственно на 
экране для получения различных художественных эффектов. 
Внешний вид и компоненты зависят от текущих установок в диалоговом окне Object Properties – Lettering. 
Вы можете изменить их в любое время. Подробнее см. в разделе Подгонка компоновки текста. 
 
Как создавать текстовые объекты на экране 
1  Нажмите кнопку Lettering (Текст). 
2 Выберите цвет из цветовой палитры. 
3 Щелкните мышью в том месте, где вы хотите начать текст. 
4 Напечатайте буквы, которые вы хотите вышить. 
 

Совет: Чтобы начать новую строку, нажмите Shift + Enter. 
5 Нажмите Enter для завершения. 
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Примечание: Внешний вид и компоненты зависят от текущих установок в диалоговом окне Object 
Properties – Lettering. Вы можете изменить их в любое время. Подробнее см. в разделе Подгонка 
компоновки текста. 
 
Создание текстовых объектов в диалоговом окне Lettering  
 

Щелкните правой кнопкой мыши по инструменту Lettering (панель Design), чтобы ввести текст в 
диалоговое окно и настройки параметров вышиваемого текста. 
 

Используя диалоговое окно Object Properties – Lettering, вы можете назначить формат текста, прежде чем 
добавлять его в проект. Это наиболее традиционный метод, который удобно использовать с более 
сложными проектами. 
 
Как создавать текстовые объекты в диалоговом окне Lettering  
1  Щелкните правой кнопкой мыши по значку Lettering (Текст). 
 Откроется диалоговое окно Object Properties - Lettering (Свойства объекта - Текст). 
 
 
 
 
             Ввод текста 
 
 
 
 
 
 
 
 
              Выбор опций 
  
 
 
 
 
 
 
 
 
 
 

Выбор базовой линии  Выбор способа выравнивания текста 
 
2 В окно ввода текста введите текст, который вы хотите вышить. 
 Чтобы начать новую строку текста, нажмите Shift + Enter. 
 
 Совет: Вы можете вставить изменение цвета между двумя буквами, поместив символ знака вставки 

(^). Последующие буквы по умолчанию примут следующий цвет из последовательности палитры. 
3 Выберите алфавит, форматирования и настройки базовой линии для текста. 
 Подробнее см. в разделах Выбор алфавитов и Форматирование текста. 
4 Нажмите кнопку ОК. 
5 Щелкните в том месте, куда вы хотите поместить текст, или наметить базисные точки для выбранной 

вами базовой линии. 
 Подробнее см. в разделе Применение базовых линий текста. 
5 Нажмите Enter. 
         
Примечание: Буквы заполняются стежками в соответствии с текущими 
установками на закладке Fill Stitch (Заполняющий стежок) диалогового 
окна Object Properties – Lettering. Вы можете изменить их в любое 
время. Подробнее см. в разделе Установка параметров стежка текста. 
 
Выбор алфавитов 
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Щелкните правой кнопкой мыши по значку Lettering (панель Design), чтобы выбрать алфавит для 
новых или выбранных текстовых объектов. 
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BERNINA artista предоставляет несколько алфавитов, подходящих для многих применений. Выберите 
нужное из входящих в комплект поставки алфавитов или конвертируйте шрифты TrueType. 
При выборе алфавита следует учитывать, где будет вышит текст и сам характер текста. Если вы 
украшаете вышивкой детскую одежду, то нужно применять простой алфавит, например Childs Play. Для 
вышивания на дамской ночной рубашке вы можете использовать элегантный рукописный шрифт, 
например Anniversary. 
 
Примечание: Соблюдайте минимальные/максимальные рекомендации для каждого алфавита и для 
получения наилучших результатов не выходите за пределы этих рекомендаций. Подробнее см. в разделе 
Примеры алфавитов. 
 
Как выбрать алфавит 
1 Щелкните правой кнопкой мыши по значку Lettering (Текст). 
 Откроется диалоговое окно Object Properties - Lettering (Свойства объекта - Текст). 
    
       
Выбор алфавита 
 
 
 
 
 
 
 
 
2 Выберите алфавит из списка Alphabet. 
 В окне просмотра появятся пример буквы выбранного алфавита. Подробнее см. в разделе Примеры 

алфавитов. 

      
список алфавитов       окно просмотра 

 
Совет: Перед выбором алфавита обратите внимание на размеры букв. Некоторые алфавиты выглядят 
лучше в меньшем размере. Другие могут быть вышиты в большом размере. См. также Подгонка текста 
по высоте и ширине. 

3 Нажмите кнопку ОК. 
 Выбранный алфавит установлен. 

Редактирование текстовых объектов 
 
Если вы создали текстовый объект, вы можете выделить его и изменять непосредственно на экране, 
через панель инструментов или через диалоговое окно Object Properties – Lettering. 
 
Редактирование текстового объекта на экране 
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Используйте инструмент Lettering (панель Design) для редактирования текста на экране. 
 
Наиболее простым способом редактирования текста является внесение изменений 

непосредственно на экране. 
 
Как редактировать текстовый объект на экране 
1 Щелкните на кнопку Lettering, затем щелкните внутри текстового объекта.  
 При этом появится балочный (I-образный) указатель. 
      

щелкните здесь для редактирования 
 

2 Отредактируйте текст, как вам требуется. 
    

буква удалена 
 

Совет: Для начала новой строки нажмите Shift + Enter. 
3 Нажмите Enter для завершения. 
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Редактирование текстовых объектов в диалоговом окне Lettering  
Если вы создали текстовый объект, вы можете выделить его и изменять в диалоговом окне Object 
Properties – Lettering. 
 
Как редактировать текстовые объекты в диалоговом окне Lettering  
1  Используйте один из следующих способов для выбора текстовых объектов:  
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◄ Выбор текстового объекта: Щелкните по текстовому объекту левой кнопкой мыши. Цвет объекта 
изменится, вокруг него появится 8 маркеров размера. 

 
◄ Выбор текстового объекта ограничивающим 

прямоугольником: Щелкните мышью и обведите 
ограничивающий прямоугольник вокруг текстового 
объекта и отпустите кнопку мыши. 

2 Дважды щелкните по выбранному текстовому объекту. 
 Откроется закладка Lettering (Текст) диалогового окна  Object Properties –Lettering. 
 

 
 

Правка текста 
 
 
 
 
 
Настройка  
параметров: 

 
 
 
 
 
3 Отредактируйте текст в окне ввода текста. 
4 При необходимости выполните любые другие изменения. 
 Подробнее см. в разделе Форматирование текста. 
5 Если вы хотите сохранить настройки в шаблоне, нажмите кнопку Save (Сохранить). 
5 Нажмите кнопку ОК. 
           

Примечание: Буквы заполняются стежками в 
соответствии с текущими установками на закладке Fill 
Stitch (Заполняющий стежок) диалогового окна Object Properties – Lettering. Вы можете изменить их в 
любое время. Подробнее см. в разделе Установка параметров стежка текста. 

Форматирование текста 
 
Вы можете преобразовывать внешний вид текста, изменяя настройки формата в диалоговом окне Object 
Properties – Lettering. Изменяйте текущие настройки формата до или после добавления текста таким же 
образом, как и для других объектов. 
 
Придание буквам курсивного начертания 
Вы можете наклонять буквы влево или вправо для создания эффекта 
курсивного шрифта. Введите угол наклона в поле Angle (Угол) на закладке 
Lettering. По умолчанию этот угол равен 0°. 
 
Как придать буквам курсивное начертание 
1  Щелкните правой кнопкой мыши по значку Lettering или дважды 

щелкните по выбранному текстовому объекту. 
 Откроется диалоговое окно Object Properties - Lettering (Свойства 

объекта - Текст). 
 

Выбор угла  
наклона букв 
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2 Введите угол в поле Italic (Курсив). 
 Буквы нельзя наклонять больше, чем на 45°. (0° эквивалентен прямому начертанию.)  
3 Нажмите кнопку ОК. 

      
угол наклона 0° 

     
угол наклона 45° 

      
угол наклона -45° 

 
Придание буквам полужирного начертания 
Вы можете создать эффект полужирного начертания букв путем увеличения установок компенсации 
стягивания для выбранных текстовых объектов. Увеличьте значение компенсация стягивания (Pull 
Compensation) до 0.4 - 0.6 мм, чтобы придать буквам полужирное начертание. 
 
Как придать буквам полужирное начертание 
1  Щелкните правой кнопкой мыши по значку Lettering или дважды щелкните по выбранному текстовому 

объекту. 
Откроется диалоговое окно Object Properties - Lettering (Свойства объекта - Текст). 

2 Выберите закладку Fill Stitch (Заполняющий стежок). 

      
3 Нажмите кнопку Effects. 
 Откроется диалоговое окно Effects (Эффекты). 

 
 
Увеличьте компенсацию  
стягивания 
 
 
 

4 Увеличьте значение компенсации стягивания до 0.4 - 0.6 мм. 
 Величина компенсации стягивания не должна превышать 0,6 мм, иначе буквы могут быть искажены. 

                       
       Компенсация стягивания 0,2 мм  Компенсация стягивания 0,6 мм 

5 Нажмите кнопку OK, чтобы возвратиться к закладке Fill Stitch. 
6 Нажмите еще раз кнопку ОК. 
 
Выравнивание текста 
Функция выравнивания позволяет выравнивать текст на базовой линии. Вы можете выравнивать текст по 
левому или правому краю, по центру или по ширине. При выравнивании по ширине текст растягивается по 
всей длине базовой линии. 
 
Как выравнивать текст 
1 Щелкните правой кнопкой мыши по значку Lettering или дважды щелкните по выбранному текстовому 

объекту. 
 Откроется диалоговое окно Object Properties - Lettering (Свойства объекта - Текст). 
2 Выберите способ выравнивания – Left (По левому краю), Center (По центру), Right (По правому краю) 

или Justified (По ширине). 
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По левому краю   По ширине 
 
 
 
 
 
 
 
 
 
 
 
По центру   По правому краю 
 
3 Нажмите кнопку ОК. 

Изменение размеров текста 
 
Вначале при создании текста он может быть слишком большим или слишком малым. Размер текстового 
объекта может быть изменен одним из следующих трех способов: 
◄ масштабированием на экране инструментом Select Object (Выбор объекта) или Reshape Object 

(Изменение формы объекта). 
◄ подгонкой ширины и высоты объекта на закладке Lettering 
◄ подгонкой ширины и высоты объекта на закладке General 
 
Масштабирование текста инструментом Select Object 
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Для масштабирования текстового объекта на экране используйте инструмент Select Object (панель 
Design). 

 
Вы можете изменять размер текстового объекта по вертикали, по горизонтали или пропорционально, 
используя инструмент Select Object (Выбор объекта). См. также раздел Преобразование текста 
инструментом Select Object. 
 
Как масштабировать текст инструментом Select Object 
1  Выберите текстовый объект. 
 
  Изменение размера по вертикали 

                
Пропорциональное изменение размера  
                
Изменение размера по горизонтали 
 
 
 

2 Перетащите мышью одну из квадратных контрольных точек, чтобы изменить объект по горизонтали, по 
вертикали или пропорционально. 

 
 
 
 
 
Перетащить 

 
  

При перетаскивании теневым контуром будет показан новый размер текстового объекта. 
3 Для завершения отпустите кнопку мыши. 
 
Масштабирование текста инструментом Reshape Object 

 
Для масштабирования текстового объекта на экране используйте инструмент Reshape Object 
(панель Design). 
 

Вы можете изменять размер текстового объекта по вертикали, по горизонтали или пропорционально, 
используя инструмент Reshape Object (Изменение формы объекта). См. также раздел Вращение текста 
инструментом Reshape Object. 
 
Как масштабировать текст инструментом Reshape Object 
1  Выберите текстовый объект. 
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2 Щелкните по значку Reshape Object, чтобы отобразить на экране контрольные точки. 
 
Изменение размера по вертикали 
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Пропорциональное изменение размера  
               

Изменение размера по горизонтали 
 
 
 
 
3 Перетащите мышью одну из темных треугольных контрольных точек, чтобы изменить объект по 

горизонтали, по вертикали или пропорционально. 
 

перетащить 
 
 
 
 

изменение размера по вертикали 
 

 
 
 
 

перетащить 
пропорциональное изменение размера  

 
 
 
 
 
 
 
 
 

перетащить 
изменение размера по горизонтали 

 
 
  
 
 
При перетаскивании ограничивающим прямоугольником будет показан новый размер текстового объекта. 
4 Для завершения отпустите кнопку мыши. 
 

 
 

изменение размера  
по вертикали 

 
 
 
 

пропорциональное изменение  
размера  

 
 
 
 

изменение размера  
по горизонтали 

 
 
Подгонка текста по высоте и ширине 

 
Используйте инструмент Lettering (панель Design) для подгонки текста по высоте и высоте. 
 

Вы можете изменять ваши текстовые объекты по вертикали, по горизонтали или пропорционально с 
помощью закладки Lettering (Текст) диалогового окна Object Properties – Lettering.  
 
Совет: Изменяйте внешний вид букв путем изменения их ширины по отношению к высоте. Оригинальное 
соотношение равно 100 %. 
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Как подгонять текст по высоте и ширине 
1  Щелкните правой кнопкой мыши по значку Lettering или дважды щелкните по выбранному текстовому 

объекту. 
 Откроется диалоговое окно Object Properties - Lettering (Свойства объекта - Текст). 
 
 
Выбор высоты  
букв в мм 
 
Выбор ширины  
в процентах 
 
 
 
 
2 В поле Height (Высота) введите высоту текстового объекта в миллиметрах.  
 
Примечание: Высоту букв следует выбирать в пределах от 1 до 200 мм. Подробнее см. в разделе 
Примеры алфавитов. 
3 Введите ширину текстового объекта в поле Width (Ширина) в виде процентного отношения к высоте.  

◄ Для широких букв увеличьте процентное отношение, например до 140 %. 
◄ Для узких букв уменьшите процентное отношение, например до 70 %. 

4 Нажмите кнопку ОК. 

 
ширина 100 %     ширина 70 % 

          
    ширина 140 % 
 
Подгонка размеров текста 
Вы можете изменять ваши текстовые объекты по вертикали, по горизонтали или пропорционально с 
помощью закладки General диалогового окна Object Properties – Lettering.  
 
Совет: Изменяйте внешний вид букв путем изменения их ширины по отношению к высоте. Оригинальное 
соотношение равно 100 %. 
 
Как подгонять размеры текста 
1 Щелкните правой кнопкой мыши по значку Lettering или дважды щелкните по выбранному текстовому 

объекту. 
 Откроется диалоговое окно Object Properties - Lettering (Свойства объекта - Текст). 
2 Выберите закладку General. 
 Откроется диалоговое окно Object Properties - Lettering > General. 
 
 
 
Подгонка ширины  
и высоты текста 
 
 
 
3 Подберите ширину и высоту текста в абсолютных (мм) или относительных значениях (%). 
4 Нажмите кнопку ОК. 

    
оригинал       высота 140 % 

 
                ширина 140 % 
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Подгонка интервала между буквами 
 
Интервалы между буквами, словами и строчками могут быть определены до или после создания 
текстовых объектов и размещения их в вашем проекте. Вы можете изменять интервалы непосредственно 
на экране или в диалоговом режиме. Интервалы между буквами рассчитываются автоматически в 
соответствии выбранным видом выравнивания – по левому или правому краю, по центру или ширине. См. 
также раздел Выравнивание текста. 
 
Примечание: Если вы выбрали выравнивание По ширине, то буквы равномерно распределяются вдоль 
базовой линии. В этом случае для изменения интервала между буквами измените длину базовой линии. 
 
Подгонка на экране интервалов между буквами по всему тексту  
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Щелкните по значку Reshape Object (панель Design), чтобы изменить интервал между буквами. 
 

Интервал между буквами рассчитывается автоматически в виде процентного отношения к высоте букв. В 
большинстве случае предлагаемый по умолчанию интервал является вполне приемлемым. Однако иногда 
вам может потребоваться изменить интервал между буквами по всему тексту. 
 
Как подогнать на экране интервалы между буквами по всему тексту  
1  Выберите текстовый объект. 
       
 
 
 
2 Нажмите кнопку Reshape Object (Изменение формы 
объекта). 
   
 
 

3 Перетащите контрольную точку интервала между 
буквами, чтобы подогнать интервал между всеми 
буквами вдоль базовой линии. 

  
Перетащите контрольную точку интервала между 

буквами 
 
4 Отпустите кнопку мыши для завершения и нажмите Esc. 
     
 
Подгонка на экране индивидуальных интервалов между буквами  

 
Щелкните по значку Reshape Object (панель Design), чтобы изменить индивидуальный интервал 
между буквами. 

 
Интервал между буквами рассчитывается автоматически в виде процентного отношения к высоте букв. В 
большинстве случае предлагаемый по умолчанию интервал является вполне приемлемым. Однако иногда 
интервал между отдельными буквами может показаться слишком большим или слишком малым в 
зависимости от формы соседних букв. Для компенсации этого визуального эффекта вы можете 
переместить одну или нескольких выбранных букв вдоль базовой линии, чтобы изменить интервал. См. 
также раздел Изменение положения букв на экране. 
 
Как подогнать на экране индивидуальные интервалы между буквами  
1 Выберите текстовый объект. 

      
2 Нажмите кнопку Reshape Object (Изменение формы объекта). 

              
Перетащите ромбовидную контрольную точку 
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3 Щелкните по ромбовидной контрольной точке в середине буквы. 
 
 Совет: Для выбора нескольких букв удерживайте нажатой клавишу Ctrl. 
4 Перетащите букву или буквы вдоль базовой линии для подгонки интервала между буквами. Щелкните 

по значку Reshape Object (панель Design), чтобы изменить индивидуальный интервал между буквами. 

      
5 Отпустите кнопку мыши для завершения и нажмите Esc. 

       
Подгонка интервала между строками на экране 

158

 
 Щелкните по значку Reshape Object (панель Design), чтобы изменить интервал между строками. 
 

Для изменения интервала между строками в многострочных текстовых объектах используйте инструмент 
Reshape (Изменение формы). 
 
Как подогнать интервал между строками на экране 
1  Выберите текстовый объект.  
 
 
 
 
 
2 Нажмите кнопку Reshape Object (Изменение формы объекта). 

                 
3 Перетащите вверх или вниз контрольную точку интервала между строками. 
 
Для увеличения интервала  
между строками перетащите  
контрольную точку вниз 
 
 
 
 
4 Отпустите кнопку мыши для завершения и нажмите Esc. 
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Глава 19  
 
 
 
 
 
 

Настройка расположения текста 
 
BERNINA artista предоставляет возможность как диалогового, так и точного цифрового 
управления многими атрибутами, воздействующими на текстовые объекты. Вы можете 
настраивать текстовые объекты как в группе, так по индивидуальным буквам, составляющим 
текстовый объект. 
Вы можете применять к текстовым объектам горизонтальные, вертикальные и изогнутые 
базовые линии. Вы можете изменять тип базовой линии, ее длину, радиус и угол, а также ее 
положение. Вы можете определять цифровым способом угол поворота букв по отношению или 
к базовой линии. 
В этом разделе описывается, как настраивать текстовые объекты, в также индивидуальные 
буквы. Кроме того, поясняется, как применять и настраивать базовые линии текста. 
 

Преобразование текстовых объектов 
 
Помимо масштабирования, вы можете использовать инструменты Select Object (Выбор объекта) и 
Reshape Object (Изменение формы объекта),  чтобы наклонять и поворачивать текстовые объекты. См. 
также Изменение размеров текста. 
 
Преобразование текста инструментом Select Object 

Вы можете преобразовывать текстовые объекты путем манипулирования контрольными точками на 
экране с использованием инструмента Select Object (Выбор объекта). См. также раздел 

Масштабирование текста инструментом Select Object. 
 
Как преобразовывать текст инструментом Select Object 
1 Щелкните по значку Select Object и выберите текстовый объект.  
 Появятся контрольные точки изменения размера. Подробнее см. в разделе Масштабирование текста 

инструментом Select Object. 
2 Щелкните по текстовому объекту еще раз. 
 Появится другой комплект контрольных точек. Эти точки позволяют поворачивать и наклонять 

текстовый объект. Для преобразования текстового объекта на экране используйте инструмент Select 
Object (панель Design). 
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  контрольная точка наклона 
                  

 
 
 
контрольная точка вращения  
 
 
 

Точка вращения  
3 Перетащите одну из ромбовидных контрольных точек, чтобы придать текстовому объекту наклон. 
 

Перетащить 

       
 Теневым контуром во время перетаскивания показывается изменение положения объекта. 

        
4 Перетащите одну из контрольных точек в виде светлого квадрата, чтобы повернуть текстовый объект. 

Теневым контуром во время перетаскивания показывается изменение положения поворачиваемого 
объекта. 

 
Перетащить 

 
 
 

Точка вращения  
 
  
Совет: Перетащите точку вращения в новое положение перед вращением объекта. 

       
новая точка вращения  

 
5 Для завершения отпустите кнопку мыши. 
 
Вращение текста инструментом Reshape Object 
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Для вращения текстового объекта на экране используйте инструмент Reshape Object (панель 
Design). 

 
Вы можете вращать текстовые объекты путем манипулирования контрольными точками на экране с 
использованием инструмента Reshape Object (Изменение формы объекта). См. также раздел 
Масштабирование текста инструментом Select Object. 
 
Как вращать текст инструментом Reshape Object 
1 Выберите текстовый объект. 
2 Нажмите кнопку Reshape Object (Изменение формы 
объекта). 
 Вокруг текстового объекта появятся контрольные точки. 
     

контрольная точка вращения базовой линии 
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3 Перетащите одну из контрольных точек в виде светлого квадрата на базовой линии, чтобы повернуть 
текстовый объект. 

 
 
 
 
 
Перетащить 

 
 Базовая линия показывает во время перетаскивания повернутое положение текстового объекта. 
4 Для завершения отпустите кнопку мыши. 

         

Установка положения отдельных букв 
 

Инструмент Reshape Object (Изменение формы объекта) используется не только для наклона и 
вращения текстовых объектов, но и для манипулирования отдельными буквами.  Вы можете 
изменять положение букв по отношению друг к другу, а также индивидуально изменять форму и 

цвет букв. 
 
Изменение положения букв на экране 
 
Для изменения положения отдельных букв на экране используйте инструмент Reshape Object (панель 
Design). 
 
Вы можете изменять положение отдельных букв в текстовом объекте, используя инструмент Reshape 
Object (Изменение формы объекта).  
 
Как изменять положения букв на экране 
1 Выберите текстовый объект. 
2 Нажмите кнопку Reshape Object (Изменение формы объекта). 
 Вокруг текстового объекта появятся контрольные точки. 
3 Щелкните по ромбовидной контрольной точке в середине буквы. 
 

Щелкните по ромбовидной контрольной точке 

     
 Совет: Для выбора нескольких букв удерживайте нажатой клавишу Ctrl. 
4 Перетащите букву по горизонтали в новое положение. 

 
5 Для завершения отпустите кнопку мыши. 

    
Изменение формы букв на экране 

 
Для преобразования отдельных букв на экране используйте инструмент Reshape Object (панель 
Design). 

 
Изменением формы контуров букв инструментом Reshape Object (Изменение формы объекта) можно 
получать специфические эффекты.  
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Как изменять форму букв на экране 
1 Выберите текстовый объект. 
2 Нажмите кнопку Reshape Object (Изменение формы объекта). 
 Вокруг текстового объекта появятся контрольные точки. 
Щелкните по ромбовидной контрольной точке, затем щелкните по контуру буквы 

          
3 Щелкните по ромбовидной контрольной точке в середине буквы, затем щелкните по контуру буквы.  

    
Вокруг контура появятся дополнительные контрольные точки. 

4 Измените форму буквы перетаскиванием контрольных точек. Подробнее см. в разделе Изменение 
формы объектов. 

     
5 Для завершения отпустите кнопку мыши. 

     
Изменение цвета букв на экране 

162

 
Используйте инструмент Lettering (панель Design) для редактирования текста на экране. 
 
BERNINA artista позволяет изменять цвет отдельных букв в пределах текстового объекта. Совет: 

Вы можете также вставить изменение цвета между двумя буквами, поместив символ знака вставки (^). 
Последующие буквы по умолчанию примут следующий цвет из последовательности палитры. Подробнее 
см. в разделе Создание текстовых объектов в диалоговом окне Lettering.  
 
Как изменять цвет букв на экране 
1 Щелкните на кнопку Lettering, затем щелкните внутри текстового объекта.  
2 Выберите букву (или буквы) путем выделения. 

    
I-образный указатель  

 

 
выделенная буква 
 
3 Щелкните по цвету в цветовой палитре. 
4 Нажмите Enter. 
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Применение базовых линий теста 
Базовые линии определяют форму текстовых объектов в проекте. Вы 
можете поместить текст на прямой горизонтальной или вертикальной 
линии, по окружности или по дуге или же создать собственную базовую 
линию произвольной формы. В зависимости от используемой базовой 
линии потребуются различные базовые точки. Вы можете 
оцифровывать базовые линии на экране. 
 
В базовых линиях используются стандартные установки, 
определяющие их размеры, межбуквенные интервалы и углы наклона. 
BERNINA artista предоставляет возможность как диалогового, так и 
точного цифрового управления многими настройками базовых линий. Имеется возможность изменять тип 
базовой линии, ее длину, радиус и угол, а также ее положение. 
 
Примечание: BERNINA artista запоминает, какую базовую линию вы использовали в последний раз и 
будет использовать ее, если вводите текст непосредственно на экране. 
 
Выбор базовых линий 
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Щелкните правой кнопкой мыши по значку Lettering (панель Design) и настройте установки базовой 
линии. 

 
Вы можете выбирать различные базовые линии из диалогового окна Object Properties – Lettering 
(Свойства объекта – Текст) или Layout (Компоновка). Вы можете также изменять настройки базовой 
линии. Вы можете применять базовые линии для новых или выбранных объектов. 
 
Совет: Создавайте идентичные базовые линии путем дублирования или копирования в вашем проекте. 
 
Как выбирать базовые линии 
1 Дважды щелкните по выбранному текстовому объекту или щелкните правой кнопкой мыши по значку 

Lettering. 
 Откроется диалоговое окно Object Properties - Lettering (Свойства объекта - Текст). 

 
 
 
Выбор базовой линии 
 
 

 
2 Выберите базовую линию. 
 Выбор базовой линии зависит от желаемого вами эффекта. Вы можете оцифровывать различные 

базовые точки в зависимости от выбранной вами базовой линии. Имеются следующие опции: 
◄ Прямая горизонтальная линия. Подробнее см. в разделе Создание горизонтальных базовых 

линий. 
◄ Окружность по часовой стрелке. Подробнее см. в разделе Создание базовых линий по окружности. 
◄ Окружность против часовой стрелки. Подробнее см. в разделе Создание базовых линий по 

окружности. 
◄ Базовая линия произвольной формы. Подробнее см. в разделе Создание пользовательских 

базовых линий. 
◄ Вертикальная базовая линия. Подробнее см. в разделе Создание вертикальных базовых линий. 
◄ Комплект базовых линий. Подробнее см. в разделе Создание пользовательских базовых линий. 

3 Нажмите кнопку ОК. 
 
Создание горизонтальных базовых линий 
Прямые горизонтальные базовые линии не имеют 
фиксированной заранее определенной длины. Она 
растягивается по мере добавления букв. 
      
Как создавать горизонтальные базовые линии 
1 Щелкните правой кнопкой мыши по значку Lettering (Текст), чтобы открыть диалоговое окно Object 

Properties - Lettering (Свойства объекта – Текст). 
2 Введите текст в окно ввода текста. 
3 Выберите значок Straight Horizontal baseline (Прямая горизонтальная базовая линия). 
4 Нажмите кнопку ОК. 
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5 Щелкните по экрану в том месте, в которое вы хотите вставить буквы. 
 
Создание вертикальных базовых линий 
Вертикальные базовые линии являются прямыми вертикальными базовыми линиями. 
Вертикальные базовые линии не имеют фиксированной длины и растягиваются по мере 
ввода букв. 
Интервал между строками рассчитывается по горизонтали, в то время как интервал между 
буквами рассчитается по вертикали. Буквы по умолчанию выравниваются по центру вдоль 
вертикальной линии. Новые строки располагаются по умолчанию справа налево для 
приспособления к азиатским языкам. 
Вертикальные базовые линии эффективны для вышивания на рукавах для создания 
декоративного эффекта и для текстов на азиатских языках. 
 
Совет: Вертикальный текст лучше подходит для прописных букв западных языков, 
поскольку строчные буквы с нижними выносными элементами нарушают нормальный 
интервал между буквами. 
 
Как создавать вертикальные базовые линии 
1 Щелкните правой кнопкой мыши по значку Lettering (Текст), чтобы открыть диалоговое окно Object 

Properties - Lettering (Свойства объекта – Текст). 
2 Введите текст в окно ввода текста. 
3 Выберите значок Vertical baseline (Вертикальная базовая линия).  
4 Нажмите кнопку ОК. 
5 Щелкните по экрану в том месте, в которое вы хотите вставить буквы. 
 
Создание базовых линий по окружности 
Используйте базовые линии по окружности по часовой стрелке и против часовой стрелки, чтобы 
расположить буквы по полной окружности. Вы можете расположить текст на окружности по часовой 
стрелке (CW) или против часовой стрелки (CCW). По умолчанию буквы располагаются над  базовой 
окружностью по часовой стрелке и под базовой окружностью против часовой стрелки. По умолчанию они 
выравниваются по центру. 
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Для окружности вам нужно наметить две контрольные точки, а для овала – три точки. Положение второй 
контрольной точки на окружности или овале определяет точку выравнивания текста. Текст выравнивается 
по центру относительно этой точки. 
Наметьте окружность, которая должна быть 
достаточно большой для размещения вашего 
текста. Если окружность слишком мала или текст 
слишком длинен, текст будет искажен. Следуйте 
указаниям, появляющимся в статусной строке. 
Подробнее см. в разделе Изменение формы 
базовой линии на экране. 

      По часовой стрелке     Против часовой стрелки  
Как создавать базовые линии по окружности 
1 Щелкните правой кнопкой мыши по значку Lettering (Текст), чтобы открыть диалоговое окно Object 

Properties - Lettering (Свойства объекта – Текст). 
2 Введите текст в окно ввода текста. 
3 Выберите значок Circle CW baseline (Базовая линия по окружности по часовой стрелке)  или Circle 

CCW baseline (Базовая линия по окружности против часовой стрелки). 
4 Нажмите кнопку ОК. 
5 Щелкните по экрану в том месте, в которое вы хотите вставить центр окружности.. 

    
       Щелкните, чтобы поместить центр окружности 
 Щелкните, чтобы  
определить радиус окружности 

 
Нажмите Enter, чтобы завершить установку окружности 

 
 
 
Щелкните, чтобы определить радиус овала 
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6  Наметьте точку на контуре окружности, чтобы определить радиус. 
7  Нажмите Enter для завершения установки окружности или щелкните мышью еще раз, чтобы 

преобразовать окружность в овал.  
 Если вы нажмете Enter для установки окружности, то текст всегда будет располагаться в верхней 

части окружности. Если вы вычерчиваете овал, то ориентация текста будет определена направлением 
движения мыши при создании окружности. Чтобы расположить текст правильным образом, 
перемещайте мышь прямо вниз по экрану во время очерчивания окружности. 

 
 Примечание: В зависимости от выбранного вами вида выравнивания текст будет расположен по 

левому краю, по центру или по левому краю базовой линии объекта с выбранной базовой точкой 
радиуса.  Подробнее см. в разделе Выравнивание текста. 

     
  по центру  по левому краю   по правому краю 

 
Создание сложных базовых линий 
Используйте сложную базовую линию, чтобы расположить текст по 
верхней дуге по часовой стрелке, по прямой линии в середине и по дуге 
против часовой стрелки внизу. 
 
 
Как создавать сложные базовые линии 
1 Щелкните правой кнопкой мыши по значку Lettering (Текст), чтобы 

открыть диалоговое окно Object Properties - Lettering (Свойства 
объекта – Текст). 

2 Введите текст для линии по верхней части окружности в окно ввода 
текста. 

3 Нажмите Enter. 
4 Для следующей строки введите текст для средней базовой линии в середине окружности и нажмите 

Enter. 
5 Для следующей строки введите текст для базовой линии по нижней дуге окружности. 
6  Выберите значок Multiple baseline (Сложная базовая линия).  
 

 
 
Выберите значок Сложная базовая линия 
 

 
7  Нажмите кнопку ОК. 
8  Щелкните по экрану в том месте, в которое вы хотите вставить центр 

окружности.. 
9  Наметьте точку на контуре окружности, чтобы определить радиус. 
     
10 Нажмите Enter для завершения установки окружности или щелкните 

мышью еще раз, чтобы преобразовать окружность в овал.  
 
Создание пользовательских базовых линий 
Используйте базовые линии Any Shape (Любая форма), чтобы подогнать форму текста к элементам 
вашего проекта. Создайте базовые линии типа Any Shape путем отметки базовых точек, которые 
определят форму нужной вам базовой линии. Число базовых точек и длина базовой линии практически не 
ограничены. 

      
Если базовая линия слегка искривлена или имеет острые углы, буквы могут накладываться друг на друга. 
Для получения наилучших результатов намечайте точки кривой и создавайте линии, которые имеют 
пологие, плавные кривые. 
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Как создавать пользовательские базовые линии 
1 В диалоговом окне Object Properties – Lettering выберите в качестве базовой линии Any Shape. 
2 Введите текст в окно ввода текста. 
3 Нажмите кнопку ОК. 
4 Щелкайте по экрану, чтобы наметить опорные точки базовой линии. 

◄ Намечайте точки кривой правой кнопкой мыши. 
◄ Намечайте угловые точки левой кнопкой мыши. 

 
5 Нажмите Enter для завершения. 
 

Настройка базовых линий 
 
Базовые линии после размещения можно модифицировать непосредственно на экране или через 
диалоговое окно Object Properties – Lettering. Базовые линии позволяют устанавливать окончательную 
длину готового текста. По установленной вами базовой линии BERNINA artista старается подогнать 
буквы вдоль базовой линии, не изменяя ее длины. Как только базовая линия будет заполнена буквами, 
интервал между буквами уменьшится. Возможно, произойдет накладка букв друг на друга. В этом случае 
измените длину базовой линии таким образом, чтобы подогнать ее по размеру текста или измените 
ширину букв. 
 
Изменение базовых линий текста на экране 
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Используйте инструмент Reshape Object (панель Design) для изменения базовых линий теста. 
 

Базовые линии можно изменять на экране после размещения их в проекте инструментом Reshape Object 
(Изменение формы объекта).  Изменяйте форму прямой базовой линии, чтобы расположить ее под 
углом. Для вертикальной базовой линии вы можете также изменить ее длину и интервал между бувками. 
Изменяйте форму окружности и базовой линии, чтобы изменить глубину кривой, точки выравнивания и 
длину базовой линии. Изменяйте базовые линии типа Any Shape путем перемещения, добавления или 
удаления контрольных точек вдоль базовой линии.  
 
Как изменять форму базовой линии на экране 
1 Выберите текстовый объект. 
2 Нажмите кнопку Reshape Object (Изменение формы объекта). 
 На экране появятся контрольные точки для разных типов базовой линии. 

 
 
 
 
 
 
контрольные точки базовой линии 
 
контрольные точки базовой линии 
 
 
  
 
Совет: Крупные ромб и крестик соответствуют началу и 
концу последовательности вышивания. Вам может 
потребоваться переместить их, чтобы совместить к 
контрольными точками базовой линии. Их можно 
переместить в новое положение входа и выхода 
согласно выполненными вами изменениями базовой 
линии. 
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3 Для изменения угла наклона прямой горизонтальной или вертикальной базовой линии перетащите 
мышью крупный черный квадратик. 

 
 
Перетащите вверх или вниз  
для изменения угла базовой линии. 
 
 

4 Для увеличения или уменьшения длины базовой линии перетащите мышью треугольную контрольную 
точку. Интервал между буквами будет подогнан к новой длине строчки. 

 
Перетащите треугольник для изменения интервала между буквами. 
 
 
 
 
 
 

 
5 Для изменения формы строки с кривой базовой линией перетащите контрольную точку в центре 

окружности, чтобы увеличить радиус. 

 
 
 Перетащите вверх или вниз  
для изменения радиуса кривой 
 
6  На базовой линии по окружности имеются две фактические контрольные точки на периметре 

окружности, одна находится над другой. Оттащите одну точку от другой, чтобы создать дуговую 
базовую линию. 

      
Перетащите влево или вправо, чтобы превратить окружность в дуговую базовую линию 

    
7  Чтобы равномерно распределить интервалы между буквами по дуговой базовой линии перетащите 

треугольник. 

              
Перетащите треугольник для изменения интервала между буквами. 
 

 Совет: Точное положение букв зависит от вида выравнивания – по левому краю, по центру, по 
правому краю или по ширине. Если базовая линия становится слишком короткой, интервал между 
буквами сокращается, и буквы могут заходить друг за друга. 
◄ Для изменения длины от точки фиксированного радиуса щелкните по центру и перетащите центр, 

чтобы придать базовой линии требуемую длину. 
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◄ Чтобы подогнать базовые линии произвольной формы типа Any Shape, добавьте, удалите или 
переместите опорные точки, как это делается с любым объектом вышивания. Подробнее см. в 
разделе Изменение формы объектов. 

◄ Чтобы изменить форму базовой линии типа Any Shape, щелкните по базовой линии, где вы хотите 
согнуть ее (изменить направление). Щелкните левой кнопкой мыши, чтобы согнуть базовую линию 
на определенный угол; щелкните правой кнопкой, чтобы плавно согнуть базовую линию. 

  Щелкните по базовой линии, чтобы изогнуть, затем перетащите контрольную точку вверх или вниз. 

                    
Щелкните правой кнопкой, чтобы плавно изогнуть базовую линию 

 
◄ Для изменения положения перетащите любую из контрольных точек базовой линии вверх или 

вниз. 

      
Перетащить для изменения кривизны 

 
◄ Для удаления выберите контрольную точку и нажмите Delete. 
◄ Для преобразования прямой линии в кривую или кривую линию в прямую, выберите контрольную 

точку и нажмите клавишу пробела. 
8 Нажмите Enter для завершения. 
 
Настройка установок искривленной базовой линии 

168

 
Используйте инструмент Lettering (панель Design), для 
настройки установок искривленной базовой линии.  

 
Вы можете подогнать базовую линию по окружности, чтобы 
использовать ваши собственные настройки радиуса и 
интервала между буквами. См. также Создание базовых линий 
по окружности. 
       
Как настраивать установки искривленной базовой линии 
1 Дважды щелкните по выбранному текстовому объекту. 
 Откроется диалоговое окно Object Properties - Lettering (Свойства объекта - Текст). 

 
 
Выберите вид выравнивания 
 
 
 
Выберите тип базовой линии 
 
 

2 Выберите один из типов базовой линии по окружности. 
3 Выберите вид выравнивания 
4 Введите, если требуется, новые установки. 

◄ Letter Height (Высота букв) 
◄ Letter Width (Ширина букв) 
◄ Italic  - Letter Angle (Курсив – Угол наклона букв) 
◄ Letter Spacing (Интервал между буквами) 
◄ Baseline Radius (Радиус базовой линии): используется 

только для подгонки дуговой базовой линии. 
                                          Радиус базовой  Радиус базовой  

линии: 10 мм    линии: 20 мм 
5 Нажмите кнопку ОК. 
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Установка параметров стежка 
текста 
 
Как и все объекты вышивания, каждый текстовый объект 
имеет свои собственные свойства. Перед созданием 
текстового объекта вам, возможно, захочется изменить 
настройки типа стежка, который вы намереваетесь 
использовать. Альтернативно вам может потребоваться 
изменить параметры стежков и эффекты существующих 
текстовых объектов. BERNINA artista, кроме того, дает вам 
возможность точно контролировать углы отдельных букв. 
В этом разделе описывается порядок изменения типов стежка 
в текстовых объектах, а также настройки угла наклона 
стежков. 
 

Применение различных типов стежков в 
текстовых объектах 
 
По умолчанию текстовые объекты заполняются стежками гладьевого валика. Вы можете также применять 
другие основные типы заполняющих стежков, такие как простегивающие или узорные, как и для остальных 
объектов вышивания. Подробнее см. в разделе Выбор оконтуривающих стежков. 
 
Настройка стежка гладьевого валика для текстового объекта 
По умолчанию текстовые объекты заполняются стежками гладьевого валика. При малой ширине буквы 
стежки располагаются плотно, поэтому требуется меньше стежков для покрытия ткани. Если колонка 
очень узкая, стежки должны быть менее плотными, поскольку слишком большое количество уколов иглой 
может повредить материал. 
Вы можете заполнять формы текста специальным гладьевым стежком (Special Satin), как и обычным 
стежком гладьевого валика. Этот стежок особенно подходит для заполнения крупных нерегулярных 
текстовых форм, которые слишком велики для гладьевого валика. See also Adjusting Satin fill spacing. 
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Гладьевый валик 
 
 
 
Гладьевый валик с  
текстурированным краем 
 
Как настроить стежок гладьевого валика для текстового объекта 
1 Дважды щелкните по выбранному текстовому объекту. 
 Откроется диалоговое окно Object Properties - Lettering (Свойства объекта - Текст). 
2 Выберите закладку Fill Stitch (Заполняющий стежок). 
3 Выберите Satin (Гладьевый стежок) из списка Stitch Type (Тип стежка) 
 
 
 
Выберите Satin 
 
 
 
Настройте интервал  
между стежками 
 
 
 
 
 
 
 
4 Выберите тип интервал между стежками, который вы хотите применить к своему тексту. 

◄ Для автоматической установки интервалов: выберите Automatic. 
◄ Для установки фиксированных интервалов: выберите Manual (Вручную) и назначьте величину 

интервала в миллиметрах.  
5 Нажмите кнопку ОК. 
 
Автоматическая установка  
интервала между буквами 
 
 
Установка интервала между  
буквами вручную. 
 
Примечание: Функция Auto Jump (Автоматический переход) поможет вам контролировать длинные 
гладьевые стежки.  Подробнее см. в разделе Сохранение длинных стежков функцией Auto Jump. 
 
Настройка простегивающего стежка для текстового объекта 
Вы можете заполнять формы текстового объекта простегивающим стежком. Этот стежок особенно 
подходит для заполнения крупных объектов нерегулярной формы. 

      
Как настроить простегивающий стежок для текстового объекта 
1 Дважды щелкните по выбранному текстовому объекту. 
 Откроется диалоговое окно Object Properties - Lettering (Свойства объекта - Текст). 
2 Выберите закладку Fill Stitch (Заполняющий стежок). 
3 Выберите Step (Простегивающий стежок) из списка Stitch Type (Тип стежка). 
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Выберите Step 

 
Введите длину  

стежка и интервал  
между стежками 

 
 

Выбор узоров  
простегивающих 

стежков 
 

 
4 Подгоните интервал между стежками, чтобы увеличить или уменьшить их плотность. 
 Подробнее см. в разделе Регулировка шага простегивающего заполняющего стежка. 
5 Отрегулируйте длину стежка. 
 Подробнее см. в разделе Регулировка длины простегивающего заполняющего стежка. 
6  Выберите узор простегивающих стежков. 
 Подробнее см. в разделе Создание заполнения простегивающим стежком. 
7  Нажмите кнопку ОК. 
 
Настройка орнаментного стежка для текстового объекта 
Вы можете заполнять формы текста орнаментным стежком 
(Fancy), как и обычным стежком гладьевого валика. Этот 
стежок особенно подходит для заполнения крупных 
нерегулярных текстовых форм, которые слишком велики для 
гладьевого валика. Плотность заполнения определяется 
установкой интервала между стежками. См. также Создание 
заполнения орнаментным стежком. 
     
Как настроить орнаментный стежок для текстового объекта 
1 Дважды щелкните по выбранному текстовому объекту. 
 Откроется диалоговое окно Object Properties - Lettering (Свойства объекта - Текст). 
2 Выберите закладку Fill Stitch (Заполняющий стежок). 
 
 
 

Выберите Fancy 
 

Выберите узор. 
 

Настройте интервал  
между стежками 

 
 

Выберите угол  
поворота  

 
3 Выберите Fancy (Орнаментный стежок) из списка Stitch Type (Тип стежка). 
4 Выберите узор из списка Pattern. 
 См. также Выбор узоров заполнения орнаментными стежками. 
5 Введите в поле Stitch Spacing интервал между стежками. 
 См. также Регулировка интервала между заполняющими орнаментными стежками. 
6  Отрегулируйте наклон стежков путем ввода угла поворота. 
 См. также Регулировка угла наклона заполняющимх орнаментных стежков. 
7  Нажмите кнопку ОК. 
 

Регулировка углов наклона стежков текстового объекта 
 
Инструменты Stitch Angle (Угол наклона стежка) и Reshape Object (Изменение формы объекта) дают 
возможность регулировать углы наклона стежков, а также удалять индивидуальные угля наклона стежков 
в текстовых объектах. 
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Регулировка углов наклона стежков индивидуальных букв 
 

Используйте инструмент Stitch Angles (панель Stitch and Color), чтобы настроить различные углы 
наклона стежков для выбранных букв. 
 

Установите различные углы наклона стежков в буквах, используя инструмент Stitch Angle. Каждый сегмент 
буквы может иметь различные углы наклона стежков. 
 
Как отрегулировать углы наклона стежков индивидуальных букв 
1 Выберите текстовый объект. 
2 Щелкните по значку Stitch Angles. 
 Вам будет предложено ввести точку угла наклона 1 (angle point 1). 
3 Назначьте такие углы наклона, чтобы стежки пересекали две стороны объекта. 

     
 
 Примечание: Убедитесь в том, что углы наклона стежков не пересекают друг друга. 
4 Нажмите Enter. 
 Стежки будут пересчитаны с новыми углами наклона. 
 
Удаление углов наклона стежков в буквах 

 
Используйте инструмент Reshape Object (панель Design) для удаления индивидуальных углов 
наклона стежков в текстовых объектах. 

 
Удаляйте индивидуальные углы наклона стежков в текстовых объектов инструментом Reshape Object 
(Изменение формы объекта). 
 
Как удалять углы наклона стежков в буквах 
1 Выберите текстовый объект. 
2 Нажмите кнопку Reshape Object (Изменение формы объекта). 
3 Щелкните по ромбовидной контрольной точке в середине буквы, чтобы выделить ее, затем щелкните 

по контуру буквы. 
4 Выберите и удалите контрольные точки, как вам требуется. 

    
 Примечание: Контуры букв сохраняются после любого удаления угла наклона. 
 

Отключение функции автоматической стабилизации ткани для 
мелких букв 
 
Качество большинства букв может быть улучшено при использовании стабилизирующих стежков таким же 
образом, как и для других вышиваемых объектов. Для мелких, узких букв стабилизирующие стежки могут 
не потребоваться, в зависимости от размеров букв и вида материала, на которых они будут вышиты. См. 
также Упрочнение и стабилизация ткани стабилизирующими стежками. 
 
Как отключить функцию автоматической стабилизации ткани для мелких букв 
1 Выберите текстовый объект. 
2 Нажмите кнопку Underlay (Стабилизация ткани). 
 Функция стабилизации ткани будет отключена. 
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Специальные функции текста 
 
BERNINA artista дает возможность добавлять символы к тексту, а также 
изменять форму букв, используя функцию "гибкого текстового объекта". 
Вы можете быстро и просто создавать монограммы. В BERNINA artista 
все установленные в вашем компьютере шрифты TrueType доступны 
для размещения в текстовых объектах вашего проекта. 
В этом разделе показывается, как добавлять символы, создавать 
монограммы и использовать шрифты TrueType в ваших текстовых 
объектах. 
 

Добавление специальных шрифтовых знаков и 
символов 
 
В BERNINA artista вы можете добавлять специальные шрифтовые знаки и символы, используя диалоговое 
окно Select Symbols (Выбрать символ) из таблицы шрифтов Windows. 
 
Выбор символов 

 
Используйте инструмент Lettering (панель Design) для добавления 
специальных шрифтовых знаков непосредственно на экране. Щелкните 

правой кнопкой мыши для выбора опций текста. 
 
Вы можете быстро добавлять специальные шрифтовые знаки к вашему 
текстовому объекту.  
Если вы знаете клавиатурную команду для символа, то вставьте этот символ 
в текст, выбрав соответствующую комбинацию клавиш на экране, или же в 
закладке Lettering. 
 
Как выбирать символы 
1 Щелкните правой кнопкой мыши по значку Lettering. 
 Откроется диалоговое окно Object Properties - Lettering (Свойства объекта - Текст). 
2 Нажмите кнопку Select Character (Выбрать символ). 
 Откроется диалоговое окно Select Character. 
 
                     Показать рисунки и символы 
                Показать символы 

Выбор алфавита или    Показать рисунки 
набора символов 

 
 
 
 
 
 
 
 
Выбор символа 
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3 Выберите алфавит или набор символов из списка Alphabet Set. 
4 Выберите символы, которые вы хотите использовать. 
 
 Совет: Если вы щелкните по символу, то буква или цифра появится в поле Selection. Эта буква или 

цифра обозначает комбинацию клавиш, требуемую для набора этого символа непосредственно на 
экране. Например, ‘m’ означает, что нужно нажать клавишу m, в то время как ‘M’ означает нажатие 
клавиш Shift + M. 

5 Нажмите кнопку ОК. 
 Выбранные символы появятся на панели ввода текста на закладке Lettering. 
6  Нажмите кнопку OK в диалоговом окне Object Properties – Lettering (Свойства объекта – Текст). 
 Вы вернетесь в окно проекта. Продолжайте создавать текстовый объект обычным способом. 
 
Использование таблицы символов 
Используйте Таблицу символов (Character Map) системы Windows для быстрого доступа к специальным 
символам и буквам. Таблица символов обычно входит в стандартный пакет системы Windows. Подробнее 
см. в документации по операционной системе Windows. 
 
Как пользоваться таблицей символов 
1 Откройте Таблицу символов ОС Windows. 
 Эта таблица находится по адресу: кнопка  Start (Пуск) > Programs (Программы) > Accessories 

(Стандартные) > System Tools  (Служебгые) > Character Map (Таблица символов). 

     
 
2 Дважды щелкните по символу или выберите его и нажмите кнопку Select (Выбрать). 
 Символ появится в поле Characters to copy (Копировать символы). 
3 Нажмите кнопку Copy (Копировать), чтобы скопировать символ в буфер обмена.  
4 Вставьте его в панель ввода текста закладки Lettering. 
 Чтобы сделать это, нажмите Ctrl + V. 
 
Добавление орнаментных букв 
BERNINA artista предлагает орнаментные алфавиты, такие как Creative Cross и Secret Garden. 
Используйте эти алфавиты, чтобы добавлять текстовые объекты к проекту, каждая буква вставляется в 
проект или используется как самостоятельный маленький проект. 
 
Алфавит Creative Cross  
 
 
 
Алфавит Secret Garden  
 
 
Примечание: При редактировании букв вам нужно удалить текущие свойства объекта. 
 
Как добавлять орнаментные буквы 
1 Щелкните правой кнопкой мыши по значку Lettering 

(Текст). 
 Откроется диалоговое окно Object Properties - 

Lettering (Свойства объекта - Текст). 
Ввод букв 

 
 
 
 

Выберите алфавит  
Creative Cross  
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2 Выберите алфавит Creative Cross или Secret Garden из списка  Alphabet (Алфавит). 
 В окне просмотра появится образец буквы. 
3 Нажмите кнопку Select Character (Выбрать символ). 
 Откроется диалоговое окно Select Character. 
4 Выберите символы, которые вы хотите использовать. 
5 Нажмите кнопку OK в диалоговом окне Object Properties – Lettering (Свойства объекта – Текст). 
 Вы вернетесь в окно проекта. 
 Продолжайте создавать текстовый объект обычным способом. 
 
 Совет: Для изменения цвета букв назначьте требуемый цвет. Подробнее см. в разделе Подбор ниток 

из различных таблиц. 
 

 
буквы и небольшой проект  

 
 
 
 
одни буквы 

 
 
 

 
только небольшой проект  

 

 

Создание специальных эффектов функцией Elastic Lettering 
 
Применяйте функцию Elastic Lettering (Гибкий текстовый объект) к текстовым объектам, чтобы сделать 
текст выпуклым или дугообразным, растянутым или сжатым. Вы можете создавать текст с постепенно 
уменьшающимися или увеличивающими буквами инструментом "прямой гибкий текст" (straight elastic 
lettering). Вы можете создавать выпуклый и двусторонне вогнутый текст инструментом "изогнутый гибкий 
текст" (curved elastic lettering). Гибкий текст можно применять с любой базовой линией. 
 
 
 
прямой гибкий текст 
 
 
 
 
изогнутый гибкий текст 
 
 
 
 
Изменение формы текстового объекта 
 
Используйте функцию Elastic Lettering (меню Edit) для создания букв со специальными эффектами. 
 
В вашем распоряжении два типа гибкого текста – прямой и изогнутый. 
 
Как изменять форму текстовых объектов 
1 Выберите текстовый объект, форму которого вы хотите изменить. 
2 Выберите Edit > Elastic Lettering. 
3 Выберите Straight (Прямой) или Curved (Изогнутый). 
 В зависимости от выбранного типа функции Elastic Lettering вокруг контура объекта появятся 

различные маркеры. 
 

Маркеры прямолинейного  
изменения формы 

 
 

Маркеры криволинейного  
изменения формы 
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4 Перетащите один или несколько маркеров вверх или вниз, чтобы изменить форму объекта. 

 
 

Перетащить 
 

◄ Чтобы переместить два маркера в противоположных направлениях, удерживайте клавишу Shift 
во время перетаскивания маркера.  

        
Shift + Перетащить 

 
◄ Чтобы переместить два маркера в одном и том же направлении, удерживайте клавишу Ctrl во 

время перетаскивания маркера.  

      
Ctrl + Перетащить 

 
5 Нажмите Enter для завершения. 
 
Редактирование текста в Elastic Lettering 
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Используйте инструмент Lettering (панель Design) для редактирования текста в огибающем 
контуре на экране. 
 

Вы можете редактировать текст в Elastic Lettering на экране тем же способом, что и нормальный текст. 
Если вы щелкните внутри текста, то под контуром объекта появится дубликат текста. 
 
Как редактировать текст в Elastic Lettering 
1 Щелкните по кнопке Lettering, затем щелкните внутри текстового объекта.  
 Под выбранным объектом появится дубликат текста в оригинальной форме. Указатель мыши 

превратится в балочный (I-образный) курсор, появляющийся после последней буквы. 
2 Отредактируйте текст, как вам требуется. 
3 Нажмите Enter для завершения. 
 

       
 

Текст в Elastic Lettering исправлен. 
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Удаление эффекта Elastic Lettering 
 
Используйте функцию Lettering (меню Edit), чтобы возвратить объект в оригинальный вид.  
 
Чтобы придать текстовому объекту оригинальный вид, удалите эффект Elastic Lettering. 
 
Как удалить эффект Elastic Lettering 

◄ Выберите текстовый объект. 
◄ Выберите Select Edit > Elastic Lettering > None.  

Эффект гибкого текста будет удален и буквы возвратятся к оригинальному виду. 

      

Создание монограмм 
 
BERNINA artista позволяет быстро и просто создавать проекты вышивки, состоящие из заглавных букв, 
называемые монограммами. 
Diamond2 и Diamond3 являются специальными монограммными алфавитами. Используйте шрифт 
Diamond2 для создания 2-буквнных монограмм и шрифт Diamond5 для создания 3-буквнных монограмм. 
При использовании шрифтов Diamond2 или Diamond3 будьте уверены в том, что угол наклона букв 
выбран правильно. Например, Diamond3 имеет 3 комплекта каждой буквы, одну для левой стороны, одну 
для середины и одну для правой стороны. 
 
Как создавать монограммы 
1 Щелкните правой кнопкой мыши по значку Lettering. 
 Откроется диалоговое окно Object Properties - Lettering (Свойства объекта - Текст). 
2 Выберите Diamond2 для 2-буквенных монограмм или Diamond3 для 3-буквенных монограмм. 
3 Щелкните по кнопке Select Character, чтобы выбрать буквы. 
 Откроется диалоговое окно Select Character (Выбор буквы). 
 
 
 
 
 
 
 
Выбор левой буквы 
 
 
 
4 Выберите левую букву, щелкнув по изображению. 
 
 Совет: Если вы щелкните по символу, то буква появится в поле Selection. Эта буква обозначает 

комбинацию клавиш, требуемую для набора этого символа непосредственно на экране. Например, ‘m’ 
означает, что нужно нажать клавишу m, в то время как ‘M’ означает нажатие клавиш Shift + M. 

5 Выберите среднюю букву, если используется шрифт Diamond3. 
6 Выберите правую букву.  
 

       
7 Выберите обрамление, если требуется. 
               

 
Выбор обрамления 
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8 Нажмите кнопку ОК, чтобы закрыть диалоговое окно Select Character. 
9 Подгоните высоту и ширину букв, если требуется. 
10 Нажмите кнопку ОК. 
11 Щелкните по экрану в том месте, куда вы хотите поместить монограмму. 
 

       
 Совет: Если вы хотите придать каждой букве 

монограммы различные стили, создавайте каждую 
букву отдельно. 

 Используйте обрамление монограмм вокруг 
нормального текста при создании двух отдельных 
объектов и скомбинируйте их. 

       

Конвертирование шрифтов 
TrueType в вышивальные шрифты 
 
Операционная система Windows поставляется с коллекцией шрифтов TrueType, другие шрифты 
устанавливаются с различными прикладными программами. В BERNINA artista все установленные в 
вашем компьютере шрифты TrueType доступны для размещения в текстовых объектах вашего проекта. 
Для установки новые шрифтов откройте Control Panel (Панель управления).  Дважды щелкните по папке 
Fonts (Шрифты), затем выберите File (Файл) > Install New Font (Установить новый шрифт). Прежде чем 
вы сможете использовать новый шрифт, вам нужно перезагрузить компьютер, и BERNINA artista отобразит 
новый шрифт в списке Alphabet. 
 
Как конвертировать шрифты TrueType в вышивальные шрифты 
1 Щелкните правой кнопкой мыши по значку Lettering (Текст). 
 Откроется закладка Lettering диалогового окна Object Properties (Свойства объекта). 
 
 
 
 
 
 
 
 
 
 
 
 
 
Выберите один  
из шрифтов TrueType  
 
 
 
 
 
 
 
 
 
2 Выберите из списка Alphabet один из шрифтов TrueType. 
 В этом списке перечислены все шрифты TrueType, установленные в вашем компьютере. 
3 В окно ввода текста введите текст, который вы хотите вышить. 
4 Нажмите кнопку ОК. 
5 Щелкните по экрану в том месте, в которое вы хотите 

вставить буквы. 
 Текст будет вышит с использованием выбранного 

шрифта. 
 Примечание: Не все шрифты TrueType пригодны для включения в проекты artista. 

Поэкспериментируйте с понравившимся вам шрифтом и различными настройками стежка. 
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Приложение 

Приложение E  
Образцы рисунков 
 
Образцы рисунков, показанные в этом приложении, включены в вашу программу BERNINA artista. 
(Онлайновое Руководство содержит полный ассортимент образцов рисунков. Вы можете получить 
к ним доступ из меню Help (Справка) программы BERNINA artista.) Эти проекты (BMP-файлы) 
можно найти в папках My Designs, Samples 1 - 4 и AutoDigitizing. 
 
Примечание: Программа BERNINA artista Portfolio отображает пиктограммы и ограниченную 
информацию о проекте каждый раз, когда открывается папка с проектами. Вы можете 
отфильтровать содержимого окна отображения, чтобы показывались лишь файлы определенного 
типа. Подробнее см. в разделе Просмотр проектов в папках. 
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Часть VII  
Указания для опытных 
пользователей 
 
Глава 22  
Повышение качества 
вышивания 
 
Используйте автоматическую стабилизацию ткани и компенсацию стягивания 
для получения гладкого, ровного расположения стежков и устранения 
пробелов в проекте. Эти функции входят в "свойства объекта" и могут быть 
применены, отменены или модифицированы в любое время. 
В этом разделе описывается, как упрочнять и стабилизировать проект 
автоматической стабилизацией ткани и как компенсировать стягивание ткани. 
Техника контролирования длинных стежков функцией Auto Jump 
(Автоматический переход) уже была описана, вы можете также найти 
детальное описание настройки автоматически устанавливаемых начальных и 
конечных точек. 
 

Упрочнение и стабилизация ткани стабилизирующими стежками 
 
Стабилизирующие стежки способствуют стабилизации ткани и сокращают опасность искажения вышивки 
вследствие стягивания материала. Они также обеспечивают "объемность" вышивки и предотвращают 
погружение стежков в мягкие ткани. Без применения стабилизации ткани слои вышивальных стежков 
выглядят плоскими. Они не только выглядят плоскими, но и часто сквозь них просматривается ткань 
подложки. Начинающие пользователи могут попытаться увеличить плотность стежков, но более 
эффективным является правильное применение стабилизации ткани. 
Функция стабилизация ткани генерирует стабилизирующее простегивание объектов в соответствии с 
установками, выбранными в диалоговом окне Effects (Эффекты). Настройки стабилизации ткани 
сохраняются для каждого объекта таким же образом, как и другие свойства объекта. Следовательно, они 
регенерируются при любом изменении размеров или формы объекта. 
 
Применение автоматической стабилизации ткани 

 
Используйте инструмент Underlay (панель General) для упрочнения и стабилизации проектов 
вышивки автоматически выполняемыми стабилизирующими стежками. 

 
Вы можете предусмотреть стабилизирующие стежки для эскиза или применить их к существующим 
объектам. Тип стабилизации, который вы должны выбрать, определяется назначением. 
 
Как применять автоматическую стабилизацию ткани 
◄ Щелкните по значку Auto Underlay (Автоматическая стабилизация ткани)  при выбранных или не 

выбранных объектах.  
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 Стабилизирующие стежки автоматически генерируются для любых новых объектов и всех выбранных 

объектов. Как для новых, так и для выбранных объектов автоматически генерируемые 
стабилизирующие стежки основываются на текущих свойствах. 

◄ Щелкните по значку Auto Underlay еще раз, чтобы отменить эффект.  
 
Выбор типа стабилизации ткани 
BERNINA artista предоставляет на выбор несколько типов стабилизации ткани. 

 
Стабилизация ткани    Стабилизация ткани стежками зигзаг 
простегивающими стежками   
 
Как выбрать тип стабилизации ткани 
1 Выберите объект и дважды щелкните по нему. 
 Откроется диалоговое окно Object Properties (Свойства объекта). 
2 Нажмите кнопку Effects (Эффекты). 
 Откроется диалоговое окно Effects > Others. 
 
Выберите Underlay  
и тип стежка 
 
 
 
 
3 Выберите опцию Underlay (Стабилизация ткани). 
4 Выберите тип стабилизации ткани. 
5  Нажмите кнопку ОК. 
 

Выбраны стабилизирующие  
стежки зигзаг 

 
Выбраны простегивающие  
стабилизирующие стежки  

 
 

Выбраны двойные  
стабилизирующие стежки  

зигзаг 
 

Выбраны стабилизирующие  
стежки с обходом по краю  

 
Настройка параметров стабилизирующих стежков с обходом по краю 
Функция Edge Walk (Обход по краю) располагает стежки по краям объекта. Настройки длину стежка для 
стабилизирующих стежков типа Edge Walk, чтобы обеспечить вписывание стабилизирующих стежков в 
криволинейные формы и чтобы эти стежки не были заметны в окончательной вышивке. 
 
Примечание: Настройки стабилизирующих стежков типа Edge Walk сохраняются отдельно и не 
воздействуют на настройки покрывающих стежков. 
 
Как настраивать параметры стабилизирующих стежков с обходом по краю 
1 Выберите объект со стабилизацией ткани и дважды щелкните по нему. 
 Откроется диалоговое окно Object Properties (Свойства объекта). 
2 Нажмите кнопку Effects (Эффекты). 
 Откроется диалоговое окно Effects > Others. 
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Выберите Underlay  
и Edge Walk 

 
Введите длину  

стежка и ширину поля 
 
3 Проставьте флажок в окошке Underlay и выберите Edge Walk в качестве типа стабилизирующих 

стежков.  
4 Если необходимо, выполните одну из следующих операций: 

◄ В поле Stitch Length введите специфичную длину стежка. 
◄ Выберите ширину поля в окошке Margin (Поле) 

 Нажмите кнопку ОК. 

               
Длина стабилизирующего    Длина стабилизирующего  
стежка Edge Walk: 1,5 мм    стежка Edge Walk: 3,5 мм 

Настройка параметров стабилизирующих стежков зигзаг и двойной зигзаг 
Используйте стабилизирующие стежки зигзаг и двойной зигзаг для стабилизации широких колонок. Вы 
можете установить длину стабилизирующих стежков Zigzag (Зигзаг) и Double Zigzag (Двойной зигзаг). 
Стабилизирующие стежки Double Zigzag подходят только для контуров или букв, выполняемых гладьевым 
валиком. 
 
Примечание: Настройки стабилизирующих стежков зигзаг сохраняются отдельно и не оказывают влияния 
на настройки покрывающих стежков зигзаг. 
 
Как настроить параметры стабилизирующих стежков зигзаг и двойной зигзаг 
1 Выберите объект со стабилизацией ткани и дважды щелкните по нему. 
 Откроется диалоговое окно Object Properties (Свойства объекта). 
2 Нажмите кнопку Effects (Эффекты). 
 Откроется диалоговое окно Effects (Эффекты) > Others (Другие). 
 

 
Выберите Underlay  

и Zigzag или Double Zigzag 
 

Введите длину стежка 
 

3 Проставьте флажок в окошке Underlay и выберите Zigzag или Double Zigzag в качестве типа 
стабилизирующих стежков.  

4 Введите требуемую длину стежка. 
5  Нажмите кнопку ОК. 

       
Длина стежка зигзаг:: 5 мм   Длина стежк :зигзаг:: 2,5 мм 

 
Длина стежка двойной зигзаг:: 7 мм Длина стежка двойной зигзаг:: 3,5 мм 
 
Установка ширины полей зоны стабилизации ткани 
Поле стабилизации ткани – это расстояние между контуром 
объекта и краем зоны стабилизации ткани. Увеличивайте ширину 
этого поля, чтобы не допустить выхода стабилизирующих 
стежков за пределы контура покрывающих стежков. 
 

поле зоны стабилизации 
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Как установить ширину поля зоны стабилизации 
1 Выберите объект со стабилизацией ткани и дважды щелкните по нему. 
 Откроется диалоговое окно Object Properties (Свойства объекта). 
2 Нажмите кнопку Effects (Эффекты). 
Откроется диалоговое окно Effects > Others. 
 

   
3 Из открывшегося списка выберите тип поля (Margin). 
 
 

Нормальное 
 
 
 
 

Среднее 
 
 
 
 

Широкое 
  
 
 
4 Нажмите кнопку ОК. 

Компенсация стягивания ткани 
 
Вышивальные стежки втягивают ткань внутрь во время прокола иглой. Это может вызвать сморщивание 
ткани и образование пробелов в вышивке. Формы окончательной вышивки становятся несколько уже и 
длиннее, чем она выглядели на экране. Функция компенсации стягивания учитывает это явление путем 
"перекрытия" контуров заполняемых форм на тех сторонах, в которые втыкается игла. 
 
 
 
 
 
Компенсация стягивания 
 
 

Оцифрованный контур  Расчетный контур 
 
Настройте требуемую вам величину перекрытия путем изменения установок компенсации стягивая в 
диалоговом окне Effects. Это особенно удобно, если вы вышиваете проект на материалах с различной 
степенью растяжения. 
 
Совет: Применяйте стабилизирующие стежки и соответствующие нижние и верхние прокладки, чтобы 
дополнительно уменьшить эффект стягивания ткани.  
 
Применение автоматической компенсации стягивания ткани 
Применяйте автоматическую компенсацию стягивания к объектам в проекте до или после 
оцифровывания.  

                  
Компенсация стягивания ВЫКЛЮЧЕНА  Компенсация стягивания ВКЛЮЧЕНА 
 
Как применять автоматическую компенсацию стягивания ткани 
1 Выберите объект и дважды щелкните по нему. 
 Откроется диалоговое окно Object Properties (Свойства объекта). 
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 Примечание: Если не выбран ни один объект, то компенсация ткани применяется ко всем новым 
объектам. Как для новых, так и для выбранных объектов, компенсация стягивания основывается на 
текущих свойствах. 

2 Нажмите кнопку Effects (Эффекты). 
 Откроется диалоговое окно Effects > Others. 
 

Выберите  
Pull Compensation 

 
 
 
 
 
3 Проставьте флажок в окошке Pull Compensation (Компенсация ткани). 
4 Нажмите кнопку ОК. 
 
Настройка параметров компенсации ткани 
Величина перекрытия, требуемая для компенсации стягивания, зависит от ткани, на которой вы намерены 
вышивать. Поэкспериментируйте с тканями, которые вы хотите использовать, и посмотрите, подходит ли 
выбранная величина компенсации. Для ориентировки можно использовать данные приводимой ниже 
таблицы. Вы можете также отрегулировать величину компенсации ткани, чтобы подогнать ее к 
подготовленной для вышивания ткани, выбрав Settings > Fabric Settings. Подробнее см. в разделе 
Регулировка настроек ткани. 
 
Ткань Компенсация стягивания 

(мм) 
тик, хлопок 0.1 
футболка 0.2 
шерсть, трикотаж 0.25 - 0.3 
текст 0.2 - 0.3 
 
Как настроить параметры компенсации ткани 
1 Выберите объект и дважды щелкните по нему инструментом Pull Compensation. 
 Откроется диалоговое окно Object Properties (Свойства объекта). 
2 Нажмите кнопку Effects (Эффекты). 
 Откроется диалоговое окно Effects > Others. 
 
Введите величину перекрытия 
 
 
 
3 Введите величину (в миллиметрах), на которую вы хотите перекрыть объект. 
 Функция Pull Compensation (Компенсация стягивания) по умолчанию устанавливается на 0,2 мм. Эта 

величина подходит для большинства проектов. Она устанавливается, если вы оставите флажок в 
окошке Pull Compensation. 

 
 Примечание: Используйте величину 0,4, если вы 
применяете автоматическое оцифровывание. 
4 Нажмите кнопку ОК. 
       
 
 

Компенсация стягивания: 0,2 мм  Компенсация стягивания: 0,5 мм 
 Внимание: Если вы нажмете кнопку Save (Сохранить) в диалоговом окне Object Properties, 

установки, которые вы уже сделали, будут применяться ко всем проектам, которые будут впоследствии 
созданы с использованием этого шаблона. Подробнее см. в разделе Свойства объекта и шаблоны. 

 

Регулировка настроек ткани.  
 
Настройки ткани основываются на типе ткани, на которой вы будете вышивать. 
Настройки ткани предусматривают компенсацию стягивания, пригодную для 
используемой вами ткани. Компенсация стягивания сохраняет ваш проект от 
появления пробелов между объектами. 
 

Стандартные программные установки  
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Вы можете изменять настройки ткани, так что машина будет учитывать тип ткани, на которой выполняется 
вышивка. Настройки ткани вносят требуемые изменения в системные настройки, например, компенсацию 
стягивания. 
Новые настройки будут применены ко всем объектам в проекте, исключая текстовые объекты. Проставьте 
флажок в окошке Apply to Lettering Objects (Применить к текстовым объектам) , чтобы эти установки 
относились также и к текстовым объектам. Вы можете включить информацию о настройках ткани в 
информацию о проекте, так что ее можно будет распечатать совместно с остальной важной информацией 
по проекту. 
 
Как настраивать параметры ткани 
1 Выберите Edit (Редактировать) > Select All (Выбрать все). 
 Будет выделен весь проект. 
2 Выберите Settings (Настройки) > Fabric Settings(Настройки ткани).. 
 Откроется диалоговое окно Fabric Settings (Настройки ткани). 
    
3 Выберите тип ткани из списка Fabric Type (Тип ткани). 
4 Выберите для использования стандартные настройки или тонкую 

настройку для использования собственных значений. 
◄ Use Standard Settings (Использовать стандартные настройки):: 

Изменения будут выполнены в соответствии с выбранным вами 
типом ткани. 

◄ Настройка параметров: Введите значения для тонкой настройки. Значение больше 100 увеличит 
интервал между стежками. Значение меньше 100 уменьшит интервал между стежками. В 
некоторых случаях будет отрегулирована также компенсация стяшивания. 

5  Если вам нужно применить настройки ткани к тексту, выберите Apply to Lettering Objects (Применить к 
текстовым объектам). 

     
Плотный трикотаж,   Плотный трикотаж,  
настройка 150 %    настройка 75% 

   
6  Нажмите кнопку ОК. 
Если вы вернетесь к диалоговому окну Fabric Settings, ваши новые настройки не будут отображены, хотя 
эти настройки остаются действующими. 
 
Примечание: Если вы решили не изменять стандартные настройки, нажмите Cancel, чтобы сохранить 
действующие по умолчанию настройки.  

Сохранение длинных стежков функцией Auto Jump 
 
Вышивальные машины способы выполнять стежки максимальной длины, определяемой ограничениями 
самой машины по перемещению пялец. Если длина стежка превышает это ограничение, то длинный 
стежок подразделяется не несколько мелких стежков. Это может повлиять на внешний вид вышивки, 
особенно гладьевого застила. При применении функции Auto Jump (Автоматический переход) вы можете 
сохранить длинные стежки, превратив их в серии переходов.  
 
Примечание: Функция Auto Jump для соединительных стежков применяется автоматически. 
 
Автоматический переход может быть использован с оцифровываемыми вручную стабилизирующими 
стежками. Эта функция может быть использована также для создания эффекта стежки, например, при ее 
применении к заполненным гладьевым застилом формам, покрываемым сверху переходными или 
узорными стежками. 
Для создания узких колонок с большей выпуклостью, чем при нормальном гладьевом заполнении, 
применяйте Auto Jump в сочетании с подходящими стабилизирующими стежками с установленной 
максимальной длиной на небольшое значение, например 6 мм. При коротких покрывающих стежках 
разбивка их переходом делает их рыхлыми и, таким образом, они более эффективно приподнимаются над 
тканью. Подробнее см. в разделе Упрочнение и стабилизация ткани стабилизирующими стежками. 
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макс. длина стежка 

      
длинный стежок разбит на несколько коротких стежков-переходов 

 
Функция Auto Jump сохраняется в свойствах объекта и по умолчанию отключена.  Вы можете изменять ее 
настройки в любое время для выбранных или заново созданных объектов в диалоговом окне Object 
Properties. Настройки Auto Jump могут быть приспособлены к заполняющему стежку, оконтуривающему 
гладьевому стежку и оконтуривающему обметочному стежку. 
 
Применение функции Auto Jump 
Вы можете применять функцию Auto Jump к проектам как до, так и после оцифровывания.  Применяйте 
Auto Jump к объектам со стежками, длина которых превышает максимальную величину.  
 

Функция Auto Jump ВКЛЮЧЕНА 

    
Функция Auto Jump ВЫКЛЮЧЕНА 

 
Как применять функцию Auto Jump 
1 Выберите объект и щелкните по нему правой кнопкой мыши. 
 Откроется диалоговое окно Object Properties (Свойства объекта). 
 
 Примечание: Если не выбран ни один объект, то Auto Jump применяется ко всем новым объектам. Как 

для новых, так и для выбранных объектов, Auto Jump основывается на текущих свойствах. 
2 Нажмите кнопку Effects. 
 Откроется диалоговое окно Effects (Эффекты). 
 
 

Выберите Auto Jump 
 

Введите макс. длину стежка  
и длину переходного стежка 
 
3 Нажмите кнопку ОК. 
 

длинные переходные стежки 

    
            БЕЗ переходных стежков 
 
Настройка параметров функции Auto Jump  
Вы можете настроить функцию Auto Jump для изменения длины, при которой длинные стежки 
разбиваются на переходные, длины самих переходных стежков и метода расчета длины стежка. 
 
Как настроить параметры функции Auto Jump  
1 Выберите объект и щелкните по нему правой кнопкой мыши. 
 Откроется диалоговое окно Object Properties (Свойства объекта). 
2 Нажмите кнопку Effects. 
 Откроется диалоговое окно Effects (Эффекты). 

 
Выберите Auto Jump 

 
Введите макс. длину  

стежка и длину переходного  
стежка 
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3 Проставьте флажок в окошке Auto Jump. 
4 В поле Maximum Stitch (Макс. стежок), введите максимально допустимую длину стежка. К стежкам, 

длины которых превышает максимально допустимую, будет применена функция Auto Jump. 

            
Макс. длина стежка: 10 мм Макс. длина стежка: 12,7 мм 
 

Установите максимальную длину стежка на величину, превышающую самый длинный гладьевый 
заполняющий стежок, который вы хотите применять в своем проекте, в противном случае некоторые 
гладьевые стежки будут разбиты на два или больше стежков. 

5  В поле Jump Length (Длина переходного стежка)  введите длину каждого переходного стежка. 

         
Длина переходного стежка: 7 мм  Длина переходного стежка: 4 мм 
 
 Короткие переходные стежки увеличивают время вышивания, но способствуют более плавному 

движению пялец поперек проекта. 
6  Нажмите кнопку ОК. 
 

Настройка автоматических начальных и конечных точек 
 
Используйте команду Start and End (меню Arrange), чтобы установить начальную и конечную точки 
проекта. 
 
Перед вышиванием некоторые вышивальные машины потребуют от вас точно позиционировать иглу в 
месте первого прокола материала иглой. 
 
Используйте команду Start and End (Начало и Конец), чтобы связать первый и конечный стежки проекта. 
Это облегчит позиционирование иглы перед вышиванием и предотвращает возможность выхода иглы за 
пределы пялец. 
 
Как настроить автоматические начальные и конечные точки 
1 Выберите команду Arrange > Start and End. 
 Откроется диалоговое окно Start and End. 
 
 
 

Выберите опцию Start Point  
 
 
 
 
 

Выберите опцию End Point  
 
 
 
 
 
 
2 Выберите метод Start Point (Начальная точка) 

◄ First Stitch (Первый стежок): начальная точка является первым стежком проекта. 
◄ Auto Start at (Автоматическая начальная точка в): Maintain Automatically (Поддерживать 

автоматически): начальная точка автоматически устанавливается с назначенной точки проекта - 
Center of Design (Центр проекта) или Bottom Middle (Середина нижней части). 

◄ Digitize Start Point (Определить начальную точку): вам будет предложено ввести начальную точку. 

214



Глава 22: Повышение качества вышивания 

BERNINA® Artista Designer Plus Версия 4 

 
 Примечание: Если вы также выбрали Digitize End Point, то вам будет предложено ввести конечную 

точку. 
 

       
Начальная точка:  Начальная точка:  
Первый стежок:   Auto Start 
Конечная точка:   Конечная точка:  
Последний стежок  Auto End, центр проекта 

   проекта 
  
3 Выберите метод End Point (Конечная точка) 

◄ Last Stitch (Последний стежок): последняя точка является последним стежком проекта. 
◄ Auto End at (Автоматическая последняя точка в): Maintain Automatically (Поддерживать 

автоматически): последняя точка автоматически устанавливается с назначенной точки проекта - 
Return to Start (Возврат к начальной точке), Center of Design (Центр проекта) или Bottom Middle 
(Середина нижней части). 

◄ Digitize End Point (Определить конечную точку): вам будет предложено ввести конечную точку. 
4 Нажмите кнопку ОК. 
 Соединительные стежки будут вставлены по необходимости перед первым и после последнего стежка 

проекта. 
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Глава 23  
 
Специальная техника 
оцифровывания 
 
BERNINA artista предлагает специальные способы оцифровывания для 
экономии времени при подготовке проектов и получения специальных 
эффектов при вышивании. Имеются инструменты для оцифровывания 
объектов аппликаций, а также способы вырезания отверстий, создания 
"перевернутых" дубликатов и добавления обрамлений. 
В этом разделе описывается, как укреплять контуры и вырезать отверстия в 
объектах. Вы сможете узнать также о специальных способах 
оцифровывания для аппликаций. 
 

Упрочнение контуров 
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Используйте инструмент Double Run (панель Design) для упрочнения контура путем обшивания его 
в обратном направлении. 

 
Используйте функцию Double Run (Двойной обход) для упрочнения контура. При 
этом контур обшивается в противоположном направлении. Обычно это свойство 
используется для утолщения строчки контура без образования нежелательных 
соединительных стежков. 
 
Как упрочнять контуры 
1 Выберите объекты, контуры которых требуют упрочнения. 
2 Щелкните по значку Double Run. 
 Объект будет дублирован реверсными стежками и помещен сверху оригинала. 

Цвет остается тем же, что и у оригинала, и помещен после него в 
последовательности вышивания. 

 
 Совет: Нажмите Ctrl + B, чтобы укрепить объект.  
3 Проверьте, дублирован ли объект, используя один из следующих способов: 

◄ Проверьте количество стежков в статусной строке 
◄ Используйте команду Slow Redraw (Медленное перерисовывание). Подробнее см. в разделе 

Замедленный просмотр последовательности вышивания. 
◄ Обойдите объект по стежкам. Подробнее см. в разделе Просмотр последовательности 

вышивания. 

Вырезание отверстий и удаление перекрывающих 
стежков 
 
Если два объекта накладываются друг на друга, то два слоя стежков будут 
назначены одному и тому же участку. Функция Remove Overlay Stitching 
(Удаление перекрывающих стежков) позволяет сохранять формы при 
удалении одного слоя стежков. Альтернативно вы можете использовать 
объекты с заполнением или текстовые объекты для вырезания отверстий. 
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Вырезание отверстий в объектах 
 
Используйте инструмент Add Holes (панель Design) для вырезания отверстий в объектах. 
 

BERNINA artista позволяет вырезать отверстия в выбранных объектах замкнутой кривой или 
прямоугольника с единообразным углом наклона стежков, используя инструмент Add Holes (Добавить 
отверстия).  
 
Примечание: Функция удаления перекрывающих стежков не предназначена для работы с функцией 
оцифровывания блока или инструментом Stitch Angle (Угол наклона стежка). Она должна использоваться 
с объектами, созданными инструментом Closed Curve (Замкнутая кривая). 
 
Как вырезать отверстия в объектах 
1 Выберите объект Замкнутая кривая или Прямоугольник. 
2 Щелкните по значку Add Holes (Добавить отверстие). 
 Вокруг контура объекта появятся базисные точки. 
 
 Совет: Следуйте указаниям в строке подсказки при оцифровывании дополнительных контуров.  
3 Оцифруйте дополнительные контуры для объекта.  
 Нажимайте Enter после каждого контура.  

   
4 Нажмите Enter. 
 

   
 Примечание: Для удаления контуров из криволинейного объекта с заполнением щелкните по значку 

Reshape Object (Изменение формы объекта), чтобы отобразить контрольные точки объекта.  
Выберите контрольные точки на нежелательном контуре и нажмите Delete. 

 
Вырезание отверстий текстом 
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Используйте инструмент Remove Overlay (панель Design) для удаления 
покрывающих стежков текстом. 
 

Вы можете также вырезать отверстия в выбранных объектах замкнутой кривой 
или прямоугольника с единообразным углом наклона стежков, используя 
инструмент Lettering Remove Overlay (Удаление стежков перекрытия текста). 
 
Как вырезать отверстия текстом 
1 Выберите текстовый объект и объект, в котором вы хотите удалить покрывающие стежки.  
 
2 Нажмите Ctrl и выберите объект, в котором вы хотите удалить покрывающие стежки. 

 
 
 
 
 
 
 
 
 
Выберите текст и объект с заполнением 
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3 Щелкните по значку Lettering Remove Overlay (Удаление стежков перекрытия текста). 
 Стежки, которые перекрывают текст, будут удалены. 

     
Объедините объекты с внутренними буквами  
с главным объектом после удаления покрывающих стежков 

 
 Примечание: После удаления покрывающих стежков сгруппируйте любые малые объекты внутри букв 

с главным объектов, так чтобы они были связаны. 
 
Удаление перекрывающих стежков 
 
Используйте команду Overlay Stitching (меню Arrange) для удаления перекрывающих стежков. 
 
Используйте функцию Remove Overlay Stitching (Удаление перекрывающих 
стежков), чтобы сохранить формы, но удалить слои перекрывающих 
стежков. 
 

перекрывающие друг друга объекты 
 
Примечание: Функция удаления перекрывающих стежков не 
предназначена для работы с функцией оцифровывания блока или 
инструментом Stitch Angle (Угол наклона стежка). Она должна 
использоваться с объектами, созданными инструментом Closed Curve (Замкнутая кривая). 
 
Как удалять перекрывающие стежки 
1 Выберите объект, который должен образовать отверстие. 
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Второй выбор  
 
 
 
Первый выбор  
 
 

2 Нажмите Ctrl и выберите объект, в котором вы хотите удалить покрывающие стежки. 
3 Выберите Arrange > Remove Overlay Stitching. 
 Перекрывающие стежки будут удалены. 

    
Восстановление удаленных перекрывающих стежков 
 
Используйте команду Include Overlay Stitching (меню Arrange) для восстановления удаленных 
перекрывающих стежков. 
 
Иногда вам может потребоваться сохранить или восстановить удаленные перекрывающие стежки. 
Используйте функцию Include Overlay Stitching (Восстановить перекрывающие стежки) для возвращения 
перекрывающих стежков. 
 
Как возвратить удаленные перекрывающие стежки 
◄ Выберите объект, в котором были удалены перекрывающие стежка, и выберите команду Arrange > 

Include Overlay Stitching. 



Глава 23: Специальная техника оцифровывания 

BERNINA® Artista Designer Plus Версия 4 

    
выбранный объект    отверстие заполнено стежками 

 

Создание пуговичных петель 
 
Выберите команду Add Buttonhole (меню Arrange), чтобы добавить петлю к проекту. 
 
BERNINA artista позволит вам вставлять заданные заранее пуговичные петли, назначать размеры петель 
и соединять петлю с проектом. Пуговичные петли выполняются обычно стежками гладьевого валика, 
обрамляющего прорезь, длина которой примерно соответствует диаметру пуговицы. Стежки гладьевого 
валика защищают прорезь от осыпания. Пуговичная петля состоит из двух гладьевых валиков с 
закрепками на концах. 
 
  

верхняя закрепка 
 
 

 
бок петли 

      прорезь 
 
    
 
 
 

нижняя закрепка 
 
 
Добавление пуговичных петель 
Добавьте пуговичные петли к проекту. 
 
   
 
Как добавлять пуговичные петли 
1 Создайте проект. 
2 Выберите команду Arrange (Расположение) > Add Buttonhole 
(Добавить петлю). 
 Текущая петля будет отображена в виде контура. 
    
3 Щелкните в том месте, куда вы хотите поместить петлю. 
4 Повторяйте эту операцию, если нужно добавить несколько петель. 

 
5 Нажмите Esc для завершения. 
 

    
 Совет: Щелкните по инструменту Undo, чтобы удалить последнюю петлю. Если щелкнуть еще раз, 

будет удалена другая петля. 
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Соединение петель с объектами 
 
Выберите команду Merge Buttonhole (меню Arrange), чтобы соединить петлю с проектом. 
 
BERNINA artista позволяет удалить часть объекта, который перекрывается объектом петли, используя 
команду Merge Buttonhole (Слияние петли). 
Если петля помещена сверху другого объекта, некоторые из расположенных ниже стежков могут 
распуститься после прорезания петли. Чтобы предотвратить это, находящийся под петлей объект может 
быть изменен по форме, так что оконтуривающая линия будет проходить вдоль прорези петли. Эта 
функция подобна удалению перекрывающих стежков. 

     
 
Примечание: При соединении некоторых объектов с пуговичными петлями они могут быть разделены на 
несколько объектов. 
 
Как соединять петли с объектами 
1 Выберите объект/ы и петлю, которые впоследствии будут включены в последовательность вышивания. 
 
 Внимание: Другой объект не должен включать в себя оконтуренные объекты. 
2 Выберите команду Arrange (Расположение) > Merge Buttonhole (Соияние петли). 
 Перекрывающие стежки будут удалены, петля будет создана. 
 
 Примечание: Вы должны объединять петли с объектами ПОСЛЕ того, как вы установите 

окончательную длину прорези, угол наклона и ширину. 

        
Выбор типов петель 
Выбирайте тип петли до или после оцифровывания. Если вы используете петли без выбора типа петли, то 
будет применена стандартная петля. 
 
Как выбрать тип петли 
1 Выберите Settings (Настройки) > Object Properties (Свойства объекта). 
2 Щелкните по закладке Buttonhole (Петля).  
Откроется закладка Buttonhole диалогового окна Object Properties. 
 
 
 

 
Выберите тип  

петли 
 

 
 
 
 
 
 
 
3 Выберите тип петли 
4 Нажмите кнопку ОК. 
 
 Совет: Дважды щелкните по объекту, чтобы изменить тип петли только для этого объекта. 
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Настройка длины и плотности петли 
Для изменения длины петли измените длину прорези. Используйте диалоговое окно Object Properties для 
ввода точной длины или используйте инструмент Reshape Object. 
 
Совет: Вы можете также отрегулировать длину петли, используйте инструмент Reshape Object 
(Изменение формы объекта). 
Увеличивайте или уменьшайте плотность гладьевых или краеобметочных стежков боков петли путем 
уменьшения или увеличения Bead Stitch Spacing (Шаг стежка бока петли). 
 
Как настроить длину и плотность петли 
1 Выберите Settings (Настройки) > Object Properties (Свойства объекта). 
2 Щелкните по закладке Buttonhole (Петля).  
 Откроется закладка Buttonhole диалогового окна Object Properties. 
 
 Совет: Дважды щелкните по объекту, чтобы изменить характеристики стежка только для этого 

объекта. 
 
 
 
Введите характеристики  

петли 
 

 
3 В поле Slit Length (Длина прорези)  введите новую длину прорези. 

     
Длина прорези:  Длина прорези:  Длина прорези: 
20 мм      15 мм    10 мм 

 
4 В поле Bead Stitch Spacing (Шаг стежка бока петли) введите новое значение. 

      
Шаг стежка:  Шаг стежка:  Шаг стежка:  
бока петли:  бока петли:  бока петли:  
0,3 мм    0,4 мм   1,0 мм 
  
5 Нажмите кнопку ОК. 

Настройка угла наклона петли 
 
Настраивайте угол наклона одной или нескольких выбранных петель, как и для других объектов, 
используя: 
◄ Диалоговое окно Object Properties для индивидуального вращения одной или нескольких петель.  
 
◄ Инструмент  Object для совместного вращения одной или нескольких петель.  
◄ Инструмент Reshape Object для вращения одиночных петель.  
◄ Инструмент Rotate 45° CCW/CW для вращения одной или нескольких петель.  
◄ Инструменты Mirror Vertical и Mirror Horizontal. 
 
Вращение петель инструментом Select Object 
 

Для преобразования текстового объекта на экране используйте инструмент Select Object (панель 
Design). 
 

Вы можете вращать петли путем манипулирования контрольными точками на экране или в диалоговом 
окне Object Properties. 
 
Как вращать петли инструментом Select Object 
1 Щелкните по значку Select Object и выберите петлю. 
 Появятся контрольные точки изменения размера. 
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2 Щелкните по петле еще раз. 
 Появится другой комплект контрольных точек. Эти точки позволят вращать петлю. 
    
 

контрольные точки вращения  
 
 

Точка вращения  
 
3 Перетащите одну из контрольных точек в виде светлого квадрата, чтобы повернуть петлю. 

 
 
Перетащить 
 
 
Точка вращения  
 
  

Теневым контуром во время перетаскивания показывается изменение положения поворачиваемого 
объекта. 

 
 Совет: Перетащите точку вращения в новое положение перед вращением объекта. 

        
новая точка вращения  

 
4 Для завершения отпустите кнопку мыши. 
 

Примечание: Инструмент Select Object работает с выбранными индивидуально и с несколькими 
петлями. 

        
 
 
 
 
вращение нескольких петель 
 
 
 
 

Изменение формы петли инструментом Reshape Object 
 
Для вращения и изменения размеров петли на экране используйте инструмент Reshape Object 
(панель Design). 

 
Вы можете вращать и изменять размеры петли путем манипулирования контрольными точками на экране 
с использованием инструмента Reshape Object (Изменение формы объекта). Инструмент Reshape Object 
работает только с индивидуально выбранными петлями.  
 
Как изменять форму петли инструментом Reshape Object 
1 Выберите петлю. 
2 Нажмите кнопку Reshape Object (Изменение формы объекта). 
 Вокруг петли появятся контрольные точки. 

   
контрольные точки 

 
3 Перетащите одну из контрольных точек (черные квадратики), чтобы изменить угол наклона и/или длину 

петли. 
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Перетащите выбранную контрольную точку 

 
4 Нажмите Enter для завершения. 
 

            
петля повернута с изменением размера 
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Глава 24  
 
 
 
 
 
Эффекты художественного 
вышивания 
 
BERNINA artista предлагает большое количество художественных 
эффектов и типов стежков для создания текстурированных и 
узорных форм заполнения объектов. Вы можете создавать эффекты 
текстурированных краев для образования "размытых" кромок или 
теневых эффектов  
В этом разделе описывается, как применять эти типы 
художественных стежков и эффекты к проектам вышивания и как 
настраивать эти функции для получения желаемых результатов. 
 

Создание текстурированных краев 
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Используйте инструмент Textured Edge (панель General) для создания текстурированных краев или 
имитации пушистых структур.  
 

Используйте функцию Textured Edge (Текстурированный край) для создания теневых 
эффектов или для имитации меха или других пушистых структур в вашем проекте. 
 
Применение текстурированного края 
Применяйте Textured Edge для создания неровного края вдоль одного или нескольких 
краев объекта. Эффект текстурированного края применяется с использованием 
текущих настроек функции Textured Edge в диалоговом окне Effects (Эффекты). 
Изменяйте эти настройки до или после применения эффекта. 
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Как применять эффект текстурированного края 
◄ Щелкните по значку Textured Edge (Текстурированный край). 
 Эффект будет применен к новым или выбранным объектам на основе текущих настроек функции Textured 

Edge. 

      
текстурирован   текстурирован   текстурированы  
левый край   правый край   оба края 

   
Настройка функции Textured Edge  
Настройте функцию Textured Edge для изменения степени рыхлости края, выбора стороны объекта, к которой 
должен быть применен этот эффект, и ширины поля, в котором должны отсутствовать стежки. 
 
Как настраивать функцию Textured Edge  
1 Выберите объект и дважды щелкните по нему. 
 Откроется диалоговое окно Object Properties (Свойства объекта). 

 
 
 
Нажмите кнопку Effects. 
 
 

2 Нажмите кнопку Effects. 
 Откроется закладка Effects > Textured Edge  
 

Выберите Textured 
 

Выберите настройки 
 
 
 

Настройте значения 
 
 
 
3 Выберите сторону объекта, к которой вы хотите применить этот эффект. 

      
текстурирован   текстурированы  текстурирован  
левый край   оба края         правый край 

 
4 Используйте ползунок поля Texture для установки степени рыхлости.  

Перемещайте ползунок для выбора требуемой текстуры, влево для рыхлой текстуры, когда  длина стежков в 
большей мере произвольна, и вправо для гладкой текстуры. 

 
больше вариаций длины  
стежков дает более рыхлую  
текстуру 

 
 
 

меньше вариаций длины  
стежков дает более гладкую  

текстуру 
5 Используйте ползунок поля Span (Диапазон) для выбора диапазона отклонения стежков от контура.   
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диапазон 

           
Перемещайте движок влево для уменьшения этого диапазона и вправо для его увеличения. 

 
короткий диапазон 

 
 
 
 
 
 

   длинный диапазон 
 
6  Нажмите кнопку ОК. 

Создание заполнения орнаментными стежками 
 
Орнаментное заполнение Fancy fill подобно заполнению простегивающими стежками, но при этом стежки 
располагаются в виде регулярно повторяющихся узоров. Эффект Fancy fill используется для художественного 
заполнения широких и крупных зон с сохранением внешнего вида сплошного заполнения. Вы можете изменять 
значения стежков для получения разнообразных эффектов. 
Вы можете также создавать художественные эффекты, используя "рукодельные" стежки и узоры. См. также 
Оконтуривание и заполнение узорами и Оконтуривание и заполнение рукодельными стежками. 

         
 
Применение орнаментного заполнения 
Вы можете применить эффект Fancy fill к заполненным объектам. Текущие значения устанавливаются в 
закладке Fill Stitch диалогового окна Object Properties. Вы можете настроить эти установки до или после 
применения эффекта. 
 
Как применять эффект Fancy fill 
1 Выберите объект с заполнением и дважды щелкните по нему. 

Откроется закладка Fill Stitch (Заполняющий стежок) диалогового окна Object Properties (Свойства 
объекта). Отображены Stitch Type (Тип стежка) и Pattern (Узор). 
 

 
 

Выберите Fancy 
 
 

2 Нажмите кнопку ОК. 
Эффект будет применен к новым или выбранным объектам на основе 
текущих настроек функции Fancy fill. 
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Совет: Чтобы лучше рассмотреть эффект Fancy fill, нажмите клавишу   для отображения точек укола или 
используйте режим Художественный Просмотр (Artistic View). 
 
Выбор узоров орнаментного заполнения 
Вы можете выбирать различные узоры для орнаментного заполнения в диалоговом окне Object Properties. 
Выберите узор до или после оцифровывания объекта. 
 
 
Примечание: Подробнее см. в разделе Образцы заполнения орнаментными стежками. 
 
Как выбрать узор орнаментного заполнения 
1 Выберите объект с заполнением и дважды щелкните по нему. 
 Откроется закладка Fill Stitch (Заполняющий стежок) диалогового окна Object Properties (Свойства 

объекта). 
 
 
 
 
 
 
 

Выберите узор 
 
 
 
 
2 Выберите тип стежка Fancy. 
3 Из открывшегося списка Pattern выберите требуемый узор. 
 Появится обзор образцов узоров. 
 
 
 
 
 
 
 

Введите угол 
 
4 Введите угол в поле Rotate clockwise (Вращение по часовой стрелке). 
 Это значение появится в скобках после имени узора 
5 Нажмите кнопку ОК. 
   
 
 
 
 
   

                                                     
           угол не введен   введен рекомендованный угол 

Настройка интервала между строчками орнаментного заполнения 
Для стежков орнаментного заполнения плотность определяется расстоянием между рядами стежков. 
Настройка интервала – это выбор расстояния между рядами стежков. Настройка интервала между строчками 
для орнаментного заполнения объектов производится таким же образом, как для других типов заполняющих 
стежков. 
 
Как настроить интервал между строчками орнаментного заполнения 
1 Выберите Settings (Настройки) > Object Properties (Свойства объекта). 
2 Выберите закладку Fill Stitch (Заполняющий стежок). 

Дважды щелкните по объекту, чтобы настроить угол стежка только для этого 
объекта. 
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Откроется закладка Fill Stitch (Заполняющий стежок) диалогового окна 
Object Properties (Свойства объекта). 

Настройка интервала  
между стежками 
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3 В поле Stitch Spacing (Шаг стежка) введите новое нужное значение. 

Это значение соответствует расстоянию между каждым передним рядом стежков. 
◄ Для увеличения плотности стежков введите меньшее значение. 
◄ Для уменьшения плотности стежков введите большее значение. 

4 Нажмите кнопку ОК. 

      
   шаг стежков уменьшен  шаг стежков увеличен 
 
Настройка угла наклона строчек орнаментного заполнения 
Вы можете изменять угол строчек орнаментного заполнения, поворачивая их по часовой стрелке. 
 
Как настроить угол наклона строчек орнаментного заполнения 
1 Выберите Settings (Настройки) > Object Properties (Свойства объекта). 
2 Выберите закладку Fill Stitch (Заполняющий стежок). 

Дважды щелкните по объекту, чтобы настроить угол стежка только для этого объекта. 
Откроется закладка Fill Stitch (Заполняющий стежок) диалогового окна Object Properties (Свойства 
объекта). 

 
 
 
 
 

Введите угол  
поворота 

 
3 В поле Rotate Clockwise (Повернуть по часовой стрелке), введите требуемое вам значение угла поворота. 
4 Нажмите кнопку ОК. 

   
Заполнение Brick Fanc     повернуто на 145° y
(Кирпичная кладка)   

Создание эффекта волнистости 
 
Эффект волнистости (Wave Effect) позволяет направлять строчки заполняющих стежков по оцифрованной 
направляющей линии. Стежки следуют по линии, но сохраняют однородную плотность и порядок проколов 
иглой материала. 

                 
Эффект волнистости  Эффект волнистости  
не применен     применен 

Эффект волнистости может быть применен к объектам замкнутой кривой с использованием простегивающих, 
орнаментных или некоторых рукодельных стежков. Для применения этого эффекта к новым объектам 
замкнутой кривой выберите функцию Wave Effect перед оцифровыванием. 
 
Совет: Для получения хороших результатов применяйте короткие стежки, т.е. 4,00 мм или меньше. 
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Как создать эффект волнистости 
1 Выберите объект замкнутой кривой и дважды щелкните по нему. 
 
 Откроется диалоговое окно Object Properties (Свойства объекта). 
2 Выберите закладку Fill Stitch и щелкните по кнопке Effects. 
 Откроется диалоговое окно Effects (Эффекты). 
3 Выберите закладку Others (Другие).. 
 
 
 
 
 
 
 

Выберите Wave Effect 
 
4 Проставьте флажок в окошке Wave Effect. 
5 Нажмите кнопку ОК. 
 Эффект волнистости будет применен к выбранному объекту. 

   
Совет: Для изменения кривой выберите объект и затем значок Reshape Object (Изменение формы). 
Перетаскиванием кривой придайте ей требуемую форму и нажмите Enter. 

      
 

Совет: Переключитесь на режим Artistic View (Художественный Просмотр) или просмотрите точки укола 
иглой, чтобы увидеть результат. 

Создание заполнения с плавным тоновым переходом 
 
Функция Gradient Fill (Заполнение с плавным тоновым переходом) изменяет 
плотность рядов строчек заполнения от весьма плотного до весьма редкого, 
создавая теневые и цветовые эффекты, которые трудно было бы получить 
вручную. В вашем распоряжении четыре типа эффекта Gradient Fill.  
    
Если вы используете эффект Gradient Fill, текущие настройки интервала 
между строчками игнорируются. Однако другие эффекты вышивания 
сохраняются. 
 
Совет: Вы можете использовать функцию Gradient Fill with для создания 
интересных теневых эффектов. 
 
Применение заполнения с плавным тоновым переходом 
Используйте функцию Gradient Fill для смешения цветов, создания эффектов перспективы и тени. 

 
миним. шаг стежка      макс. шаг стежка 
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Вы можете применить ее, используя текущие настройки в диалоговом окне Effects. Они могут быть 
отрегулированы, а тип заполнения с плавным тоновым переходом изменен как до. так и после применения. 
 
Как применять заполнение с плавным тоновым переходом 
1 Выберите объект и дважды щелкните по нему. 
 Откроется закладка Fill Stitch (Заполняющий стежок) диалогового окна Object Properties (Свойства 
объекта). 
2 Нажмите кнопку Effects (Эффекты). 
 Откроется диалоговое окно Effects (Эффекты). 
3 Выберите закладку Effects > Gradient Fill  
 
 
 
Выберите Gradient Fill 
 
 
 
 
 
4 Проставьте флажок в окошке Gradient Fill  

Эффект будет применен к новым или выбранным объектам на основе текущих настроек функции Gradient 
Fill. 

 
Настройка шага стежков плавного тонового перехода  
Выберите тип заполнения с плавным тоновым переходом и установите в диалоговом окне Effects 
максимальный и минимальный шаг стежков.  
 
Как настроить шаг стежков плавного тонового перехода  
1 Щелкните правой кнопкой мыши по объекту с заполнением плавным тоновым переходом. 
 Откроется закладка Gradient Fill диалогового окна Effects. 
 

 
Установите значение  

шага стежков 
 
 
2 Передвигайте ползунок, чтобы отрегулировать значение, или введите новую величину. 

       
 макс. шаг: 1 мм    миним. шаг: 3 мм 

 
3 Нажмите кнопку ОК. 
 

Совет: Чтобы стабилизирующие стежки не проступали через стежки заполнения, уберите флажок из окошка 
Underlay. См. также Упрочнение и стабилизация ткани стабилизирующими стежками. 

Создание открытых заполнений 
 
Эффект Travel on Edges (Перемещение по краям) создает очень открытое заполнение, 
часто используемое в качестве фона или для заполнения крупных форм. Используйте эту 
функцию совместно с эффектом Заполнения с плавным тоновым переходом. чтобы 
избежать выполнения соединительных стежков внутри объекта. Этим создается более 
сглаженное заполнение с редкими стежками. Используйте эту функцию совместно с 
эффектом Color Blending (Смешивание цветов), чтобы избежать выполнения 
соединительных стежков внутри объекта со смешиванием цветов. 
 

Объект с эффектом  
Travel on Edges  

 

231



Глава 24: Эффекты художественного вышивания 

BERNINA® Artista Designer Plus Версия 4 

Примечание: Функция Travel on Edges применима только к объектам замкнутой кривой с простегивающими 
стежками.  Другие типы объектов не требуют этой функции. 
 
Как создать открытое заполнение 
1 Выберите объект и дважды щелкните по нему. 
 Откроется диалоговое окно Effects > Others. 
 
 
 
 
 

Выберите Select  
Travel on Edges 

 
2 Проставьте флажок в окошке Travel on Edges (Перемещение по краям). 
3 Нажмите кнопку ОК. 

Переходные стежки и перекрывающие строчки будут удалены, будет применен существующий шаг стежков. 
 

          
Эффект Travel on Edges    Эффект Travel on Edges  

ОТКЛЮЧЕН        ВКЛЮЧЕН 

Создание эффекта смешивания цветов 
 
Используйте инструмент Color Blending (панель Design) для создания эффектов тени и перспективы.  
 

Эффект Color Blending (Смешивание цветов) автоматически создает различные 
теневые, перспективные и трехмерные эффекты путем смешивания двух 
цветных слоев в одном объекте вышивки. Этот эффект создается путем 
дублирования объекта, затем применения функций Gradient Fill и Travel on Edges 
к обоим слоям, которые потом объединяются в группу. Имеются два разных 
эффекта смешивания цветов: 
◄ линейный шаг стежков 
◄ криволинейный шаг стежков 
 
 
Эффект смешения цветов может быть применен к объектам, заполненным 
гладьевыми, простегивающими или орнаментными стежками, или к объектам, оконтуренным гладьевыми или 
краеобметочными стежками. 
 
Применение эффекта смешивания цветов 
 
Щелкните по значку Color Blending (панель Stitch Types) для применения этого эффекта к новым или выбранным 
объектам. 

 
Используйте функцию Color Blending для смешения цветов, создания эффектов перспективы и тени. 
 

    
миним. шаг стежка     макс. шаг стежка 
 
Вы можете применить ее, используя текущие настройки в диалоговом окне Effects. Они могут быть 
отрегулированы, а тип смешивания цветов изменен как до, так и после применения. 
 

232



Глава 24: Эффекты художественного вышивания 

BERNINA® Artista Designer Plus Версия 4 

Как применять смешивание цветов 
1 Выделите объект. 
2 Щелкните по значку Color Blending (Смешивание цветов). 

Эффект будет применен к новым или выбранным объектам на основе текущих настроек функции Color 
Blending. 

 
Настройка параметров функции Color Blending  
Выберите тип смешивания цветов и установите в диалоговом окне Color Blending максимальный и 
минимальный шаг стежков.  
 
Как настраивать параметры функции Color Blending  
1 Щелкните правой кнопкой мыши по значку Color Blending (Смешивание цветов). 
 Откроется закладка Color Blending диалогового окна Effects. 
 
 
 
 

Выберите эффект  
шага стежка 

 
 

Выберите  
первый цвет 

 
 

Выберите  
второй цвет 

 
2 На панели Profiles щелкните по одному из значков  Spacing Effect (Эффект шага стежка). 

    
Нижний слой: Profile1   Нижний слой: Profile3 
Верхний слой: Profile1  Верхний слой: Profile3 
 
3 На панели Bottom Layer (Нижний слой) 

◄ Выберите цвет первого слоя. 
◄ Введите, если требуется, новые значения шага стежка. 

4 На панели Top Layer (Верхний слой) 
◄ Выберите цвет второго слоя. 
◄ Введите, если требуется, новые значения шага стежка. 

5 Нажмите кнопку ОК. 

     
Нижний слой: красный  Нижний слой: желтый 
Верхний слой: желтый  Верхний слой: красный 

 
Совет: Чтобы стабилизирующие стежки не проступали через стежки заполнения, уберите флажок из окошка 
Underlay. См. также Упрочнение и стабилизация ткани стабилизирующими стежками. 

 
Редактирование объектов со смешиванием цветов 
Редактирование объекта со смешиванием цветов. Два объекта должны быть вначале разгруппированы, и 
отдельные объекты редактируются в соответствии с настройками функции Gradient Fill. Подробнее см. в 
разделе Настройка шага стежков плавного тонового перехода. 
Примечание: Если вы редактируете сгруппированный объект, эффект смешивания цветов будет потерян, 
поскольку оба слоя имеют одни и те же настройки. 
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Как редактировать объекты со смешиванием цветов 
1 Выберите объект со смешиванием цветов и разгруппируйте его. 
2 Выберите один из объектов. 
3 Измените цвет. 
4 Дважды щелкните, чтобы открыть диалоговое окно Object Properties (Свойства объекта). 
5 Выберите закладку Effects > Gradient Fill  
 
 
 
 

Выберите Gradient Fill 
 
 

Настройте шаг стежков 
 
6 Выберите профиль 
7  Настройте шаг стежков 
8  Нажмите кнопку ОК. 
9  Повторите эти операции для второго объекта и разгруппируйте объекты. 
 
 

234



Глава 25: Оконтуривание и заполнение узорами 

BERNINA® Artista Designer Plus Версия 4 

Глава 25  
 
 
 
Оконтуривание и заполнение 
узорами 
 
Узоры – это предварительно определенные элементы дизайна, такие 
как сердечки, листья или узоры бордюра, которые могут быть быстро 
вставлены в проект. Они обычно состоят из одного или нескольких 
простых объектов и сохраняются в специальном комплекте узоров. 
Вы можете создавать собственные узоры или использовать узоры, 
входящие в программное обеспечение. Узоры можно масштабировать, 
поворачивать и переводить в зеркальное отображение таким же 
образом, как и другие объекты. Вы можете использовать узоры, 
расположенные вдоль оцифрованной линии. Можно также заполнять 
формы рядами повторяющихся узоров и применять специальные эффекты, используя функцию 
Pattern Fill (Узорное заполнение). 
В этом разделе описывается, как вставлять узоры в проект и как подгонять их настройки, чтобы 
получать наилучшие результаты. Также объясняется, как создавать собственные узоры и комплекты 
узоров. 
 

Создание цепочки узоров 
 
Цепочка узоров - Pattern Run – это тип стежков, которые создают повторяющиеся узоры 
вдоль оцифрованной линии. Вы можете создавать декоративные контуры, используя 
любой узор из списка. Вы можете изменять угол поворота, ориентацию и размеры, а 
также интервал между узорами. 
 
Выбор и вставка цепочки узоров 
Выбирайте цепочку узоров до или после оцифровывания. Если вы используете цепочку 
узоров без выбора узора, то будет применен узор по умолчанию. См. также Создание цепочки узоров. 
 
Как выбирать и вставлять цепочки узоров 
1  Убедитесь в том, что не выбран ни один объект. 
2  Выберите Settings (Настройки) > Object Properties (Свойства объекта). 
 Откроется диалоговое окно Object Properties (Свойства объекта). 
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3  Выберите закладку Outline Stitch (Оконтуривающий стежок) и затем выберите Pattern Run из списка Stitch 
Type (Тип стежка).  
 
 

Выберите Pattern Run 
 
 

Нажмите Select, чтобы  
выбрать узор 

 
 
 
4 Нажмите кнопку Select. 

Откроется диалоговое окно Select Pattern (Выбор узора), в котором показываются все имеющиеся узоры.  
 
Выберите комплект  

узоров. 
 
 
 
 

Выберите узор. 
 
 
 
 
 
 

Номер выбранного  
узора 

 
5 Выберите комплект узоров из списка Pattern Set. 
6 Выберите режим просмотра. 
 Вы можете выбирать узоры по картинке, имени или по обоим признакам. 
7  Выберите узор. 
 Будет отображено имя или номер узора. 
8  Щелкните по кнопке Make Current (Сделать текущим). 
9  Щелкните по кнопке OK, чтобы закрыть диалоговое окно. 
10 Оцифруйте форму, используя инструменты Open Curve (Незамкнутая кривая), 

Closed Curve (Замкнутая кривая), Circle (Окружность) или Rectangle 
(Прямоугольник).  

11 Нажмите Enter. 
 Узор оцифрован вдоль линии. 
 
     
 
Изменение цепочки узоров 
Выберите узор для использования в цепочке узоров до или после оцифровывания. Выбирайте узор до 
оцифровывания, как описано в разделе Выбор и вставка цепочки узоров. Если вы используете Outline Pattern 
(Оконтуривание узорным стежком) без выбора узора, то будет применен узор по умолчанию. Для изменения 
узора после оцифровывания используйте диалоговое окно Object Properties, как описано в разделе Как 
изменить цепочку узоров. 
 
Примечание: Если цепочка узоров не соответствует цвету, который вы выбрали в палитре цветов при первом 
оцифровывании, выберите контур после оцифровывания, затем выберите цвет. 

   
узор выбран до    узор изменен после  
оцифровывания    оцифровывания 
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Примечание: Подробнее см. в разделе Примеры оконтуривания и заполнения узорами. 
 
Как изменять цепочки узоров 
1  Выберите и дважды щелкните по объекту с оконтуриванием узором. 
 Откроется закладка Outline Stitch (Оконтуривающий стежок) диалогового окна Object Properties (Свойства 

объекта). 
 

Выберите Pattern Run  
 

Нажмите Select,  
чтобы выбрать узор 

 
 
 
 
2  Нажмите кнопку Select. 
 Откроется диалоговое окно Select Pattern (Выбор узора). 
3  Выберите узор из списка. 
 Подробнее см. в разделе Выбор и вставка цепочки узоров. 
4 Нажмите кнопку ОК. 
 
Настройка размера узоров и интервала между узорами 
Вы можете вставить цепочку узоров оригинального размера и ориентации и после этого изменить интервалы 
между узорами. Вы можете также установить точный размер и величину интервала до вставки цепочки узоров. 
Подробнее см. в разделе Выбор и вставка цепочки узоров. В данном случае интервал – это расстояние между 
каждым повторением узора. 
 
 
 
 

первоначальный интервал 
 
 
 
 
 

увеличенный интервал 
 
Если цепочка узоров не точно соответствует базовой линии, 
BERNINA artista проведет требуемые изменения интервала: 
◄ Если интервал, остающийся в конце базовой линии, меньше половины длины узора, то этот остаток 

равномерно распределяется между узорами.  
◄ Если интервал больше половины длины узора, то BERNINA artista вставит дополнительный узор с 

небольшим взаимным перекрытием для равномерного распределения по базовой линии. 
 
Совет: Вы можете изменить форму базовой линии, чтобы получить требуемый вам точный интервал. 
Подробнее см. в разделе Изменение формы цепочки узоров. 
 
Как настроить размер узоров и интервал между узорами 
1  Выберите и вставьте цепочку узоров. 

Подробнее см. в разделе Выбор и вставка цепочки узоров. 
2  Выберите объект и дважды щелкните по нему. 

Откроется диалоговое окно Object Properties (Свойства объекта). 
Глава 25: Оконтуривание и заполнение узорами 
 
 
 
Введите размер  
оконтуривающей  
цепочки узоров 
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3  В поле Size (Размер)  введите размер цепочки узоров. 
 
 

размер увеличен 
 
 
 

стандартный размер 
 

 
размер уменьшен 

 
4 Если размер задан правильно, отрегулируйте интервал (Spacing). 
 
 

увеличенный интервал 
 
 

стандартный интервал 
 
 
 

уменьшенный интервал 
 
5 Нажмите кнопку OK и проверьте окончательный контур. 
 

Совет: Вы можете также изменить размеры цепочки узоров, используя маркеры выделения. Подробнее см. 
в разделе Изменение размеров объектов. 

 
Изменение формы цепочки узоров 
Форма цепочки узоров изменяется инструментом Reshape (Изменение формы) таким же образом, как вы 
изменяете форму текстового объекта. Вы можете сделать 
цепочку узоров выше или уже, поворачивать цепочку узоров, 
перемещать индивидуальные узоры по базовой линии или 
изменять форму базовой линии. Вы можете поворачивать, 
наклонять и переводить в зеркальное отображение цепочку 
узоров таким же образом, как и другие объекты. См. разделы 
Вращение объектов, Перекос объектов и Перевод объектов в 
зеркальное отображение. 
                        оригинальный   узкие узоры   широкие узоры 
                       размер узора 
Как изменять форму цепочки узоров 
1  Выберите цепочку узоров для изменения формы, затем щелкните по 

Reshape (Изменение формы). 
     

отображены контрольные точки 
 

2  Перетащите контрольные точки изменения формы, чтобы изменить 
внешний вид цепочки узоров. 
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перетащите для перемещения  
индивидуальных узоров      перетащите, чтобы сделать узоры выше  
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переместите базовую линию или добавьте  
контрольные точки 

 
перетащите, чтобы сделать узоры уже  

 
перетащите, чтобы сделать узоры  
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пропорционально уже и выше 

Создание узорного заполнения 
 
Узорное заполнение Pattern Fill – это заполнение декоративными стежками, которое 
можно применять к объектам замкнутой кривой. Эта функция обеспечивает 
заполнение формы параллельными рядами узоров. Вы можете компоновать узоры 
на экране или с использованием настроек в диалоговом окне Object Properties 
(Свойства объекта). 
 
Добавление узорного заполнения 
Применяйте функцию Pattern Fill к объектам замкнутой кривой или прямоугольника для создания декоративного 
заполнения с использованием текущих настроек узорного заполнения. Вы можете выбрать узор или изменить 
компоновку и настройки как до, так и после оцифровывания. Подробнее см. в разделе Компоновка узорного 
заполнения на экране. 
 
Примечание: Если узорное заполнение не соответствует цвету, который вы выбрали в палитре цветов при 
первом оцифровывании, выберите контур после оцифровывания, затем выберите цвет. 
 
Как добавить узорное заполнение 
1  Щелкните по значку Closed Curve (Замкнутая кривая) или Rectangle (Прямоугольник). 
2  Оцифруйте объект обычным способом. 
 

Примечание: Угол наклона стежка не влияет на расположение узоров. 
 
3  Выберите объект и дважды щелкните по нему. 

Откроется закладка Outline Stitch (Заполняющий стежок) диалогового окна Object Properties (Свойства 
объекта). 

 
 

4 Выберите Pattern Fill (Узорное заполнении) из списка Stitch Type (Тип стежка) 
5 Выберите узор. 

Подробнее см. в разделе Выбор узоров для использования в узорном заполнении. 
 

Примечание: Если больше половины узора находится за пределами контура, он может быть подрезан 
вдоль контура. 

6 Нажмите кнопку OK. 
Оцифрованный объект будет заполнен текущим узорным заполнением. 

 
Выбор узоров для использования в узорном заполнении 
Выберите узоры для заполнения в диалоговом окне Object Properties.  
 
Примечание: Подробнее см. в разделе Примеры оконтуривания и заполнения 
узорами. 
 

Как выбирать узоры для использования в узорном заполнении 
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1  Выберите объект с узорным заполнением и дважды щелкните по нему. 
 Откроется закладка Fill Stitch (Заполняющий стежок) диалогового окна 

Object Properties (Свойства объекта). 
Выберите комплект  

узоров и нажмите Select 
 
 

Выберите узор 
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2  Нажмите кнопку Select, чтобы открыть диалоговое окно Select Pattern. 
 Откроется диалоговое окно Select Pattern (Выбор узора). 
3  Выберите узор из списка. 
4 Нажмите кнопку ОК. 
 
Компоновка узорного заполнения на экране 
Вы можете расположить узоры заполнения на экране, используя "направляющие узоры", чтобы 
масштабировать, трансформировать и смещать все узорное заполнение. Имеются три синих направляющих 
узоров. Другие примеры узоров появляются желтыми. Каждый направляющий узор позволяет изменять 
различные элементы компоновки. Если вы изменяете направляющий узор, соответственно изменяются все 
узоры заполнения. 
 
Совет: Вы можете также использовать этот метод для изменения заполнения черными узорами (Blackwork Fill), 
заполнения узелковыми строчками (Candlewicking Fill) и заполнения стежками кружевного переплетения 
(Lacework). 
 
 

Используйте верхний направляющий узор для  
изменения интервала между рядами,  

смещения рядя и масштабирования всех  узоров 
 
 
 
 
Используйте средний направляющий узор    Используйте боковой направляющий узор  
для перемещения, вращения, наклона  и     для изменения интервала между колонками и  
масштабирования всех узоров      масштабирования всех  узоров 
 
Совет: Как правило, расположение узоров определяется до оцифровывания объекта. Если важно, чтобы узоры 
были выровнены по контуру объекта, то нужно оцифровывать объект с использованием текущих настроек и 
после этого изменять расположение узоров. 
 
Как компоновать узорное заполнение на экране 
1  Дважды щелкните по объекту с узорным заполнением. 
 Откроется закладка Fill Stitch (Заполняющий стежок) диалогового окна Object Properties (Свойства 

объекта). 
 

Щелкните по кнопке Layout 
 
2  Щелкните по кнопке Layout (Размещение). 
Диалоговое окно Object Properties закроется и в окне проекта 
появится желтый узор и синие направляющие узоры.  Если вы 
изменяете направляющий узор, соответственно изменяются все 
узоры заполнения. 
 
 

 
Совет: Увеличьте изображение на экране, чтобы правильно выбрать направляющий узор. 
3  Настройте положение направляющих узоров, чтобы получить нужный эффект. 

◄ Перемещайте узоры путем выделения среднего направляющего узора и перетаскивания его в новое 
положение. 

◄ Масштабируйте узоры путем выделения направляющего узора и изменения его размеров с 
использованием маркеров выделения. 

 
пропорциональное изменение размеров 

    
 
 

Изменение размера по горизонтали 
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Изменение размера по вертикали 

◄ Вращайте узоры, дважды щелкнув по среднему направляющему узору, чтобы отобразить маркеры 
вращения. Щелкните по угловому маркеру и перетащите его, чтобы повернуть узор. 

◄ Перекашивайте узоры, дважды щелкнув по среднему направляющему узору, чтобы отобразить 
маркеры перекоса. 

вращение 
   

 
анкер 

  
наклон 

 
 
 
 
 
 

 
◄ Изменяйте интервал между колонками, выбрав боковой направляющий узор и перетащив его влево или 

вправо. 

      
Изменение интервала между колонками 

 
◄ Изменяйте интервал между рядами, выбрав верхний направляющий узор и перетащив его вверх или 

вниз. 
◄ Изменяйте смещение рядов, выбрав верхний направляющий узор и перетащив его влево или вправо. 

Изменение смещения искажает ряды. 
 

Изменение интервала между рядами 
 
 

Изменение смещения 
 
 
4 Нажмите Enter для завершения. 

Выбранные вами настройки размеров и размещения становятся текущими настройками функции Pattern Fill. 

Управление узорами 
 
BERNINA artista предоставляет различные возможности управления узорами, включая  составление 
комплектов узоров, сохранения узоров, копирование узоров из одного комплекта в другой и удаление узоров. 
 
Создание собственных комплектов узоров 
 
Используйте команду Create Pattern (меню Settings) для создания собственного комплекта узоров.  
 
Функция Create Pattern (Создание узора) позволяет создавать собственные комплекты узоров для организации 
и классификации ваших узоров.  
 
Как создавать собственные комплекты узоров 
1  Выберите объект, который вы хотите сохранить в качестве узора. 
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2  Выберите Settings (Настройки) > Create Pattern (Создать узор). 
 Откроется диалоговое окно Create Pattern. 

 
 
 
 
Щелкните по New Set для создания  
нового комплекта узоров 
 
 

3  Щелкните по кнопке New Set (Новый комплект). 
 Откроется диалоговое окно New Pattern Set (Новый комплект узоров). 
 

Ввод имени нового  
комплекта узоров 

 
 
 
 
4 Введите имя нового комплекта узоров и нажмите OK. 
 Комплект узоров готов для использования. 
 

Примечание: Комплекты узоров хранятся в папке C:\BERNINA artista\Userletw. 
 
Создание собственных цепочек узоров 
Вы можете создавать собственные цепочки узоров и сохранять их в комплекте узоров. Оцифруйте объект слева 
направо, так чтобы стежки не пересекали форму при соединении. 
Требуется только одна завершенная часть узора. Например, если вам требуется цепочка узоров из 
соединенных ромбов, то вам нужно оцифровать только один ромб, но если ваш узор состоит из серий ромбов и 
квадратов, то необходимо оцифровать ромб, соединенный с квадратом. 
 
Как создавать собственные цепочки узоров 
1  Выберите объект или объекты, которые вы хотите сохранить в качестве цепочки узоров. 
 
выбранный объект  
 
 
 
 
 

Совет: Для создания объектов с отверстиями подробнее см. в разделе Вырезание отверстий и удаление 
перекрывающих стежков. 

2  Выберите Settings (Настройки) > Create Pattern (Создать узор). 
 Откроется диалоговое окно Create Pattern. 
 
 
 

Выберите комплект узоров 
 

Введите имя нового узора 
 
 
3  Выберите комплект узоров из списка Pattern Set. 
 

Примечание: Выбирайте комплект узоров внимательно, так чтобы вы могли вспомнить, где вы сохранили 
ваш новый узор. Вы можете не найти его в списке в диалоговом окне Select Pattern (Выберите узор). В папке 
Designs отображены только файлы комплектов узоров, но не индивидуальные узоры. 

4 Введите имя для вашего нового узора. 
5 Нажмите кнопку ОК. 

Вам будет предложено оцифровать базисные точки. 
 
6 Щелкните, чтобы наметить две базовые точки узора. 
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Наметьте базисные точки. 
 

◄ Базисные точки устанавливают стандартную ориентацию узора. 
◄ Базисные точки устанавливают также интервал между каждым повторением узора. 

 Появится сообщение о подтверждении. 
 

      
7  Нажмите кнопку ОК. 
8  Проверьте ваш новый узор, следуя указаниям раздела Выбор и вставка цепочки узоров. 
 
Удаление узоров 
Можно удалить любой не нужный вам узор из комплекта узоров. 
 
Как удалить узор 
1  Выберите Settings (Настройки) > Object Properties (Свойства объекта). 
2  Выберите закладку Outline (Оконтуривание), затем выберите Pattern Run или Pattern Fill из списка Stitch 

Type (Тип стежка). 
 
 

Выберите Pattern Run 
 
 
 
 
 
 
3  Нажмите кнопку Select. 
 Откроется диалоговое окно Select Pattern (Выбор узора). 
 

Номер выбранного  
узора 

 
 
 
 
 

Выберите узор для  
удаления 

 
 
 

Выберите комплект  
узоров. 

 
4 Выберите узор для удаления 
5 Нажмите кнопку Delete (Удалить). 
 Появится сообщение о подтверждении. 
6 Нажмите кнопку ОК. 
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Глава 26  
Оконтуривание и заполнение 
рукодельными стежками 
 
BERNINA artista предлагает ряд "рукодельных" стежков, которые вы 
можете использовать в своих проектах для имитации некоторых 
традиционных ручных вышивок. Сюда входит большой выбор 
черно-белых узоров "blackwork" и узелковых узоров "candlewicking", 
подходящих как для оконтуривания, так и для заполнения объектов. 
Подробнее см. в разделе Образцы узоров рукодельных стежков. 
Стежок "назад в иголку" (Backstitch) и стебельчатый стежок (Stemstich) 
являются двумя разными оконтуривающими стежками. Стежок "назад в 
иголку" образует непрерывную тонкую линию, подобную машинной 
строчке, в то время как стебельчатый стежок образует шнуроподобную строчку, толщину которой 
можно изменять в зависимости от угла наклона стежков. Оба стежка могут быть использованы для 
создания ровных рядов стежков, пригодных для оконтуривания и образования черно-белых узоров 
blackwork. 
Стежки кружевного переплетения (Lacework) и пунктирные стежки (Stipple) используются для 
декоративного заполнения. Кружевное переплетение можно использовать для придания таким 
объектам, как цветы, вид кружева. Строчки пунктирного простегивания, известные также, как 
"вермишель", образуют плавные произвольные линии, используемые для декоративных эффектов 
или для стежки квилтов. 
В этом разделе поясняется, как выбирать типы рукодельных стежков, а также изменять настройки 
стежков для получения наилучших результатов. 
 

Создание контуров рукодельными стежками 
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Щелкните по значку Outline (панель Stitch & Color) для выбора оконтуривающих стежков. 
 
 
 
Используйте инструмент Blackwork Border (панель Craft Stitch) для оконтуривания в технике blackwork.  
 
 
Используйте инструмент Candlewicking Border (панель Craft Stitch) для обрамления в технике 
candlewick. 
 
 
 
Используйте инструмент Backstitch (панель Craft Stitch) для обрамления стежками "назад в иголку". 
 
 
 
Используйте инструмент Stemstitch (панель Craft Stitch) для обрамления стебельчатыми стежками. 
 

 
Различные типы стежков подходят для различных форм. Когда вы оцифровываете объект, используется 
текущий тип стежка для выбранного метода оцифровывания. Однако вы можете изменить тип стежка в любое 
время. Подробнее см. в разделе Настройка текущих свойств объекта. 
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Как создать контур рукодельными стежками 
1 Выберите нужный вам оконтуривающий рукодельный стежок, щелкнув по 
значку. 
2 Создайте незамкнутую или замкнутую фигуру. 
 Подробнее см. в разделе Методы оцифровывания. 
3 Нажмите Enter. 
 Выбранный тип стежка будет применен к оцифрованному объекту. 
 

Совет: Вы можете быстро перейти от заполнения к оконтуриванию рукодельными стежками, используя 
кнопки на панели Craft Stitch. См. также Создание заполнения рукодельными стежками. 

 

Настройка контуров обрамления в технике Blackwork  
 
Используйте инструмент Blackwork Border (панель Craft Stitch) для оцифровывания обрамления в 
технике blackwork.  

 
Техника Blackwork (дословно "черная работа") получила свое название от черных 
шелковых ниток, используемых в этом виде вышивания. В более ранних проектах 
преобладали угловатые мотивы, тогда как теперь больше используются диагональные 
стежки. 
В технике Blackwork используется лишь несколько простых стежков для создания 
комплексных проектов. Эта техника может быть использована для декорирования 
предметов одежды или украшения, например, носовых платков, скатертей и салфеток. 
Используйте инструменты Open Curve (Незамкнутая кривая), Closed Curve (Замкнутая 
кривая), Circle (Окружность) или Rectangle (Прямоугольник) для создания 
направляющей линии обрамления в технике Blackwork. 
 
Настройка размеров и интервала элементов обрамления Blackwork  
Отрегулируйте настройки, чтобы получить желаемые точные результаты. Вы можете назначить точные 
размеры каждого узора, а также интервала между узорами. 
 
Как настраивать размеры и интервалы элементов обрамления Blackwork  
1 Выберите объект и дважды щелкните по нему. 
 Откроется закладка Outline Stitch (Оконтуривающий стежок) 
диалогового окна Object Properties (Свойства объекта). 
 
 
 

Введите размер и величину  
интервала 

 
2 Выберите Blackwork Border из списка Stitch Type. если этот стежок 

еще не был выбран. 
3 В поле Size (Размер)  введите новый размер. 

     
уменьшение размера 

 
4 В поле Spacing (Интервал) введите новое нужное значение. 

◄ Для увеличения плотности стежков введите меньшее 
значение. 

◄ Для уменьшения плотности стежков введите большее значение. уменьшенный интервал 
 
5 Нажмите кнопку ОК. 
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Выбор узоров обрамления Blackwork  
Добавляйте различные узоры blackwork к вашему проекты путем выбора 
в диалоговом окне Select Pattern (Выбор узора). 
 
      
 
Как выбирать узоры обрамления Blackwork  
1 Выберите объект и дважды щелкните по нему. 
 Откроется закладка Outline Stitch (Оконтуривающий стежок) диалогового окна Object Properties (Свойства 

объекта). 
 
 

Нажмите Select,  
чтобы выбрать узор 

 
 
 
 
 
 
2 Выберите Blackwork Border из списка Stitch Type. если этот стежок еще не был выбран. 
3 Нажмите кнопку Select. 
 Откроется диалоговое окно Select Pattern (Выбор узора). 
 
 
 

Выберите режим просмотра 
 
 
 

Выберите  
узор 

 
 
    
 
 
 
 
 
 
4 Выберите режим просмотра. 
 Вы можете выбирать узоры по картинке, имени или по обоим признакам. 
5 Выберите узор. 
6 Нажмите кнопку ОК. 
 

Примечание: Обрамление blackwork может не подойти к текущему выбранному цвету. Если это так, то 
выберите объект обрамления и затем выберите цвет. 

 

Настройка оконтуривающих стежков "назад в иголку" 
 
Используйте инструмент Backstitch (панель Craft Stitch) для 
оцифровывания обрамления стежками "назад в иголку". 

 
Стежок "назад в иголку" (Backstitch) является старым легко приспосабливаемым 
стежком, который может быть использован для изысканного оконтуривания. 
Строчка этого стежка хорошо вписывается в замысловатые кривые, Эти стежки 
небольшие и ровные, так что они точно располагаются на очертании кривой Стежок 
"назад в иголку" может быть использован для проектов "черной" и "красной" 
вышивки. Отрегулируйте настройки, чтобы получить желаемые точные результаты. 
Вы можете назначить точную длину стежка, толщину и величину перекрытия, а 
также число строчек. 
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Как настраивать оконтуривающие стежки "назад в иголку" 
1 Выберите объект и дважды щелкните по нему. 
 Откроется закладка Outline Stitch (Оконтуривающий стежок) диалогового 

окна Object Properties (Свойства объекта). 
Введите длину стежка,  

толщину контура и  
величину перекрытия 

 
 
 
 

Выберите число строчек 
 
2 Выберите Backstitch из списка Stitch Type, если этот стежок еще не был выбран. 
3 В поле Stitch Length (Длина стежка) введите новое 
нужное значение. 

       
Длина стежка: 1,5 мм     Длина стежка: 3,5 мм 

4 В поле Stitch Thickness (Толщина строчки 
стежка) введите новое нужное значение. 

           
Толщина строчки: 0,25 мм   Толщина строчки: 0,15 мм 
 

5 В поле Overlap (Перекрытие) введите новое 
значение. 

            
            Перекрытие: 30 %     Перекрытие: 70 % 

6 Введите число строчек. 

                 
Число строчек: 3   Число строчек: 5 

 

 
7 Нажмите кнопку ОК. 

Настройка оконтуривания стебельчатым стежком 
 
Используйте инструмент Stemstitch (панель Craft Stitch) для оцифровывания 
обрамления стебельчатыми стежками. 
 

Стебельчатый стежок (Stemstitch) является детализированным стежком, который может 
быть использован для оконтуривания или заполнения форм. Он используется для вышивки 
стеблей и виноградной лозы вместе с другими декоративными стежками или в качестве 
оконтуривающих стежков совместно с гладьевыми заполняющими стежками. Отрегулируйте 
настройки, чтобы получить желаемые точные результаты. Вы можете назначить точную 
длину стежка, толщину и величину перекрытия, а также число строчек. 
 
Как настраивать оконтуривающие стебельчатые стежки 
1 Выберите объект и дважды щелкните по нему. 
 Откроется закладка Outline Stitch (Оконтуривающий стежок) диалогового 

окна Object Properties (Свойства объекта). 
 

Введите значения толщины,  
 интервала и угла наклона 

 
 
 

Выберите тип стебельчатого  
стежка 
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2 Выберите Stemstitch из списка Stitch Type, если этот стежок еще не был выбран. 
3 В поле Line Thickness (Толщина линии) введите 
новое нужное значение. 

               
     Толщина линии: 1,0 мм  Толщина линии: 1,5 мм 

4 В поле Spacing (Шаг стежка) введите нужное 
значение. 

               
Шаг: 1,2 мм      Шаг: 0,8 мм 

 
5 В поле Angle (Угол) введите нужное значение. 

                   
Угол: 90°     Угол: 45° 

 

6 Выберите Single (Одинарный) или Triple (Тройной). 

                
Тип: тройной     Тип: одинарный 

 
 
7 Только для Тройного в поле Stitch Thickness (Толщина стежка) введите нужное значение. 
 

                     
Тройной стежок     Тройной стежо  к
Толщина: 0.15      Толщина: 0.25 

 
 
8 Нажмите кнопку ОК. 

Настройка контуров обрамления в технике Candlewicking  
 
Используйте инструмент Candlewicking Border (панель Craft Stitch) для оцифровывания обрамления в 
технике candlewicking.  

 
Стежок для узелкового обрамления (Candlewicking Border) может быть использован 
для оконтуривания участков проекта вышивки. См. также Настройка заполнения 
строчками в технике Candlewicking. 
 
Примечание: Если обрамление candlewicking не соответствует цвету, который вы 
выбрали в палитре цветов при первом оцифровывании, выберите контур после 
оцифровывания, затем выберите цвет. 
 
Настройка размеров и интервала элементов обрамления 
Candlewicking  
Отрегулируйте настройки, чтобы получить желаемые точные результаты. Вы можете назначить точные 
размеры каждого узора, а также интервала между узорами. 
 
Как настроить размер и интервал обрамления Candlewicking  
1 Выберите объект и дважды щелкните по нему. 
 Откроется закладка Outline Stitch (Оконтуривающий стежок) диалогового окна Object Properties (Свойства 

объекта). 
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Введите размер стежка  
и интервал 

 
 
 
2 Выберите Candlewicking Border из списка Stitch Type. если этот стежок еще не был выбран. 
 
3 В поле Size (Размер)  введите новый размер. 

 
Размер: 2 мм      Размер: 3 мм 

 

4 В поле Spacing (Шаг стежка) введите нужное 
значение. 

 
Шаг: 3 мм      Шаг: 6 мм 

 
 
5 Нажмите кнопку ОК. 
 
Выбор узоров обрамления Candlewicking  
Добавляйте различные узоры candlewicking к вашему проекту путем 
выбора в диалоговом окне Select Pattern (Выбор узора). 
 
Как выбирать узоры обрамления Candlewicking  
1 Выберите объект и дважды щелкните по нему. 
 Откроется закладка Outline Stitch (Оконтуривающий стежок) 

диалогового окна Object Properties (Свойства объекта). 
 
 
 
Нажмите Select, чтобы  
выбрать узор 
 
 
 
 
 
 
2 Выберите Candlewicking Border из списка Stitch Type. если этот стежок еще не был выбран. 
3 Нажмите кнопку Select. 
 Откроется диалоговое окно Select Pattern (Выбор узора). 
 

                                   Выберите режим  
просмотра 

 
 

Выберите  
узор 

 
 
4 Выберите режим просмотра. 
 Вы можете выбирать узоры по   
картинке, имени или по обоим  
признакам. 
5 Выберите узор. 
6 Нажмите кнопку ОК. 
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Создание заполнения рукодельными стежками 
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Нажмите кнопку Fill (Заполнение) на панели Stitch & Color (Стежок и Цвет) для выбора заполняющих 
стежков. 
 
 
Используйте инструмент Blackwork Fill (панель Craft Stitch) для заполнения в технике blackwork.  
 
 
 
Используйте инструмент Candlewicking Fill (панель Craft Stitch) для заполнения в технике candlewick. 
 
 
Используйте инструмент Lacework (панель Craft Stitch) для получения специальных кружевных 
эффектов. 
 
 
Используйте инструмент Stipple (панель Craft Stitch) для получения специальных пунктирных эффектов. 
 

BERNINA artista предоставляет четыре вида рукодельных стежков заполнения 
-- Blackwork Fill, Candlewicking Fill, Lacework и Stipple. Различные типы стежков 
подходят для разных форм. Вы можете выбрать эти стежки заполнения с 
помощью панели инструментов Stitch & Color (Стежок и Цвет) или специально 
выделенной для них панели Craft Stitch (Рукодельный Стежок). Подробнее см. 
в разделе Образцы узоров рукодельных стежков. 
 
     
Как создать заполнение рукодельными стежками 
1 Выберите нужный вам заполняющий рукодельный стежок, щелкнув по 
значку. 
2 Создайте замкнутую фигуру (включая окружность или квадрат). 
 Подробнее см. в разделе Методы оцифровывания. 
3 Нажмите Enter. 
 Выбранный тип стежка будет применен к оцифрованному объекту. 
 

Совет: Вы можете быстро перейти от заполнения к оконтуриванию рукодельными стежками, используя 
кнопки на панели Craft Stitch. См. также Создание контуров рукодельными стежками. 

 

Настройка заполнения в технике Blackwork 
 

Используйте инструмент Blackwork Fill (панель Craft Stitch) для заполнения в 
технике blackwork.  

 
Техника Blackwork (дословно "черная работа") получила свое название от черных 
шелковых ниток, используемых в этом виде вышивания. В большинстве случаев при 
таком "черно-белом" заполнении используются простые стежки для создания 
комплексных геометрических узоров. При использовании различных узоров заполнения "блэкуорк" вы можете 
создавать светлые и темные тона участков проекта. Заполнение черными узорами применимо только для 
объектов в виде замкнутых кривых или прямоугольников. См. также Настройка контуров обрамления в технике 
Blackwork. 
С таким заполнением вы можете подогнать компоновку стежков к узорам. Используйте тот же метод, что и при 
узорном заполнении. Подробнее см. в разделе Компоновка узорного заполнения на экране. 
 
Как настраивать заполнение в технике Blackwork  
1 Выберите объект и дважды щелкните по нему. 
 Откроется закладка Fill Stitch (Заполняющий стежок) 

диалогового окна Object Properties (Свойства объекта). 
 
 

Нажмите Select,  
чтобы выбрать узор 
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2 Выберите Blackwork Fill из списка Stitch Type. если этот стежок еще не был выбран. 
3 Нажмите кнопку Select. 
 Откроется диалоговое окно Select Pattern (Выбор узора). 
 
 

Выберите режим просмотра 
 
 
 
 
Выберите узор 
   
 
 
 
 
 
 
 
 
4 Выберите режим просмотра. 
 Вы можете выбирать узоры по картинке, имени или по обоим признакам. 
5 Выберите узор. 
 
 
 
Узор появится в  
панели просмотра 
 
 
 
 
6 Нажмите кнопку ОК. 

 

Настройка заполнения строчками в технике Candlewicking.  

Настройка заполнения строчками в технике Candlewicking.  
Используйте инструмент Candlewicking Fill (панель Craft Stitch) для заполнения в технике candlewick. 
 

Вышивание узелковыми строчками (Candlewicking) является традиционной 
техникой вышивания "белым-по-белому", выполняемому обычно на белой льняной 
или хлопчатобумажной ткани толстыми хлопчатобумажными нитками. Сегодня 
более популярно использование цветных ниток. Применяются в основном стежки, 
образующие узелки, - "колониальные" и "французские", а также стебельчатый 
стежок. Эта техника может использоваться для вышивания на постельных 
покрывалах, наволочках и одежде. Заполнение узелковыми строчками применимо 
только для объектов в виде замкнутых кривых или прямоугольников. См. также 
Настройка контуров обрамления в технике Candlewicking. 
С таким заполнением вы можете подогнать компоновку стежков к заданным узорам. 
Используйте тот же метод, что и при узорном заполнении. Подробнее см. в разделе Компоновка узорного 
заполнения на экране. 
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Как настраивать заполнение в технике Candlewicking  
1 Выберите объект и дважды щелкните по нему. 
 Откроется закладка Fill Stitch (Заполняющий стежок) диалогового окна Object Properties (Свойства 

объекта). 
 
 
 
 
 
 
 
 
 
Нажмите Select, чтобы выбрать узор 
 
 

 
2 Выберите Candlewicking Fill из списка Stitch Type. если этот стежок еще не был выбран. 
3 Нажмите кнопку Select. 
 Откроется диалоговое окно Select Pattern (Выбор узора). 
   
 
 

Выберите режим просмотра 
 

Выберите  
узор 

 
 
 
 
 
 
4 Выберите узор. 
 
 

Узор появится в  
панели просмотра 

 
 
 
5 Нажмите кнопку 
ОК. 

Настройка заполнения стежками кружевного переплетения. 
 
Используйте инструмент Lacework (панель Craft Stitch) для получения специальных кружевных 
эффектов. 

 
Стежки кружевного переплетения образуют похожие на сетку узоры, которые придают объекту вид 
кружеваЗаполнение стежками кружевного переплетения применимо только для объектов в виде замкнутых 
кривых или прямоугольников. С таким заполнением вы можете 
подогнать компоновку стежков к заданным узорам. Используйте тот 
же метод, что и при узорном заполнении. Подробнее см. в разделе 
Компоновка узорного заполнения на экране. 
 
Как настраивать заполнение стежками кружевного 
переплетения 
1 Выберите объект и дважды щелкните по нему. 
 Откроется закладка Fill Stitch (Заполняющий стежок) 

диалогового окна Object Properties (Свойства объекта). 
 

Нажмите Select, чтобы выбрать узор 
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2 Выберите Lacework из списка Stitch Type, если этот стежок еще не был выбран. 
3 Нажмите кнопку Select. 
 Откроется диалоговое окно Select Pattern (Выбор узора). 
 
      

Выберите режим просмотра 
 
 

Выберите  
узор 

 
 
 
 
4 Выберите узор. 
 

 
 

Узор появится в  
панели просмотра 

 
 
 
5 Нажмите кнопку ОК. 

 
 
Настройка пунктирного заполнения 
 
Используйте инструмент Stipple (панель Craft Stitch) для получения 

специальных пунктирных эффектов. 
 
Пунктирные стежки позволяют заполнять объекты извилистыми 
линиями в пределах контура. Этот метод применим для объектов в 

виде замкнутых кривых или прямоугольников, заполняемых стежками с 
единым углом наклона. Вы можете регулировать плотность стежков и 
расстояние между строчками. 
 
 
 
Как настраивать пунктирное заполнение  
1 Создайте и выделите объект замкнутой кривой, окружности или прямоугольника. 
2 Щелкните по значку Stipple. 
 Откроется диалоговое окно Stipple. 
 
 
 
 
 
Введите длину стежка и  
интервал между петлями 
 
 
 
 
 
3 Введите, если требуется, новое значение длины стежка (Stitch Length).  
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Длина стежка: 2,0 мм    Длина стежка: 1,0 мм 

 
4 Введите, если требуется, новое значение интервала между петлями (Loop Spacing).  

 
Интервал между петлями: 3,0 мм     Интервал между петлями: 1,5 мм 
 

Примечание: Однажды установив, вы не сможете позже изменить шаг стежков или интервал между 
петлями в диалоговое окне Object Properties. 

5 Нажмите кнопку ОК. 
 

Совет: Измените тип стежка, например на Candlewicking или Satin, для получения различных эффектов. 

 
Пунктирное заполнение стежками  Пунктирное заполнение стежками Satin 
 Candlewicking  
 

Создание эффекта волнистости рукодельными заполняющими 
стежками 
Эффект волнистости (Wave Effect) является функцией, позволяющей искривлять линии строчек стежков 
заполнения. Стежки следуют оцифрованной линии, но сохраняют однородную плотность и порядок проколов 
иглой материала. См. также Создание эффекта волнистости. 
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Эффект волнистости с  
заполнением Blackwork  
 
 
 
 
 
 
 
Эффект волнистости с  
заполнением Candlewicking  
 
 
 
 
 
 
Эффект волнистости с 
заполнением Lacework  
 
 
 
 
 
 
Эффект волнистости может быть применен к объектам замкнутой кривой с использованием стежков 
заполнения Blackwork, Candlewicking или Lacework. Однако вам нужно вначале создать объект замкнутой 
кривой с простегивающими стежками и затем преобразовать стежки заполнения в рукодельные стежки. 
 
Как создавать эффект волнистости рукодельными заполняющими стежками 
1 Создайте объект замкнутой кривой, заполненный простегивающими стежками. 
2 Примените эффект волнистости (Wave Effect) к объекту и, если требуется, измените форму кривой.  
 Подробнее см. в разделе Создание эффекта волнистости. 
3 Выберите объект простегивающего стежка и дважды щелкните по нему. 
 Откроется диалоговое окно Object Properties (Свойства объекта). 
4 На закладке Fill Stitch (Заполняющий стежок) выберите тип стежка Blackwork Fill, Candlewicking Fill или 

Lacework.  
5 Нажмите кнопку ОК. 
 Эффект волнистости будет применен к выбранному объекту. 

     
  Использован   Эффект волнистости  Выбран рукодельный стежок 
  простегивающий   применен  стежок 
    
 

Совет: Переключитесь на режим Artistic View (Художественный Просмотр) или просмотрите точки укола 
иглой, чтобы увидеть результат. 
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Глава 27  
 
 
 
Оцифровывание для аппликаций 
 
Функция Auto Appliqué автоматически создаст все элементы вышивки, 
требуемые для аппликации, или же можно создать аппликацию 
вручную. Когда вы оцифровываете объект функцией Auto Appliqué, 
линия размещения, линия обреза, закрепляющие и покрывающие 
стежки генерируются автоматически с использованием текущих 
настроек Auto Appliqué. 
 

Создание объектов аппликации 
 
Используйте функцию Auto Appliqué для получения стежков, которые требуются для объектов 
аппликации. Покрывающий стежок создает обрамление вокруг формы аппликации. Вы можете 

контролировать различные настройки, включая тип покрывающего стежка, шаг стежка, а также смещение.  
 
Совет: Вы можете также создавать объекты аппликации с частичным покрытием вышивкой для создания 
эффекта нахлестки без дублирования обрамления. См. также Создание частичного покрытия объектов 
аппликации. 
 
Создание объектов аппликации с использованием функции Auto Appliqué. 
 
Используйте инструмент Auto Appliqué (панель Design) для оцифровывания объектов аппликации. 
 
Используйте функцию Auto Appliqué для получения стежков, которые требуются для объектов аппликации. 
Для каждого объекта аппликации генерируется до четырех слоев вышивки – линию размещения, линию 
обрезки, закрепляющие и покрывающие стежки в соответствии с текущими настройками. 
 
Как создавать объекты аппликации с использованием функции Auto Appliqué. 
1 Загрузите рисунок в режиме Picture. 
2 Щелкните по кнопке режима Design. 
3 Щелкните по значку Auto Applique. 
4 Оцифруйте контур аппликации, наметив базисные точки вокруг контура 
фигуры. 

◄ Щелкните для создания угловой точки. 
◄ Щелкните правой кнопкой, чтобы создать точку кривой. 

257



Глава 27: Оцифровывание для аппликаций 

BERNINA® Artista Designer Plus Версия 4 

Совет: Следуйте указаниям в строке состояния, помогающим при оцифровывании. Если вы ошиблись, нажмите 
клавишу Backspace, чтобы удалить последнюю базисную точку, и затем продолжайте оцифровывание. 
5 Нажмите Enter для закрытия формы. 
6 Щелкните по контуру, чтобы установить точки входа и выхода, или нажмите Enter, чтобы принять 

стандартные настройки.  
7  Если будет предложено, наметьте положение выхода пялец. 

◄ Для использования текущих значений выхода пялец нажмите Enter. 
◄ Чтобы назначить положение выхода пялец, щелкните для отметки на проекте. 

 
    

Положение выхода пялец 
 
 
Положение  

выхода 
 
8  Нажмите Enter. 

Для каждого объекта аппликации генерируется до четырех слоев вышивки – линию размещения, линию 
обрезки, закрепляющие и покрывающие стежки в соответствии с текущими настройками Auto Appliqué. 

 
Примечание: Линия обреза генерируется лишь в том случае, если выбрана функция Trim in Place. 
Поместите лоскут ткани после того, как будет прострочена линия размещения, затем обрежьте ткань, как 
только будет прострочена линия обреза. 

 
     
 
 

ли линия размещения 
    
 
 

покрывающий гладьевый стежок   закрепляющая строчка 
зигзаг 

 
Когда вы вышиваете объект аппликации, машина останавливается 
между слоями. Перед началом вышивания аппликации уложите материал аппликации на проект и запустите 
машину. 
Когда будет прострочена направляющая линия, обрежьте излишек материала аппликации и снова запустите 
машину для выполнения обтачивающих и покрывающих стежков. 

 
Настройка покрывающих стежков 
Покрывающий стежок создает обрамление вокруг формы аппликации. Вы можете контролировать различные 
настройки, включая тип покрывающего стежка, шаг стежка, а также смещение по отношению к оцифрованному 
контуру. 
 
 
Как настроить покрывающие стежки 
1 Выберите режим аппликации. 
2 Выберите Settings (Настройки) > Object Properties (Свойства объекта). 
3 Выберите закладку Appliqué. 
 Откроется закладка Applique диалогового окна Object Properties (Свойства объекта). 
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4 Выберите покрывающий стежок: 

◄ Satin (Гладьевый стежок) 
◄ Blanket (Обметочный стежок) 

 
Обметочный  
покрывающий  
стежок 
 
 
 
 
Гладьевый  
покрывающий  
стежок 
 
5 При использовании гладьевого покрывающего стежка, выберите, если требуется, выберите ширину строчки 

и шаг обтачивающего стежка. 
  
 Примечание: При использовании обметочного стежка обтачивания не требуется. 
6 Введите ширину строчки и шаг покрывающего стежка. 

◄ Width (Ширина): введите ширину строчки гладьевого или обметочного стежка. 

         
Ширина обметочной Ширина обметочной     Ширина гладьевого  Ширина гладьевого  
строчки: 2,5 мм   строчки: 1,5 мм      валика: 1,0 мм   валика: 2,5 мм 

              
◄ Spacing (Шаг стежка): введите величину смещения строчки внутрь и наружу от контура. 

        
Шаг гладьевого  Шаг гладьевого       Шаг обметочного  Шаг обметочного  
стежка  1,0 мм    стежка  0,4 мм        стежка: 2,0 мм   стежка: 1,3 мм 
 

     7  Выберите стиль (Style) аппликации. 
Линия обреза генерируется лишь в том случае, если выбрана функция Trim in Place. Поместите лоскут ткани 
после того, как будет прострочена линия размещения, затем обрежьте ткань, как только будет прострочена 
линия обреза. 
◄ Trim in Place (Обрезать на месте): создание линии обреза. 
◄ Pre-cut (Предварительно вырезано): без линии обреза. 
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◄  
8  Используйте ползунок для регулировки смещения покрывающих и обтачивающих стежков. 

Для гладьевых стежков, покрывающих стежков и обтачивающих стежков смещение по отношению к линии 
размещения устанавливается ползунком. Смещение может быть назначено внутрь или наружу от контура 
аппликации. Для обметочного стежка всегда применяется 100%-ное смещение внутрь. 

9  Нажмите кнопку ОК. 
 

Создание частичного покрытия объектов аппликации. 
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Щелкните по значку Partial Appliqué (панель Design) для создания объектов аппликации с частичным 
покрытием стежками. 

 
Вы можете создавать объекты аппликации с частичным покрытием вышивкой для создания эффекта нахлестки 
без дублирования обрамления. Важно тщательно заблаговременно спланировать ваш проект, чтобы вы знали, 
где нужны и где не нужны аппликационные покрывающие стежки. Нижние слои являются теми, к которым 
применяется частичное покрытие аппликации. 

 
Как создавать частичное покрытие объектов аппликации. 
1 Оцифруйте формы аппликации таким же образом, как и при оцифровывании форм функцией Auto Appliqué. 
 

        
2 Выберите все формы аппликации в группе для применения Partial Appliqué. 

 
 
 
 
 
3 Щелкните по значку Partial Appliqué. 

Покрывающие стежки генерируются по часовой стрелке между 
начальной и конечной точками, оставляя не простроченными 
остальные части контура. 

 
 
 
частичное покрытие 
 
  
непрострачиваемые части контура 
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Распечатка узоров аппликации 
 
Распечатайте копию узора аппликация для использования в качестве шаблона для вырезания мотива 
аппликации из материала. Каждый узор аппликации нумеруется в соответствии с последовательностью 
вышивания. 
 
Как распечатать узор аппликации 
1 Выберите File > Print Preview. 
2 Щелкните по значку Options. 
 Откроется диалоговое окно Print Options. 
3 Выберите опцию Appliqué pattern. 
 

      
 

Каждый узор аппликации нумеруется в соответствии с последовательностью вышивания.  
 

    
4 Нажмите кнопку Print. 
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Часть VIII  
Обработка проекта и 
установка аппаратных 
средств 
 

Глава 28  
Обработка файлов в различных 
форматах 
По умолчанию BERNINA artista сохраняет проекты в собственном ["родном"] 
формате файла, ART. Этот формат содержит всю информацию, требуемую 
как для вышивания проекта, так и для последующих изменений. При открытии 
проектов, созданных или сохраненных в других форматах, BERNINA artista 
конвертирует информацию проекта, так что его можно модифицировать, 
используя весь диапазон функций BERNINA artista. В зависимости от типа 
файла вам может потребоваться ввести дополнительную информацию, 
чтобы содействовать процессу конвертирования. 
В этом разделе описывается, как выбирать опции конвертирования и 
сохранения проектов в различных форматах. 
 

Форматы проектов вышивки 
Проекты вышивки сохраняются в одном из трех форматах – чистом формате ART, "контурном" формате или 
"стежковом" формате. 
 
Примечание: Подробнее о специфичных форматах, поддерживаемых BERNINA artista, см. в разделах 
Поддерживаемые форматы вышивальных файлов и Сравнение контурных и стежковых форматов файлов. 
 
ART-файлы  
Проекты в "родном" ART-формате, называемом ‘ART Grade A’, содержат полный комплект информации о 
проекте в едином файле – очертания объекта и его свойства, фактические стежки, цвета ниток, пиктограмма и 
комментарии. Таким образом только проекты в "родном" формате ART содержат полный набор информации, 
требуемой для 100%-ного совершенства масштабирования и трансформации. 
Имеется четыре степени файлов формата ART, в зависимости от того, как был создан ART-файл, Grade А 
является наилучшим форматом, Grade В более надежен, чем Grade С, но не так хорош, как формат Grade А, а 
Grade D является наименее надежным форматом. 
 
Источник 
файла 

Описание 

Art Grade A  

 

Файл чистого формата ART, созданный программным обеспечением BERNINA 
artista. Такие файлы содержат "чистые" ART объекты, контуры и стежки. 

Art Grade B  

 

Проекты, считанные с контурного формата, такого как CND, и сохраненные как 
ART-файлы. Вы не можете создавать проекты формата Grade B в BERNINA artista, 
но если проект конвертирован в ART в другом программном обеспечении, 
BERNINA artista считывает его как проект формата Grade B. 
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Art Grade C  Проекты, считанные со стежковых файлов -- SEW, PCS, PES, и др., - в которых 
стежки конвертированы в объекты. Подробнее см. в разделе Открытие стежковых 
файлов с конвертированием объекта. 

Art Grade D  Проекты, считанные со стежковых файлов -- SEW, PCS, PES, и др., - в которых 
стежки НЕ конвертированы в контуры. Подробнее см. в разделе Открытие 
стежковых файлов без конвертирования объекта. 

 
 
Для информации об источниках файла проекта обратитесь к Информации о проекте (Design information) в 
диалоговом окне Open (Открыть) или Design Properties (Свойства проекта). Подробнее см. в разделе 
Просмотр информации о проекте в BERNINA ARTlink. 

 
"Родной" ART-проект  

 
Контурные файлы 
Контурные, или "сжатые" файлы, такие как ART, являются файлами формата высшего уровня, содержащими 
контуры объекта, свойства объекта и данные о стежках. Когда вы открываете контурный файл в BERNINA 
artista, применяются соответствующие типы стежков, методы ввода и эффекты. 
Контурные файлы могут быть масштабированы, преобразованы и изменены по форме без воздействия на 
плотность или качество стежков. После модификации вы можете сохранить свой проект в родном формате ART 
или в каком-либо другом формате. 
Для масштабирования и преобразования проектов (перевод в зеркальное отображение, наклон, поворот) и 
регенерации стежков BERNINA artista потребует информацию о контуре проекта. 
Поэтому полное преобразование проекта и опции генерации стежков доступные только для файлов контурного 
формата. 

 
"Родной" ART-проект  

 
Стежковые файлы 
Различные вышивальные машины понимают различные языки. Каждая из них имеют собственные команды 
управления для разных функций машины. Прежде чем вы сможете вышить проект, он должен быть переведен в 
формат, который может быть интерпретирован машиной. 
Стежковые, или "расширенные" проекты являются форматами низшего уровня для непосредственного 
использования вышивальной машиной. Они содержат только координаты стежков и функции машины. Они 
обычно создаются "налету" при отправке проектов в машину. Их можно также вывести на вышивальный диск 
или на карту памяти. 
Когда такие файлы считываются в BERNINA artista, в них не содержится информации об объектах, такой как 
контуры или типы стежков, представляя проект как набор блоков стежков. Блоки стежков создаются, когда в 
проекте отмечается изменение цвета или обрезание ниток. Такие файлы имеют только Общие (General) 
свойства. 
 
Стежковые проекты в общем случае не подлежат изменениям, так как 
стежки не регенерируются. На экране может появится предупреждение, 
если открытый вами проект не может быть масштабирован. 
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Совет: Вы можете назначить вывод на экран этого предупреждения, выбрав опцию Help (Справка) > Show 
Design Warning (Показывать предупреждение о проекте). 
Однако BERNINA artista может интерпретировать с определенным успехом контуры объекта, типы стежков и 
интервалы из данных о стежках. Такие "конвертированные" проекты можно масштабировать с пересчетом 
стежков.  
 
Примечание: Обработка является эффективной для большинства стежковых проектов, но не может 
обеспечить тот же уровень качества, как оригинальные контурные файлы, и не может иметь дело с некоторыми 
орнаментными стежками. 
По умолчанию стежковые файлы конвертируются в контуры и объекты во время открытия, но вы можете также 
выбрать опцию, при которой проект открывается без конвертирования. Проекты, открытые таким образом, 
могут быть выведены на вышивание в другом формате. Или вы сможете редактировать стежки и добавлять 
новые элементы. 
 
Примечание: Вы можете масштабировать проекты стежкового формата, открытые без конвертирования 
объект. Однако, поскольку количество стежков не изменяется, плотность стежков увеличивается или 
уменьшается с изменением размеров проекта. Поэтому вы не должны изменять размеры проектов больше чем 
на ±5 % в противном случае некоторые зоны вышивки будут иметь слишком плотное или слишком тонкое 
покрытие.  

 
масштабированный стежковый проект  
 
Примечание: С конвертированием объекта или без конвертирования стежковые файлы могут быть сохранены 
в формате ART, если они были открыты в BERNINA artista. 
 

Открытие стежковых файлов в BERNINA artista 
 
Если вы хотите масштабировать проект, редактировать контур или изменить тип стежка, то проект должен быть 
конвертировать в объекты. По умолчанию стежковые файлы конвертируются при открытии. 
Если вы не хотите масштабировать проект больше чем на ±5 % или хотите только провести только 
незначительные изменения стежков или передать файл в другом формате, вы можете выбрать открытие 
стежкового файла без конвертирования объекта. 
 
Совет: Чтобы гарантировать правильность контуров объекта, типов стежка и выбора цветов, всегда 
рекомендуется проверять и редактировать проекты после конвертирования. 
 
Открытие стежковых файлов с конвертированием объекта 
Когда вы масштабируете проект, то вы изменяете число стежков, необходимых для заполнения формы. 
BERNINA artista автоматически пересчитывает и перерисовывает все стежки. Эта операция называется 
(автоматической) обработкой стежков (stitch processing), после ее выполнения проект появляется на экране в 
том виде, в котором он будет вышит. Когда вы открываете стежковые файлы с конвертированием объекта, 
проект конвертируется в файл формата Grade C ART. 
 
Однако существуют ситуации, когда вам может потребоваться отказаться от функции обработки стежков. 
Например, вам нужно использовать специальные эффекты или редактировать проект вышивки вручную (эти 
функции недоступны, если стежки были обработаны автоматически после изменения размеров проекта). Вы 
можете отключить функцию обработки стежков для любого проекта при его открытии. 
 
Примечание: Эта опция применима только к файлам вышивок, таким как файлы с расширением .PES, она не 
действует в отношении файлов с расширением .ART. 
 
Как открывать стежковые файлы с конвертированием объекта 
1 Откройте файл с жесткого диска компьютера или считайте его с дискеты или карты памяти. 
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 Откроется диалоговое окно Open. 

 
Выберите формат 

 
2 Выберите стежковый формат из списка Files of Type (Тип файла) и открываемый файл. 
3 Щелкните по кнопке Options. 
 Откроется диалоговое окно Open Options (Опции открытия). 
 
 
Выберите  
Convert Stitches  
Into Object Shapes 
 
 
 
 
4 Выберите Convert Stitches Into Object Shapes (Конвертирование стежков в формы объекта). 
5 Нажмите кнопку ОК. 
6 Нажмите кнопку Open (Открыть). 
 Выбранный проект будет обработан и конвертирован в объекты со свойствами заполняющих или 

оконтуривающих стежков, а также с общими свойствами. Если объект не распознан, то вы получите объект с 
только общими свойствами. 

 
    объект конвертирован в     стежки обработаны (ART Grade C) 
    свойства заполняющих стежков 
    
 
 
Открытие стежковых файлов без конвертирования объекта 
 
При открытии стежкового файла без конвертирования объекта, вы можете вывести проект без изменения, 
редактировать индивидуальные стежки и провести незначительные изменения размеров и формы без потери 
оригинальной информации о стежках. Когда вы открываете стежковые файлы без конвертированием объекта, 
проект конвертируется в файл формата Grade D ART. 
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Как открывать стежковые файлы без конвертирования объекта 
1 Откройте файл с жесткого диска компьютера или считайте его с дискеты или карты памяти. 
 Откроется диалоговое окно Open. 
2 Выберите стежковый формат из списка Files of Type (Тип файла) и открываемый файл. 
3 Щелкните по кнопке Options. 
 Откроется диалоговое окно Open Options (Опции открытия). 
 

Выберите Leave Stitches As  
Individual 

4 Выберите Leave Stitches As Individual Stitches (Оставить стежки как 
индивидуальные) для отмены автоматической обработки стежков. 

5 Нажмите кнопку ОК. 
6 Нажмите кнопку Open (Открыть). 

 
Стежковые объекты только  стежки импортированы (ART Grade D) 
с общими свойствами 
    
 
 Проект откроется как набор стежков с только общими свойствами. 

Сохранение проектов в формате PES  
 
Если у вас имеется проект, использующий стандарт PES или Brother hoop, вы можете сохранить его в формате 
PES вместе с соответствующей информацией о пяльцах. 
 
Как сохранить проект в формате PES  
1 Выберите File (Файл)> Save As (Сохранить как). 
2 Выберите PES из списка Files of Type (Тип файла). 
3 Нажмите кнопку Save (Сохранить). 

 Откроется диалоговое окно PES Hoop Type (Тип пяльцев PES). 
 
 
 
 
Выберите тип пялец 
 
4 Выберите тип пялец 

◄ Для пялец PES выберите PES hoop. 
◄ Для других пялец выберите User Defined Hoop (Пяльцы, 

определенные пользователем) и введите значения высоты и 
ширины.  

5 Нажмите кнопку ОК. 
 Пяльцы размером 100 x 100 и 180 x 130 сохраняются в формате PES V1, 260 x 160 и определяемые 

пользователем пяльцы – в формате PES V4. 
 
Примечание: Может появиться предупреждение, что проект не подходит к выбранным пяльцам. 
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Глава 29  
 
 
 
 
 

Вывод и сохранение проектов 
 
Вы можете выводить проекты вышивки различными способами – 
передачей в машину для вышивания или сохранением в машине, на карте 
памяти или в ПК. 
Когда вы отправляете проекты непосредственно в машину для 
вышивания, они могут быть потеряны после отключения машины. Чтобы 
сохранить проекты, записывайте их в память вышивального модуля или 
на карте памяти или сохраняйте на жестком диске ПК, на компакт-диске 
или на дискете. Сохраненные проекты можно затем открыть и 
редактировать в BERNINA artista. Вы можете также удалять или переименовывать сохраненные 
проекты. 
В этом разделе описывается, как проверять и распечатывать информацию о проекте и как 
назначать различные выводы из вашего проекта, а также как считывать и записывать файлы 
проектов вышивки на карты памяти. 
 

Предварительный просмотр и распечатка проектов 
 
Вы можете создать бумажную копию ваших проектов, используя стандартные или пользовательские 
настройки принтера. Вы можете также просмотреть проекты перед печатью. Настройте опции принтера для 
отображения информации по вашему желанию. Если вы пользуетесь цветным принтером, вы можете 
печатать в режиме Artistic View (Художественный Просмотр). 
 
Настройка опций печати 
Вы можете распечатать копию вашего проекта с информацией относительно размеров проекта, 
последовательности вышивания цветных фрагментов, количества стежков вместе с изображением проекта. 
Распечатайте копию узора аппликация для использования в качестве шаблона для вырезания мотива 
аппликации из материала. 
 
Как настраивать опции печати 
1 Откройте диалоговое окно Print (Печать). Альтернативно: 

◄ Выберите File > Print. 
◄ Выберите File > Print Preview. 

 Откроется диалоговое окно Print. 
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2 Выберите принтер из списка Name. 
3 Укажите количество копий, которые необходимо распечатать и остальную информацию о печати. 
4 Выберите Options (Опции), если нужно изменить размер изображения, тип просмотра или 

включаемые в распечатку детали. 
 Откроется диалоговое окно Print Options (Опции печати). 

        
5 На панели Print (Печать) выберите Embroidery (Вышивка), чтобы активировать эти опции: 

◄ Artistic View: проект будет напечатан в режиме Художественный Просмотр. 
◄ Hoop: проект будет распечатан вместе с изображением пялец. 
◄ Picture: проект будет распечатан вместе с рисунком за ним. 

6 На панели Print выберите Applique Pattern, чтобы распечатать копию мотива аппликации для вырезания 
из материала.  

 Каждый узор аппликации нумеруется в соответствии с последовательностью вышивания. 
7 Выберите опцию размера на панели Size: 

◄ Actual Size: проект будет распечатан в том же размере, в котором он будет вышит. 
◄ Fit to Page: крупный проект будет уменьшен до размера печатной страницы, а небольшой проект – 

соответственно увеличен.  
8  Нажмите кнопку ОК. 
 
Предварительный просмотр проектов 
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Используйте инструмент Print Preview (панель General) для просмотра проекта перед печатью. 
 
Используйте функцию Print Preview для просмотра информации о вышивании. Проверьте 

последовательность вышивания перед вышиванием проекта, так как вам нужно знать последовательность 
цветных фрагментов. 
 
Как просмотреть проект 
1 Нажмите кнопку Print Preview (Предварительный просмотр). 
2 Нажмите кнопку Options, чтобы выбрать опцию печати. 
 Подробнее см. в разделе Настройка опций печати. 
3 Нажмите кнопку ОК. 
 
 

Ваш проект откроется в том виде, в котором он будет 
отпечатан. Большие проекты могут изображаться на 
нескольких страницах в случае их распечатки в фактическом 
размере. Используйте команды Next Page (Следующая 
страница), Previous Page (Предыдущая страница) 
или Two Pages (Две страницы) для просмотра 
нескольких страниц. 
Щелкните по значку Zoom In, чтобы проверить детали 
проекта или прочитать рабочую информацию. 

4 Нажмите кнопку Print. 
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Распечатка проектов 

 
Используйте кнопку Print (панель General) для печати проекта. 
 

Вы можете создать бумажную копию ваших проектов, используя стандартные или пользовательские 
настройки принтера.  
 
Совет: Вы можете просмотреть проекты перед печатью. Подробнее см. в разделе Предварительный 
просмотр проектов. 
 
Как распечатать проект 

◄ Нажмите кнопку Print. 
Проект будет распечатан с использованием стандартных настроек принтера. Рекомендуется печатать 
проект с использованием функции Print Preview, таким образом вы сможете выбрать опции принтера.  
Подробнее см. в разделе Предварительный просмотр проектов. 

 

Сохранение проектов на картах памяти BERNINA  
 
Проекты от BERNINA artista должны сохраняться в памяти вышивального модуля машины, на карте памяти 
или на жестком диске ПК или дискете. 
◄ Если вы намереваетесь сразу же приступить к вышиванию, перешлите проект в машину. Подробнее 

см. в разделе Вышивание проектов. 
          
 
◄ Если вы хотите вышить проект несколько раз или если машина 

не подсоединена к компьютеру, сохраните проект на карте 
памяти, используя модуль считывания и записи карт памяти 
или прибор Magic Box. Подробнее см. в разделах Запись 
проектов на карты памяти BERNINA и Запись проектов на 
карту Magic Card.  
Проекты, сохраненные на карте памяти также могут быть открыты для редактирования в BERNINA 
artista. Подробнее см. в разделе Открытие проектов из машины. 

◄ Если вы хотите вышить проект несколько раз на машине, подсоединенной к компьютеру, сохраните 
проект на жестком диске или на дискете. Подробнее см. в разделе Сохранение проектов. 

       
 
◄ Многие современные машины позволяют также сохранять проекты в своем "модуле памяти". Такое 

устройство подобно встроенной карте памяти. Подробнее см. в разделе Запись проектов в память 
вышивальной машины.  

В этом разделе рассматриваются считывание и запись файлов проекта в машину или на карту памяти. 
 
Запись проектов на карты памяти BERNINA 

 
Используйте инструмент Write to Machine (панель General), чтобы передать проект на карту памяти 
BERNINA artista. 
 

Проекты могут быть загружены на карту памяти, вставленную в вашу вышивальную машину, и сохранены 
для последующего использования. Вы можете вышить его как угодно много раз. Таким образом, нет 
необходимости подсоединять компьютер к машине при вышивании проекта. Карты памяти вставляются в 
вышивальный модуль, подключенный к вашей швейной машине. См. соответствующую документацию для 
более подробной информации о вышивании с карты памяти. 
 
Примечание: При загрузке проекта в модуль считывания и записи карт памяти руководствуйтесь 
указаниями инструкции, прилагаемой к этому устройству. 
 
Как записывать проекты на карты памяти BERNINA 
1 Откройте свой проект в BERNINA artista. 
2 Вставьте карту памяти с проектом в вышивальную машину или в модуль считывания и записи карт 

памяти. 
3 Щелкните по значку Write to Machine (Передать в машину).  
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Если вы загружаете проект в первый раз после включения машины или модуля считывания карт, то 
появится диалоговое окно Device Selection (Выбор устройства). 

    
 

4 Выберите тип вышивальной машины и соответствующий последовательный порт. 
Если связь с последовательным портом установлена правильно, то появится диалоговое окно Write to 
Embroidery System (Передать в вышивальную систему)  и имя и картинка вашего проекта.  

 
 Выберите, чтобы увидеть проекты на карте 
 
 
 
 
Выберите папку,  
в которой будет  
сохранен проект  
  
 
 
 
 
 
 

Кнопка Download  для     Проект, который будет записан на карте памяти 
записи выбранного проекта  

5 Щелкните по кнопке Design Card (Карта памяти). 
Будут отображены проекты, сохраняемые на карте памяти. 

6 Щелкните по закладке папки, в которой должен быть сохранен проект. 
7 Щелкните по кнопке Download, чтобы загрузить проект.  
 

Примечание: Убедитесь в том, что во время загрузки проекта на карту памяти машины стержень 
игловодителя находится в верхнем положении. 
Сенсорный дисплей машины во время загрузки проекта остается пустым. Проект теперь сохранен на 
карте памяти. Вы можете вышить проект в любое время, не подсоединяя компьютер к вашей машине. 
Вы можете также открывать и сохранять проекты, используя прибор Magic Box. Подробнее см. в разделе 
Magic Box. 

 
Запись проектов в память вышивальной машины 
 

Используйте инструмент Write to Machine (панель General), чтобы передать проект в память 
вышивальной машины. 
 

Проекты могут быть записаны непосредственно в память вышивального модуля машины для 
использования в будущем. Вы можете вышить его как угодно много раз. Таким образом, нет необходимости 
подсоединять компьютер к машине при вышивании проекта. 
 
Как записывать проекты в память вышивальной машины 
1 Откройте свой проект в BERNINA artista. 
2 Щелкните по значку Write to Machine (Передать в машину). 

Если вы загружаете проект в первый раз после включения машины, то появится 
диалоговое окно Device Selection (Выбор устройства). 
 
 
 

3 Выберите тип вышивальной машины и при необходимости последовательный 
порт. 

Если связь с последовательным портом установлена правильно, то появится 
диалоговое окно Write to Embroidery System (Передать в вышивальную систему)  и имя и картинка 
вашего проекта.  
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 Выберите, чтобы увидеть проекты в памяти машины 
 
 
 
 
Выберите папку,  
в которой будет  
сохранен проект  
 
 
 
  
 
 

Кнопка Download  для записи     Проект, который будет записан в память машины 
выбранного проекта  

  
4 Щелкните по кнопке Embroidery Machine (Вышивальная машина). 

Будут отображены проекты, в памяти вышивального модуля машины. 
5 Щелкните по закладке папки, в которой должен быть сохранен проект. 
6 Щелкните по кнопке Download, чтобы загрузить проект.  
 

Примечание: Убедитесь в том, что во время загрузки проекта в машину стержень игловодителя 
находится в верхнем положении. Сенсорный дисплей машины во время загрузки проекта остается 
пустым. Проект теперь сохранен в памяти машины. Вы можете вышить проект в любое время, не 
подсоединяя компьютер к вашей машине. 

 
Просмотр информации о проекте 
Просмотр информации о проекте, сохраняемом в вышивальной машине, на карте памяти или 
компакт-диске. 
 
Как просматривать информацию о проекте 
1 Откройте новый, пустой файл. 
2 Вставьте карту памяти с проектом в вышивальную машину BERNINA или в модуль считывания и записи 

карт памяти. 
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Примечание: Перед тем, как вставить карту памяти, необходимо включить машину или модуль 
считывания карт памяти, в противном случае проекты не будут отображены на дисплее машины и 
загружены в машину.  

3 Выберите File > Card/Machine Read. 
Появится диалоговое окно Read from Embroidery System and Design Manager (Считывание с 
вышивальной системы и диспетчер проектов).. 
 

 
 
Выберите  
вышивальную  
машину,  
карту памяти  
или компакт-диска 

 
 
 
 
 
 
 
 
 

4 Выберите место сохранения проекта. 
◄ Нажмите кнопку Embroidery Machine (Вышивальная машина), чтобы просмотреть проекты, 

сохраняемые в вашей вышивальной машине BERNINA. 
◄ Нажмите кнопку Design Card (Карта памяти), чтобы просмотреть проекты, сохраняемые на 

вашей карте памяти. 
◄ Нажмите кнопку CD (Компакт-диск), чтобы просмотреть проекты, сохраняемые на вашем 

компакт-диске. 
5 Нажмите на ярлык папки, в которой сохраняется проект, затем выберите проект. 
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Проект будет показан в окне просмотра. 
 
 

    
 
 
 
 
 
 
 

Нажмите для  
просмотра свойств проекта 

 
 
 
 

 
 

6 Нажмите кнопку Design Properties (Свойства проекта), чтобы  
просмотреть информацию по выбранному проекту. 

    
 
Управление проектами на картах памяти BERNINA  
На картах памяти можно сохранить много различных проектов. Каждый из них 
можно редактировать в BERNINA artista, переименовывать или удалять с 
карты памяти, если они изменены или в них нет больше необходимости. 
 
Управление проектами на картах памяти BERNINA  
1 Откройте проект. 
2 Вставьте карту памяти с проектом в вышивальную машину или в модуль считывания и записи карт 

памяти. 
3 Выберите File > Card/Machine Read. 
4 Когда откроется диалоговое окно, выберите вышивальную машину и/или последовательный порт, к 

которому подсоединена машина. 
Появится диалоговое окно Read from Embroidery System and Design Manager (Считывание с 
вышивальной системы и диспетчер проектов).. 

      
Щелкните, чтобы передать выбранный проект на рабочий стол ПК 

 
5 Выберите кнопку для просмотра проекта. 

◄ Нажмите кнопку Embroidery Machine (Вышивальная машина), чтобы просмотреть проекты, 
сохраняемые в вашей вышивальной машине BERNINA. 

◄ Нажмите кнопку Design Card (Карта памяти), чтобы просмотреть проекты, сохраняемые на 
вашей карте памяти. 

◄ Нажмите кнопку CD (Компакт-диск), чтобы просмотреть проекты, сохраняемые на вашем 
компакт-диске. 

6 Выберите проект. 
Когда вы выбираете проект из списка, в панели Selected Design (Выбранный проект) показывается 
картинка проекта. 

7 Выберите папку для сохранения проекта. 
◄ Нажмите кнопку One Folder Up (На одну папку вверх) для выбора другой папки. 
◄ Нажмите кнопку Create a New Folder (Создать новую папку) для создания новой папки. 
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◄ Нажмите кнопку Select any Folder (Выбор любой папки) для обзора  папок вашего 
компьютера. 

8  Для сохранения проекта в вашем компьютере нажмите кнопку Read selected design to desktop PC 
(Передать выбранный проект на рабочий стол ПК). 

 Выбранный проект будет сохранен в компьютере. 
 

Вышивание проектов 
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Используйте инструмент Write to Machine (панель General), чтобы передать проект в машину.  
 
Вы можете использовать функцию Write to Machine (Передать в машину) для непосредственной 

передачи проекта в готовую для работы вышивальную машину.  
 
Совет: Проверьте последовательность вышивания перед вышиванием проекта, так как вам нужно знать 
последовательность цветных фрагментов. Используйте функцию Print Preview (Предварительный 
просмотр), для просмотра информации о вышивании. Подробнее см. в разделе Предварительный 
просмотр проектов. 
 
Как вышивать проект 
1 Откройте проект. 

Подробнее см. в разделе Открытие проектов из 
компьютера. 
 

     
2 Выберите режим Design. 

Проверьте, подходит ли проект к пяльцам. Вышивайте 
проект в как можно меньших пяльцах. 

3 Щелкните по значку Write to Machine (Передать в 
машину). 
 
 

Откроется диалоговое окно Write to Embroidery System (Передать в вышивальную систему).  На экране 
появится имя и картинка вашего проекта. 
 

 
Нажмите для вышивания выбранного проекта. 

 
4 Нажмите кнопку Stitch out Selected Design (Вышивание выбранного проекта). 

Появится окно Writing file(s) to device (Передача файла(ов( в устройство), за которым последует 
сообщение о подтверждении.  

 

       
 
Проект будет передан в вышивальную машину, готовый в вышиванию. 
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Глава 30  
 
 
 
 
 
Magic Box 
 
Прибор Magic Box ("Волшебная шкатулка") позволяет конвертировать 
файлы, сохраненные в различных "не родных" форматах. Вы можете 
передать проект с карты памяти в BERNINA artista, отредактировать и 
передать затем на карту Magic Card. Если вы получили проект с карты 
Magic Card или другой карты памяти, то вы сможете записать его 
обратно только на карту Magic Card. Вы не сможете сохранить его в 
компьютере или передать на карту памяти, отличную от Magic Card. 
Программное обеспечение Magic Box устанавливается автоматически 
при инсталляции программного пакета BERNINA artista и работает 
только с BERNINA artista. В этом разделе рассматривается, как использовать программу Magic 
Box для конвертирования карт памяти. Приводимые здесь указания применимы только к работе 
прибора Magic Box с BERNINA artista. Обратитесь к руководству пользователя прибором Magic 
Box за указаниями по установке, настройке и работе с прибором. 
Учтите также, что эти указания относятся к использованию прибора Magic Box, подключаемого к 
последовательному порту. При использовании прибора Magic Box, подключаемого к порту USB, 
обратитесь в центр онлайновой поддержки Bernina/OESD по адресу: 
http://berninasupport.custhelp.com/cgi-bin/berninasupport.cfg/php/enduser/home.php 
Если вы используете прибор Magic Box, подключаемый к порту USB, вам требуется обновить 
программное обеспечение BERNINA artista, так чтобы была установлена правильная версия. 
Подробнее можно узнать в последней редакции Указаний по поддержке BERNINA artista. 
 

Использование прибора Magic Box 
 
Из BERNINA artista вы можете считывать проекты с компакт-диска, дискеты или жесткого диска. Вы 
можете также считывать проекты с Magic Box в любом поддерживаемом проекты формате карт памяти. 
Оттуда вы можете передавать проекты в Magic Box, используя карты Magic Card в любом из четырех 
форматов. Используйте карту Magic Card, которая поддерживает нужный вам формат. Подробнее см. в 
разделе Поддерживаемые форматы карт памяти. 
 
Примечание: Вы не сможете передать проекты, считанные с Magic Box на дискету или жесткий диск 
компьютера. Вы не сможете также передать проект на карту памяти, отличную от Magic Card. 
 
На передней стороне прибора Magic Box имеется четыре прорези для различных карт памяти. (Прибор 
mini Magic Box имеет только прорези 1 и 2.) Цвет прорези соответствует цвету карты Magic Card, 
используемой в этой прорези. 
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Красная лампочка: индикатор Чтение/Запись 

 
Зеленая лампочка: индикатор Вкл./Выкл. 

 
Внимание: Попытка вставить карту с усилием в не соответствующую ей прорезь может привести к 
серьезному повреждению.  
Используйте прибор Magic Box совместно с BERNINA artista для того, чтобы: 
◄ Считать ART-файл с компакт-диска, жесткого диска или дискеты, выполнить требуемые изменения и 

передать файл на карту Magic Card. 
◄ Считать стежковый файл одного из поддерживаемых форматов карт памяти (включая Magic Card), 

выполнить требуемые изменения и передать обратно на карту Magic Card. 
Если проект в формате BERNINA artista, вы можете добавить надпись, вставить другие проекты, 
сохраняемые на вашем компьютере, компакт-диске или дискете, используя все функции редактирования 
BERNINA artista. Вы можете копировать и вставлять объекты в пределах каждого проекта, но не можете 
копировать или вставлять объекты из одного проекта полученного через Magic Box в другой. 
 
Поддерживаемые форматы файлов проектов 
Прибор Magic Box позволяет считывать многие форматы проектов. Большинство таких форматов 
перечислены в таблице. 
 
Формат Расширени

е 
Используется в 

CSD  *.csd  DOS HuskyGram  
Toyota POEM  
Singer Embroidery Unlimited 

DST  *.dst  Tajima 
EXP  *.exp  DOS Expanded 
HUS  *.hus  Viking DOS Customizer  

Viking Customizer 95 
PCM  *.pcm  Pfaff Macintosh 
PCS  *.pcs  Pfaff PC-Designer V2.0 (PC)  

Pfaff PC-Designer V2.1 (PC) 
PES  *.pes  

*.pec  
Bernette Deco Wizard  
Baby Lock Palette  
Brother PE-Design 

PSW  *.xxx  Singer PSW 
SEW  *.sew  JANOME Scan-n-Sew PC  

Elna Envision Scan PC 
 
Примечание: Все проекты на карте памяти записываются в стежковом, или "сжатом" формате. Это 
означает, что если вы изменяете размеры проекта, количество стежков не изменяется. Подробнее см. в 
разделе Обработка файлов в различных форматах. 
 
Поддерживаемые форматы карт памяти 
Хотя прибор Magic Box может считывать большинство карт памяти, он может записывать только на 
карты Magic Cards. Вы можете приобрести чистые карты Magic Cards для записи своих проектов. 
Подробную информацию о приобретении дополнительных карт вы можете получить у своего дилера или 
по адресу: http://www.embroideryonline.com 
Имеется четыре типа карт Magic Card. На каждой из них можно записывать проекты в формате выбранной 
машины. Назначение этих карт указывается в таблице. 

280



Глава 30: Magic Box 

BERNINA® Artista Designer Plus Версия 4 

 
Номер 
прорези 

Цвет 
прорези 

Цвет карты 
Magic Card  

Чтение карт с 
машины 

Запись на 
форматы карт 
Magic Card 

Прорезь 1 красный красный Bernette-Deco  
Brother  
Babylock 
Simplicity  
Viking  

Bernette-Deco  
Brother  
Babylock  
Simplicity  
Viking 

Прорезь 2 синий синий Bernina-artista 
Pfaff 

Bernina-artista 
Pfaff 

Прорезь 3 желтый желтый Singer  Singer  
Прорезь 4 зеленый зеленый Janome 

Elna 
New Home 
Kenmore 

Janome 
Elna 
New Home 
Kenmore 

Чтение проектов из программы Magic Box  
 
Вы можете передавать проекты с компакт-диска, дискеты или жесткого диска в BERNINA artista. Вы 
можете также считывать проекты с Magic Box в любом поддерживаемом проекты формате карт памяти. 
 
Считывание проектов с карт памяти 
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Используйте инструмент Read from Magic Box (панель General) для считывания других форматов 
прибором Magic Box. 
 

Вы можете считать проект с любой поддерживаемой карты памяти, отредактировать его и затем записать 
на одну из карт Magic Card – красную, синюю, желтую или зеленую. Вы можете выбрать до шести 
проектов для записи на карту Magic Card. Однако вы можете передать в BERNINA artista и редактировать 
за раз только один проект. 
 
Примечание: В BERNINA artista импортируется только проект в первой позиции экрана конвертирования 
Magic Box. 
 
Как считывать проекты с карты памяти 
1 Вставьте карту памяти в Magic Box. Выбранная вами прорезь зависит от формата карты. Подробнее 

см. в разделе Поддерживаемые форматы карт памяти. 
2 Откройте BERNINA artista. 
3 Щелкните по значку Read from Magic Box (Считать с Magic Box). 

Откроется диалоговое окно Magic Box About (О программе Magic Box). 

 
4 Нажмите на ОК, чтобы запустить программу. 

Откроется диалоговое окно Converter Box (Окно конвертирования).  
 
 

 
 
 
Нажмите кнопку, соответствующую  
прорези карты Magic Box  
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5 На панели Load Card (Вставить карту) нажмите кнопку соответствующую прорези карты Magic Box  
◄ B/V соответствует прорези 1. 
◄ P/A соответствует прорези 2. 
◄ S соответствует прорези 3. 
◄ J/E/K соответствует прорези 4. 

 
Примечание: Кнопки активны только в том случае, если надлежащая карта вставлена в надлежащую 
прорезь. Подробнее см. в разделе Поддерживаемые форматы карт памяти. Откроется диалоговое 
окно Read Design (Считывание проекта). 

 
 
Ввод номера проекта 
 
 
 
Нажмите, чтобы просмотреть проекты 
 
 

6 Нажмите Browse (Обзор) для просмотра всех проектов на карте.  
Откроется диалоговое окно Card’s Directory (Каталог карты памяти). 

 
Примечание: Если вы знаете индексный номер нужного проекта, введите его здесь. Номера проектов 
перечислены в таблицах информации о стежках и цвете, прилагаемым к каждой карте с проектами. 

7  Нажимайте кнопки Next Page/Prev Page (След. страница/Предыдущ. страница) для 
прокручивания проектов, содержащихся на карте. 

 
 
 
 
Выберите проект.  
 
 
 
 
 
8  Выберите проект и нажмите Load (Загрузить). 

Выбранный проект будет удален с панели просмотра и загружен в память. 
 

 
 

Проект удален 
 
 
 
 
 

9  Нажмите кнопку ОК. 
Проект отобразится в первой панели просмотра диалогового окна Converter Box (Окно 
конвертирования). 

      
Отображен выбранный проект   Нажмите Exit, чтобы открыть проект  

 
Вы можете загрузить в окно Converter Box несколько проектов, если вы хотите передать их на другую 
карту памяти. Если вам нужно вначале отредактировать проект, то в BERNINA artista откроется только 
проект, отображенный в первой панели просмотра. 
 
Совет: Для удаления проекта выберите его и нажмите кнопку Delete. Проект будет удален из окна 
просмотра. Но фактически он не будет удален из памяти. 
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10 Нажмите кнопку Exit. 
Первый выбранный проект откроется в BERNINA artista. 

 

      
Совет: Вы можете собрать подборку проектов с различных карт и затем сохранить его на одной карте. 
Извлеките текущую карту с проектами и вставьте другую карту с проектами, которые вы хотите 
загрузить.  

 
Считывание проектов с компьютера 

 
Используйте инструмент Read from Magic Box (панель General) для считывания других форматов 
прибором Magic Box. 
 

Вы можете считывать проекты с компакт-диска, дискеты или жесткого диска и записывать на карту Magic 
Card. Вы можете выбрать до шести проектов для записи на карту Magic Card. Однако вы можете передать 
в BERNINA artista и редактировать за раз только один проект. 
 
Как считывать проекты с компьютера 
1 Откройте BERNINA artista. 
2 Щелкните по значку Read from Magic Box (Считать с Magic Box). 

Откроется окно Magic Box About (О программе Magic Box). 
3 Нажмите на ОК, чтобы запустить программу. 

Откроется диалоговое окно Converter Box (Окно конвертирования).  
 

 
Нажмите Read 

 
 
 
 
 
 
 
 
4 Нажмите кнопку Read (Считать). 

Может открыться стандартное диалоговое  
окно Open (Открытие файла) или окно  
Select by Icon (Выбор по рисунку) в  
зависимости от настройки функции File  
Open (Открыть фвйл). 

5 Выберите проект. 
6 Нажмите Open или OK. 
Проект будет скопирован в диалоговое окно  
Converter Box. 
 
 
 
Отображен  
выбранный проект  
 
 
 
 
 
 
 
  
 
            Нажмите кнопку Exit. 
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7  Повторяйте эту операцию для выбора нескольких проектов. 
Вы можете выбрать до шести проектов, но в BERNINA artista можно открыть только первый проект.  

 
 
 
Отображен  
выбранный проект  
 
    
 
 
 
 
 
 
 
 
 

Нажмите кнопку Exit. 
 
8  Нажмите кнопку Exit. 

В BERNINA artista откроется только первый проект. Повторяйте эту 
операцию для открытия нескольких проектов. 

 
 
Запись проектов на карту Magic Card 
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Используйте инструмент Write to Magic Box (панель General) для передачи проектов на карты Magic 
Card прибором Magic Box. 

 
Из BERNINA artista вы можете передавать проекты в Magic Box, используя карты Magic Card в любом из 
четырех форматов. Используйте карту Magic Card, которая поддерживает нужный вам формат. Подробнее 
см. в разделе Поддерживаемые форматы карт памяти. 
 
Примечание: Вы не сможете передать проекты, считанные с Magic Box на дискету или жесткий диск 
компьютера. Вы не сможете также передать проект на карту памяти, отличную от Magic Card. 
 
Как записывать проекты на карту Magic Card 
1 Загрузите существующий проект с карты памяти в компьютер. 

См. разделы Считывание проектов с карт памяти и Считывание проектов с компьютера. 
Проекты будут отображены в диалоговом окне Converter Box (Окно конвертирования). 

      
Совет: Для удаления проекта выберите его и нажмите кнопку Delete. Проект будет удален из окна 
просмотра. Но фактически он не будет удален из памяти. 

 
2 Извлеките из прибора Magic Box любые карты, которые использовались для передачи проектов. 
3 Вставьте надлежащую карту Magic Card в надлежащую прорезь прибора Magic Box. 
 

Примечание: Вы не сможете записать проект на карту памяти, если она вставлена в не 
соответствующую прорезь. Подробнее см. в разделе Поддерживаемые форматы карт памяти. 

4 Нажмите кнопку Write to Magic Box (Передать в Magic Box) на панели инструментов BERNINA artista. 
 Откроется диалоговое окно Write to Magic Box (Передать в Magic Box).  
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5 Выберите тип карты памяти, на которую вы хотите записать проект, и нажмите OK. 

Откроется диалоговое окно Converter Box с отображением текущего проекта.  
 

 
 
 
 
 

Нажмите кнопку,  
соответствующую  
прорези карты Magic Box  

 
 
 
 
 

6 На панели Write Card (Передать на карту) нажмите кнопку, соответствующую формату, а котором вы 
хотите произвести запись: 
◄ B соответствует формату Bernette-Deco, Brother, Babylock или Simplicity (Прорезь 1). 
◄ V соответствует формату Viking (Прорезь 1). 
◄ P соответствует формату Pfaff (Прорезь 2). 
◄ A соответствует формату BERNINA artista (Прорезь 2). 
◄ S соответствует формату Singer (Прорезь 3). 
◄ J/E/K соответствует формату Janome, Elna, New Home или Kenmore (Прорезь 4). 

 
Примечание: Кнопки активны только в том случае, если надлежащая карта вставлена в надлежащую 
прорезь. Подробнее см. в разделе Поддерживаемые форматы карт памяти. Появится 
предупреждающее сообщение. 
 

  
 
 
Внимание: При записи проектов на карту Magic Card уже находящиеся на карте проекты будут стерты.  

7  Нажмите на ОК, чтобы запустить программу. 
Появится сообщение о готовности карты Magic Card к использованию. 

8  Нажмите кнопку Exit. 
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Глава 31  
 
 
Установка аппаратных 
средств и настройка 
системы 
 
Для работы с BERNINA artista вам необходимо подсоединить периферийные устройства. К ним 
относятся, например, принтеры, сканеры и вышивальные машины. 
BERNINA artista позволяет настраивать различные установки системы, управляющие внешним 
видом проектов на экране, отображением информации о проекте, поведением окна проекта, и 
другие установки. 
В этом разделе описывается, как настраивать вышивальные машины и сканеры и как 
калибровать монитор. Кроме того, объясняется, как изменять интервал сетки и опции 
позиционирования и изменять опции пялец. Имеется также информация о том, как настраивать 
отображение указателя мыши и как установить опцию автосохранения. 
 

Установка аппаратных средств 
 
Различные устройства устанавливаются различными способами – некоторые в ОС Windows через Панель 
управления, другие в самой программе BERNINA artista itself. За указаниями по подключению устройств к 
компьютеру и их настройке в системе Windows обратитесь к прилагаемым к устройствам инструкциям, а 
также к документации по Microsoft Windows. 
 
Настройка подсоединения периферийного устройства 
Периферийные устройства, такие как принтеры, подсоединяются к имеющемуся порту на передней или 
задней стороне компьютера. Это может быть последовательный, параллельный или USB порт. 
Конфигурацию программного обеспечения нужно выбирать через Панель управления системы Windows. 
 
Настройка последовательного порта 
Последовательные COM-порты компьютера имеют ответные 9- или 25-штырьковые разъемы. Они 
называются COM1, COM2 и т.д.  Количество имеющихся портов ограничивает количество подключаемых 
устройств. Если требуются дополнительные порты, вы можете их добавить. BERNINA artista дает 
возможность иметь до 4 последовательных портов. 
 
Примечание: Вы должны уметь идентифицировать порты вашего компьютера. При возникновении 
сомнений проконсультируйтесь со специалистом. 
 
Настройка параллельного порта 
Параллельные порты используются для подсоединения принтера и сканера. Они называются LPT1, LPT2 
и т.д.  
 
Настройка USB-порта 
Порты USB (Universal Serial Bus) используются для подсоединения вашего аппаратного ключа dongle. Они 
могут быть также использованы для подсоединения принтера или сканера. Дополнительные USB-порты 
могут использовать устройство для подпитки. 
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Настройка вышивальных машин 
Ваша вышивальная машина BERNINA должен быть подключена к порту COM1, COM2, COM3, COM4 или 
USB вашего компьютера. Подробно о подключении машины к компьютеру можно узнать в Руководстве по 
эксплуатации вашей вышивальной машины. 
 
Настройка принтеров 
Ваш принтер подключен к USB- или параллельному порту. Некоторые принтеры могут быть подключены к 
любому типу порта. BERNINA artista использует выбираемый по умолчанию принтер, назначенный в парке 
Printer (Принтер) в Панели управления Windows. Руководствуйтесь инструкцией по принтеру, чтобы 
обеспечить правильную настройку. Воспользуйтесь Справкой Windows (Пуск > Справка > Указатель, затем 
выберите Принтер по умолчанию), чтобы получить указания по установке принтера по умолчанию. 
 
Настройка сканеров 
 
Используйте команду Scanner Setup (меню Settings) для установки сканера. 
BERNINA artista поддерживает сканеры, совместимые с протоколом TWAIN. 
 
Примечание: Некоторые сканеры не могут работать с BERNINA artista, так как им требуется собственное 
программное обеспечение. В таком случае для сканирования используйте программу сканера, сохраните 
изображение на жестком диске и затем загрузите изображение в программу BERNINA artista. 
 
Как настраивать сканеры 
1 Подсоедините сканер, руководствуясь прилагаемой инструкцией. 
2 Установите сканер в системе Windows, руководствуясь прилагаемой инструкцией и/или документацией 

по Microsoft Windows. 
3 Запустите BERNINA artista. 
4 Выберите Settings (Настройки) > Scanner Setup (Настройка сканера). 
 Откроется диалоговое окно Select Source (Выбор источника) со списком драйверов сканеров, 

загруженных в вашем компьютере. 
 
 
Выберите драйвер  
сканера 
 
 
 
 
5 Выберите драйвер сканера, затем нажмите Select. 
 

Примечание: Если возникнут проблемы со сканированием после перезапуска BERNINA artista, то речь 
может идти о конфликте с ранее установленными драйверами сканера. Переустановите BERNINA 
artista и испытайте повторно сканер. Если выбранный драйвер сканер не работает в BERNINA artista, 
выберите из списка другой драйвер сканера. Для каждого сканера обычно установлено два драйвера.  

Калибровка монитора 
 
Используйте команду Display Setup (меню Settings) для калибровки монитора.  
 
Вам потребуется откалибровать монитор, так чтобы проект отображался в масштабе 1:1 в натуральную 
величину. Это необходимо в том случае, когда вы впервые устанавливаете BERNINA artista или по какой-
либо причине меняете монитор.  
 
Как калибровать монитор 
1 Выберите Settings (Настройки) > Scanner Setup (Настройка монитора). 
 Откроется диалоговое окно Screen Calibration (Калибровка экрана). 
 
           
 
 
 

Измеренная высота 
 
 
 
 

 
Измеренная ширина 
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2 Измерьте высоту и ширину диалогового окна. 
3 Введите измеренные значения в поля Width (Ширина) и Height (Вымота). 
4 Нажмите кнопку ОК. 
 

Настройка опций сетки 
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Щелкните правой кнопкой мыши по кнопке Show Grid (панель General) для установки базисной 
точки сетки и интервала. 

 
Вы можете включить или выключить показ сетки, изменить 
интервал сетки или установить базисную точку. Вы можете 
также включить или выключить опцию Snap to Grid (Выровнять 
по сетке) в диалоговом окне Options. Выровняйте сетку со 
специфичной точкой в проекте путем установки базисной 
точки, например, если вы хотите, чтобы линии сетки 
пересекали центральную точку проекта или чтобы 
горизонтальная линия сетки находилась под определенным 
объектом. 
Используйте опцию Snap to Grid для выравнивания объектов 
вашего проекта по ближайшей линии сетки.  Вы можете выровнять объект по горизонтальной (X) или 
вертикальной (Y) оси или по обеим осям. Новые базисные точки будут совпадать с ближайшей линией 
сетки во время оцифровывания. Существующие объекты будут выровнены по сетке, когда вы выбираете и 
перемещаете их. 
 
Как настраивать опции сетки 
1 Щелкните правой кнопкой мыши по значку Show Grid (Показать сетку). 
 Откроется диалоговое окно Options (Опции) с открытой закладкой Grid (Сетка). 
 
 

Выберите для  
отображения сетки 

 
 

Выберите для  
выравнивания сетки по точке 

 
 

Введите горизонтальный  
и вертикальный интервалы 

 
 

Выберите  
"Выровнять по сетке" 

 
 
2 Проставьте флажок в окошке Show Grid, чтобы отобразить сетку. 
3 Проставьте флажок в окошко Set Reference Point (Установить базисную точку). 
 

Например, вы можете установить базисную точку сетки в центре проекта. Это более простая и быстрая 
операция, чем перемещение всего проекта. 

4 Введите значения интервала сетки (Grid Spacing) для горизонтальных и вертикальных линий. 
5 Проставьте флажок в окошке Snap to Grid (Выровнять по сетке). 
 

Совет: Для временной отмены опции Snap to Grid во время оцифровывания удерживайте нажатой 
клавишу Alt. 

6 Нажмите кнопку ОК. 
Если вы выбрали опцию Set Reference Point, наметьте базисную точку на вашем проекте. Сетка будет 
выровнена, так что горизонтальные и вертикальные линии сетки пересекались в этой точке. 
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Настройка опций пялец 
 
Щелкните правую кнопкой мыши инструмент Hoop (панель General) для изменения настроек пялец. 
 

Имеется определенный диапазон размеров подбора к размеру проекта, а также к числу вышивальных 
машин. Рекомендуется выбирать наименьший размер пялец, который будет соответствовать размеру 
проекта. Благодаря этому ткань в время вышивания будет оставаться плотно натянутой. 

             
 
Как настраивать опции пялец 

◄ Щелкните правой кнопкой мыши по значку Show Hoop (Показать пяльцы). 
Появится диалоговое окно Options с открытой закладкой Hoop (Пяльцы).  

 

        
 

Совет: Для скрытия пялец уберите флажок из окошка Display Hoops (Показать пяльцы). 
1 Выберите пяльцы из списка Hoop. 
2 Выберите положение пялец на панели Position. 

Подробнее см. в разделе Настройка центра пялец. 
3 Нажмите кнопку New Hoop (Новые пяльцы) для создания собственных пялец. 

Подробнее см. в разделе Создание собственных пялец. 
4 Нажмите кнопку Edit Hoop (Изменить пяльцы) для изменения существующих пялец. 

Подробнее см. в разделе Редактирование собственных пялец. 
5 Нажмите кнопку Delete Hoop (Удалить пяльцы) для удаления существующих пялец. 

Подробнее см. в разделе Удаление пялец. 
6 Нажмите кнопку ОК. 
 
Настройка общих опций 
 
BERNINA artista позволяет настраивать различные общие установки, управляющие автосохранением 
проектов, определения положения указателя мыши на экране, а также отображением единиц измерения. 
 
Установка функции автоматического сохранения 
 
Выберите Options (меню Settings) для установки опций автосохранения и создания резервных копий  
Сохраняйте свою работу автоматически с регулярными интервалами, используя функцию Auto Save 
(Автосохранение) для защиты от потери при сбое аппаратных или программных средств.  
Резервная копия файла создается каждый раз при сохранении проекта. Проект сохраняется в папке 
BACKUP программы BERNINA artista. Копия имеет то же имя, что и оригинальный файл, но с 
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расширением BAK. 
 
Внимание: Резервные копии файлов остаются в папке BACKUP до тех пор, пока вы не удалите их. Чтобы 
эта папка не занимала слишком много места на жестком диске, регулярно удаляйте ставшие не нужными 
резервные файлы. 
 
Как установить опцию автосохранения 
1 Выберите закладку Settings > Options > General. 
 
 
 
 

Выберите для  
автосохраниея 

 
 

Введите интервал  
автосохранения 

 
 
 
 
 
2 Проставьте флажок в окошке Save Design (Сохранять проект) 
3 Введите в поле Auto Save Period интервал автосохранения в минутах. 
4 Нажмите кнопку ОК. 
 
Интерпретация положения указателя мыши 
Значения X и Y показывают горизонтальное (X: horizontal) и вертикальное (Y: vertical) расстояние 
указателя от относительной или абсолютной отметки. Значение L – это длина линии, соединяющей 
указатель с предыдущей точкой, а A – это угол наклона этой линии по отношению к горизонтали. 
 
длина = 60.6 мм 

 
 
 
 
 
 
 
 
 
 
L: длина     A: угол 

 
 
 
 

X: горизонталь  Y: вертикаль 
 
Отрицательное значение величины X означает, что вторая точка 
расположена слева от первой точки, в том время как отрицательное 
значение величины Y означает, что вторая точка находится ниже первой. 
Отрицательные значения углов означают, что угол больше 180°, например, 
угол -60° равен углу 300°.  
 
      
 
Совет: Вы можете измерять расстояния на экране, пользуясь величинами в 
статусной строке. Подробнее см. в разделе Измерение расстояний на 
экране. 
 
Настройка опций отображения положения указателя мыши 
 
Выберите команду Options (меню Settings) для установки опций отображения положения указателя мыши.  
 
Когда вы перемещаете мышь, положение указателя отображается в статусной строке в нижней части 
экрана. Вы можете факультативно отображать положение указателя относительно последней 
оцифрованной точки или точки стежка или как абсолютное значение от первой точки укола иглой в 
проекте. 
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Как настраивать опции отображения положения указателя мыши 
1 Выберите закладку Settings > Options > General. 
 
 
 

Выберите относительное  
или абсолютное положение  

указателя 
 
 
2 Выберите Relative (Относительную) или Absolute (Абсолютную) установку указателя.  

◄ Relative: показывается положение указателя относительно последней оцифрованной точки или 
точки стежка. Полезно во время оцифровывания или редактирования стежков. 

◄ Absolute: показывается положение указателя в абсолютных единицах от первой точки укола иглой 
в проекте. Полезно для проверки соответствия проекта имеющейся площади.  

3 Нажмите кнопку ОК. 
 
Скрытие всплывающей подсказки инструмента Measure  
 
Выберите Options (меню Settings) для отображения всплывающей подсказки Show Measure  
 
Инструмент Measure (Измерить) отображает координаты, расстояние и угол указателя мыши от точки, 
соответствующей центру пялец в пустом проекте. Вы можете показывать или скрывать эти измерения, 
используя опцию Show Measure Tooltip (Показывать всплывающую подсказку измерений). 
 
Как скрыть всплывающую подсказку инструмента Measure  
1 Выберите закладку Settings > Options > General. 
 
 
 
 
Выберите Show  
Measure Tooltip 
 
2 Проставьте флажок в окошке Show Measure Tooltip, чтобы включить опцию всплывающей подсказки.  
 

 
Опция Show Measure     Опция Show Measure  
Tooltip ВКЛЮЧЕНА     Tooltip ВЫКЛЮЧЕНА 
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Часть IX  
Управление проектом 
 
Глава 32  
 
 
Основные сведения о 
программе Portfolio  
 
Программа BERNINA artista Portfolio обеспечивает 
эффективный способ просмотра и управления проектами 
вышивки. Этот инструмент управления проектами может 
обеспечить доступ к файлам, сохраняемым на жестом диске 
компьютера, компакт-диске или дискете. Программа Portfolio 
позволяет даже архивировать и просматривать файлы в 
папках, которые были архивированы с помощью популярного 
архиватора WinZip. Она распознает все форматы файлов 
проектов, используемые в ПО BERNINA artista. Подробнее см. 
в разделе Конвертирование файлов проектов в папках. 
В этом разделе описывается полный порядок работы с 
BERNINA artista Portfolio, начиная с запуска и кончая 
просмотром, сортировкой и конвертированием проектов. Также 
объясняется, как использовать BERNINA artista Portfolio для 
публикации каталога проектов. 
 

Открытие программы Portfolio и установка стандартных настроек 
 
Программа BERNINA artista Portfolio не требует отдельной установки. Она работает как составная часть 
программного обеспечения BERNINA artista и легко настраивается и запускается. 
 
Открытие программы Portfolio 
Программу Portfolio можно открыть с рабочего стола или из меню кнопки Start (Пуск) системы Windows. 
 
Примечание: Если вы запускаете программу Portfolio с рабочего стола или из меню кнопки Start (Пуск), 
то открывается также и BERNINA artista. Если ваш компьютер работает медленно или у вас открыто много 
приложений, то Portfolio может не открыться. 
 
Совет: Закрывайте программу Portfolio в режиме View by Details (Детальный просмотр), в этом случае 
она в следующий раз будет открываться быстрее.  
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Как открыть программу Portfolio 
◄ Дважды щелкните мышью по пиктограмме Portfolio на рабочем столе Windows. 

Portfolio и BERNINA artista откроются в отдельных окнах. По умолчанию в окне Portfolio открывается 
папка My Designs (Мои проекты) с представлением всех проектов формата ART в виде свернутых в 
пиктограммы изображениями.  
 
Примечание: Вы можете переключится в Portfolio, если эта программа уже запущена. Подробнее см. в 
разделе Открытие проектов в BERNINA artista. 

 
Пиктограммы плюс информация 

Пиктограммы   Информация 
 
 

Строка  меню 
Панель  

инструментов 
 
 
 

Папки 
 

Пиктограммы  
проектов 

 
Разделительная  

линейка 
 
 
 
 
 
 
 
 

Строка состояния 
 
 
Совет: Если окно BERNINA artista перекрывает окно Portfolio, воспользуйтесь для переключения функцией  
Alt + Tab системы Windows. 
 
Изменение папок 
 
Программа Portfolio позволяет просматривать любой проект в файле поддерживаемого типа, помещенный 
в папках проектов. Обращаться с папками проектов в окне Portfolio значительно проще, чем в Windows 
Explorer (Проводник Windows). См. также Поддерживаемые форматы файлов. 
 
Совет: Процесс образования свернутых в пиктограмму изображений может занять много времени на 
старых компьютерах или если в папке содержится очень много проектов. Удерживайте нажатой клавишу 
Alt, чтобы прервать процесс перерисовывания. Пиктограмма может быть изображена с желтым 
восклицательного знака. Это не означает, что проект отсутствует. См. также Местоположение 
отсутствующих файлов. 
 
 
 
Как изменять папки 
1 Откройте программу Portfolio 

Подробнее см. в разделе Открытие программы Portfolio. 
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   Открывающийся список файлов 
 
 
 
 
 
 
 
 
 

My Computer 
 
 
 
 
 
 
 
 

Дерево  
каталогов 

 
    

Проекты в выбранной папке 
 

2 Чтобы найти проект, который не находится в текущей парке, т.е. в папке C:\My Designs, используйте 
дерево каталогов для поиска требуемой папки. 

 
Совет: Если отображены не все драйверы или парки, щелкните по значку "+" слева от  папки My 
Computer, чтобы увидеть все локальные и сетевые драйверы вашего компьютера. 

3 Щелкните по папке в дереве каталогов, чтобы просмотреть ее содержание в окне просмотра. 
Вы можете увидеть список файлов папки различными способами. Подробнее см. в разделе Просмотр 
проектов в папках. 

 
Совет: Перетащите разделительную линейку между окном дерева каталогов и окном содержания 
текущей папки влево или вправо, чтобы изменить размеры этих окон. 

 
Настройка функции просмотра проектов 
 
Выберите команду User Preferences (меню View), чтобы установить пользовательские предпочтения 
просмотра проектов. 
 
Вы можете изменять различные стандартные установки в окне Portfolio, включая размер пиктограмм 
проектов. Вы можете также изменять способ выделения выбранных проектов. 
 
Как настроить функцию просмотра проектов 
1 Откройте программу Portfolio 

Подробнее см. в разделе Открытие программы Portfolio. 
2 Выберите View > User Preferences. 

Откроется диалоговое окно User Preferences (Предпочтения пользователя). 

       
3 Выберите Highlight in Full (Полное выделение), чтобы полностью выделять пиктограмму, как только она 

быдет выбрана.  
Если вы хотите, чтобы выделение относилось только к обрамлению пиктограммы, уберите флажок из 
окошка Highlight in Full. 
 
Совет: Цвет и интенсивность выделения могут быть изменены в Панели управления (Control Panel) 
системы Windows по желанию пользователя. Подробнее см. в "Справке" системы Windows, в разделе 
"Настройки экрана". 

4 Выберите опцию Double Click Opens Design для открытия выбранного проекта двойным щелчком 
мыши. 

5 Выберите опцию Double Click Shows Properties для открытия диалогового окна Design Properties 
(Свойства проекта) двойным щелчком мыши. 

6 Нажмите OK, чтобы сохранить настройки. 
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Совет: Если вам требуется больше места в окне отображения для просмотра пиктограмм, щелкните 
по кнопке Hide/Show Directory Tree (Скрыть/Показать дерево каталогов). 

 
Изменение региональных установок 
Во время установки программы Portfolio могут быть выбраны опции рабочего языка для диалоговых окон и 
сообщений, например, немецкого. Вы можете изменять эти настройки в любое время. 
 
Внимание: Если выбранный по умолчанию язык не соответствует рабочему языку операционной системы, 
то эта опция может работать неправильно. См. также "Региональные настройки" ("locale") в Справке 
системы Windows для более подробной информации о региональных настройках. 
 
Как изменять региональные настройки 
1 Откройте программу Portfolio 
 Подробнее см. в разделе Открытие программы Portfolio. 
2 Выберите View > Change Locale, чтобы  открыть диалоговое окно. 
 Откроется диалоговое окно Choose Locale (Изменить 

региональные настройки. . 
    

Примечание: В списке будут указаны только те настройки, 
которые были выбраны при установке Portfolio. 

3 Выберите нужные вам настройки и нажмите OK для подтверждения изменений.  
 

Совет: См. также "Региональные настройки" ("locale") в Справке системы Windows для более 
подробной информации об изменениях раскладки клавиатуры, шрифтов и др. 

Просмотр проектов в папках 
 
Программа Portfolio отображает пиктограммы и ограниченную информацию о проекте каждый раз, когда 
открывается папка с проектами. Вы можете отфильтровать содержимого окна отображения, чтобы 
показывались лишь файлы определенного типа. Вы можете также переименовывать папки и папки 
нижнего уровня и удалять папки без выхода из Portfolio. 
 
Просмотр проектов 
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Щелкайте по кнопке Hide Directory Tree, чтобы показывать или скрывать дерево каталогов. 
 

При работе программы Portfolio в полноэкранном режиме в некоторых случаях удобно просматривать 
проекты, используя опцию Browse Location (Обзор местоположения). 
 
Как просматривать проекты 
1 Запустите программу Portfolio со скрытым деревом каталогов. 

    
 
2 Выберите View > Browse Location. 
 
    
3 Найдите дерево каталогов для нужной вам папки или базы 

данных и нажмите OK. 
 Зона отображения соответственно обновится. 
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Отображение пиктограмм проектов и обзорной информации 
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Щелкните по кнопке Thumbnails, чтобы отображать проекты только в виде пиктограмм. 
 
 
 
Щелкните по кнопке Thumbnails and Summary, чтобы отображать проекты в виде пиктограмм с 
данными о проекте. 
 
 
 
Щелкните по кнопке Details, чтобы просмотреть информацию о выбранном проекте. 

 
В окне Portfolio проекты могут быть представлены только как пиктограммы (по умолчанию), как 
пиктограммы с краткой информацией или только в виде таблицы.  
 
Совет: Проекты могут быть представлены на полном экране BERNINA artista. Подробнее см. в разделе 
Открытие проектов в BERNINA artista. 
 
Как отображать пиктограммы проектов и обзорную информацию 
1 Откройте программу Portfolio и выберите парку. 
 Подробнее см. в разделе Просмотр проектов в папках. 
2 Используйте опции просмотра, чтобы увидеть проекты в базе 
данных в требуемом вам формате. 
◄ Чтобы отобразить проекты только в виде пиктограмм, 

щелкните по значку Thumbnails (Пиктограммы) на панели 
инструментов. Или выберите View > Thumbnails. 

 
только пиктограмма 

 
 
 
◄ Чтобы отобразить проекты в виде пиктограмм с краткой 

информацией, щелкните по значку Thumbnails and Summary 
(Пиктограммы и информация) на панели инструментов. Или 
выберите View > Thumbnails and Summary. 

 
пиктограмма и информация 

 
 
 
 
 
◄ Чтобы отобразить проекты в виде таблицы, щелкните по 

значку Details (Детали) на панели инструментов. Или выберите View > Details. 

     
 

Примечание: Количество выбранных проект отображается в строке состояния в нижней части окна 
Portfolio. 

 
Просмотр информации о проекте 

 
Щелкните по кнопке Design Properties, чтобы просмотреть информацию о выбранных проектах. 
 

Информацию о проектах в папке можно увидеть в диалоговом окне Properties (Свойства). Эти данные 
извлекаются непосредственно из файлов проектов, созданных в BERNINA artista. Вы не можете 
добавлять, удалять и редактировать эти поля. 
 
Совет: Проекты в папках могут быть просмотрены с помощью кнопок и ползунка прокрутки в диалоговом 
окне Properties. Подробнее см. в разделе Обзор проектов в папках. 
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Как просматривать информацию о проекте 
1 Откройте программу Portfolio и выберите парку с 

проектами. 
 Подробнее см. в разделе Просмотр проектов в 

папках. 
2 Щелкните правой кнопкой мыши по проекту и 

выберите Properties (Свойства) из всплывающего 
меню. 

 Откроется диалоговое окно Properties (Свойства). 
   
 

Совет: Если не весь текст виден в поле, выберите 
поле и используйте клавиши со стрелками и клавиши 
Home, End для прокручивания текста. 
Альтернативно измените размеры диалогового окна. 

3 Нажмите OK, чтобы закрыть окно.. 
 
Просмотр архивированных проектов в папках 
Программа Portfolio позволяет архивировать и просматривать файлы в папках, которые были 
архивированы с помощью популярного архиватора WinZip. Эта программа связывает файлы в единый 
сжатый файл с расширением *.ZIP. Это может быть удобным для пересылки или получения файлов по 
электронной почте. См. также Архивирование файлов проектов. 
 
Как просматривать архивированные проекты в папках 
1 Откройте программу Portfolio и перейдите к папке, содержащейся архивированные файлы. 

◄ Если папка содержит индивидуальные архивированные проекты, они появляются непосредственно 
в окне отображения. Имя файла появится в курсивном начертании. 

◄ Если папка содержит архивированные файлы с несколькими проектами, они появляются в окне 
отображения. 

 
Архивированный файл  Архивиро-– имя написано курсивом 
в дереве каталогов   ванный проект 
 
2 Выберите архивированный файл для просмотра его содержания. 
 

 
    Архивированный файл в  Содержание файла появляется в окне просмотра 
    дереве каталогов 
    
 
Ограничение типов отображаемых файлов 
Программа Portfolio позволяет фильтровать содержимое любой папки с проектами, чтобы просматривать 
только определенные типы файлов, например только файлы ART. 
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Как ограничивать типы отображаемых файлов 
1 Откройте программу Portfolio и выберите парку с проектами. 

Подробнее см. в разделе Просмотр проектов в папках. 
2 Щелкните по кнопке Files с раскрывающимся списком на панели инструментов. 
 

      
3 Выберите: 

◄ All Files для просмотра файлов любого типа. 
◄ Artwork Files для просмотра только BMP- и PNG-файлов. 
◄ Любую другую опцию для просмотра только файлов определенного типа, например шаблонов 

(AMT). См. Поддерживаемые форматы файлов в Руководстве пользователя. 
 
Обновление экрана 
Время от времени ваш экран может не отображать выполненные вами изменения до тех пор, пока вы не 
обновите экран. Изменения в папках могут не отображаться до тех пор, пока вы не обновите дерево 
каталогов. Если графика и пиктограммы все еще не появляются в правильном виде или вы обновили ПО 
BERNINA artista, то вам потребуется обновить экран. 
 
Как обновлять экран 

◄ Для обновления окна экрана выберите View (Вид) > Refresh (Обновить) или нажмите F5. 
◄ Для обновления папок в дереве каталогов выберите View (Вид) > Refresh Tree Node (Обновить 

узел дерева каталогов). Альтернативно выберите требуемый для обновления узел, щелкните 
правой кнопкой мыши и выберите Refresh из раскрывающегося меню. 

◄ Для проверки и обновления папок щелкните по парке, содержащей файлы и выберите View > 
Validate and Refresh (Подтверждение правильности и обновление). 

 
Совет: Время от времени программа Portfolio выводит на экран красные, синие или зеленые 
вопросительные знаки и краткое описание вместо графической пиктограммы. Подробнее см. в разделе 
Местоположение отсутствующих файлов. 

 

Обращение к проектам в папках 
 
Portfolio позволяет выбирать проекты, находящиеся в папках. С выбранными проектами можно 
манипулировать различными способами, например, вырезать, копировать и вставлять объекты, 
редактировать тексты и конвертировать в другие форматы. Вы можете также открывать для просмотра 
или редактирования проекты в BERNINA artista непосредственно из Portfolio. 
 
Совет: Щелкните правой кнопкой мыши по выбранному файлу для открытия всплывающего меню с 
наиболее часто применяемыми командами. 
 
Выбор проектов в папках 
Проекты должны быть выбраны перед тем, как с ними могут быть проведены любые действия, например, 
просмотр, открытие или копирование. Можно выбрать группу проектов, несколько идущих подряд проектов 
или все проекты.   
 
Как выбирать проекты в папке 
1 Откройте программу Portfolio и выберите парку с проектами. 
 Подробнее см. в разделе Просмотр проектов в папках. 
2 Выберите отображение проектов в виде пиктограмм или в виде таблицы.  
 Подробнее см. в разделе Отображение пиктограмм проектов и обзорной информации. 
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Совет: Процесс образования свернутых в пиктограмму изображений может занять много времени на 
старых компьютерах или если в базе данных содержится очень много проектов. Удерживайте нажатой 
клавишу Alt, чтобы прервать процесс перерисовывания. Пиктограмма может быть изображена с 
желтым восклицательного знака. 

3 Отсортируйте проекты по нужной вам категории. 
Подробнее см. в разделе Сортировка файлов. 

4 Выберите проект или проекты. 
◄ Для выбора нескольких идущих подряд проектов удерживайте нажатой клавишу Shift. 
◄ Для выбора нескольких проектов удерживайте нажатой клавишу Ctrl. 
◄ Для выбора нескольких проектов в текущей папке выберите Edit > Select All. 

5 Чтобы отменить выделение всех выбранных проектов, выберите Edit > Deselect All или щелкните по 
любому невыделенному объекту. 

 
Совет: Чтобы отменить выделение одного из проектов в выбранной группе, щелкните по нему, 
удерживая клавишу Ctrl. 

 
Открытие проектов в BERNINA artista 
Любые проекты, выбранные в окне Portfolio, могут быть открыты в BERNINA artista для просмотра или 
редактирования. Подобным же образом любой графический файл в другой графической программе для 
просмотра или редактирования. 
 
Как открывать проекты в BERNINA artista 
1 Откройте программу Portfolio и выберите парку с проектами. 

Подробнее см. в разделе Просмотр проектов в папках. 
2 Выберите проект или проекты. 
 

Совет: Если вы хотите открыть несколько проектов одной командой, выберите просмотр в виде 
таблицы. Подробнее см. в разделе Отображение пиктограмм проектов и обзорной информации. 

3 Выберите File (Файл) > Open with BERNINA artista (Открыть с BERNINA artista) . 
 

Примечание: Если вы хотите открыть графический файл в другой графической программе для 
просмотра или редактирования, выберите File > Open. 

4 Альтернативно, если проекты отображены как пиктограммы, дважды щелкните по отдельной 
пиктограмме проекта. 

 Убедитесь в том, что в диалоговом окне User Preferences выбрана опция Double Click Opens Designs.  
Подробнее см. в разделе Настройка функции просмотра проектов. 

 Выбранный проект или проекты будут отображены готовые для редактирования в окне BERNINA 
artista. 

 
Совет: Для переключения между окнами BERNINA artista и Portfolio: 

 

           
 

◄ Удерживая нажатой клавишу Alt, нажмайте клавишу Tab, пока не появится значок BERNINA 
artista. Отпустите клавишу Alt. 

 
◄ Альтернативно щелкните дважды мышью по значку BERNINA artista на панели задач Windows. 

 
Создание новых проектов с шаблонами пользователя 
Вы можете открыть новый шаблон проекта в BERNINA artista из окна Portfolio. 
 
Как создать новый проект с шаблоном пользователя 
1 Выберите File > New. 

Откроется BERNINA artista и появится диалоговое окно New. 
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Примечание: Если шаблонов пользователя не имеется, диалоговое окно New может не появиться. 
2 Выберите шаблон из списка. 
3 Нажмите кнопку ОК. 
 
Восстановление соединения Portfolio с BERNINA artista 
В редких случаях программа Portfolio может вызвать проблему, которую потребуется устранить, прежде 
чем можно будет продолжать работу. Эта проблема не допускает соединения программы Portfolio с 
BERNINA artista. Следуйте приводимым ниже указаниям (в перечисленном ниже порядке), пока не будет 
найдено решение. 
 
Как восстановить соединение Portfolio с BERNINA artista 
◄ Проверьте, подсоединен ли ваш аппаратный ключ (dongle). 
◄ Проверьте, правильно ли запускается сама по себе система BERNINA artista – закройте Portfolio, затем 

запустите BERNINA artista, щелкнув по ее значку на рабочем столе Windows. 
◄ Откройте BERNINA artista, затем откройте Portfolio. 
◄ Если ни одно из этих действий не устранит проблему, переустановите BERNINA artista. 
◄ Убедитесь в том, что запущенная версия BERNINA artista соответствует той, которая 

зарегистрирована в окне Shortcut Properties программы Portfolio:  
◄ Щелкните правой кнопкой мыши по значку Portfolio на рабочем столе Windows, затем выберите 

Properties. 
 
 
 
 
 
 
 
 
 
быстрый доступ 
 
 
 
 
 

◄ Щелкните по закладке Shortcut и прочитайте последнюю часть текста в поле Target, например, 
...version=4.0A 
Эта версия должна быть идентична версии работающей у вас системы BERNINA artista. Если это не 
так, то исправьте версию и нажмите OK. 

◄ И, наконец, но только для очень опытных компьютерных пользователей, запустите функцию Windows 
regedit.exe и удалите запись под:  
\Software\BERNINA\BERNINA artista\4.0\DESIGNLIB\... 

◄ Переустановите BERNINA artista. 
 
Местоположение отсутствующих файлов 
Если пользователи неправильно перемещают файлы, нормальная пиктограмма обычно заменяется 
пиктограммой "отсутствующего проекта", когда в следующий раз открываете Portfolio. Каждый цвет 
обозначает определенную причину:  
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Значок Описание 

 

Это означает, что Portfolio не может найти файл проекта. Замените 
отсутствующие файлы резервными или файлами из других источников. 
Если это невозможно, то удалите запись или обновите каталог. См. также 
Обновление экрана. 
 

 

Это означает, что программа Portfolio нашла соответствующую 
пиктограмму, но не может распознать формат. Используйте функцию 
Validate and Refresh, чтобы обновить экран. Программа Portfolio попытается 
выполнить замену в следующий раз при открытии или обновлении. См. 
также Обновление экрана. 
 

 

Программа Portfolio распознает заранее определенный набор типов 
файлов согласно списку типов файлов. Она ищет проект, который имеет 
требуемое расширение файла – ART, BMP и т.д., – но не в состоянии 
считать файл, отображенный с зеленым знаком вопроса. Определите 
местоположение такого файла и удалите его. 

 
Переименование, добавление или удаление папок 
Вы можете переименовывать папки и папки нижнего уровня и удалять папки без выхода из Portfolio. 
 
Как переименовывать, добавлять или удалять папки 
1 Откройте программу Portfolio 

Подробнее см. в разделе Открытие программы Portfolio. 
2 Найдите папки, которые вы хотите переименовать, удалить или к которым нужно добавить папки 

нижнего уровня. 
Подробнее см. в разделе Просмотр проектов в папках. 

3 Добавьте, переименуйте или удалите папки, как вам требуется: 
◄ Чтобы добавить папку нижнего уровня к другой, выберите папку и щелкните по ней правой кнопкой 

мыши. Выберите Add Sub-directory и введите имя, когда появится новая папка нижнего уровня. 
◄ Для переименования папки выберите ее и щелкните правой кнопкой мыши. Выберите Rename из 

всплывающего меню и введите новое имя папки. 
◄ Для удаления папки выберите ее и щелкните правой кнопкой мыши. Выберите команду Delete из 

всплывающего меню. Появится требование подтвердить удаление. 
 

Вырезание, копирование и удаление проектов 
 
Проект может быть вырезан или скопирован и затем вставлен в ту же или другую папку с использованием 
программы Portfolio. Проект может быть также удален из папки. 
 
Копирование и вставка проектов 
Если выбранный проект скопирован, то он может быть вставлен в другое место, используя команду Paste. 
Скопированный проект может быть вставлен любое число раз. 
 
Как копировать и вставлять проекты 
1 Откройте программу Portfolio 

Подробнее см. в разделе Открытие программы Portfolio. 
2 Выберите любое число проектов. 
 

Подробнее см. в разделе Выбор проектов в папках. 
3 Выберите Edit > Copy. 
4 Перейдите к другой папке, выбрав нужный каталог. 

Проект может быть вставлен в ту же папку как оригинальный проект. 
5 Выберите Edit > Paste. 

Если выбранный проект, например Bear.ART, вставлен в текущую папку, а текущая папка содержит 
оригинальный проект или файл с тем же именем, новый проект автоматически получает имя Copy of 
Bear.ART. Вы можете потом переименовать новый файл, щелкнув правой кнопкой мыши по его имени, 
выбрав команду Rename и введя новое имя. Нажмите Enter, чтобы завершить переименование. 

 
Примечание: При переименовании файла обратите внимание на то, чтобы последние три буквы 
расширения, например ART, не были изменены. 
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Вырезание и вставка проектов 
Если выбранный проект вырезан, то он удаляется из текущей папки. Проект может быть затем вставлен в 
другое место с использованием команды Paste. 
 
Как вырезать и вставлять проекты 
1 Откройте программу Portfolio 

Подробнее см. в разделе Открытие программы Portfolio. 
2 Выберите любое число проектов. 

Подробнее см. в разделе Выбор проектов в папках. 
3 Выберите Edit > Cut. 

Откроется диалоговое окно с подтверждением.  
4 Нажмите Yes, чтобы вырезать проект. 
5 Перейдите к папке, в которую вы хотите вставить файл или файлы. 
6 Выберите Edit > Paste, чтобы вставить выбранный проект в новую папку. 

Если проект с таким же именем уже существует, каждая вставленная копия переименовывается. 
 
Удаление проектов из программы Portfolio 
При удалении проекты окончательно удаляются из компьютера. 
 
Как удалять проекты из программы Portfolio 
1 Откройте программу Portfolio 

Подробнее см. в разделе Открытие программы Portfolio. 
2 Выберите любое число проектов. 

Подробнее см. в разделе Выбор проектов в папках. 
3 Выберите Edit > Delete. 

Откроется диалоговое окно с подтверждением.  
4 Нажмите Yes, чтобы удалить проект. 
 

Внимание: Файл удаляется из папки окончательно. 
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Программа Portfolio для 
опытных пользователей 
 
Проекты в папках BERNINA artista Portfolio можно 
сортировать тремя способами. Это удобно для тех 
случаев, когда вы хотите выбирать проекты для 
вышивания, распечатки, архивирования и т.п. 
Проект, выбранный в папке Portfolio, может быть 
непосредственно передан в вышивальную машину. 
Вы можете также непосредственно из окна Portfolio 
конвертировать ваши ART-файлы и файлы других 
форматов. 
Каталоги проектов в папке содержат пиктограммы 
и/или краткое описание. Они могут быть 
направлены в принтер и распечатаны в различных 
форматах. Программа Portfolio позволяет 
архивировать и просматривать файлы в папках, 
которые были архивированы с помощью 
популярного архиватора WinZip. Это может быть 
удобным для пересылки или получения файлов по электронной почте. 
В этом разделе описывается более "продвинутая" технология работы с Portfolio, начиная с 
сортировки файлов для вышивания и кончая конвертированием проектов. Также объясняется, 
как печатать и публиковать каталоги проектов и как архивировать неиспользуемые проекты. 
 

Обзор проектов в папках 
 
Проекты в папках могут быть просмотрены с помощью кнопок прокрутки и скользящего показа в 
диалоговом окне Properties. Вы можете делать это как по всей папке, так и по отношению к проектам, 
выделенным инструментом Search или Sort. Вы можете также отфильтровать содержимое любой папки с 
проектами, чтобы просматривать только определенные типы файлов, например только файлы ART. 
Подробнее см. в разделах Сортировка файлов и Ограничение типов отображаемых файлов. 
 
Обзор проектов в папках 
Кнопки прокрутки в диалоговом окне Properties позволяют перемещаться вперед и назад, а также к 
первому и последнему проекту выбранной папки. Подобным же образом можно перемещаться вперед и 
назад по выбранным проектам. Во время просмотра в диалоговом окне Properties отображаются 
пиктограммы вместе с основной информацией о проекте. 
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Совет: Когда вы найдете нужный вам проект, щелкните правой кнопкой мыши по имени или пиктограмме и 
выберите File > Open with BERNINA artista, чтобы открыть его в BERNINA artista. Или выберите File > Open, 
чтобы открыть растровое изображение в другой графической программе.  
 
Как просматривать проекты в папке 
1 Откройте программу Portfolio и выберите папку с проектами. 

См. также Открытие программы Portfolio и установка стандартных настроек. 
2 Выберите или отсортируйте проекты, как вам требуется. 

См. также Сортировка файлов. 
3 Откройте диалоговое окно Properties. 

См. также Просмотр информации о проекте. 
 

     кнопки прокрутки 

 
 

4 Прокрутите содержимое всей папки или выбранных проектов, как вам требуется. 
 
  прокрутка всех папок  прокрутка выбранных папок 

 
      начало    конец    начало   конец 
 

◄ Если вы хотите прокрутить все содержание папки, используйте красные кнопки прокрутки. 
Эти кнопки позволяют перемещаться к первому проекту, последнему проекту, к предыдущему и 
следующему проекту в папке. 

◄ Используйте поле Selected для выделения или отмены выделения проектов во время просмотра. 
◄ Если вы хотите прокрутить выделенные проекты, используйте синие кнопки прокрутки. Эти кнопки 

также позволяют перемещаться к первому проекту, последнему проекту, к предыдущему и 
следующему проекту в папке. 

5 Нажмите кнопку ОК. 
 
Просмотр проектов с использованием кнопок скользящего показа 
Все проекты в папке могут быть просмотрены в режиме скользящего показа, с плавным переходом от 
одного проекта к другому. Скользящий показ запускают их диалогового окна Properties, в котором 
отображается пиктограмма проекта вместе с основной информацией.  Вы можете управлять скоростью и 
направлением скользящего показа. 
 
Как просматривать проекты с использованием кнопок скользящего показа 
1 Откройте программу Portfolio и выберите папку с проектами. 
 См. также Открытие программы Portfolio и установка стандартных настроек. 
2 Выберите или отсортируйте проекты, как вам требуется. 
 См. также Сортировка файлов. 
3 Откройте диалоговое окно Properties. 
 См. также Просмотр информации о проекте. 
 
                                                          кнопки скользящего показа 

 
             стоп               быстро/медленно 
         назад              вперед 
 
4 Щелкните по кнопке Forwards (Вперед) или Backwards (Назад), чтобы запустить скользящий показ. 
 В этом режиме происходит автоматическая плавная прокрутка проектов с быстрым возвращением к 

началу после достижения конца. 
5 Нажимайте кнопки "+" или "-", чтобы увеличить или уменьшить скорость прокрутки. 
6 Для остановки нажмите кнопку Stop. 
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Сортировка файлов 
Проекты в папках программе Portfolio можно сортировать тремя основными способами: 
◄ Простая сортировка выполняется командой View > Sort by (Name, Type, Size, or Date). Проекты 

располагаются в соответствии с выбранным критерием сортировки. Проекты могут быть 
отсортированы независимо от того, отображаются ли они в виде пиктограмм или таблицы с 
параметрами. 

◄ Простой сортировкой является использование названий заголовка таблицы:  File Name, Size, File 
Type, Version, Date, Stitches или Description. Проекты располагаются в соответствии с выбранным 
заголовком таблицы, а повторение команды реверсирует порядок сортировки. Проекты должны быть 
отображены в виде таблицы. 

◄ Сложная одно- или двухуровневая сортировка по возрастанию или по убыванию по критериям:  Colors 
(Цвет), Date Designed (Дата создания), Design Name (Имя проекта), File Type (Тип файлв), Height 
(Высота), Stitches (Стежки), Version (Версия), Width (Ширина) или None (Ни один). Проекты могут 
быть отображены в виде пиктограмм, пиктограмм с информацией или таблицы. 

 
Выполнение простой сортировки с использованием меню View  
Вы можете сортировать пиктограммы или параметры таблицы по любому из четырех критериев из меню 
View.  
 
Как выполнить простую сортировку с использованием меню View  
1 Откройте программу Portfolio и выберите папку с проектами. 
 Подробнее см. в разделе Открытие программы Portfolio. 
2 Выберите отображение проектов в виде пиктограмм или в виде таблицы.  
 Подробнее см. в разделе Отображение пиктограмм проектов и обзорной информации. 
3 Выберите View (Вид) > Sort by Name (Сортировать по имени), Sort by Type (Сортировать по типу), 

Sort by Size (Сортировать по размеру), or Sort by Date (Сортировать по дате). 
 Проекты будут рассортированы согласно выбранной опции. 
 
Выполнение простой сортировки с использованием заголовков таблицы 
Вы можете сортировать данные таблицы, нажимая заголовки таблицы.  
 
Как выполнять простую сортировку с использованием заголовков таблицы 
1 Откройте программу Portfolio и выберите папку с проектами. 
 Подробнее см. в разделе Открытие программы Portfolio. 
2 Выберите отображение проектов в виде таблицы. 
 Подробнее см. в разделе Отображение пиктограмм проектов и обзорной информации. 
 
    Для сортировки нажмите заголовок колонки 

 
3 Нажмите на заголовок колонки, по которой будет проведена сортировка, например Name. 
 Проекты будут рассортированы в порядке выбранного критерия.  
4 Нажмите заголовок опять, чтобы реверсировать расположение проектов. 
 
Выполнение сложной сортировки командой Sort 

 
Используйте команду Sort, чтобы провести сложную сортировку в диалоговом окне Sort. 
 

Вы можете рассортировать проекты по различным критериям, таким как Colors (Цвет), Date Designed 
(Дата создания), Design Name (Имя проекта), File Type (Тип файла) и т.д. Программа Portfolio позволяет 
сортировать их на одном или двух уровнях, по возрастанию или по убыванию.  
 
 
Как выполнить сложную сортировку командой Sort 
1 Откройте программу Portfolio и выберите папку с проектами. 
 Подробнее см. в разделе Открытие программы Portfolio. 
2 Выберите отображение проектов в виде таблицы. 
 Подробнее см. в разделе Отображение пиктограмм проектов и обзорной информации. 
3 Выберите View > Sort. 
 Откроется диалоговое окно Sort (Сортировать). 
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Выбор критерия уровня 1 
 
 
 
 
Выбор критерия уровня 2 
 
 
 
 

4 Выберите первый критерий сортировки: 
◄ Выберите нужную вам основную категорию из списка Sort By (Сортировать по), например Date 

(Дата). 
◄ Выберите Ascending (По возрастанию), чтобы сортировать буквы от A до Z, а числа от меньшего к 

большему, или Descending (По убыванию), чтобы сортировать в обратном порядке.  
5 Выберите критерий сортировки второго уровня: 

◄ Выберите один из критериев из открывшегося списка And Then By (И потом по), например Stitches 
(Стежки). 

◄ Выберите Ascending или Descending. 
6 Нажмите кнопку ОК. 
 В приведенном выше примере проекты в таблице будут расположены по датам и типам стежка. 

Вышивание проектов 
 
Если проект выбран в папке, вы можете непосредственно переслать в вышивальную машину, 
подсоединенную к системе BERNINA artista.  
 
Совет: Если файл выбран, щелкните по нему правой кнопкой мыши, чтобы открыть всплывающее меню с 
командами Open, Print, Convert, Write to Card/Machine и Delete. 
 
Вышивание непосредственно из Portfolio 
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Используйте команду Stitch Selected Designs, чтобы передать проект непосредственно в машину. 
 

Выберите один или несколько проектов в папке, используя программу Portfolio. Вы можете затем передать 
их в любую вышивальную машину, подсоединенную к системе BERNINA artista. 
 
Как вышивать непосредственно из Portfolio 
1 Откройте программу Portfolio и выберите папку с проектами. 
 Подробнее см. в разделе Открытие программы Portfolio. 
2 Выберите и отсортируйте подлежащие вышиванию проекты, используя команды Sort (Сортировать) 

или Search (Найти). 
 Подробнее см. в разделах Сортировка файлов и Выбор проектов в папках. 
3 Щелкните по значку Stitch Selected Designs (Вышить выбранные проекты). 
 Откроется диалоговое окно Stitch Options (Опции вышивания). 

 
 
Выберите тип машины и формат 
 
 
 
 

4 Нажмите OK и обождите. 

Конвертирование файлов проектов в папках 
 
Используйте команду Convert, чтобы конвертировать один тип файла проекта в другой. 
 

Вы можете непосредственно из окна Portfolio конвертировать ваши ART-файлы и файлы других форматов. 
 
Примечание: Вы не можете конвертировать в окне Portfolio файлы в формат PES, так как PES-файлы 
требуют установки размера пялец. 
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Как конвертировать файлы проектов в папках 
1 Откройте программу Portfolio и выберите папку с проектами. 
 Подробнее см. в разделе Открытие программы Portfolio. 
2 Выберите файл(ы) для конвертирования. 
 Подробнее см. в разделе Выбор проектов в папках. 
3 Нажмите кнопку Convert (Конвертировать). 
 Откроется диалоговое окно Convert Options (Опции конвертирования). 
 

 
 
Введите местоположение  
конвертированных проектов 
 
 
Выберите тип файлов  
для конвертирования  
 
 
 

4 Выберите типы файлов, в которые вы хотите конвертировать 
проекты. 

5 Перейдите к папке, в которой вы хотите сохранить 
конвертированные проекты, используя кнопку ... и диалоговое 
окно Browse for Folder. 

    
 
6 Щелкните по кнопке OK, чтобы начать конвертирование. 
 Конвертированные проекты будут сохранены в назначенной 

папке. 
 
 

Распечатка и публикация проектов 
 
Каталоги проектов в папке содержат пиктограммы и/или краткое описание. Они могут быть направлены в 
принтер, опубликованы на вашем сайте в интернете или интранете и экспортированы в форматах, 
совместимыми с программами электронных таблиц или баз данных. 
 
Совет: Перед распечаткой публикацией или экспортированием рассортируйте проекты по удобным для 
вас группам. Подробнее см. в разделе Сортировка файлов. 
 
Распечатка проектов 

 
Используйте команду Print для распечатки выбранного проекта или проектов. 
 

Вы можете напечатать копию проектов для выбранной группы в папках и включить пиктограммы каждого 
проекта. 
 
Примечание: В отличие от Print Designs эта опция обеспечивает распечатку всех проектов и имеющейся 
информации, но она потребует больше бумаги.  См. также Печать каталогов проектов. 
 
Как распечатать проект 
1 Откройте программу Portfolio и выберите папку с проектами. 
 Подробнее см. в разделе Открытие программы Portfolio. 
2 Выберите и рассортируйте распечатываемые проекты, используя опцию Sort. 
 Подробнее см. в разделе Сортировка файлов. 
3 Нажмите кнопку Print. 
 Откроется диалоговое окно Print. 
4 Выберите принтер, который вы хотите использовать, и введите 

количество требуемых вам копий. 
5 Для настройки опций печати нажмите Options. 
 Откроется диалоговое окно Print Options (Опции печати). 
    
6 Установите требуемые вам опции печати. Подробнее см. в 

разделе Настройка опций печати. 
7 Нажмите кнопку ОК. 
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8  Убедитесь в том, что установки принтера выбраны правильно в диалоговом окне Print Setup системы 
Windows. 

 
Примечание: Диалоговое окно и доступные установки для разных принтеров могут быть разными. 
Подробнее см. руководстве по применению вашего принтера.  

 
Распечатка каталогов проекта 
Распечатанные каталоги ваших проектов содержат пиктограммы программ и ограниченную текстовую 
информацию. Вы можете подготовить каталоги всех ваших и других проектов по своим потребностям.  
 
Как распечатать каталог проектов 
1 Откройте программу Portfolio и выберите папку с проектами. 
 Подробнее см. в разделе Открытие программы Portfolio. 
2 Выберите и рассортируйте проекты, которые должны быть включены в каталог, используя опцию Sort. 
 Подробнее см. в разделе Сортировка файлов. 
3 Выберите File > Print Designs. 
 Откроется диалоговое окно Print Designs Options (Опции печати проектов). 

     
 
4 Выберите масштаб – Scale (%), - если вы хотите увеличить или уменьшить пиктограммы. 
5 Выберите Summary, если вы хотите, чтобы была распечатана краткая информация.  
6 Нажмите Preview, если требуется предварительный просмотр. 

      
7  Нажмите Printer, чтобы выбрать принтер, размер бумаги и другие опции в диалоговом окне Print 

системы Windows для подключенного к вашему компьютеру принтера. 
8  Нажмите OK, чтобы распечатать каталог. 
 

Совет: Если для каталога требуется больше одной страницы, в диалоговом окне Print системы 
Windows вы можете выбрать, какая страница должна быть отпечатана. 

 
Публикация каталогов проектов для просмотра в браузере 
Вы можете конвертировать свои проекты в HTML- PNG-форматах, пригодны для просмотра в браузерах, 
таких как Microsoft Internet Explorer. Это даст вам возможность публиковать проекты в Интернете. Вы 
можете также пересылать каталоги по электронной почте. 
 
Как публиковать каталоги проектов для просмотра в броузере 
1 Откройте программу Portfolio и выберите папку с проектами. 
 Подробнее см. в разделе Открытие программы Portfolio. 
2 Выберите и рассортируйте проекты, которые должны быть опубликованы, используя опцию Sort. 
 Подробнее см. в разделе Сортировка файлов. 
3 Выберите File > Publish Designs. 
 Откроется диалоговое окно Publish Options (Опции публикации). 
      
4 Выберите масштаб – Scale (%), - если вы хотите увеличить или 

уменьшить пиктограммы. 
5 Выберите количество строк (Rows) и количество столбцов (Columns) 

для окончательного вывода, которые появятся в таблице. 
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6 Удалите флажок из окошка Detailed, если вы не хотите, чтобы появилась краткая информация о 
проектах.  

7  Введите имя файла и его местоположение в поле Catalog Name, например 
C:\Designs\Catalogs\Crests.htm, или примите установки по умолчанию.  

 
Совет: Создайте отдельную папку для каждого каталога – конвертирование каталога создаст PNG-
файл для пиктограммы или каждого проекта, другой PNG-файл для художественного просмотра 
каждого проекта и файл HTML для каждой странице. 

8  Щелкните по кнопке OK, чтобы начать конвертирование проектов. 
 Ваш браузер, например Windows Internet Explorer, откроется автоматически на первой странице 

проектов после завершения конвертирования. 

    
 

Если ваш браузер автоматически не открывается: 
◄ Откройте ваш браузер, например Windows Internet Explorer, через меню кнопки Start (Пуск) 

системы Windows. 
◄ Щелкните по полю Address, перейдите к выбранной папке и дважды щелкните по первому HTM-

файлу, содержащему пиктограммы, например Crests1.htm. 
Может быть по меньшей мере два HTM-файла с одним и тем же названием, например Crests.htm, 
Crests1.htm и т.д. Имя файла без цифры является индексом для всех HTM-файлов. 

Ваш браузер отобразит в окне один или несколько пиктограмм проектов. 
9  Проверьте содержание страницы. 
 Нажмите Next Page, чтобы увидеть следующий экран с пиктограммами. 
 
 Совет: Дважды щелкните по пиктограмме, чтобы увидеть изображение в режиме Художественного 

просмотра. 
10 Повторяйте эту процедуру, чтобы подогнать размер пиктограммы и расположение таблицы, если это 

потребуется. 
 
Экспорт каталогов проектов 
Информация о проекте может быть конвертирована в форматы Tab и CSV (Comma Separated Value), 
подходящие для использования в большинстве крупноформатных электронных таблиц. Подробности 
можно узнать в инструкции по пользованию программой электронных таблиц. 
 
Как экспортировать каталог проектов 
1 Откройте программу Portfolio и выберите папку с проектами. 
 Подробнее см. в разделе Открытие программы Portfolio. 
2 Выберите и рассортируйте проекты, которые должны быть опубликованы, используя опцию Sort. 
 Подробнее см. в разделе Сортировка файлов. 
3 Выберите File > Export Designs. 
 Откроется диалоговое окно Export to File Options. 

   
4 Выберите Tabs или Commas в зависимости от требуемого вашей программой электронных таблиц 

формата. 
 Откроется диалоговое окно Save As. 
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5 Выберите папку и имя файла для сохранения CSV- или TXT-файла. 
6 Нажмите кнопку Save (Сохранить). 

Проекты будут преобразованы и сохранены в выбранном формате. 
 

Архивирование файлов проектов 
 
Программа Portfolio позволяет архивировать и просматривать файлы в папках, которые были 
архивированы с помощью популярного архиватора WinZip. Эта программа связывает файлы в единый 
сжатый файл с расширением *.ZIP. Это может быть удобным для пересылки или получения файлов по 
электронной почте. 
 
Сохранение файлов проектов в одном сжатом файле 

 
Используйте программу WinZip для архивирования выбранных проектов в одном сжатом файле. 
 

Программа Portfolio обеспечивает прямой доступ к WinZip через панель инструментов. 
 
Как сохранить файлы проектов в одном сжатом файле 
1 Откройте программу Portfolio 
 Подробнее см. в разделе Открытие программы Portfolio. 
2 Выберите папку и выберите проект или проекты, которые вы хотите архивировать. 
3 Щелкните по значку WinZip. 

◄ Если вы выбрали один файл проекта, система создаст ZIP-файл, имя которого будет 
соответствовать имени проекта. 

◄ Если вы выбрали больше одного файла проекта, откроется диалоговое окно Create Zip Archive. 

       
 
4 Выберите, нужно ли архивировать выбранные файлы индивидуально или в одном сжатом файле . 

◄ Если вы выберете Individuals, система создаст ZIP-файл для каждого проекта, имя которого 
будет соответствовать имени проекта. 

◄ Если вы выберете One, откроется диалоговое окно Save As. 
 
 
Выберите местоположение 
 
 
 
 
 
 
 
 
 
 
Введите имя файла 
 
 
 

5 Введите имя файла для вашего архивного файла и нажмите Save. 
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 Выбранные проекты будут скопированы в ZIP-файл. Вы можете просматривать их в выделенном 
файле. Подробнее см. в разделе Просмотр архивированных проектов в папках. 

 
Извлечение файлов проектов из ZIP-архива 
Программа Portfolio позволяет извлекать файлы проектов из ZIP-архива непосредственно в базу данных. 
Это удобно, например, если вы получили архивированные проекты по электронной почте. 
 
Как извлекать файлы проектов из ZIP-архива 
1 Откройте программу Portfolio 
 Подробнее см. в разделе Открытие программы Portfolio. 
 
2 Выберите папку и выберите проект или проекты, которые вы хотите извлечь из архива. 

 
 
 
 
 
 
 
 
 
 
 
 
Архивированный проект –  
имя написано курсивом 

 
 
 
 
 
 
 

Архивированный проект в дереве каталогов 
 
3 Выберите индивидуальный проект для извлечения в окне отображения или ZIP-файл в дереве 

каталогов. 
4 В ZIP-файле выберите нужный вам проект или проекты.  

◄ Для выбора нескольких проектов удерживайте нажатой клавишу Ctrl. 
◄ Для выбора нескольких идущих подряд проектов удерживайте нажатой клавишу Shift. 

5 Выберите File > Extract Zip Archive. 
Откроется диалоговое окно Browse for Folder, в котором требуется определить место сохранения 
извлеченного файла.  

 
 
 
 
 
Выберите местоположение 
 
 
 
 
 
 
 
 

6 Выберите местоположение и нажмите OK. 
 Проект будет извлечен в выбранное местоположение. Если вы сохранили его в папке, открытой в 

Portfolio, то вы сможете его увидеть. Подробнее см. в разделе Изменение папок. 
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Часть X  
Вышивка крестом 
 

Глава 34  
 
Введение в технику вышивки 
крестом 
Вышивка крестом является популярной техникой заполнения больших зон 
малым количеством стежков. Такие стежки можно использовать также для 
оконтуривания и обрамления. Вышивание в такой технике подходит для 
украшения домашнего текстиля, скатертей, детской одежды и 
фольклорных мотивов. Стежок для вышивки крестом иногда комбинируют с 
аппликацией. 
В отличие от машинной вышивки, в которой проекты усовершенствуются 
различными типами и углами наклона стежков, а также разными 
эффектами, при вышивке крестом вы можете только добавлять формы к 
проекту с различными оттенками цвета. По этой причине в большинстве 
проектов вышивки крестом используется больше цветов, чем при 
машинной вышивке. 
В этом разделе дается обзор различных стежков для вышивки крестом. 
 

Типы стежков для вышивки крестом 
 
Стежки для вышивки крестом создаются на основе квадратных матриц, или "пикселей". Может быть 
вышита любая часть квадрата, от краев до диагоналей. Ниже проиллюстрирован полный диапазон 
стежков для вышивки крестом: 
 

Full Cross  
Полный крест 
 

Upright Cross 
Прямой крест 

Three-Quarter Cross  
Три четверти креста 
 

Double Cross 
Двойной крест 

 
Half Cross  
Половина креста  

Elongated Vertical Cross 
Удлиненный по вертикали крест 

 
Quarter Cross 
Четверть креста 
 

Elongated Horizontal Cross 
Удлиненный по горизонтали крест 

Mini Cross  
Мини крест 
 

Single Line 
Одиночная линия 

 
French knot 
Французский узел 
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Заполнение стежками для вышивки крестом 
При использовании стежков для вышивки крестом для заполнения вы можете выбрать любой тип этих 
стежков. 
 
Стежок "Полный крест" 
Стежки этого типа – это два пересекающихся стежка одинаковой длины, образующие крест (Х).  Общий 
эффект заполнения зависит от того, на каком стежке находится Х – ниже или выше. Вы можете также 
смешивать расположение стежков для специальных эффектов. 
 
узор стежка "Полный крест" 
 
 
 
 
 
 
Стежок "Три четверти креста" 
Стежок этого типа обычно создается из четверти креста, за которым следует половина креста. Другой 
эффект получается при выполнении вначале половины креста, закрепляемой четвертью креста. 
 

    
Узор стежка "Три четверти креста" 
 
Примечание: Длинное плечо стежка "Три четверти креста" может иметь направление "/" или "\". Нередко 
четверть стежка и стежок три четверти креста разных цветов образуют простой квадрат. При смешивании 
и подгонке их положения можно получать различные эффекты. 

   
смешивание стежков в четверть и три четверти креста 
 
 
Стежок "Половина креста" 
Половина креста – это простой диагональный стежок, 
имеющий вид "/" или "\". Стежки этого типа обычно 
используются для создания тени или фоновой тени. Стежок 
может начинаться от любого угла. Иногда две половины 
стежка разного цвета используются для создания полного 
креста. 
 

узор стежка "Половина креста" 
 
Стежок "Половина креста" может быть выполнен в разном направлении в зависимости от нужного вам 
эффекта. Например, этот стежок, используемый для изображения перьев, может иметь тот же наклон, что 
и сами перья.  
 
Стежок "Четверть креста" 
Стежок этого типа используется для создания более 
сложных узоров. 
 

узор стежка "Четверть креста" 
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Стежок "Мини крест" 
Стежки "Мини крест" образуются двумя стежками равной длины, 
пересекающимися в виде "Х", но заполняющими только четверть 
квадрата. Используйте стежок "Мини крест" для таких деталей, 
как глаза, или для более плотных деталей проекта. 
 

узор стежка "Мини крест" 
 

 
Стежок "Прямой крест" 
Стежки "Прямой крест" создаются вертикальными и 
горизонтальными стежками. 
Эти стежки можно располагать по диагонали по отношению к 
канве или по горизонтальным или вертикальным линиям. 
 

узор стежка "Прямой крест" 
 

 
Стежок "Двойной крест" 
Этот стежок образуется двумя стежками полного креста, 
повернутыми на 90є. Двойной крест напоминает звезду. Он 
обычно используется с произвольным расположением или в 
виде рядов для образования декоративного обрамления. 
 

узор стежка "Двойной крест" 
 

 
Обычно верхняя нитка нижнего креста является 
располагаемым под углом 135є к горизонтали стежком, а верхняя нитка перекрывающего стежка является 
горизонтальным стежком. 
 
Стежок удлиненного креста 
Стежок удлиненного креста состоит из двух стежков 
равной длины, пересекающихся в виде "Х". 
Имеются два типа: 
◄ стежок "Удлиненный по горизонтали крест" 
◄ стежок "Удлиненный по вертикали крест" 
Стежки удлиненного по горизонтали креста являются 
уменьшенными в два раза по высоте, а стежки 
удлиненного по вертикали креста - уменьшенными в два 
раза по ширине нормальными стежками полного креста. 
 

узор стежка "Удлиненный крест" 
 

 
Французский узел 
Французские узлы являются оригинальными 
рукодельными стежками, используемыми в Европе для 
придания "объемности" декоративной вышивке. 
Традиционно они используются в "белом шитье" с 
эксклюзивными хлопчатобумажными и тонкими 
шелковыми нитками. Французские узлы могут быть 
использованы в комбинации с другими стежками для 
вышивки крестом или оконтуривающими стежками. 
 

Узор стежков "Французский узел" 
 

 
Используйте этот стежок для изображения глаз, круглых дверных ручек, бутонов цветов или в виде 
бусинок в составляемых вручную проектах, а также для точки над буквой "I". Используйте его также для 
оконтуривания обрамления. Попытайтесь использовать полноцветные металлизированные или 
разноцветные нитки. Французские узлы лучше выглядят в крупной сетке. 
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Обрамление стежками для вышивки крестом 
Стежок для вышивки крестом может быть использован для выполнения контура или обрамления. Можно 
также комбинировать стежки для вышивки крестом с другими типами стежков для получения специальных 
эффектов. 
Вы можете создавать контуры стежками типа Single Line (Одиночная линия) или Full Cross (Полный крест) 
или обоими этими стежками для более плотных контуров. Контур стежком Single Line обрабатывается 
программой как обрамление, в то время как стежком Full Cross – как заполнение.  Это важно знать, если 
вам нужно удалять обрамление, поскольку обрамление одиночной линией может быть удалено как 
одиночный объект, обрамление полным крестом – нельзя. 
 
Обрамление стежком "Одиночная линия" 
Стежки Single Line используются только для создания обрамлений или добавления деталей. Одиночная 
линия может быть помещена на любой стороне квадрата. Щелкните по стороне, на которой вы хотите 
поместить линию. Вы можете поместить одиночную линию обрамления на одной или на всех четырех 
сторонах квадрата. Стежки обрамления одиночной линией могут быть размещены в квартратах, в которых 
уже имеется крест.  

 
Обрамление стежком "Одиночная линия" 
 
Обрамление стежком "Полный крест" 
Стежки "Полный крест" могут использоваться также в качестве декоративных оконтуривающих стежков. 
Если вы используете стежок "Полный крест" в качестве обрамления он будет тем же, что и был выбран 
для заполнения в списке Fill stitch type (Тип заполняющего стежка). Вы можете изменить его путем 
изменения типа заполняющего стежка. 

 
Обрамление стежком "Полный крест" 
 

Вариации стежка для вышивки крестом 
 
Ориентацию стежков с неполным крестом можно изменять для создания различных узоров с эффектами. 
Вы можете делать это непосредственно в каждом квадрате или путем настройки оконтуривающих 
стежков. Вы можете также комбинировать стежки с неполным крестом различными способами. См. также 
Типы стежков для вышивки крестом. 
 
Стежки "Три четверти креста" 
Стежки "Четверть креста" и "Три четверти креста" могут быть использованы для создания закругленных 
углов. См. также Заполнение стежками для вышивки крестом. 

 
 
 
Стежки "Половина креста" 
Стежки "Половина креста" могут быть использованы для получения объектов "воздушного" вида. Вы 
можете также использовать такие стежки, чтобы создавать двухцветные стежки "Полный крест".  См. 
также Комбинация стежков. 

 
  две половины креста  комбинация для получения  
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двухцветного полного креста 
Стежки "Четверть креста" 
Стежки "Четверть креста" и "Три четверти креста" могут быть использованы для создания плавных 
закругленных углов. Вы можете также использовать такие стежки, чтобы создавать стежки "Полный крест" 
с четырьмя цветами. См. также Комбинация стежков. 
 

Щелкните здесь, чтобы начать с этого угла 
 
 
 

Стежок "Полный крест", созданный из четырех  
четвертей креста разных цветов 

 
 
См. также Комбинация стежков. 
 
Стежки "Мини крест" 
Используйте стежок "Мини крест" для таких деталей, как глаза, или для более плотных деталей проекта. 

             
четыре мини креста         комбинация для получения  

           четырех мини креста 
Стежки удлиненного креста 
Удлиненные по горизонтали и вертикали кресты создаются из двух равной длины стежков, образующих 
крест.  
 

    
узоры стежка "Удлиненный крест" 

 
Комбинации стежков 
Стежки в четверть, половину и три четверти креста можно комбинировать для создания составных 
многоцветных крестов. Вы можете также комбинировать мини кресты, удлиненный по горизонтали или 
вертикали кресты с оконтуривающими стежками. 
 

 
 
 
комбинированные стежки  
в 1/4, 1/2 и 3/4 креста 
 
 
комбинированные стежки  
удлиненного по вертикали или горизонтали креста 
 
 
комбинированные стежки  
неполного креста и мини креста 
 
 
комбинированные по цвету  
оконтуривающие стежки 
 
 
комбинация оконтуривающих  
стежков 
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Глава 35  
 
 
 
 
 
 
Основные сведения о 
программе Cross Stitch  
 
 
В программе BERNINA artista Cross Stitch вы можете 
добавлять стежки для вышивки крестом в весь проект 
или в отдельный его фрагмент. Или вы можете 
размещать их индивидуально. Имеется два типа 
стежков – оконтуривающие и заполняющие. Стежковое 
оконтуривание может быть однорядным или в виде 
линии стежков для вышивки крестом. Для заполнения 
можно использовать любой тип стежка для вышивки крестом. Вы можете заранее установить 
тип стежка, длину и число повторения каждого стежка. 
В этом разделе описывается использование окна проекта стежков для вышивки крестом, 
техника ручного оцифровывания стежков и обращение с файлами проектов вышивки крестом. 
 

Открытие программы вышивки крестом Cross Stitch 
 
Щелкните по инструменту Cross Stitch (панель Design) для запуска приложения Cross Stitch  

 
Проект вышивки крестом предусматривает использование различных приемов оцифровывания. По этой 
причине приложение для вышивки крестом имеет собственное окно проекта, открывающееся из BERNINA 
artista. 
 
Как открыть программу Cross Stitch 
1 Запустите BERNINA artista. 
2 Выберите режим Design. 
3 Нажмите на значок Cross Stitch  
 Откроется окно Cross Stitch. 
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Строка заголовка 
Строка  меню 

Общая панель инструментов 
Кнопки переключения  

режимов 
 
 
 

Панель рисунка/проекта 
 (изменяется при 
 выборе режима) 

 
 
 
 
 
 
 
 
 
 
 
 

Панель инструментов  
Stitch and Color  

Строка состояния 
 
Режимы Picture и Design  
 

Нажмите кнопку Picture, чтобы загрузить рисунок, используемый в качестве шаблона. 
 
 
Нажмите кнопку Design для редактирования и добавления стежков. 
 

Программа Cross Stitch использует два режима рабочего окна – Picture (Рисунок) и Design (Проект).  
Используйте режим Picture для открытия или сканирования рисунка в качестве шаблона вышивки. 
Отредактируйте рисунок в режиме Picture, затем выберите режим Design, чтобы редактировать стежки, 
или перейдите сразу же к режиму Design, добавлять стежки без использования шаблона. Чтобы увидеть 
свой проект в режиме Artistic, откройте проект в BERNINA artista. Подробнее см. в разделе Использование 
стежков для вышивки крестом в BERNINA artista. 
 
Изменение настроек сетки 
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Нажмите инструмент Grid (панель General), чтобы отобразить или скрыть сетку. Щелчок правой 
кнопкой мыши открывает диалоговое окно Grid. 

 
Используйте диалоговое окно Options > Grid для изменения настроек сетки:  
◄ показать или скрыть сетку 
◄ показать главные линии (если сетка вкдючена) 
◄ установить интервал сетки 
◄ изменить цвет главных и второстепенных линий 
 
Как изменить настройки сетки 
1 Щелкните правой кнопкой мыши по значку Grid (Сетка). 
 Появится диалоговое окно Options с открытой закладкой Grid.  
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Выберите Show Grid 
Выберите Show Major  

Lines 
 
 
 

Введите число крестиков для  
подгонке к сетке 

 
 
 

Выберите цвета линий 
 
 
 
2 Проставьте флажок в окошке Show Grid, чтобы отобразить линии сетки. 
3 Выберите Show Major Lines, чтобы отобразить главные линии сетки. 
4 Введите число крестиков для подгонки к главным линиям сетки. 
5 Нажмите Edit для изменения цвета главных и второстепенных линий сетки.  

 
 
 
 
 
Выберите цвет 
 
6 Выберите из имеющихся цветов или назначьте собственный цвет. 
 Нажмите кнопку Define Custom Colors (Определить цвет 
пользователя), чтобы смешать цвета из цветового круга. 
7  Нажмите кнопку ОК. 
 
 
 

Изменение настроек пялец 
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Нажмите инструмент Hoop (панель General), чтобы отобразить или скрыть пяльцы. Щелчок правой 
кнопкой мыши открывает диалоговое окно Hoop. 

 
Вы можете отображать или скрывать пяльцы, изменять размеры пялец и центрировать проект в пяльцах. 
 
Как изменить настройки пялец 
1 Щелкните правой кнопкой мыши по значку Hoop (Пяльцы). 
 Появится диалоговое окно Options с открытой закладкой 

Hoop (Пяльцы).  
 

Выберите Display Hoop 
 

Выберите тип пялец 
 
 
 
2 Проставьте флажок в окошке Display Hoop (Отобразить 

пяльцы). 
3 Выберите тип пялец из списка. 
 

Примечание: Функция Automatic Centering (Автоматическая центровка) всегда включена. Чтобы 
создать группу стежков установите на одной стороне проекта, оцифруйте несколько временных 
стежков на другой стороне. 

4 Нажмите кнопку ОК. 
 
Изменение цветов фона и ткани 
BERNINA artista дает возможность выбирать цвет фона в окне проекта, чтобы согласовать его с цветом 
вашей ткани. Или же можно выбрать фон ткани для более реалистичного вида и воспроизведения. 
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Как изменить цвет фона или ткани 
1 Выберите Settings > Options. 
2 Выберите закладку Background (Фон). 

 
 
 
 
Правка цветности 
 
Выбор узора ткани 
 
 
 
 
 
 

Выбор цвета фона  Центровка или мозаичное расположение узора ткани в окне проекта 
или ткани 
 
3 Выберите окно проекта с типом фона. 
    

◄ Color (Цвет):  используется выбранный цвет. 
◄ Fabric (Ткань): используется образ ткани. 

4 Выберите для использования цвет или ткань. 
◄ Для выбора цвета фона нажмите Edit. Выберите цвет в 

диалоговом окне Color и нажмите OK. 
 
 

Выбор цвета фона 
 
 
 
 

◄ Для выбора ткани нажмите Browse (Обзор). Выберите 
тип ткани из диалогового окна Open и нажмите OK. 

 
 
 
 
 

Выбор  
ткани фона 

 
 
 
 
 
 

Вы можете расположить растровый рисунок ткани по центру 
окна проекта или образовать мозаичную структуру. Если 
растровый рисунок достаточно большой, выберите Center. В 
противном случае выберите Tile (Плиточная кладка).. 

5 Нажмите кнопку ОК.  
 
 
Просмотр стежков в виде крестиков или плиток 
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Нажмите инструмент Crosses (панель General), чтобы показать стежки в виде цветных плиток или 
крестиков. 

 
Имеется два режима отображения стежков для вышивки крестом – в виде крестиков или цветных "плиток". 
Когда вы перейдете к режиму Tile, вы увидите тот же результат, когда вы импортируете растровое 
изображение в окно проекта. 
 
Как просматривать стежки в виде крестиков или плиток 
1 Выберите режим Design. 
2 Нажмите кнопку Crosses (Крестики). 

Все оцифрованные зоны показываются в виде крестиков (или линий для линии обрамления). 
3 Щелкните еще раз, чтобы показать стежки в виде цветных квадратов. 
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Стежки показаны     Стежки показаны  
в виде квадратиков    в виде цветных квадратиков 

   
Стежки показаны     Стежки неполного креста  
в виде квадратиков    показаны в виде цветных квадратиков 

 
Просмотр информации о проекте 
В строке состояния показывается информация о проекте, такую как сведения об индивидуальных стежках, 
приблизительное количество стежков и нитках, используемых в проекте, а также масштабный 
коэффициент. 
 

 
         координаты указателя мыши                 количество стежков     масштабный коэффициент  
 

Настройка размера и плотности проекта 
 
В программе BERNINA artista Cross Stitch размер проекта контролируется плотностью ткани. Например, 
чем больше стежков на дюйм, тем меньше размеры и тем более компактнее проект. Вы можете 
регулировать плотность индивидуальных стежков для вышивки крестом, выполняя его один, два или три 
раза. 
 
Установка размера проекта 
Вы можете установить размер проекта для вышивки крестом, регулируя "плотность ткани". В 
действительности этим изменяется масштаб вашего окончательного проекта. Например, чем больше 
стежков на дюйм, тем меньше размеры и тем более компактнее проект.  
 
Внимание: Общей проблемой проектов для вышивки крестом является их "стягивание", особенно при 
использовании мелких и плотно расположенных стежков. Проекты для вышивки крестом имеют 
склонность стягивать ткань равномерно, с образованием пробелов по прямым линиям. Иногда отверстия 
создают впечатление пропуска стежков.  См. также Настройка плотности стежков. 
 
Как устанавливать размер проекта 
1 Выберите Settings (Настройки) > Fabric Count (Плотность ткани).. 
 Откроется диалоговое окно Fabric Count. 
 
 
 

Ввод числа стежков  
на дюйм 

 
Ввод числа стежков  

на мм 
 
 
2 Выберите опцию плотности ткани, в дюймах или миллиметрах. 

◄ Число стежков на дюйм: Чем меньше стежков на дюйм, тем крупнее готовый проект. 
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◄ Число миллиметров на число стежков: Поскольку стежки для вышивки крестом больше 
миллиметра, вы можете настроить проект относительной величиной, отношением числа 
миллиметров к числу стежков.  Чем больше число миллиметров или меньше число стежков, тем 
крупнее проект. 

 
Совет: При нажатии кнопки Update происходит немедленное преобразование любой введенной вами 
величины. Например, измените число стежков на дюйм, нажмите Update, и соответствующее число 
стежков на мм будет обновлено.  

3 Нажмите кнопку ОК. 
15 стежков на дюйм  10 стежков на дюйм 

     
15 стежков на 25,4 мм  10 стежков на 25,4 мм 

 
Настройка плотности стежков 

 
Используйте список Threads в строке Stitch / Color для установки плотности 
стежков. 

 
Вы можете регулировать плотность любого стежка для вышивки крестом, выполняя его один, два или три 
раза. Число "пересечений" соответствует значениям 2, 4 и 6 в списке Threads (Нити). Вы можете 
изменить эти значения в любое время. 
Если вы уменьшаете проект для его подгонки к размеру пялец, стежки могут накладываться друг на друга 
и стягивать ткань. Вы можете устранить эту проблему, сократив число пересечений до одного (2 нити) для 
заполнений и контуров. Вы также можете использовать нитки меньшей толщины. 
 
Совет: Если вы вышиваете крестом проект, в котором каждый квадрат заполняется стежком, не забудьте 
стабилизировать ткань. 
 
Как установит плотность стежков 

◄ Выберите значение из списка Threads. Значение 
2 соответствует одинарному стежка, 4 – 
двойному, а 6 – тройному. На экране это 
отображается толщиной линий. 

    
 

Совет: При перемещении указателя мыши по 
стежкам во всплывающей подсказке можно узнать о 
типе и цвете стежка. 

 
в 2 нитки       в 6 ниток 

Выбор типов стежков для вышивки крестом 
 
Программа BERNINA artista Cross Stitch предоставляет полный набор стежков для вышивки крестом, 
которые вы можете использовать для создания контуров и заполнений любого цвета. Вы можете также 
изменять ориентацию неполных стежков-крестиков для создания различных эффектных узоров. 
 
Выбор цвета стежков 
Вы можете выбирать цвет стежков из Color Palette (Палитра цветов) до оцифровывания или применить 
новый цвет для выбранных зон.  
 
Как выбрать цвет стежка 
1 Щелкните правой кнопкой мыши по палитре цветов, чтобы открыть ее. 
 

Совет: Если вы хотите, чтобы панель Select Thread Palette (Панель выбора нитки) оставалась 
открытой, щелкните правой кнопкой мыши по кнопке Stitch Type (Тип стежка). 

2 Выберите цвет: 
◄ Выберите цвет из палитры цветов, чтобы применить его к заново оцифровываемым объектам. 
◄ Выберите блок стежков, затем выберите цвет для изменения первоначального цвета.  
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                 Палитра цветов 

 
Стежки будут оцифрованы в этом цвете.  

 
Совет: Вы можете перетащить палитру Select Thread Palette в любое 
удобное для вас место экрана.   

 
Выбор оконтуривающих стежков 

 
Используйте инструмент Outline (панель Stitch & Color) для выбора оконтуривающих стежков. 

 
Выберите оконтуривающий стежок из списка Outline Stitch. 

 
Имеется два типа оконтуривающих стежков: Single Line (Одиночная линия) и Current Cross Stitch (Текущий 
стежок для вышивки крестом). Выберите тип стежка перед выбором опции Current Cross Stitch. 
 
Как выбрать оконтуривающий стежок 
1 Нажмите кнопку Outline (Оконтуривание). 
2 Выберите тип оконтуривающего стежка из списка Outline Stitch. 

Новые стежки будут оцифрованы в виде одиночных линий или крестиков. Если вы используете опцию 
Current Cross Stitch, будет применен выбранный тип стежка для вышивки крестом. Подробнее см. в 
разделе Выбор заполняющих стежков. 

     
Оконтуривание одиночной  оконтуривания крестообразными  
линии       стежками 

 
 

Примечание: В зависимости от выбранного типа стежка вы можете задать направление стежка. 
Подробнее см. в разделе Настройка ориентации стежков для вышивки крестом. 
 

Выбор заполняющих стежков 
 
Используйте инструмент Fill на панели Stitch / Color для выбора заполняющих стежков. 
 

Щелкните по кнопке Fill Cross, чтобы открыть карту Fill Stitch. 
 

В качестве заполняющих используются все типы стежков для вышивки крестом. Выберите нужное из 
следующих типов: Full Cross (Полный крест), Three-quarter Cross (Три четверти креста), Half Cross 
(Половина креста), Quarter Cross (Четверть креста), Mini Cross (Мини крест), Upright Cross (Прямой 
крест), Double Cross (Двойной крест), Elongated Vertical Cross (Удлиненный по вертикали крест) и 
Elongated Horizontal Cross (Удлиненный по горизонтали крест). См. Заполнение стежками для вышивки 
крестом в Руководстве пользователя. 
 
Как выбрать заполняющий стежок 
1 Нажмите кнопку Fill (Заполнить). 
2 Щелкните правой кнопкой мыши по кнопке Fill Cross. 
 

Совет: Если вы хотите, чтобы диалоговое окно Select Stitch (Выбор стежка) оставалось открытым, 
щелкните правой кнопкой мыши по кнопке Fill Stitch (Заполняющий стежок).  

 
 Кнопка Fill Stitch  
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Откроется карта Select Stitch (Выбор стежка). 

 
 

3 Выберите тип стежка. 
Стежки будут оцифрованы с этим типом стежков. Карта Select Stitch (Выбор стежка) закроется. 

4 В зависимости от выбранного типа стежка вы можете задать направление стежка. Подробнее см. в 
разделе Настройка ориентации стежков для вышивки крестом. 

 
 

Различные эффекты заполнения стежками для вышивки крестом 
 

 
 
 
 
Настройка ориентации стежков для вышивки крестом. 
Вы можете также изменять ориентацию неполных стежков-крестиков для 
создания различных эффектных узоров. При оцифровывании 
индивидуальных стежков вы делаете это непосредственно квадрат за 
квадратом. При оцифровывании заполнения для этого нужно пользоваться диалоговым окном Select Fill 
Style (Выбор типа заполнения). Способ остается тем же. См. Типы стежков для вышивки крестом в 
Руководстве пользователя. 
 
 
 
 

Щелкните по заполняемому квадранту  
 
 
Как установить ориентацию стежков для вышивки крестом 
◄ Для создания стежков в три четверти креста щелкните по углу, в котором должен образоваться этот 

стежок. 

    
 
◄ Для создания стежка в половину креста щелкните по углу, в котором должен образоваться этот 

стежок. 

                                  
Щелкните здесь для создания стежка "/"            Щелкните здесь для создания стежка "\" 
 
◄ Для создания стежка в четверть креста щелкните по углу, в котором должен образоваться этот 

стежок. 
Щелкните здесь, чтобы начать с этого угла 
 
 
 

◄ Для создания стежка мини крест щелкните по углу, в котором должен образоваться этот стежок. 
 
Щелкните здесь для помещения стежка в этом углу 
 
 
 
 
 

◄ Для создания стежка удлиненного креста щелкните по углу, в котором должен образоваться этот 
стежок. 
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Щелкните здесь для помещения стежка на этой стороне 

           

Оцифровывание стежками для вышивки крестом 
 
Программа BERNINA artista Cross Stitch предоставляет различные технические приемы для 
оцифровывания одиночных стежков или рядов стежков, заполненных и не заполненных прямоугольников 
или окружностей или  заполненных и не заполненных "закрытых" произвольных форм. Вы можете также 
создавать контуры или обрамления произвольной формы. Функция Area Fill (Заполнение формы) 
позволяет заполнять стежками закрытые  формы или "цветовые блоки".  
 
Оцифровывание одинарных стежков или рядов стежков 
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Используйте инструмент Pencil (панель Design), чтобы нарисовать одинарный стежок или ряд 
стежков. 

 
Вы можете оцифровывать одинарный стежок или ряд стежков. В зависимости от выбранного типа стежка 
вы должны также задать направление стежка. См. также Создание комбинации стежков. 
 
Как оцифровать одинарный стежок или ряд стежков 
1 Щелкните по Outline (Оконтуривание) и выберите тип оконтуривающего стежка. 

Если вы используете опцию Full Cross, будет применен выбранный тип стежка для вышивки крестом. 
См. также Выбор заполняющих стежков. 

2 Выберите цвет из цветовой палитры. 
Подробнее см. в разделе Выбор цвета стежков. 

3 Нажмите кнопку Pencil (Карандаш). 
4 Щелкните по квадрату, чтобы создать одинарный стежок, или перетащите карандаш, чтобы нарисовать 

линию. 
 

Примечание: Нажмите Ctrl перетаскивайте инструмент, чтобы получать прямые вертикальные линии. 
 
 
 
Одинарные стежки и линии 
 
 
Совет: Вы можете также использовать инструмент Pencil для создания 
комбинаций неполных крестов разного цвета. См. также Создание комбинации 
стежков. 
 

Оцифровывание окружностей 
 

Используйте инструмент Circle (панель Design) для оцифровывания окружностей. 
 

Инструмент Circle ( Окружность) позволяет быстро оцифровывать заполненные или не заполненные 
окружности. 
 
Как оцифровывать окружность 
1 Нажмите кнопку Circle (Окружность). 
2 Выберите цвет из цветовой палитры. 

Подробнее см. в разделе Выбор цвета стежков. 
3 Выберите тип стежка Outline (Оконтуривающий) или Fill (Заполняющий). 

Подробнее см. в разделе Выбор типов стежков для вышивки крестом. 
4 Наметьте точку центра и затем точку на окружности. 

◄ Если вам нужна окружность, нажмите Enter дважды. 
◄ Если вам нужен эллипс, наметьте третью контрольную точку и нажмите Enter. 
Окружность или овал заполняются или оконтуриваются в зависимости от выбранного типа стежка. 
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Обрамление стежком 
"Полный крест 

Обрамление стежком 
"Полный крест" 

Заполнение стежком 
"Три четверти креста" 

Заполнение стежком 
"Половина креста" 

 
Оцифровывание прямоугольников 
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Используйте инструмент Rectangle (панель Design) для оцифровывания прямоугольников или 
квадратов. 
 

Инструмент Rectangle (Прямоугольник.) позволяет быстро оцифровывать заполненные или не 
заполненные прямоугольники или квадраты. 
 
Как оцифровывать прямоугольник 
1 Щелкните по значку Rectangle (Прямоугольник). 
2 Выберите цвет из цветовой палитры. 

Подробнее см. в разделе Выбор цвета стежков. 
3 Выберите тип стежка Outline (Оконтуривающий) или Fill (Заполняющий). 

Подробнее см. в разделе Оцифровывание стежками для вышивки крестом. 
4 Наметьте начало объекта, а затем угол прямоугольника. 

Нажмите Ctrl и наметьте углы, чтобы оцифровать квадрат.  Квадрат или прямоугольник заполняются 
или оконтуриваются в зависимости от выбранного типа стежка. Подробнее см. в разделе 
Оцифровывание прямоугольников.  

 
Примечание: В зависимости от выбранного типа стежка вы можете задать направление стежка. 
Подробнее см. в разделе Создание комбинации стежков.. 

 
Обрамление стежком   Обрамление стежками  Заполняющие стежки 
"Одиночная линия"   полного креста 

  
  
Оцифровывание открытых и закрытых форм 

 
Используйте инструмент Closed Curve (панель Design), чтобы рисовать и оцифровывать замкнутые 
фигуры. 
 
Используйте инструмент Open Curve (панель Design), чтобы рисовать и оцифровывать незамкнутые 
фигуры. 
 

Вы можете создавать произвольной формы контуры или обрамления, используя инструмент Open Curve 
(Незамкнутая кривая). Вы можете создавать произвольные заполняемые формы, используя инструмент 
Closed Curve (Замкнутая кривая). Выберите оконтуривающий стежок для не заполняемых форм и 
заполняющий стежок для заполняемых форм. 
 
Как оцифровывать незамкнутую или замкнутую фигуру 
1 Нажмите на кнопку Open Curve ( Незамкнутая кривая) или Closed Curve (Замкнутая кривая). 
2 Выберите цвет из цветовой палитры. 

Подробнее см. в разделе Выбор цвета стежков. 
3 Выберите тип стежка Outline (Оконтуривающий) или Fill (Заполняющий). 

Подробнее см. в разделе Выбор типов стежков для вышивки крестом. 
4 Наметьте базисные точки вашего проекта. 

Щелкайте левой кнопкой мыши для острых углов и правой кнопкой для округленных углов. 
5 Нажмите Enter. 

Форма заполняется или оконтуривается в зависимости от выбранного типа стежка. 
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Намеченные  
базисные точки. 
 
 
 
 
Оконтуренная            Оконтуренная стежком  
одиночной линией    полного креста незамкнутая форма 
незамкнутая форма 
 
 
 
 
Оконтуренная                                 Оконтуренная стежком  
одиночной линией          полного креста замкнутая форма 
замкнутая форма 
  
 
 
 
Заполненные цветовые блоки  

 
Используйте инструмент Area Fill (панель Design) для заполнения стежками закрытых форм или 
цветовых блоков. 

 
Закрытые зоны заполняются стежками инструментом Area Fill (Заполнение формы). Вы можете также 
использовать этот инструмент для изменения цвета и типа стежков контуров, выполняемых стежком Full 
Cross.  
 
Примечание: Инструмент Area Fill работает только со слоями стежков для вышивки крестом. Этот 
инструмент не работает с растровыми изображениями, используемыми в качестве фона. Подробнее см. в 
разделе Редактирование изображений в пакете графических программ. 
 
Как заполнять цветовые блоки 
1 Выберите цвет из цветовой палитры. 

Подробнее см. в разделе Выбор цвета стежков. 
2 Выберите тип заполняющего стежка. 

Подробнее см. в разделе Выбор заполняющих стежков. 
3 Нажмите кнопку Area Fill (Заполнить форму). 
4 Щелкните в пределах закрытой формы. 

Форма будет заполнена стежками выбранного типа и цвета. 

    
Оцифровано инструментом   Цвета изменены инструментом Area Fill 
Auto Digitizer 

Внимание: Инструмент Area Fill не работает в формах с оконтуриванием одинарным стежком, 
некоторые формы с угловыми линиями могут быть заполнены неправильно. 

Обращение с файлами проектов со стежками для вышивки крестом 
 
Проекты со стежками для вышивки крестом имеют собственный ARX-формат. Они могут быть считаны в 
BERNINA artista. Вы также можете комбинировать ARX-файлы с проектами в других форматах. 
 
Сохранение проектов со стежками для вышивки крестом 
 

Используйте кнопку Save (панель General) для сохранения файлов программы Cross Stitch.  
 

Сохраняйте проект во время работы, как можно чаще. Для сохранения файлов со стежками для вышивки 
крестом используйте расширение ARX. 
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Как сохранить проект со стежками для вышивки крестом 
1 Выберите File > Save. 

Если вы сохраняете проект в первый раз, откроется 
диалоговое окно Save As (Сохранить как …). Файл 
следует сохранить как ARX-файл. 

2 Из списка Files of Types (Тип файла) выберите cross 
stitch (ARX). 
     

Примечание: Вы можете сохранить проект только в 
формате ARX. 

3 Введите новое имя для проекта и нажмите Save. 
 
 
Использование стежков для вышивки крестом с BERNINA artista 
Вам требуется закрыть и сохранить проекты со стежками для вышивки крестом в формате ARX и затем 
открыть их в BERNINA artista. 
 
Как использовать стежки для вышивки крестом с BERNINA artista 
1 Запустите BERNINA artista. 
2 Выберите File > Open. 

Откроется диалоговое окно Open. 
 

     
 
3 Выберите файлы ARX из списка Files of Type (Тип файла). 
4 Выберите ваш файл. 
5 Нажмите Open. 
 Проект будет отображен в том виде, в котором он будет вышит. 
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Глава 36  
 
 
Редактирование в программе 
Cross Stitch  
 
Программа BERNINA artista Cross Stitch предоставляет технические 
возможности редактирования проектов вышивки крестом, включая 
перемещение, вращение и перевод в зеркальное отображение блоков 
стежков. Вы можете удалять стежки, а также изменять цветность и тип 
стежков в выбранных фрагментах. Вы можете клонировать выделенные 
объекты для их повторного использования в виде "резинового штампа" и 
заполнять большие формы мотивами или специальными композициями 
стежков. Вы можете также редактировать стежки для создания 
комбинаций неполных крестов разного цвета. 
В этом разделе дается подробная информация о функциях 
редактирования стежеов для вышивки крестом. 
 

Выбор и блокирование стежков 
 
Для редактирования фрагмента проекта, вы должны вначале его выделить. Программа BERNINA artista 
Cross Stitch предоставляет несколько способов выделения стежков. Она также дает возможность 
блокировать стежки для вышивки крестом и/или контуры, чтобы их нельзя было случайно переместить или 
изменить. 
 
Выбор стежков для вышивки крестом инструментом Select Object или Polygon 
Select 

 
Используйте инструмент Select Object (панель Design), чтобы выбрать одиночный стежок или блок 
стежков. 
 
 
Используйте инструмент Polygon Select (панель Design), чтобы выбирать фрагменты или формы с 
нерегулярными контурами.  
 

Инструменты Select Object (Выбор объекта) и Polygon Select (Выбор многоугольником) работают таким 
же образом, как в BERNINA artista. Различие заключается в том, что в программе BERNINA artista Cross 
Stitch вы работаете с блоками стежков или фрагментами, а не с объектами проекта. 
 
Внимание: Вы не можете выбирать стежки для вышивки крестом за пределами пялец. 
 
Как выбирать стежки для вышивки крестом инструментом Select Object или Polygon 
Select 
◄ Инструментом Select Object (Выбор объекта) нужно просто обвести ограничивающий прямоугольник 

вокруг выделяемого фрагмента. 
◄ Инструментом Polygon Select (Выбор многоугольником) нужно наметить базисные точки вокруг 

выделяемого фрагмента и нажать Enter. 
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◄  

               
Использован инструмент Select Object  Удалены заполняющие стежки 

               
Использован инструмент Polygon Select   Удалены заполняющие стежки 
 

Совет: Удерживайте нажатой клавишу Ctrl для выбора нескольких фрагментов. 
 
Выбор стежков для вышивки крестом инструментом Auto Select 
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Используйте инструмент Auto Select (панель Design) для выбора одиночных цветовых блоков или не 
оцифрованного фрагмента.  

 
Инструмент Auto Select (Автоматический выбор) является специфичной функцией программы BERNINA 
artista Cross Stitch. Он позволяет выбирать одиночные цветовые блоки или не оцифрованный фрагмент. 
Выбираются только связанные стежки одного цвета. 
 
Как выбирать стежки для вышивки крестом инструментом Auto Select 
1 Щелкните по значку Auto Select. 
2 Щелкните по блоку стежков. 

Выбираются только связанные стежки одного цвета. 
 
Совет: Удерживайте нажатой клавишу Ctrl для выбора нескольких блоков. 

      
Выбранный цветовой блок   Удерживайте нажатой клавишу Ctrl для выбора блоков желтого цвета 

 
Совет: Вы можете изменить цвет всех выделенных стежков, выбрав цвет из палитры. 
 
Блокирование стежков 
Вы можете блокировать стежки для вышивки крестом и/или контуры, чтобы их нельзя было случайно 
переместить или изменить. 
 
Как блокировать стежки 
1 Выберите Edit > Crosses или Edit > Outlines. 

Если в меню выбрано Crosses, то могут быть перемещены стежки для вышивки крестом. Подобным же 
образом, если выбрано Outlines, то могут быть перемещены контуры.  

2 Выберите фрагмент, щелкните по нему и перетащите, чтобы переместить стежки. 
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Выбранный проект  
содержит контур и  
заполняющие стежки  
для вышивки крестом 
 
 
 
 
 
 
Команда Edit > Crosses не  
выбрана, при перетаскивании  
фрагмента перемещаются  
только контуры 
 
 
 
 
 
3 Снова выберите Crosses или Outlines, чтобы убрать флажки и заблокировать все стежки или контуры.  
 

Простое редактирование стежков 
 
Программа BERNINA artista Cross Stitch позволяет в любое время изменять цвет или тип выбранных 
блоков стежков. Вы можете также в любое время удалять стежки. 
 
Подбор цвета ниток 
Программа BERNINA artista Cross Stitch позволяет изменять цвет ниток существующего проекта. 
Подробнее см. в разделе Выбор цвета стежков. 
Вы можете также смешивать собственные цвета, которые более точно соответствуют требуемым цветам 
проекта. Подробнее см. в разделе Создание собственных таблиц ниток в Руководстве пользователя. 
 
Внимание: Воспроизведение цвета в таблицах фирменных ниток является приблизительным, и 
компьютерная имитация не предназначена для точного подбора цвета ниток.   
 
Копирование, вырезание и вставка блоков стежков 

 
Используйте инструмент Copy (панель Standard), чтобы копировать выделенные блоки стежков в 
буфер обмена. 
 
 
Используйте инструмент Cut (панель Standard), чтобы вырезать выделенные блоки стежков в 
буфер обмена. 
 
 
Используйте инструмент Paste (панель Standard), чтобы вставить скопированные блоки стежков из 
буфера обмена. 
 

Вы можете копировать, вырезать и вставлять выбранные блоки стежков в любое время. Различие 
заключается в том, что в программе BERNINA artista Cross Stitch вы работаете с блоками стежков или 
фрагментами в большей мере, чем с объектами проекта. См. также Заполнение резиновым штампом. 
 
Как копировать, вырезать и вставлять блоки стежков 
1 Выберите блок стежков для копирования или вырезания. 
 Подробнее см. в разделе Выбор и блокирование стежков. 
2 Нажмите кнопку Copy (Копировать) или Cut (Вырезать). 
 Выбранный фрагмент или фрагменты будут скопированы в буфер обмена. 
3 Нажмите кнопку Paste (Вставить). 
 Дублированный фрагмент будет вставлен сверху в выбранный фрагмент. 
4 Щелкните и переместите вставленный блок стежков. 
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Совет: Дублируйте и поворачивайте блоки стежков для создания узоров. Подробнее см. в разделе 
Преобразование блоков стежков. 
 
Изменение настроек блока стежков 

 
Используйте инструмент Auto Select (панель Design) для изменения цвета или типа блока стежков.  
 

Вы можете в любое время изменять цвет и/или тип стежка в выбранном блоке. 
 
Как изменять настройки блока стежков 
1 Используйте инструмент Auto Select (Автоматический выбор)  для выбора цветового блока или 
блоков.  

Подробнее см. в разделе Выбор стежков для вышивки крестом инструментом Auto Select. 
 

Совет: Удерживайте нажатой клавишу Ctrl для выбора нескольких блоков. 
2 Выберите новый цвет из цветовой палитры. 

Выбранный цвет заполнит выбранный фрагмент. Фрагмент останется выделенным. 

     
Выбранный блок стежков        Цвет изменен 

 
3 Выберите новый тип стежка из панели Stitch (Стежок). 

Выбранный тип стежка заполнит выбранный фрагмент. 

 
Стежки полного креста      Стежки неполного стежка 

 
 
Стирание заполнения и одиночных линий 

 
Используйте инструмент Eraser (панель Design) для стирания заполнений и одиночных линий.  
 

Используйте инструмент Eraser (Ластик) для удаления стежков.  Этим инструментом удаляются 
заполняющие стежки или одиночные линии обрамления в зависимости от выбранного типа стежка. 
Обрамляющие стежки для вышивки крестом обрабатываются как заполняющие стежки. 
 
Внимание: Вы не можете выбирать и стирать стежки для вышивки крестом за пределами пялец. 
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Как стереть заполнение или одиночную линию 
1 Щелкните по значку Eraser (Ластик). 
2 Выберите Fill (Заполнить) на панели Stitch/Color  
3 Перетащите указатель мыши по стежкам, которые нужно удалить. 
 Будут удалены только заполняющие стежки. Все одиночные линии обрамления останутся. 

       
Перетащите указатель мыши    Стерты только заполняющие стежки,  
по стежкам для их удаления   линия обрамления останется 
  
 Совет: Вы можете также удалять стежки для вышивки крестом, выделив их и нажав клавишу Delete. 
4 Выберите Outline (Оконтурить) на панели Stitch/Color  
5 Щелкните где-либо по одиночной линии. 
 Линия будет удалена. Стежки для вышивки крестом не будут стерты. 
 

     
Щелкните по линии для удаления  Линия стерта 

 
 Примечание: Обрамление одиночной линией удаляется одним щелчком. 

Преобразование блоков стежков 
 
Программа BERNINA artista Cross Stitch позволяет производить различные преобразования на выбранных 
блоках стежков для вышивки крестом. Вы можете перемещать их, поворачивать по часовой стрелке или 
против часовой стрелки. Вы можете также зеркально отображать блоки стежков, переворачивая их по 
горизонтали или по вертикали. 
 
Перемещение блоков стежков для вышивки крестом 
Вы можете перемещать блоки стежков для вышивки крестом в любое время. 
 
Как перемещать блоки стежков для вышивки крестом 
1 Выберите блок стежков для перемещения. 
 Подробнее см. в разделе Выбор и блокирование стежков. 
2 Перетащите его мышью в новое положение. 
 

Выбранный фрагмент 

 
Фрагмент перемещен 

 
Вращение блоков стежков для вышивки крестом 
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Используйте инструмент 90° CW/CCW (панель Design), чтобы повернуть выбранные стежки.  Для 
поворота по часовой стрелке щелкните по нему левой кнопкой мыши. Щелчок правой кнопкой – 

поворот против часовой стрелки. 
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Вы можете поворачивать блоки стежков для вышивки крестом по часовой стрелке или против часовой 
стрелки. Дублируйте и поворачивайте блоки стежков для создания узоров. 
 
Как вращать блоки стежков для вышивки крестом 
1 Выберите блок стежков для вращения. 
 Подробнее см. в разделе Выбор и блокирование стежков. 
2 Щелкните по значку Rotate 90° CW/CCW. 
 

       
Перевод в зеркальное отображение блоков стежков для вышивки крестом 
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Щелкните по инструменту Mirror Horizontal (панель Design) для переворачивания выбранных 
стежков по горизонтали. 
 
 
 
Щелкните по инструменту Mirror Vertical для переворачивания выбранных стежков по вертикали. 
 

Вы можете зеркально отображать блоки стежков, переворачивая их по горизонтали или по вертикали. 
 
Как переводить в зеркальное отображение блоки стежков для вышивки крестом 
1 Выберите блок стежков для перевода в зеркальное отображение. 

Подробнее см. в разделе Выбор и блокирование стежков. 
2 Щелкните по значку Mirror Horizontal (Зеркальное отображение по горизонтали). 

     
                         Переворот по вертикали Переворот по горизонтали 
 

Совет: Для перевода в зеркальное отображение всего проекта выберите команду Arrange > Mirror 
Horizontal/Mirror Vertical. 

Специальная техника редактирования 
 
Программа BERNINA artista Cross Stitch располагает рядом технических приемов редактирования, 
специально предназначенных для оцифровывания стежков для вышивки крестом. Вы можете клонировать 
выделенные объекты для их повторного использования в виде "резинового штампа" и заполнять большие 
формы мотивами или специальными композициями стежков. Вы можете комбинировать стежки с 
неполным крестом различными способами. Вы можете также добавлять обрамления из крестообразных 
стежков или одиночных линий, а также из обоих типов стежков к фрагментам проекта. 
 
Заполнение резинового штампа 

 
Используйте инструмент Rubber Stamp (панель Cross Stitch) для клонирования стежков. 
 

Клонируйте выделенные объекты для их повторного использования в виде "резинового штампа" и 
заполнения больших форм мотивами или специальными композициями стежков. 
 
Как заполнять резиновый штамп 
1 Щелкните по значку Select Object (Выбор объекта) и выберите фрагмент для клонирования. 
2 Щелкните по значку Rubber Stamp (Резиновый штапм). 
 Выбранный фрагмент будет скопирован и присоединен к указателю мыши. 
3 Щелкайте "штампом" столько раз, сколько вам требуется. 
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Мотив, созданный для обрамления       Использован "резиновый штамп" 
 
4 Нажмите Esc или выберите другой инструмент, чтобы отключится от функции Rubber Stamp. 
 
Создание комбинации стежков 

 
Используйте инструмент Pencil (панель Cross Stitch) для добавления комбинации стежков. 

 
Стежки в четверть, половину и три четверти креста можно комбинировать для создания составных 
многоцветных крестов. Вы можете также комбинировать мини кресты, удлиненный по горизонтали или 
вертикали кресты с оконтуривающими стежками. См. Вариации стежка для вышивки крестом в 
Руководстве пользователя. 
 
Как создать комбинацию стежков 
1 Выберите Edit > Insert. 

Опция Insert (Вставить) помечена флажком в меню. При выбранной опции Insert вы можете 
добавлять в квадрат больше одного стежка. В противном случае новый стежок заменит существующий 
стежок. 

 
Совет: При выбранной опции Insert в строке состояния появляется слово Insert. В противном случае 
появляется Overwrite. 

2 Выберите тип стежка 
 Подробнее см. в разделе Выбор заполняющих стежков. 
3 Выберите цвет из цветовой палитры. 
 Подробнее см. в разделе Выбор цвета стежков. 
4 Нажмите кнопку Pencil (Карандаш). 
5 Щелкните в том месте, где вы хотите вставить стежок. 
 

 
Щелкните по верхнему левому углу,  
чтобы  вставить мини крест 
 
затем щелкните по верхнему правому углу,  
чтобы вставить 1/2 креста 
 
затем щелкните по нижнему правому углу,  
чтобы вставить 1/4 креста 

 
 
 Примечание: Если вы не выбрали опцию Insert, будет заменен весь стежок. 
6 Повторяйте эти операции столько раз, сколько требуется. 
 
Добавление обрамлений к существующим фрагментам 
Можно добавлять обрамления из крестообразных стежков или одиночных линий, а также из обоих типов 
стежков к фрагментам проекта. 
 
Как добавлять обрамления к выбранным фрагментам 
1 Выберите значок Outline (Оконтуривание). 
2 Щелкните по значку Area Fill (Заполнить фрагмент) и затем внутри фрагмента. 
 Линия оконтуривающих стежков добавляется вокруг краев выделенного фрагмента. 
 
 Совет: Щелкните еще раз по выбранному фрагменту, чтобы добавить другую линию стежков внутри 

первой линии. 
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Без обрамления 
 
 
 
 
 
 
 

Обрамление стежком "Одиночная линия" 
 
 
 
 
 

Обрамление стежком "Двойной крест" 
 
 
 
 
 

Совет: Для комбинирования стежков крестом с линейным обрамлением выберите тип стежка Full 
Cross и Flood Fill, затем выберите Single Line и Flood Fill опять. 
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Глава 37  
 
 
 
 
Программа Cross Stitching для 
опытных пользователей 
 
Окно проекта программы BERNINA artista Cross Stitch позволяет 
также импортировать рисунки для использования в качестве 
оригинала-шаблона или для автоматического оцифровывания. Вы 
можете также создавать тексты стежками для вышивки крестом. 
В этом разделе приводится подробная информация о более 
сложных функциях программы Cross Stitch, включая 
автоматическое оцифровывание и вышивание текстов. 
 

Оцифровывание с оригиналом 
 
В программу BERNINA artista Cross Stitch можно вставлять или сканировать рисунки для использования в 
качестве оригинала для оцифровывания. Вы можете автоматически оцифровывать оригинальный рисунок, 
используя функцию Auto Stitch. Используйте растровые рисунки чистых цветов для создания цветовых 
блоков стежков для вышивки крестом. 
 
Совет: Если нужно изменить размеры или повернуть изображение, то лучше делать это во время 
сканирования. Последующее изменение размера может разрушить изображение. 
 
Вставка растровых изображений 

 
Используйте инструмент Load Picture (панель Picture) для открытия изображения. 
 
 
 
Используйте инструмент Scan (панель Picture) для сканирования изображения. 
 
 

Вы можете вставлять растровые изображения в различных форматах для использования в качестве 
оцифровываемых трафаретов. См. Поддерживаемые форматы рисунков и изображений в Руководстве 
пользователя. 
 
Как вставить изображения 
1 Нажмите кнопку New (Создать). 
 Откроется новый файл. 
2 Нажмите кнопку режима Picture, чтобы открыть изображение.  
3 Нажмите кнопку Load Picture (Загрузить изображение). 
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 Откроется диалоговое окно Open Design (Открыть проект). 

     
4 Выберите папку из списка Look In. 
5 Выберите тип файла из списка Files of Type (например, BMP). 
6 Выберите файл, который вы хотите вставить. 
 
 Совет: Проставьте флажок в окошке Preview, чтобы просмотреть выбранный файл. 
7  Нажмите Open. 
8  Переместите рисунок, так чтобы он поместился в пяльцах, или измените размер пялец. Подробнее см. 

в разделе Изменение настроек пялец. 
 
 Примечание: Фрагменты за пределами пялец не будут вышиты. 
 
Просмотр или скрытие растровых изображений 

 
Щелкните по инструменту Picture (панель Standard ), чтобы отобразить или скрыть рисунок. 
 

Вы можете просматривать или временно скрывать растровый оригинал во время оцифровывания в 
режиме Design. 
 
Как просмотреть или скрыть растровое изображение 
◄ Щелкните по значку Picture (Рисунок), чтобы просмотреть изображение. 
◄ Щелкните еще раз, чтобы скрыть изображение. 
 

   
отображаемый рисунок       скрытый рисунок 

 
Масштабирование и преобразование растровых изображений 
Вы можете изменять размеры и форму изображений, загруженных в BERNINA artista Cross Stitch. Однако, 
если нужно изменить размеры или повернуть изображение, то лучше делать это во время сканирования. 
Последующее изменение размера может исказить изображение. См. Расположение и трансформация 
объектов Objects в Руководстве пользователя. 
 
Как масштабировать и преобразовывать растровые изображения 
1 Вставьте изображение. 

Подробнее см. в разделе Вставка растровых изображений. 
2 Щелкните по кнопке Select (Выбрать). 
3 Щелкните по изображению. 

Вокруг изображения появятся восемь маркеров изменения формы. Щелкните и переместите их для 
масштабирования изображения, как и для других объектов. См. раздел Изменение размеров объектов 
в Руководстве пользователя. 
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Маркеры изменения размера   Маркеры изменения формы 
 
4 Щелкните по изображению опять. 

Вокруг изображения появятся восемь маркеров изменения формы. Щелкните и переместите их для 
вращения или перекоса изображения, как и для других объектов. См. разделы Вращение объектов и 
Перекос объектов. 

      
Изменение размера изображения  Изменение формы изображения 
 

Автоматическое оцифровывание рисунков 
 
Вы можете автоматически оцифровать весь оригинальный рисунок, используя функцию Auto Stitch. 
Альтернативно, используя инструмент Magic Wand (Волшебная палочка), вы можете создать заполнение 
стежками для вышивки крестом по цветовым фрагментам рисунка. 
 
Оцифровывание инструментом Auto Stitch 
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Используйте инструмент Auto Stitch (панель Design) для автоматического создания по рисунку 
проектов для вышивки крестом. 

 
Вы можете автоматически оцифровать весь оригинальный рисунок, используя функцию Auto Stitch. Вы 
можете позже изменять вручную тип стежка, если вам это потребуется.  
 
Совет: Вы можете также выбрать для вышивания цветовые блоки в вашем рисунке, используя функцию 
Magic Wand. Подробнее см. в разделе Оцифровывание Волшебной палочкой, 
 
Как оцифровывать инструментом Auto Stitch 
1 Подготовьте надлежащим образом изображение. 
 Для очистки изображения используйте какую-либо графическую 

программу. 
2 В режиме Picture загрузите рисунок. 
 Подробнее см. в разделе Вставка растровых изображений. 
 
 
3 В режиме Design щелкните по значку Auto Stitch и щелкните по 

изображению.  
 Откроется диалоговое окно Auto Stitch. 
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           Выбор таблицы ниток Назначение максимума цветов 
Выбор метода  
отображения  
изображения 

  
 
Выбор для пропуска цвета фона 

 
 
4 Выберите, как отображать цвета рисунка: 

◄ Current Palette (Текущая цветовая палитра): Используется только текущая цветовая палитра. 
◄ Specific Thread Chart (Назначенная таблица ниток): Используются только цвета выбранной 

таблицы ниток. 

                 
Текущая цветовая    Назначенная таблица   Назначенная таблица ниток:  
палитра:       ниток: CSD     Isacord 40 модных цветов 
Ограниченное количество  
цветов 
 
5 Назначьте максимальное количество используемых цветов. 

◄ Unlimited (Неограниченное): Цвета ниток будут назначены в соответствии с количеством цветов в 
палитре, выбранной в первом диалоговом окне. 

◄ Restricted (Ограниченное): Введите количество цветов, которое вы хотите использовать. 
◄ Omit Background (Пропустить фон): Выбор для пропуска цвета фона. 
Результат будет отображен в панели просмотра. 

             
Выбрано неограниченное     Выбрано ограниченное  
максимальное количество цветов  максимальное количество цветов 
   
6 Нажмите кнопку ОК. 

Рисунок оцифрован. Вам может потребоваться отделать некоторые фрагменты вручную. 
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Выбрано 4 цвета  Выбрано неограниченное  

максимальное количество цветов 
 

Примечание: Функция Auto Stitch не действует, если рисунок не загружен. 
 
Оцифровывание инструментом Magic Wand 
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Используйте инструмент Magic Wand (панель Design) для создания стежков для вышивки крестом 
по цветным фрагментам рисунка. 
 

Используя инструмент Magic Wand (Волшебная палочка), вы можете создать заполнение стежками для 
вышивки крестом по цветовым фрагментам рисунка. Инструмент Magic Wand применяется как для 
заполняющих, так и для оконтуривающих стежков.  
 
Как оцифровывать инструментом Magic Wand 
1 Подготовьте надлежащим образом изображение. 
 Для очистки изображения используйте какую-либо графическую программу. 
2 В режиме Picture загрузите рисунок. 
 Подробнее см. в разделе Вставка растровых изображений. 

      
 
3 В режиме Design щелкните по значку Magic Wand. 
4 Выберите тип стежка для вышивки крестом. 
5 Выберите цвет из цветовой палитры. 
6 Щелкните по цветовому блоку вашего рисунка. 
Все фрагменты этого цвета будут оцифрованы в выбранном цвете. 

     
Выбранный фрагмент 

 
 Примечание: Инструмент Magic Wand выбирает и оцифровывает все блоки этого цвета из вашего 

рисунка. Вы можете позже изменить тип и цвет стежка по своему желанию. 

Оцифровывание букв, выполняемых стежками для вышивки 
крестом. 
 

Используйте инструмент Lettering (панель General) для добавления текста к проекту. Щелчок правой 
кнопкой мыши открывает диалоговое окно Font. 

 
Как и в BERNINA artista, в программе Cross Stitch можно добавлять тексты впечатыванием 
непосредственно в окно проекта. В программе Cross Stitch для выбора шрифта, размера и начертания 
используется диалоговое окно Font (Шрифт). Выберите контур или заполнение для оцифровывания букв. 
Введенные буквы не могут быть отредактированы. Каждая буква обрабатывается, как блок стежков. 
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Совет: Используйте алфавит Creative Cross для добавления текстовых объектов к своему проекту 
вышивки крестом.  См. раздел Добавление орнаментных букв в Руководстве пользователя. 
 
Как оцифровывать буквы, выполняемые стежками для вышивки крестом. 
1 Щелкните правой кнопкой мыши по значку Lettering (Текст). 
 Откроется диалоговое окно Font (Шрифт). 
 
 
 
Выберите из  
списка шрифт,  
начертание и  
размер 
 
 
 
 
 
 
 
 
 
 
2 Выберите из списка шрифт, начертание и размер. 
3 Нажмите кнопку ОК. 
4 Щелкните по начальное точке в окне проекта. 
5 Наберите текст и нажмите Enter. 
 

 
Буквы, выполненные      Буквы, выполненные  
заполняющими стежками     оконтуривающими стежками 

 
Совет: Для редактирования текста используйте инструмент Auto Select при нажатой клавише Ctrl во 
время выделения. Затем можно изменять тип или цвет стежков. 
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Часть XI 

Пэчворк и квилт 
 
Глава 38 
Введение в технику пэчворка и 
квилта 
 
Пэчворк – это популярная техника компоновки и сшивания лоскутов 
ткани в блоки. Программа BERNINA Quilter может быть использована 
для рахмещения лоскутных узоров на квилтах по существующим или 
по создаваемым собственноручно проектам. Используйте эту 
программу для экспериментирования с лоскутами ткани и цветом, 
чтобы создавать прекрасные квилты, отражающие вашу 
индивидуальность. 
Блоки на квилте могут быть заполнены лоскутами узорчатой или 
одноцветной ткани. В программу BERNINA Quilter включает в себя 
большую коллекцию блоков пэчворка и тканей, но вы можете 
сканировать собственные блоки и сохранять их в библиотеке квилтов. 
После завершения работы с проектом квилта вы можете распечатать 
его с отображением блоков, их конструкции, а также информации, 
относящейся к расходу ткани, шитью и кройке лоскутов. 
В этом разделе дается обзор техники пэчворка и квилта. 
 

Проекты стежки пэчворка 
Пэчворк и квилт являются взаимосвязанными и взаимодополняющими техническими приемами 
шитья. Программа BERNINA Quilter является важным инструментом проектирования, который 
должен вам помочь компоновать квилты, комбинируя лоскутные узоры, вышивки и аппликации. 
Используйте программу BERNINA Quilter для составления и компоновки блоков пэчворка на 
экране, выбора тканей и добавления украшений, таких как вышивки и аппликации. 
 
Пэчворк  
"Блок пэчворка" – это набор сшитых вместе лоскутов, образующих обычно фигуру правильной 
формы, такую как прямоугольник. "Лоскут" – это одиночный кусок ткани, сшитый с другими 
кусками, скомпонованными в блок пэчворка. Сшивание лоскутов в блоки называют 
"стачиванием". 
                                                                                        
                              блок пэчворка, составленный из лоскутов ткани 
 
одиночный лоскут  
  
 
 
 
 
Блоки затем сшиваются вместе по прямой или диагональной сетке. 
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Квадратная структура  Ромбовидная структура 
 
 
Хотя в некоторых квилтах блоки пэчворка доходят до самых краев, в большинстве случаев применяется 
одна или несколько окантовок. В некоторых квилтах используются узкие полоски ткани, разделяющие блоки 
пэчворка. Окантовки и межблоковые полоски могут изменять размеры и внешний вид вашего квилта. Их 
можно использовать для образования рамки и сглаживания слишком контрастных проектов. Окантовки 
могут быть также использованы для увеличения размеров квилта, чтобы он подходил к размеру 
стандартной кровати. В каждом квилте может быть несколько окантовок. 

     
с окантовками и межблоковыми полосками 
 
Во многих квилтах используется комбинация одинаковых по цвету тканей в качестве фона. Узоры пэчворка 
создаются по контрасту между светлыми, средними по тону и темными тканями. Контраст по насыщенности 
цвета является критическим для некоторых квилтов. Следует рекомендовать выбирать цвет фона перед 
принятием решения о других цветах проекта. 

 
контраст между светлыми, средними и темными тканями  
 
При тщательном подборе и размещении лоскутов ткани может быть создан трехмерный эффект. Сплошные 
или однотонные цвета размещают таким образом, чтобы создавать четкие контрасты между блоками 
пэчворка. При работе с одним цветом используйте несколько типов ткани.  

           
создание трехмерного эффекта использование доминирующего цвета 
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Программа BERNINA Quilter позволяет также добавлять к квилту аппликации и вышивки. 

 
12-элементный блок 

 

 
 
блок с аппликацией 

 
 
 
 
 

окантовка со скошенными углами, без 
межблоковых полосок 

  

 
 
 
 
блок с вышивкой 

 
 

 квадратный квилт с 4 блоками  
При планировании квилта определите его общие размеры, затем рассчитайте, сколько должно быть 
использовано блоков, окантовок и межблоковых полосок. Определите, какие блоки пэчворка будут 
использованы и какие будут выбраны цвета. Просмотрите различные расположения блоков и различные 
сочетания цветов, чтобы выбрать наиболее подходящее. 
 
Стежка квилта 
Квилт подобен сэндвичу, образованному из трех слоев:  
◄ Верх квилта: стачанные лоскуты ткани, обычно образующие правильные формы, такие как 

прямоугольник, с добавлением при необходимости окантовок и межблоковых полосок.  
◄ Прокладка: слой объемного материала между верхней и нижней сторонами квилта, придающий квилту 

рельефность.  
◄ Подкладка: цельный кусок ткани, подкладываемый под прокладку. 

 
 
Верх квилта: 
 
 
Материал прокладки 
 
 
 
Ткань подкладки 
 
 

При стежке квилта простегиваются декоративные элементы квилта. Простегивающими строчками квилт 
делится на выпуклые декоративные узоры. Стежку квилта можно выполнять вручную или на швейной 
машине со свободной подачей материала. 
Совет: Квилтом может быть комбинация пэчворка с квилтом при использовании блоков пэчворка, 
стачанных простегивающими стежками. 

Таблица перевода в метрическую систему единиц 
В программе BERNINA Quilter для измерения длины используются дюймы. Для перевода единиц 
британской системы измерения в метрические единицы пользуйтесь приводимой ниже таблицей. В 
некоторых случаях при пользовании калькулятором удобнее пользоваться дюймами с десятичными 
долями. 
Метрическая 
система (мм) 

Британская 
система (дюйм) 

Десятичная 
система (дюйм) 

3 1/8 0.125 
6 1/4 0.25 
9 3/8 0.375 
12 1/2 0.5 
16 5/8 0.625 
19 3/4 0.75 
22 7/8 0.875 
25 1 1.0 
50 2 2.0 
75 3 3.0 
100 4 4.0 
130 5 5.0 
150 6 6.0 
225 9 9.0 
250 10 10.0 
300 12 12.0 
450 18 18.0 
500 20 20.0 
900 36 (1 ярд) 36.0 
1000 (1 метр) 40 40.0 
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Размеры квилта 
В следующей таблице приведены ориентировочные размеры наиболее распространенных квилтов. Эти 
размеры могут изменяться в зависимости от используемых блоков. 
 
Квилт Британская 

система (дюйм) 
Метрическая 
система (мм) 

Бэби 36-45 x 45-54 90-115x115-137 
Детская 
кроватка 

42-48 x 54-60 107-122x137-152 

Одинар-
ный 

56-64x84-100 142-162x213-254 

Двойной 70-80x84-100 178-203x213-254 
Квин 76-84x90-104 193-213x228-264 
Кинг 92-100x90-104 234-254 x 228-264 
Джамбо 120-124 x 120-124 304-315x304-315 
 
 

Основные сведения о программе BERNINA Quilter  
 
Проект квилта включает в себя технические приемы, отличающиеся от обычного проекта 
вышивки. По этой причине приложение BERNINA Quilter имеет собственное окно проекта, 
открывающееся из BERNINA artista. 
 
Запуск программы BERNINA Quilter 

 
Щелкните по значку BERNINA Quilter (панель Design) для запуска приложения. 
 

Программа BERNINA Quilter запускается из BERNINA artista. 
 
Примечание: Если программа BERNINA Quilter не открывается из BERNINA artista, проверьте, 
установлена ли в вашем компьютере программа Internet Explorer V.6. Это предусмотрено 
минимальными требованиями к системе. 
 
Как запустить программу BERNINA Quilter 
1 Запустите BERNINA artista. 
2  Выберите режим Design. 
3 Щелкните по значку BERNINA Quilter. 
 Откроется окно проекта BEBNINA Quilter. 
 
Примечание: Вы можете также запустить BERNINA Quilter, выбрав команду File > BERNINA Quilter 
или нажав клавиши Ctrl + Q. 
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Стандартная панель инструментов   Палитра тканей 

Строка 
заголовка 

Строка  меню 
Панель  

инструментов  
блокирования 

 
Панель  

инструментов  
правки 

 
Панель 

размещения 
 

  
          
 
 
 
 
 
 
 
 
 
 
 
    Используемые блоки     Используемые цвета    Используемые ткани 
 
Изменение настроек сетки 

 
Нажмите инструмент Grid (панель Standard), чтобы отобразить или скрыть сетку. Щелчок правой кнопкой 
мыши открывает диалоговое окно Grid. 

 
Программа BERNINA Quilter дает возможность:  
◄ показать или скрыть сетку 
◄ установить интервал сетки 
◄ выровнять объекты по сетке или другим контурам. 
 
Примечание: В программе BERNINA Quilter используются дюймы для измерения проектов, в отличие от 
вышивальной программы, в которой используются региональные настройки Windows (обычно 
миллиметры). 
 
Как изменить настройки сетки 
1 Щелкните правой кнопкой мыши по значку Grid (Сетка). 
 Появится диалоговое окно Options с открытой закладкой Grid.  
 

 
 
 

Выберите Show Grid 
 

Установка базисной точки 
 
 
 
 

Установка интервала сетки 
 
 
 
 

Выровнять по сетке 
 

Опция Smart snap 
 
2  Проставьте флажок в окошке Show Grid, чтобы отобразить сетку. 
3  Проставьте флажок в окошко Set Reference Point (Установить базисную точку). 
 Например, вы можете установить базисную точку сетки в центре проекта. Это более простая и быстрая 

операция, чем перемещение всего проекта. 
4  Введите значения интервала сетки (Grid Spacing) для горизонтальных и вертикальных линий. 
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5 Проставьте флажок в окошке Snap to Grid (Выровнять по сетке). 
 

Объекты выравниваются по сетке только в том случае, если они находятся близко от линии сетки. 
 
Совет: Для временной отмены опции Snap to Grid во время оцифровывания удерживайте нажатой 
клавишу Alt. 

6 Выберите опцию Smart Snap (при отключенной опции Snap to Grid), чтобы привязать каждую 
оцифровываемую точку или контрольную точку изменения формы к существующим контурам. 

7 Нажмите кнопку ОК. 
 Если вы выбрали опцию Set Reference Point, наметьте базисную точку на вашем проекте. Сетка будет 

выровнена, так чтобы горизонтальные и вертикальные линии сетки пересекались в этой точке. 
 

Совет: Чтобы скрыть линии блоков, нажмите Ctrl + L. 
 
Просмотр информации о проекте квилта. 
Диалоговое окно Quilt Properties (Свойства квилта) предоставляет информацию о количестве блоков, 
аппликациях и вышивках в проекте квилта. Используйте закладку Summary для добавления своего имени, а 
также вышивальной и общей информации. Имя Autbor включается в распечатки. 
 
Как просматривать информацию о проекте квилта 
1  Выберите File > Quilt Properties. 
 
 Откроется закладка Quilt  диалогового окна Quilt 

Properties..  
2 Введите свое имя и другую информацию, которую вы 

хотите сохранить в проекте квилта. 
    
 
 

           
3 Нажмите кнопку ОК. 
 
Сохранение проектов BERNINA Quilter  

 
Используйте кнопку Save (панель General) для сохранения файлов программы BERNINA Quilter.  
 

Сохраняйте проект во время работы, как можно чаще. Проекты BERNINA Quilter сохраняются в формате 
ARQ, который может быть считан только в BERNINA Quilter. Шаблоны файлов сохраняются в формате AMQ. 
 
Как сохранять проекты BERNINA Quilter  
1  Выберите File > Save. 
 Если вы сохраняете проект в первый раз, откроется диалоговое окно Save As (Сохранить как …). Файл 

следует сохранить как ARQ-файл. 
2  Из списка Files of Types (Тип файла) выберите BERNINA Quilter (ARQ). 
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 Примечание: Вы можете сохранить проект только в формате ARQ.  
3 Введите новое имя для проекта и нажмите Save. 
 

Настройка компоновки квилта 
 
Используйте инструмент Quilt Layout (панель Edit) для настройки компоновки квилта. 
 

Когда вы создаете новый проект квилта, вы определяете формат блоков, добавляете полоски между 
блоками и одну или несколько окантовок по краям квилта. Вам нужно установить компоновку квилта перед 
тем, как сможете добавить ткани, цвета, аппликации или вышивки. Компоновка квилта основывается на 
формате блоков, который может быть изменен:  
◄ вращением блоков на их точках, 
◄ изменением количества блоков в рядах и столбцах или 
◄ изменением размеров блоков. 
 
Примечание: Определите компоновку квилта до добавления тканей, цветов, аппликаций или вышивок. 

     
           Ромбовидная структура    Квадратная структура  
 
Изменение расположения блоков 
Блоки могут быть расположены горизонтально, образуя квадратную структуру, или по диагонали,  образуя 
ромбовидную структуру,  
 
Как изменить расположение блоков 
1  Откройте проект квилта. 
2  Щелкните по значку Quilt Layout.  
 Откроется диалоговое окно Quilt Layout. 

 
3  Выберите формат:  

◄ Rectangular (Прямоугольный) 
◄ On-point (Ромбовидный) 

4  Нажмите кнопку ОК. 
Прямоугольные блоки 

 
 Ромбовидные блоки 
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Изменение количества блоков 
 
Вы можете изменить внешний вид квилта, изменив количество блоков в рядах и столбцах.  

 
                                        Тот же размер блока, но разное их количество  
 
Как изменять количество блоков 
1 Откройте проект квилта. 
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2 Щелкните по значку Quilt Layout.  
 Откроется диалоговое окно Quilt Layout. 

Введите количество блоков 
 
3  Введите опции Blocks:  

◄ Blocks across (Блоки в ширину) 
◄ Blocks down (Блоки по высоте) 

 
 
 
 
 

Блоки в ширину: 4  
Блоки по высоте: 4 

 
 

Блоки в ширину: 4  
Блоки по высоте: 6 

 
4  Нажмите кнопку ОК. 
 
Изменение размеров блоков 
Вы можете изменить внешний вид квилта, изменив размеры блоков. 

 
То же количество блоков, но с разными размерами 
 
Как изменять размер блоков 
1 Откройте проект квилта. 
2  Щелкните по значку Quilt Layout.  

Откроется диалоговое окно Quilt Layout. 
 
 

Ввод размеров блока 
3 Введите опции Blocks:  

◄ Block Width (Ширина блока) 
◄ Block Height (Высота блока) 
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увеличенная ширина 

 
увеличенная высота 

 
4 Нажмите кнопку ОК. 

Добавление полосок между блоками 
 
Для разделения блоков между ними могут быть вставлены узкие полоски ткани. Иногда в местах 
соединения добавляют небольшие соединительные квадраты. Вы можете также добавить полосу 
окантовки, в зависимости от выбранного стиля межблоковых полосок. 
 
Добавление межблоковых полосок 
Полоска между блоками может быть добавлена и определена: 
◄ изменением ширины полоски, 
◄ изменением стиля полоски, 
◄ добавлением полосы окантовки. 

            
Полоски между ромбовидными блоками    Полоски между квадратными блоками 
 
При добавлении межблоковых полосок размеры квилта увеличиваются в соответствии с шириной полосок. 
Размеры блоков остаются теми же. 
 
Как добавлять полоски между блоками 
1  Откройте проект квилта. 
2  Щелкните по значку Quilt Layout.  
 Откроется диалоговое окно Quilt Layout. 
 
 
 
Выбор стиля полоски 
 
 
3 Выберите стиль межблоковой полоски. 
 
Примечание: Стили полосок различны для квадратных и ромбовидных блоков. 
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no sashes  
(без полосок) 

sash squares 
(квадратное 
расположение 
полосок) 

horizontal sash 
(горизонтальные 
полоски) 

 
horizontal sash on  
top 
(горизонтальные 
полоски сверху) 

vertical sash 
(вертикальные 
полоски) 

vertical sash on 
top 
(вертикальные 
полоски сверху) 

 
Примечание: При выборе опции None опция  Sash Border (Окантовка полоской) отключается. 
 

без полосок 

  
квадраты 

 
назад 

 
 вперед 

 
4  Проставьте флажок в окошке Sash Border для добавления полоски окантовки вокруг квилта. 
 
 
 
 
 
 
Выбор полоски окантовки 
 
 
Окантовка отображает выбранный вами стиль межблоковой полоски, т.е. если вы выбрали горизонтальную 
полоску, то окантовка добавляется только к верхней и нижней стороне квилта. 
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полоски вокруг квадратов     окантовка, добавленная ко всем сторонам  

 
горизонтальные полоски     окантовка, добавленная к верхней и нижней сторонам 

 
вертикальные полоски      окантовка, добавленная к боковым сторонам 
 
5  Нажмите кнопку ОК. 
 
Изменение ширины полоски 
Ширину полоски между блоками можно изменять. 
     
 
Как изменять ширину полоски 
1 Откройте проект квилта. 
2  Щелкните по значку Quilt Layout.  
 Откроется диалоговое окно Quilt Layout. 
 
 
Настройка ширины полоски 
 
 
 
 
 
3  Выберите стиль межблоковой полоски. 
4  Введите ширину полоски (Sashes Width). 

   
ширина полоски: 1 дюйм    ширина полоски: 2 дюйма 

 
5 Нажмите кнопку ОК. 
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Добавление окантовок вокруг квилта 
По наружному краю квилта можно добавить одну или несколько окантовок. Окантовки могут отображать 
стиль квилта, нужно выбрать квадратный, скошенный, вертикальный, горизонтальный или блочный стиль. 
 
Добавление окантовок 
Добавление окантовки означает размещение окантовки по наружному краю квилта, в то время как вставка 
окантовки означает размещение окантовки внутри выбранной окантовки. 

    
Как добавлять окантовки 
1 Откройте проект квилта. 
2 Щелкните по значку Quilt Layout. 
 Откроется диалоговое окно Quilt Layout. 
3 На панели Border (Окантовка) нажмите кнопку Add. 
 Новая окантовка будет добавлена и выделена. 
 

Добавить новую окантовку 
 

 
 
 
 
 
 

Совет: Нажмите кнопку Add еще раз, чтобы добавить  
 еще одну окантовку.   

4  Нажмите кнопку ОК. 

 
Без окантовки  Одинарная окантовка Двойная окантовка 
 
Вставка окантовок 
Внутрь выбранной окантовки можно вставить одну или несколько окантовок. 
 
Как вставить окантовки 
1  Откройте проект квилта. 
2 Щелкните по значку Quilt Layout.   Вставить новую окантовку 
 Откроется диалоговое окно Quilt Layout. 
 
 
 
 
 
 
 
 
 
 
Примечание: Чтобы активировать кнопку Insert, нужно добавить окантовку.  
3 Выберите окантовку. 
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Выбранная 
окантовка выделена 

 
 
 
 
4 На панели Border (Окантовка) нажмите кнопку Insert. 
 
 

Вставлена новая  
окантовка 

 
 
 
 
 Новая окантовка вставлена внутрь выделенной окантовки. 
 

Совет: Нажмите кнопку Insert еще раз, чтобы вставить еще одну окантовку.  
5 Нажмите кнопку ОК. 
 
Удаление окантовок 
Окантовки можно удалять так же просто, как и 
вставлять.  
    
 
Как удалять окантовки 
1 Откройте проект квилта. 
2  Щелкните по значку Quilt Layout.  
 Откроется диалоговое окно Quilt Layout. 
 
Выберите окантовку для  
удаления 
 
 
 
 
 
3 Выберите окантовку для удаления 
4  На панели Border (Окантовка) нажмите кнопку Delete. 
 

Совет: Нажмите кнопку Delete еще раз, чтобы удалить следующую окантовку.   
5  Нажмите кнопку ОК. 
 
Изменение стиля окантовки 
Окантовки квилта могут быть изменены с использованием 
различных стилей. Каждая окантовка может быть выполнена 
в разном стиле. 
     
 
 
Как изменить стиль окантовки 
1 Откройте проект квилта. 
2 Щелкните по значку Quilt Layout.  
 Откроется диалоговое окно Quilt Layout. 
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Выбор стиля окантовки 
 
 
 
 
 
 
 
 
3  Выберите окантовку. 
4 Выберите стиль окантовки: 
 

◄ Mitred 
(Скошенный) 

 

◄ Corner Squares 
(Угол с 
квадратом) 

 

◄ Horizontal 
(Горизонтальный) 

 

◄ Vertical 
(Вертикальный)  

 

  
 

 

 
◄ Rectangles (Прямоугольники) 

 
 
5  Нажмите кнопку ОК. 
 
Изменение ширины окантовки 
Ширина окантовок квилта может быть подогнана к 
точным размерам квилта. Если вы выбрали 
окантовку прямоугольниками, то вы можете также 
изменить количество прямоугольников вдоль 
каждой стороны или же превратить прямоугольники 
в квадраты. 
 
Как изменить ширину окантовки 
1 Откройте проект квилта. 
2  Щелкните по значку Quilt Layout.  
 Откроется диалоговое окно Quilt Layout. 
3  Выберите окантовку. 
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Ввод ширины окантовки 
 
 

4  Введите ширину окантовки 

 
увеличенная ширина окантовки 

 
5  Нажмите кнопку ОК. 
 
Настройка параметров окантовок 
прямоугольниками 
Окантовки прямоугольниками могут быть изменены 
таким образом, что ширина верхней и нижней окантовок 
будет отличаться от ширины боковых окантовок. Вы 
можете также изменить количество прямоугольников 
вдоль каждой стороны или же превратить 
прямоугольники в квадраты. 
    
Как изменять окантовки прямоугольниками 
1 Откройте проект квилта. 
2  Щелкните по значку Quilt Layout.  
 Откроется диалоговое окно Quilt Layout. 
3 В поле Borders выберите Rectangles. 

 
 
 
 
 
 
 
 
 
 
Ввод числа прямоугольников окантовки 
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4 Введите число прямоугольников окантовки.  

◄ Across (По ширине): в поперечном направлении по верхней и нижней сторонам квилта.  
◄ Down (По высоте): в продольном направлении по боковым сторонам квилта. 

 
Примечание: Количество прямоугольников окантовки не обязательно должно соответствовать 
количеству блоков в квилте в поперечном и продольном направлениях. 

     
      По ширине: 2    По ширине: 3    По ширине: 4  

По высоте: 2    По высоте: 4     По высоте: 4 
 

 
5  Введите высоту прямоугольников окантовки в поперечном направлении и их ширину в продольном 

направлении.  
◄ Height (Высота): высота прямоугольников окантовки.  
◄ Width (Ширина): ширина прямоугольников окантовки. 

      
Высота: 1"     Высота: 2"     Высота: 3"  
Ширина: 3"    Ширина: 2"    Ширина: 1" 

6 Проставьте флажок в окошке Square (Квадрат), чтобы превратить прямоугольники окантовки в 
квадраты по ширине (Across) и/или высоте (Down) квилта. 

                      
Выбрана функция     Квадраты по ширине: 4  
Squares Across 

Квадраты по высоте: 4 
 
7  Нажмите кнопку ОК. 
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Глава 39 
 
Основные сведения о 
программе BERNINA Quilter  
 
В программе BERNINA Quilter вы можете создавать и 
отображать на экране весь проект квилта, выбирать блоки, 
изменять цветность и добавлять ткани, затем редактировать 
проект и просматривать всю компоновку квилта. Можно 
распечатать схему завершенного квилта, как всего квилта и 
всех компонентов из блоков пэчворка и лоскутов, так и 
шаблонов для выкройки лоскутов и блоков пэчворка. 
Программа BERNINA Quilter может также рассчитать и 
выдать на печать расход каждой ткани в данном проекте. 
В этом разделе поясняется, как настраивать проект квилта, 
как добавлять блоки пэчворка, а также как располагать блоки 
пэчворка и ткани на экране.  Также описывается, как 
распечатывать проект квилта и как обращаться с файлами 
проектов. 
 
Использование изображений 
 
Растровые изображения могут быть вставлены или отсканированы в программу BERNINA Quilter для 
использования в качестве оригиналов для оцифровывания вышивок, аппликаций или образцов ткани. Как и 
в BERNINA artista, вы можете временно показывать или скрывать растровый оригинал. См. Оцифровывание 
с оригиналом в Руководстве пользователя. 
 
Сканирование оригиналов и тканей 

 
Используйте команду Scan (меню Edit) для сканирования растрового изображения или ткани в BERNINA 
Quilter. 
 

Сканирующие функции BERNINA artista позволяют вам использовать большинство совместимых с 
протоколом TWAIN сканеров. Вы можете использовать любое ПО сканера, если оно способно сохранять 
изображения в одном из совместимых форматов. 
Если вы сканируете ткань, установите сканирование на 256 цветов, 100 % и 72 dpi. Такие настройки 
позволят получить файл небольшого размера, который будет хорошо отображаться на экране, не занимая 
много места на жестком диске или в памяти компьютера. 
 
Совет: Если нужно изменить размеры или повернуть изображение, то лучше делать это во время 
сканирования. Последующее изменение размера может исказить изображение. 
 
Как сканировать оригинал или ткань 
1 Установите ваш сканер. 
 См. раздел Настройка сканера в Руководстве пользователя. 
2  Подготовьте оригинал или ткань для сканирования. 
3  Создайте новый файл или откройте проект, в который вы хотите вставить рисунок ткани. 
4  Нажмите кнопку Scan (Сканировать). 
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 Откроется ваша программа сканирования. 
5  Выберите режим сканирования и разрешение. 
 См. раздел Сканирование изображения в программу BERNINA artista. в Руководстве пользователя. 
6  Просмотрите изображение в программе сканирования. 
7  Выберите зону сканирования и отсканируйте изображение. 
8  Сохраните отсканированное изображение в совместимом формате, таком как BMP. 
 
Вставка рисунков 

 
Используйте инструмент Load Picture (панель Edit) для открытия изображения. 
 
 
 
Используйте инструмент Scan Image (панель Edit ) для сканирования изображения или ткани. 
 
Вы можете вставлять растровые изображения в различных форматах для использования в качестве 

оцифровываемых трафаретов или аппликаций. Вы можете также вставить растровые изображения или 
ткани для сохранения в Fabrics Library (Библиотеке тканей). Подробнее см. в разделе Создание образцов 
ткани. 
 
Как вставить рисунок 
1  Нажмите кнопку New (Создать). 

Откроется новый файл. 
2  Нажмите кнопку Load Picture (Загрузить 

рисунок).  
 Откроется диалоговое окно Load Picture. 
   
 
3  Выберите папку из списка Look In. 
4  Выберите тип файла из списка Files of 

Type (например, BMP). 
5  Выберите файл, который вы хотите 

вставить. 
 
 Совет: Проставьте флажок в окошке Preview, чтобы просмотреть выбранный файл.  
6 Нажмите Open. 
 
Отображение и скрытие рисунка 

 
Щелкните по инструменту Show/Hide Picture (панель Standard ), чтобы отобразить или скрыть рисунок. 
 

Вы можете отобразить или временно скрыть растровый трафарет.  
 
Как отобразить или скрыть рисунок 
◄ Щелкните по значку Picture (Рисунок), чтобы просмотреть изображение.  
◄ Щелкните еще раз, чтобы скрыть изображение. 
 
отображаемый рисунок 

 
       скрытый рисунок 
 

Добавление блоков и тканей к квилту 
В программе BERNINA Quilter вы используете встроенную "Библиотеку" (Library) для добавления блоков 
пэчворка в квилт. Они сохранятся в Blocks Library (Библиотеке блоков). Если вы добавили их в проект, то 
затем вы добавляете выбранные вами ткани. Цвета и ткани, которые вы скомплектовали для проекта 
квилта, помещаются в Библиотеку цветов (Colors Library), содержащей чистые цвета, или в Библиотеке 
тканей (Fabrics Library), содержащей подборку отсканированных тканей. 
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Библиотека блоков 
Библиотека блоков (Blocks Library), содержит традиционные проекты пэчворка, такие как Log Cabin или Wild 
Goose Chase, которые могут быть использованы в качестве исходной формы для вашего проекта.  
 
Используйте один тип блока по всему квилту или несколько подобранных друг к другу блоков. Вы можете 
изменять внешний вид квилта путем вращения блоков, изменения цвета и узоров используемых тканей. 
Поэкспериментируйте с различными эффектами, пока не получите то, что вам понравится. 
 
 
 
Выбор блоков,                                               Текущий выбор 
цвета или ткани 
 
 
 
 
 
 
 
Выбор блока 
 
 
 
Разворачивание  
или  
сворачивание  
узла 
 
 
Когда вы оцифровываете свой квилт, вы можете распечатать список с указанием расхода каждой ткани для 
данного проекта, а также шаблоны для выкройки лоскутов с учетом или без учета припусков на шов. 
 
Библиотека цветов 
 
Библиотека цветов (Colors Library) включает в себя 
диапазон чистых цветов с подразделением на     Текущий 
светлые, средние по тону и темные оттенки.              выбор 

Выбор цветов  
для отображения  

одноцветной ткани 
 

Выбор светлого,  
среднего или  

темного оттенка 
 

Выберите чистый цвет из Библиотеки цветов, чтобы он 
соответствовал имеющейся у вас одноцветной ткани,  
или используйте цветную распечатку, чтобы подобрать 
подходящий цвет ткани из сохраненных вами тканей. 
 
 
Библиотека тканей 
 
Библиотека тканей (Fabrics Library) содержит коллекцию отсканированных образцов ткани из ассортимента 
фирмы Benartex. Они могут быть заказаны на фирме Benartex или приобретены в местном магазине тканей. 
Номер заказа указывается  
во всплывающей подсказке. Ткани упорядочены по категориям похожих друг на друга тканей. Вы можете 
добавлять в эту библиотеку собственные образцы отсканированных тканей. 
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Выбор ткани из                                                                      Текущий выбор 

ассортимента  
Benartex 

 
 
 
 
 
 
 
 
 
 

Выбор блока 
 
 

Разворачивание  
или  

сворачивание  
узла 

 
Примечание: Вы можете также сканировать одноцветные ткани и сохранять их в Библиотеке тканей. См. 
также Управление трафаретами и образцами тканей. 
 
Добавление блоков пэчворка к квилтам  

 
Используйте инструмент Library (меню Edit) для отображения и выбора блоков пэчворка.  
 
 
 
Используйте инструмент Paintbrush (меню Edit) для выбора и добавления блоков пэчворка к квилту.  
 

Библиотека блоков (Block Library) содержит ассортимент блоков пэчворка, упорядоченный по категориям. 
Вы можете заменять блоки в любое время. Если вы добавили их в проект, то затем вы добавляете 
выбранные вами ткани. 
 
Как добавлять блоки пэчворка к квилту 
1  Откройте программу BERNINA Quilter и проведите настройку компонентов квилта. 
 Подробнее см. в разделе Настройка компоновки квилта. 
2  Нажмите кнопку Paintbrush (Кисть). 
 В правой части окна проекта откроется диалоговое окно Library. 
3 Нажмите кнопку Blocks (Блоки). 
 Появится список всех предварительно определенных блоков пэчворка с подразделением на категории. 
4  Щелкните по знаку "+" у названия категории, чтобы увидеть содержание категории. 
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Выбор блока 
 
 
 
Разворачивание  
или  
сворачивание  
узла 
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5  Выберите блок или блоки для квилта.  
 Для выбора нескольких блоков:  

◄ обведите ограничивающий прямоугольник 
вокруг группы блоков или, 

◄ удерживая нажатой клавишу Ctrl, щелкайте 
мышью по нужным вам блокам. 

6  Выберите блок пэчворка из Библиотеки.  
Блок пэчворка будет скопирован в окно проекта. 

 
 

Если выбрано больше одного блока, то блок 
пэчворка копируется во все выделенные блоки. 

      
Выбранные блоки     Все выделенные блоки  
выделены       заполнены образцом из Библиотеки 

 
7 Продолжайте выбирать блоки пэчворка по своему желанию. См. также Добавление блоков пэчворка к 

квилтам. 
 

Совет: Чтобы добавить один из образцов ко всем 
блокам квилта, удерживайте нажатой клавишу Ctrl и 
щелкните по любому блоку квилта.  
 
 

 
Просмотр тканей 
Образцы тканей в библиотеке имеют небольшой размер и 
не дают представления о действительном внешнем виде. 
Вы можете отобразить большой образец любой такни с 
натуральным размером узора. 
 
Как просмотреть ткань 
1 В окне Library выберите ткань: 

◄ щелкните по кнопке Colors для чистых цветов,   
◄ щелкните по кнопке Fabrics для тканей.  

2 Нажмите клавишу Alt, щелкните по образцу ткани и 
удерживайте нажатой кнопку мыши. Образец ткани 
заполнит все окно проекта с отображением рисунка в 
масштабе 1:1. Как только вы отпустите кнопку мыши, 
экран возвратится в нормальный режим. 

   
Добавление тканей к квилту 

 
Используйте инструмент Library (панель Edit) для 
отображения и выбора чистого цвета или тканей для 
квилта. 
 
 
 
Используйте инструмент Paintbrush (меню Edit) для 

выбора и добавления тканей к квилту.  
 
Добавляйте одноцветные или узорчатые ткани к 
индивидуальным блокам или ко всему квилту. 
     
Как добавлять ткани к квилту 
1 Откройте проект квилта. 
2 Нажмите кнопку Paintbrush (Кисть). 
3  Выберите Colors (Цвета) или Fabrics (Ткани) в диалоговом окне Library:  
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◄ Для чистых цветов нажмите кнопку Colors, затем выберите тон – светлый, средний или темный.  
◄ Для тканей нажмите кнопку Fabrics, затем щелкните по знаку "+", чтобы отобразить образцы тканей. 

4  Выберите нужный вам цвет ткани. 
5 Щелкните по блоку, в котором вы хотите поместить ткань. 

 
 
 
Щелкните, чтобы поместить ткань 
 
 
 
 

6  Продолжайте эти операции, пока не 
добавите все ткани. 
   

Совет: Чтобы добавить один из 
образцов ткани ко всем блокам 
квилта, удерживайте нажатой 
клавишу Ctrl и щелкните по любому 
блоку квилта.  

 
Добавление тканей к лоскутам пэчворка 
Вы можете добавлять ткани к лоскутам пэчворка индивидуально или по группам. 

   
 
 
 
 
Как добавлять ткани к лоскутам пэчворка 
1  Откройте проект квилта. 
2  Добавьте блоки пэчворка. 
 Подробнее см. в разделе Добавление блоков пэчворка к квилтам. 
3  Нажмите кнопку Paintbrush (Кисть). 
4  Выберите Colors (Цвета) или Fabrics (Ткани) в диалоговом окне Library:  

◄ Для чистых цветов нажмите кнопку Colors, затем выберите тон – светлый, 
средний или темный.  

◄ Для тканей нажмите кнопку Fabrics, затем щелкните по знаку "+", чтобы 
отобразить образцы тканей. 

5  Выберите цвет или фактическую ткань. 
   

Оригинальный квилт 
 

6 Щелкните в том месте, куда вы хотите поместить цвет или ткань. 
 

  
 
 
Щелкните, чтобы  поместить ткань 
 
 

7  Продолжайте эти операции, пока не добавите все ткани. 

      
Совет: Чтобы добавить ткань ко всем геометрически подобным лоскутам пэчворка, удерживайте 
нажатой клавишу Ctrl во время щелканья мышью.  
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Просмотр блоков и тканей, используемых в проекте 
 
На панелях под окном проекта отображается до восьми блоков пэчворка, цветов или образцов ткани, 
использованных в проекте. 
 
Как просматривать блоки и ткани, используемые в проекте 
◄ Используйте кнопки прокрутки (< или >) для перемещения картинок на одну ячейку влево или вправо. 

     
 
◄ Щелкайте по кнопкам прокрутки (« или ») для перемещения к концу ряда влево или вправо. 
 

Примечание: Блоки показываются в том виде, в котором они изображены в окне библиотеки, т.е. с тем 
же цветом, ориентацией и формой, даже если блоки квилта были изменены по цвету, повернуты и/или 
перекошены. 

Просмотр проектов квилта 
 
BERNINA Quilter предоставляет несколько возможностей просматривать проекты, чтобы облегчить работу с 
ними. Увеличьте изображение на экране, чтобы рассмотреть проект  в натуральном размере или уменьшите 
изображение, чтобы увидеть весь проект. Это делается таким же образом, как при изменении размеров 
изображения в BERNINA artista. Вместо прокрутки можно панорамировать проект и быстро переходить от 
одного края проекта к другому. 
Вы можете показывать или скрывать элементы проекта разнообразными настройками отображения. Вы 
можете показывать или скрывать контуры объектов. Можно показывать линейное изображение блоков 
квилта вместе с аппликацией или вышивкой, а также версию со смешиванием цветов. 
 
Панорамирование проектов 

 
 Используйте инструмент  Pan (панель General) для панорамирования проекта квилта. 
 

В дополнение к линейкам прокрутки панорамирование позволяет быстро просматривать детали проекта, 
которые не видны в данный момент в окне проекта.  Панорамирование обычно используется после 
изменения размеров изображения. 
 
Как панорамировать проект  
1 Выберите значок Pan. 
 Указатель мыши превратится в изображение руки. 
 

Совет: Нажмите и удерживайте нажатой клавишу пробела, чтобы указатель мыши превратился в 
значок Pan. 

2 Щелкните и перетащите квилт для его перемещения в нужное положение. 
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Перетаскивание изображение 

 
Отображение черных и белых контуров 

 
 Используйте инструмент Show Outlines (панель Standard), чтобы отображать только черные контуры 
блоков квилта. 

 
Если у квилта сложный узор, то полезно скрыть все цвета ткани и отобразить проект в виде только белых и 
черных контуров. Все блоки, формы аппликаций и мотивы вышивок преобразуются в простые контуры. Эта 
техника может быть также использована для более четкого просмотра объектов аппликаций при изменении 
формы. 
 
Как отображать черные и белые контуры 
◄ Нажмите кнопку Show Outlines (Показать контуры). Будут отображены только контуры. 

   
         Функция Show      Функция Show  
         Outlines ОТКЛЮЧЕНА   Outlines ВКЛЮЧЕНА 
 Щелкните по значку Show Outlines еще раз, чтобы переключиться в нормальный режим. 
◄ Просмотрите цветовые блоки без контуров, чтобы получить более реалистичное представление о 

готовом квилте, нажав клавиши Ctrl + L. 

     
показан весь квилт   видна только аппликация 

 
Просмотр узоров тканей в натуральную величину 

 
 Используйте инструмент Show Pattern 1:1 (панель Standard) для просмотра тканей в натуральную 
величину. 
 

Иногда бывает полезно просматривать набивные ткани в натуральную величину. Это позволяет легче 
различать отдельные ткани, особенно если используется несколько похожих друг на друга тканей. Размеры 
блоков не изменяются, увеличиваются только узоры ткани. 
 
Как просматривать узоры тканей в натуральную величину 
◄ Нажмите инструмент Show Pattern 1:1 (Показать узоры в масштабе 1:1).  

Если выбран этот инструмент, узоры ткани отображаются в натуральную величину.  



Глава 39:Основные сведения о программе BERNINA Quilter  
 

BERNINA® Artista Designer Plus Версия 4 377

       
Функция Show Pattern    Функция Show Pattern  
1:1 ВЫКЛЮЧЕНА    1:1 ВКЛЮЧЕНА 

  
◄ Нажмите инструмент Show Pattern 1:1 еще раз, чтобы уменьшить размер узоров до пропорций 

изображения квилта. 
 
Просмотр сбалансированных оттенков цвета 
 

 Используйте инструмент Show Pattern Average Color (панель Standard) для просмотра тканей со 
сглаженными оттенками цвета.  

 
Когда вы выбираете ткани для квилта, важно подобрать баланс светлых, средних и темных оттенков, 
создающий требуемый вам эффект. Используйте инструмент Show Pattern Average Colors (Показать 
сбалансированные оттенки узоров) для сведения каждой ткани в усредненный цвет, что позволит вам 
проверить, достигнут ли вами правильный баланс оттенков. 
 
Как просматривать сбалансированные оттенки цвета 
◄ Щелкните по значку Show Pattern Average Colors. Если выбран этот инструмент, то ткань в каждом блоке 

приобретает усредненный цвет. 

   
Функция Show Pattern     Функция Show Pattern  
Average Colors ВЫКЛЮЧЕНА   Average Colors ВКЛЮЧЕНА 
  
◄ Щелкните по значку Show Pattern Average Colors еще раз, чтобы возвратиться к нормальному режиму. 

Упорядочение тканей на палитре 
 
Вы можете разместить подборку тканей на палитре для облегчения распознавания и доступа. Вы можете 
использовать, например подборку зеленых тканей, для выбора и отображения нескольких возможных 
тканей для использования в квилте. Вы можете также использовать подборку тканей, если у вас имеется 
проект квилта, по которому вы хотите создать несколько квилтов с разными тканями или цветами. 

 
 
Перемещайте цвета и ткани по палитре путем перетаскивания мышью. Попеременно переходите от одной 
ткани к другой перетаскиванием мышью. Дважды щелкните по цвету на палитре тканей, чтобы открыть 
диалоговое окно Color. 
 
Как упорядочить ткани на палитре 
1  Выберите одноцветную или набивную ткань из библиотеки. 
 

Примечание: Значок Paintbrush выбирается автоматически и превращается в "пипетку", когда указатель 
мыши находится над библиотекой.  

2 Щелкните по кнопке To palette (К палитре). 
Копия выбранного блока пэчворка или узора помещается в Палитру. 
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добавлено в палитру 

 
Щелкните, чтобы добавить в палитру 

Настройка цветности 
 
Когда вы добавляете блоки пэчворка и ткани к своему квилту, вы можете просто настроить оттенки или 
яркость всего квилта. Вы можете также смешивать и сохранять собственные цвета. 
 
Настройка оттенка или яркости 

 
 Используйте инструмент Adjust Hue/Brightness (панель Edit) для настройки оттенка или яркости. 
 

Диалоговое окно Adjust Hue/Brightness(Настройка оттенка/яркости) может быть использовано для:   
◄ изменения цвета или оттенка всего квилта или выбранных объектов, 
◄ настройки яркости всего квилта или выбранных объектов. 
 
Примечание: Проекты вышивки при настройке оттенка/яркости не затрагиваются. 
 
Как настраивать оттенок или яркость 
1   Откройте проект квилта. 
2 Выделите зону настройки или отмените выделение всех фрагментов, чтобы настроить весь квилт. 
3 Щелкните по значку Adjust Hue/'Brightness.  
 Откроется диалоговое окно Adjust Hue/Brightness. 
 
  
 
 
 
 

Используйте ползунки  
для изменения настроек 

 
 
 
 
 
4 Перемещайте ползунки для настройки оттенка и/или яркости. 

    
Оригинальные цвета     Отрегулированы оттенки 
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Оттенки отрегулированы в  Отрегулирована яркость 
выбранных фрагментах   

 
Совет: Проставьте флажок в окошке Preview, чтобы обновлять изображение во время изменения 
настроек.   

5 Щелкните по кнопке Hide Color (Скрыть цвет), чтобы удалить цвет выбранной зоны или всего квилта, 
если не выбран ни один фрагмент. 
Это поможет просматривать баланс светлого и темного в квилте. 

    
Цвет скрыт в      Цвет скрыт по всему квилту 
выбранных блоках   

6  Нажмите кнопку ОК. 
 
Смешивание ваших собственных цветов  
Из Палитры (Palette) вы можете изменять цвет любой одноцветной ткани или создавать и сохранять новые 
цвета тканей, используя диалоговое окно Color. 
 
Как смешивать ваши собственные цвета  
1 Перетащите мышью одноцветную ткань в Палитру тканей (Fabric Palette). 
2 Дважды щелкните по одноцветной ткани а Палитре тканей.  
 Откроется окно Color (Цвет).. 
 

  
 
Передвиньте ползунок  
для регулировки яркости цвета 
 
 
 
 
 
 
 
 

 
3 Из таблицы Basic colors (Основные цвета) выберите цвет, который ближе всего подходит к нужному вам 

цвету. 
4 Щелкните мышью и перетащите перекрестие нитей по спектру цветов, чтобы получить требуемый вам 

цвет. 
5 Передвиньте ползунок на правой стороне окна цветового спектра, чтобы отрегулировать яркость цвета. 

В правом нижнем углу диалогового окна Color появятся значения HLS (Цвет-Яркость-Насыщенность) и 
RGB (Зеленый, Красный, Синий). Введите эти значения для точного определения цветов. 

6 После смешивания требуемого цвета нажмите кнопку Add to Custom Colors (Добавить к 
пользовательским цветам). 

7 Нажмите кнопку ОК. 
Новый цвет появится в Палитре тканей (Fabric Palette). 
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Печать проектов квилта и блоков 
 
 Используйте кнопку Print (панель Standard) для распечатки текущего проекта с использованием 
текущих настроек. 
 
 
 
Используйте кнопку Print Preview (панель Standard) для предварительного просмотра текущего проекта 
и изменения настроек перед печатью. 

 
Создайте печатную копию проекта, используя принтер. Настройте опции печати и принтера перед печатью 
или используйте текущие опции. На распечатке будут указаны имена квилта и автора. Добавьте свое имя в 
диалоговом окне Quilt Properties на закладке Summary. Подробнее см. в разделе Просмотр информации о 
проекте квилта. 
 
Печать проектов квилта 
Распечатка содержит обзор квилта, а также основную рабочую информацию, включая размеры квилта, 
блоков и их элементов, аппликаций, а также указания по кройке лоскутов и расход ткани. 
 
Совет: Для проверки правильности проекта воспользуйтесь функцией предварительного просмотра перед 
печатью. 
 
Как печатать проекты квилта 
1 Выберите File > Print. Откроется диалоговое окно Print. 
    
2  Выберите принтер, который вы хотите использовать. 
 

Примечание: Для изменения настроек принтера, 
нажмите кнопку Options и выберите требуемые 
настройки. 

3  На панели Print What (Что печатать) выберите 
информацию, включаемую в распечатку:  

◄ Blocks (Блоки): Подробнее см. в разделе Печать 
блоков пэчворка.  

◄ Block Construction (Конструкция блока): Подробнее 
см. в разделе Печать конструкции блоков пэчворка.  

◄ Appliquй (Аппликация): Подробнее см. в разделе Печать форм аппликации.  
◄ Whole Quilt (Весь квилт): Подробнее см. в разделе Печать всего квилта.  
◄ Yardage (Расход ткани): Подробнее см. в разделе Печать данных о расходе ткани. 

4  Нажмите кнопку Options для изменения настроек.  
5  Для предварительного просмотра: 

◄ нажмите кнопку Preview в любом диалоговом окне Print Options, 
◄ нажмите кнопку Print Preview или 
◄ выберите File > Print Preview. 

6  Введите нужное вам число копий. 
7  Нажмите кнопку ОК. 
 
Печать блоков пэчворка  
Используется для распечатки всей компоновки блоков пэчворка, включая 
блоки, межблоковые полоски, соединительные квадраты и окантовку. 
 
Как распечатать блоки пэчворка 
1 Нажмите кнопку Print Preview. Откроется диалоговое окно Print Preview. 

  
2 Выберите опцию Blocks.  
3 Нажмите кнопку Options. 
 Откроется диалоговое окно Print Options Blocks (Опции печати блоков). 
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4 Выберите, нужно ли печатать в натуральную величину или назначьте число блоков на одной странице. 
5 Выберите, нужно ли печатать в цвете или только контуры: 

◄ опция Outline: печатаются только линии вокруг блоков и его элементов, 

     
 

◄ Опция Color:   печатаются блоки в цвете. 

    
 
6 Выберите диапазон печати, все или только выделенную часть.  

◄ Опция All: печатаются все блоки.  
◄ Опция Selection: печатаются только выделенные блоки. 

 
Совет: Не забудьте выделить блоки перед печатью. 
7  Проставьте флажок в окошке Print Guide, чтобы распечатать справку по квилту. 

В этой справке дается контурная схема всего квилта с номером каждого элемента, которые будут 
напечатаны на следующих страницах. Этот же номер появится около элемента, который будет 
напечатан отдельно. 
 
Совет: Для перехода от страницы к странице нажимайте кнопки Next Page и Previous Page.  

8  Нажмите кнопку Print. 
 
Печать конструкции блока пэчворка  
Конструкция блока включает индивидуальные лоскуты, из которых 
составлен блок, межблоковые полоски, соединительные квадраты и 
элементы окантовки. Каждый лоскут печатается с назначенным припуском 
на шов. Распечатка подразделяется на секции блока, начинающиеся 
непосредственно после печати справки. В каждой секции печатается все, 
что требуется для блока. Каждая секция блока начинается со справки 
блока, напечатанного в масштабе 1:5, с буквенными кодами, 
идентифицирующими положение лоскутов в блоке. 
 
Используйте этот метод для печати блоков, которые включают аппликацию как часть блока.  См. раздел 
Печать форм аппликации для печати аппликаций, созданных с использованием инструмента рисования 
аппликаций. 
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Как распечатать конструкцию блока пэчворка 
1 Нажмите кнопку Print Preview (Предварительный просмотр).  
 Откроется диалоговое окно Print Preview. 

    
 
2 Выберите Block Construction (Конструкция блока). 
3 Нажмите кнопку Options. 
 Откроется диалоговое окно Print Options Block Construction (Печать опций конструкции блока). 

    
 
4 Выберите, нужно ли печатать в натуральную 

величину или назначьте число блоков на одной 
странице. 

5 Выберите диапазон печати, все или только 
выделенную часть.  

◄ Опция All: печатаются все блоки. 
     

◄ Опция Selection: печатаются только 
выделенные блоки. 

 
 
 
 
 
 
 
 
 
 

 
Совет: Не забудьте выделить блоки перед печатью.  

6 Введите значение припуска на шов (Seam Allowance). 
 Контур, обведенный по припуску на шов, является линией раскроя, и он не соответствует контуру 

лоскута или линии стежки. 
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Припуск на шов: 0.25" 

 
Припуск на шов: 1.0" 

 
7 Проставьте флажок в окошке Print Guide  для первой страницы, чтобы распечатать контурную схему 

всего квилта с номером каждого элемента, которые будут напечатаны на следующих страницах. Этот же 
номер появится около элемента, который будет напечатан отдельно. 

 
Совет: Для перехода от страницы к странице нажимайте кнопки Next Page и Previous Page.  

8 Нажмите кнопку Print. 
 
Печать форм аппликации 
Используйте функцию Print Appliqué для печати контура форм аппликации в квилте, который может быть 
использована как шаблон или как схема для сборки.  При выборе опции Print Guide номера, печатаемые в 
каждой аппликации, помещаются внутри изображения этой аппликации или снаружи – с линией, 
соединяющей номер с контуром формы. Если две аппликации имеют идентичную форму, то им 
присваивается один и тот же номер и они печатаются один раз. При распознавании одинаковых форм 
игнорируется поворот формы, но не перевод в зеркальное отображение, перекос или изменение размера. 
Аппликация может быть использована в квилте одним из двух способов: 
◄ нормальным: припуска на шов не требуется; 
◄ с подвернутыми краями: необходимо добавить припуск на шов. 
 
 
Используйте этот метод для печати форм аппликаций, созданные с 
использованием инструментов рисования аппликаций. См. раздел 
Печать конструкции блоков пэчворка для печати блоков, которые 
включают аппликацию как часть блока.  
 
Как печатать формы аппликации 
1 Нажмите кнопку Print Preview (Предварительный просмотр).  
 Откроется диалоговое окно Print Preview. 

 
2 Выберите Appliquй. 
3 Нажмите кнопку Options. 

Откроется диалоговое окно Print Options- Appliqué (Опции печати аппликаций). 

 
4 Выберите, нужно ли печатать в натуральную величину или назначьте число блоков на одной странице. 
5 Выберите опции печати: 

◄ Опция All: печатаются все формы аппликации. 
◄ Опция Selected: печатаются только выбранные формы аппликации. 

 
Совет: Не забудьте выделить формы аппликаци перед печатью. 
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Все аппликации 
 
 
 
 
 
 
 
 
 
 
 
 
Одна выбранная аппликация  
 
 
 
 
 
 
 
 
 
 
6 Введите величину припуска на шов:  

◄ нормальная аппликация: 0  
◄ с подвернутыми краями: обычно 0.25". 

 
Совет: Для перехода от страницы к странице нажимайте кнопки Next Page и Previous Page. 

7 Нажмите кнопку Print. 
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Распечатка всего квилта 
Используйте команду Print Whole Quilt для печати всего квилта с 
блоками и/или вышивкой и/или аппликацией.  
 
 
Как распечатать весь квилт 
1 Нажмите кнопку Print Preview.  
 Откроется диалоговое окно Print Preview. 

 
 
2  Выберите Whole Quilt (Весь квилт). 
3 Нажмите кнопку Options. 

Откроется диалоговое окно Print Options- Appliqué (Опции печати аппликаций). 

 
 

4 Выберите, нужно ли печатать в натуральную величину или назначьте масштабный коэффициент. 
5 Выберите, какие детали квилта вы хотите напечатать:  

◄ Blocks (Блоки) 
◄ Appliqué (Аппликация) 
◄ Embroidery (Вышивка) 

 



Глава 39:Основные сведения о программе BERNINA Quilter  
 
выбраны все опции 

 
           только квилт и блоки 
 
только квилт и аппликация 

 
         только квилт и вышивка 
 

Совет: Для перехода от страницы к странице нажимайте кнопки Next Page и Previous Page.  
6 Нажмите кнопку Print. 
 
Распечатка данных о расходе ткани 
Используйте команду Yardage для расчета и распечатки списка 
используемых тканей с указанием их расхода на основе ширины ткани и 
назначенной величины припуска на шов. Список начинается тканью с 
наибольшим расходом и заканчивается  тканью с наименьшим расходом. 
 
Как распечатать данные о расходе ткани 
1  Нажмите кнопку Print Preview (Предварительный просмотр). 
 Откроется диалоговое окно Print Preview.  
2 Выберите Yardage 

 
 
3 Нажмите кнопку Options. 
 Откроется диалоговое окно Print Options-Yardage (Опции печати расхода ткани). 

     
 
4  Введите ширину ткани (Fabric width). 
5  Введите значение припуска на шов (Seam Allowance). 
 

Примечание: Один и тот же припуск на шов применяется ко всем лоскутам пэчворка и аппликациям. 
6 Проставьте флажок в окошке Print Details (Печатать подробности) для печати дополнительной 

информации под каждой тканью. При выбранной опции Print Details показывается контур требуемой 
ширины и длины ткани с каждым лоскутом пэчворка и объектом аппликации. 
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Без опции Print Details:  

 
 
С опцией Print Details:  

 
 
 

Совет: Для перехода от страницы к странице нажимайте кнопки Next Page и Previous Page.  
7 Нажмите кнопку Print. 
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Глава 40 
 
 
 
Редактирование в программе 
BERNINA Quilter  
 
BERNINA Quilter предоставляет технические средства для 
вставки рисунков и добавления  аппликаций или вышивок к 
квилту. BERNINA Quilter также позволяет копировать и 
вставлять, а также группировать и разгруппировать объекты и 
блоки пэчворка. Вы можете также редактировать проекты 
квилтов, включая перемещение, вращение и зеркальное 
отображение блоков пэчворка. 
В этом разделе дается подробная информация о функциях 
редактирования программы BERNINA Quilter. 
 
Добавление аппликаций к квилту 
 

 Используйте инструмент Rectangular Appliquй (панель Edit) для 
создания прямоугольных аппликаций. 
 
 
Используйте инструмент Draw Appliquй (панель Edit) для создания 
аппликаций произвольной формы. 
 
Используйте инструмент Circular Appliquй (панель Edit) для создания овальных аппликаций. 
 
 
 
Используйте инструмент Reshape Appliquй (панель Edit) для изменения формы аппликаций. 
 

 
Аппликация представляет собой одиночный кусок ткани, нашиваемый на квилт. 
Имеются три типа аппликаций: прямоугольные, овальные или произвольной 
формы. Аппликация произвольной формы может иметь сложные контуры.  
BERNINA Quilter предоставляет технические средства для добавления 
прямоугольников или окружностей, а также "замкнутых" произвольных форм. Эти 
аппликации являются только лоскутами ткани. Функция Auto Appliquй в программе 
BERNINA artista позволяет создавать вышитые аппликации.  
 
Примечание: Для создания аппликаций вы можете использовать растровые 
изображения в качестве трафарета. См. Оцифровывание с оригиналом в 
Руководстве пользователя. 
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Рисование прямоугольных аппликаций 

 
 Используйте инструмент Rectangular Appliqué (панель Edit) для создания прямоугольных аппликаций. 
 

Инструмент Rectangular Appliqué (Прямоугольная аппликация.) позволяет быстро оцифровывать 
аппликации в форме прямоугольника или квадрата. 
 
Как рисовать прямоугольную аппликацию 
1 Щелкните по значку Rectangular Appliqué. 
2 Оцифруйте один или несколько краев, как в BERNINA artista, наметив начало прямоугольника, а затем 

его углы. 
 
 Совет: Нажмите Alt и наметьте углы, чтобы оцифровать квадрат. 
3 Щелкните мышью, чтобы закрыть контур. 

    
 Совет: Изменяйте форму аппликации, используя инструмент Reshape Appliqué (Изменение формы 

аппликации). Этот инструмент используется таким же образом, как инструмент Reshape в BERNINA 
artista. См. Изменение формы объектов с использованием контрольных точек в Руководстве 
пользователя 

 
Рисование аппликаций произвольной формы 

 
 Используйте инструмент Draw Appliqué (панель Edit) для создания аппликаций произвольной формы. 
 

Вы можете создавать произвольной формы контуры или обрамления, используя инструмент Draw Appliqué 
(Рисование аппликации). 
 
Как рисовать аппликации произвольной формы 
1 Щелкните по значку Draw Appliqué. 
2 Щелкните для создания точек на первом контуре. 
3 Щелкните, чтобы закрыть контур. 
4 Для создания отверстий в аппликации щелкните, чтобы наметить точки следующего контура. 
 Все контуры после первого являются отверстиями в аппликации. 
5 После оцифровывания последнего контура нажмите Enter еще раз, чтобы завершить создание 

аппликации.  
 Если цвет ткани выбран в библиотеке (Library), аппликация заливается этим цветом.  Если ткань не 

выбрана, аппликация заливается белым цветом. Добавьте требуемый цвет аппликации. 
 

     
Намеченные базисные точки. 

 
 Добавьте цвета или ткани, как это делается с блоками. Подробнее см. в разделе Добавление тканей к 

квилту. 
 
Рисование аппликаций в форме окружности 

 
 Используйте инструмент Oval Appliqué (панель Edit) для создания овальных аппликаций. 
 

Инструмент Oval Appliqué (Овальная аппликация.) позволяет быстро оцифровывать аппликации в форме 
окружности. 
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Как рисовать аппликацию в форме окружности 
1 Щелкните по значку Oval Appliqué. 
2 Оцифруйте одну или несколько точек, как в BERNINA artista, наметив центр, а затем точку на 

окружности. 
◄ Если вам нужна окружность, нажмите Enter.. 
◄ Если вам нужен эллипс, наметьте третью базисную точку и нажмите Enter. 

    
 

Изменение формы аппликации 
 
 Используйте инструмент Reshape Object (панель Design) для установки контрольных точек выбранных 
объектов аппликации. 

 
Вы можете изменять форму аппликации, выбрав его инструментом Reshape Object (Изменение формы 
объекта) и перемещая, добавляя или удаляя контрольные точки на контуре. Для некоторых аппликаций 
вы можете также заменять угловые контрольные точки на контрольные точки кривых. 
 
Изменение формы аппликаций с использованием контрольных точек 

 
 Используйте инструмент Reshape Object (панель Design) для отображения на экране контрольных точек 
выбранных аппликаций. 

 
Изменяйте форму объектов аппликации, выбирая их инструментом Reshape Object (Изменение формы 
объекта) и манипулируя появившимися контрольными точками. 
 
Как изменять формы объектов аппликации с использованием контрольных точек 
1 Выделите объект. 
2 Нажмите кнопку Reshape Object (Изменение формы объекта). 
 Вокруг объекта появятся контрольные точки. 
 

     
угловая контрольная точка 
 
 
контрольная точка кривой 
 
 
 
 

3 Измените контур путем добавления, удаления или перемещения контрольных точек в зависимости от 
типа объекта и требуемых изменений. 

4 Измените точки входа и выхода и угол стежков по своему желанию. 
5 Нажмите Enter, чтобы принять изменения. 
 
 Совет: Нажмите клавишу Esc, чтобы отменить выделение инструментом Reshape. 
 
Выбор контрольных точек 
Контрольные точки могут быть выбраны индивидуально или совместно для изменения положения или 
модификации. 
 
Как выбирать контрольные точки 
1 Выделите объект. 
2 Нажмите кнопку Reshape Object. 

◄ Щелкните, чтобы выбрать единичную контрольную точку. 
 
 

◄ Удерживая клавишу Ctrl, щелкните,  
чтобы выбрать несколько контрольных  
точек.  
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◄ Щелкните и обведите ограничивающий прямоугольник вокруг группы контрольных точек, чтобы 
выбрать их. 

    
 
Перемещение контрольных точек 
Вы можете перемещать контрольные точки, чтобы изменить форму контура. 
 
Как перемещать контрольные точки 
1 Выделите объект. 
2 Нажмите кнопку Reshape Object. 

◄ Перетащите контрольную точку в новое 
положение. 

◄ Подобным же образом перетащите несколько 
точек в новое положение. 

     
 
Добавление контрольных точек 

 
 Используйте инструмент Reshape Object (панель Design) для добавления контрольных точек. 
 

Вы можете добавлять контрольные точки на контуре объекта выбранным инструментом Reshape Object. 
 
Примечание: Вы не можете добавлять контрольные точки к объектам аппликации, созданным 
инструментом Circle (Окружность). 
 
Как добавлять контрольные точки 
1 Выделите объект. 
2 Нажмите кнопку Reshape Object. 
3 Установите указатель мыши в том месте, где вы хотите добавить контрольную точку. 
4 Щелкните, чтобы добавить контрольную точку: 

◄ левой кнопкой, чтобы добавить угловую точку: 

390

◄ правой кнопкой, чтобы добавить точку кривой. 
 
 

 Щелчок правой кнопкой мыши 
 
 
 
 
 
Щелчок левой кнопкой мыши 
 
 
 

5 Определите положение новой контрольной точки, перемещая ее по контуру объекта. 
 
Изменение контрольных точек 
Изменение формы объекта выполняется путем преобразования угловых контрольных точек в точки кривой 
и наоборот. 
 
Примечание: Вы не можете изменять контрольные точки объектов аппликации, созданным инструментом 
Circle (Окружность). 
См. также Изменение формы объектов аппликации. 
 
Как изменять контрольные точки 
1 Выделите объект. 
2 Нажмите кнопку Reshape Object. 
3 Выберите контрольную точку. 
4 Нажмите клавишу пробела. 
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Удаление контрольных точек 
Удаляйте нежелательные контрольные точки для изменения контура 
 
Как удалять контрольные точки 
1 Выделите объект. 
2 Нажмите кнопку Reshape Object. 
3 Выберите контрольную точку или точки. 
4 Нажмите клавишу Delete. 

    
Примечание: Если у объекта имеется только две контрольных точки, то при удалении одной из них 
удаляется весь объект. 

 
Изменение формы объектов аппликации в виде окружности 

 
 Используйте инструмент Reshape Object (панель Design) для изменения формы объектов аппликации в 
виде окружности. 
 

Для объектов аппликации, созданных инструментом Circle (Окружность), изменение формы производится 
только контрольными точками. В таких объектах аппликации вы не можете добавлять, изменять или 
удалять контрольные точки. Объекты аппликации в форме окружности можно преобразовывать из 
окружности в овал инструментом Reshape Object. Объекты аппликации в форме окружности имеют две 
контрольные точки изменения формы (используемые для изменения радиуса и ориентации объекта), 
центральную точку (используемую для изменения положения) и точку входа стежка. 
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                           контрольная точка 
 
 
точка центра  
                                                                        контрольная точка 
 
 
 
Как изменять форму объектов аппликации в виде окружности 
1 Выберите объект окружности. 
2 Нажмите кнопку Reshape Object. 
 

Совет: Для перемещения окружности щелкните по контрольной точке в центре окружности и 
перетащите ее в новое положение. 

3 Щелкните по контрольной точке на контуре окружности и перетащите ее для изменения формы 
контура. 
◄ Для изменения формы без изменения ориентации используйте верхнюю контрольную точку. 
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 контрольная точка изменения формы  
 
 

 
◄ Для изменения формы и вращения объекта вокруг центральной точки используйте нижнюю 

контрольную точку. 
 
 
 
 
 
контрольная точка изменения формы  
 
 
 
 
4 Нажмите Enter. 

 

Включение вышивки в проекты квилта 
 
Проекты вышивки можно открывать и редактировать в окне BERNINA Quilter Embroidery. Вы можете также 
создать новый проект вышивки "на лету" для добавления к квилту. 
 
Добавление вышивки к квилту 

 
 Используйте инструмент Embroidery Window (панель Edit) для добавления вышивки к проектам квилта.  
 

Добавьте предварительно оцифрованный проект или новый проект вышивки в окне BERNINA Quilter 
Embroidery. Проект квилта может содержать больше одного проекта вышивки. 

 
 
Примечание: Проекты вышивки на квилте нужно открывать и вышивать в программе BERNINA artista. Вы 
не можете вышивать проекты вышивки из программы BERNINA Quilter. 
 
Как добавлять вышивку к квилту 
1 Откройте проект квилта. 
2 Щелкните по значку Embroidery Window. 
 Откроется окно Embroidery Window. 
 
 
3 В окне проекта вышивки выберите File 

(Файл) > Insert Design (Вставить проект). 
4 Выберите проект и нажмите OK. 
5 Проведите требуемые изменения. 
 Все изменения можно увидеть в окне 

квилта. 
    

392



Глава 40: Редактирование в программе BERNINA Quilter  

BERNINA® Artista Designer Plus Версия 4 

 
6 Выберите File (Файл) > Save and Return (Сохранить и вернуться). 
 Окно Embroidery Window закроется. 
 
 Совет: Используйте команду File (Файл) > Save As (Сохранить как) для сохранения копии 

оригинального проекта. 
7 Выделите и переместите проект вышивки в требуемое положение. 

    
Создание нового проекта вышивки 

 
 Используйте инструмент Embroidery Window (панель Edit) для добавления 
вышивки к проектам квилта.  

 
Создайте новый проект вышивки "на лету" для добавления к квилту. При создании 
проекта вышивки объекты  со стежками и цветом показываются в окне BERNINA 
Quilter. Каждый проект вышивки на квилте открывается для редактирования в собственном окне 
Embroidery Window. 
Объекты, оцифрованные в окне Embroidery Window, показываются в окне BERNINA Quilter с 
использованием той же средней базисной точки. 
 
Как создать новый проект вышивки 
1 Откройте проект квилта. 
2 Щелкните по значку Embroidery Window. 
 Откроется окно Embroidery Window. 

 
3 Используйте инструменты оцифровывания для создания проекта вышивки, как в BERNINA artista. 
4 Когда проект будет завершен, выберите команду File > Save and Return. 
 Файл проекта вышивки будет сохранен с программой BERNINA Quilter, и открывается при открытии 

файла BERNINA Quilter. 
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Вставленный объект 

 
Редактирование проектов вышивки в программе Quilter 
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 Используйте инструмент Embroidery Window (панель Edit) для добавления вышивки в проекты квилта.  

 
Вы можете редактировать проекты вышивки в 
программе Quilter. Любые сделанные вами 
изменения показываются во время работы. 
 
Примечание: Вы не сможете открыть окно 
Embroidery Window, если вы выбрали несколько 
проектов или сгруппированные проекты. 
     
 
Как редактировать проект вышивки в программе Quilter 
1 Откройте проект квилта. 
2 Выделите объект вышивки. 
 

Выделенный объект  
 

3 Щелкните по значку Embroidery Window. 
 Откроется окно Embroidery Window. 
4 Запомните положение средней базисной точки. 
5 После редактирования выберите команду File (Файл) > Save and Return. 
Файл вышивки сохраняется в программе Quilter и образует часть файла, 

сохраненного на диске. 
 

Объект, редактированный  
в BERNINA artista 

 
 
 
Редактирование блоков и объектов 
Для редактирования фрагмента проекта, вы должны вначале его выделить. Программа BERNINA Quilter 
предусматривает несколько способов выделения блоков. Имеется также возможность блокировать блоки 
в комплексных проектах, так чтобы их нельзя было случайно выделить и переместить. 
Вы можете сгруппировать или разгруппировать любую комбинацию блоков, рисунков, аппликаций и 
проектов вышивки тем же способом, что и в BERNINA artista. Специальный инструмент Regroup 
(Перегруппировать) позволяет снова объединить в группу все предварительно сгруппированные, а затем 
разгруппированные объекты. См. раздел Группировка и разгруппировка объектов в Руководстве 
пользователя. 
 
Примечание: Команда Regroup не работает, если объект был редактирован после разгруппирования. 
Вышивка, объект аппликации или рисунок могут быть выровнены по любому блоку путем выделения 
объекта и блока и использованием инструментов выравнивания, как в BERNINA artista. Инструменты 
расположения по слоям помогут правильно расположить по слоям аппликации и объектов вышивки. См. 
раздел Выравнивание объектов в Руководстве пользователя. 
 
Выбор блоков инструментом Select  

 
 Используйте инструмент Select (панель Edit) для выбора блоков или объектов. 
 

Инструмент Select (Выбор) работает таким же образом, как в BERNINA artista. Различие заключается в 
том, что в программе BERNINA Quilter вы работаете с блоками или фрагментами, а не с объектами 
проекта. 
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Совет: Нажмите Ctrl + A для выделения всех объектов аппликации.  
 
Как выбрать блок инструментом Select  
◄ Выбранным инструментом Select щелкните по блоку.  

 
Выделен один блок 

 
Выделено несколько блоков 

 
Совет: Удерживайте нажатой клавишу Ctrl для выбора нескольких блоков. 

 
Выбор блоков инструментом Eyedropper 

 
 Используйте инструмент Eyedropper (панель Edit) для выбора блоков или тканей. 

 
Используйте инструмент Eyedropper (Пипетка) для выбора блока пэчворка или ткани, который уже был 
использован в квилте или сохранен в Палитре тканей (Fabric Palette). Используйте инструмент Paintbrush 
(Кисть) для добавления блока пэчворка или ткани к квилту. 
 
Как выбрать блок инструментом Eyedropper 
1 Щелкните по значку Eyedropper (Пипетка). 
2 Выберите блок пэчворка или ткань. 
◄ Нажмите кнопку Blocks (Блоки) для блоков пэчворка.  
◄ Нажмите кнопку Colors для одноцветных тканей.  
◄ Нажмите кнопку Fabrics для набивных тканей.  

3 Выберите цвет, ткань или блок пэчворка из квилта или одну из используемых палитр (Palettes Used). 
 Для предварительного просмотра служит панель Library Preview (Предварительный просмотр 

библиотеки). 
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Выбранные цвета 
Пипеткой переносится  
выбранный цвет 
 
 
 
 
 
 
 
 
 
Выбранные блоки 
Пипеткой переносится  
выбранный блок 
 
 
 
 
 
 
 
 
 

 
 
4 Щелкните по значку Paintbrush (Кисть) для добавления блока или ткани к квилту. 
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Кистью добавляется  
выбранный блок. 
 
 
 
 
 
 
 

 
Блокирование фрагментов квилта 
 

Используйте инструмент Lock Quilt (панель Lock), чтобы заблокировать весь квилт.  
 
 
 
Используйте инструмент Lock Appliquй (панель Lock), чтобы заблокировать формы аппликации.  
 
 
 
Используйте инструмент Lock Embroidery (панель Lock), чтобы заблокировать проект вышивки.  
 

В сложных квилтах не исключена возможность ошибочного выделения и перемещения частей квилта. 
Блокирование квилта позволяет работать с аппликацией или вышивкой, не опасаясь случайного 
выделения и изменения квилта. Блоки, межблоковые полоски и окантовки не могут быть случайно 
выделены и перемещены. 
 
Как блокировать фрагменты квилта 
◄ Щелкните по значку Lock Quilt (Заблокировать квилт).  
 

Квилт не заблокирован,   Квилт заблокирован,  
выделен блок      легко выделяется аппликация 

    
◄ Щелкните по значку Lock Quilt еще раз для разблокирования квилта. 
◄ Щелкните по значку Lock Appliquй (Заблокировать аппликацию). 
 
Аппликация не заблокирована,  Аппликация заблокирована,  
по ошибке изменен цвет    облегчено редактирование блоков 

      
◄ Щелкните по значку Lock Appliquй еще раз для разблокирования аппликации. 
◄ Выберите Lock Embroidery (Заблокировать вышивку). 
 

Вышивка заблокирована   Вышивка не заблокирована 

     
◄ Щелкните по значку Lock Embroidery еще раз для разблокирования вышивки. 
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Перегруппировка объектов 

 
Щелкните по значку Group (панель Arrange), чтобы сгруппировать выделенные объекты. 
 
 
 
Щелкните по значку Ungroup (панель Arrange), чтобы разгруппировать выделенные объекты. 
 
 
Щелкните по значку Regroup (панель Arrange), чтобы снова объединить в группу предварительно 
разгруппированные объекты. 
 

Вы можете сгруппировать или разгруппировать любую комбинацию блоков, рисунков, аппликаций и 
проектов вышивки тем же способом, что и в BERNINA artista. См. раздел Группировка и разгруппировка 
объектов в Руководстве пользователя. 
Используйте команду Regroup (Перегруппировать) для повторного объединения в группу всех 
предварительно сгруппированных, а затем разгруппированных объектов. Например, если у вас имеются 
некоторые объекты аппликации, которые вы объединили в группу, а затем разгруппировали для 
редактирования, то вы можете сгруппировать их опять без повторного выделения. Эта команда работает 
только в том случае, если в группу не были включены новые объекты. 
 
Как перегруппировать объекты 
1 Выберите сгруппированный объект и разгруппируйте его. 
2 При необходимости отредактируйте объекты, а затем: 

◄ выберите команду Arrange > Regroup, или 
◄ щелкните по значку Regroup на панели Arrange, или 
◄ нажмите Ctrl + R. 

Объекты будут снова объединены в группу. 

     
Сгруппированы        Объекты отредактированы  
оранжевые аппликации     и снова объединены в группу. 
  
Размещение объектов 
 

Используйте инструмент Bring to Front (панель Arrange), чтобы перевести выбранный объект на 
передний план.  
 
 
 
Используйте инструмент Bring Forward (панель Arrange), чтобы перевести выбранный объект на один 
слой вперед.  
 
 
Используйте инструмент Send to Back (панель Arrange), чтобы отослать выбранный объект на задний 
план.  
 
 
 
Используйте инструмент Send Backwards (панель Arrange), чтобы перевести выбранный объект на 
один слой назад.  
 

При использовании вышивок или объектов аппликации важно расположить их в правильном порядке, 
чтобы. например, вышивка находилась сверху, а служащая фоном аппликация – снизу. Перемещайте 
объекты непосредственно на задний или передний план или же постепенно на один слой назад или 
вперед. Передним планом является верхний слой, задним планом – самый нижний слой. 
 
Совет: Используйте инструменты расположения по слоям для удержания рисунка на переднем плане во 
время калькирования объектов аппликации. 
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Как размещать объекты 
1 Выберите вышивку, объект аппликации или рисунок. 

 
 
Объект, подлежащий перемещению 
 
 
 
 
 

2 Щелкните по одному из инструментов послойного размещения по слоям: 
◄ Bring to Front (Перевести на передний план) 

 
 
 
 
 
Объект переведен на передний план 
 
 
 
 
◄ Move Forwards (Перевести на один слой вперед) 

 
 
 
Объект перемещен на один слой вперед 
 
 
 
 
 

◄ Move Backwards (Перевести на один слой назад) 
 
 
 
Объект перемещен на один слой назад 
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◄ Send to Back (Отослать на задний план) 
 
Объект переведен на задний план 
 
Совет: Вышивка, объект аппликации или рисунок могут быть выровнены по 
любому блоку путем выделения объекта и блока и использованием инструментов 
выравнивания, как в BERNINA artista. См. раздел Выравнивание объектов в 
Руководстве пользователя. 
 

Дублирование блоков и объектов 
Вы можете копировать, вырезать и вставлять выбранные блоки, аппликации или вышивки в любое время. 
В программе BERNINA Quilter вы можете работать с блоками пэчворка и тканями, а также с объектами 
аппликации и вышивки. 
 
Копирование, вырезание и вставка инструментом Select  
 

Используйте инструмент Select (панель Edit) для выбора блоков или объектов. 
 
 
 
Используйте инструмент Copy (панель Standard), чтобы копировать выделенные блоки в буфер обмена. 
 
 
 
Используйте инструмент Cut (панель Standard), чтобы вырезать выделенные блоки в буфер обмена. 
 
 
Используйте инструмент Paste (панель Standard), чтобы вставить скопированные блоки из буфера 
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обмена. 
 
Используйте инструмент Select (Выбор) для копирования и вставки блоков, аппликации или вышивки и 
инструмент Paintbrush (Кисть) для копирования и вставки тканей. 
 
Примечание: Если блок вставляется из одного квилта в другой, а у этих квилтов разные размеры блоков, 
то вставляемый блок будет увеличен или уменьшен для подгонки к новому квилту. 
 
Как копировать, вырезать и вставлять инструментом Select  
1 Щелкните по инструменту Select. 
2 Выберите блок, вышивку или аппликацию, которую нужно вырезать или скопировать, и затем  

выполните одну из следующих операций: 
◄ Нажмите кнопку Cut (Вырезать). 
◄ Выберите Edit > Copy. 
◄ Нажмите кнопку Copy (Копировать). 
◄ Нажмите Ctrl + R. 
◄ Щелкните правой кнопкой мыши по объекту и выберите Copy из всплывающего меню. 

 
      Выберите блоки для копирования 

 
Оригинальный квилт 

 
3 Щелкните по месту, куда нужно вставить блок, и затем  выполните одну из следующих операций: 

◄ Выберите Edit > Paste. 
◄ Нажмите кнопку Paste (Вставить). 
◄ Нажмите Ctrl + V. 
◄ Щелкните правой кнопкой мыши по объекту и выберите Paste из всплывающего меню. 

 
    Блоки, вставленные в новое положение 

     
Выберите, куда нужно вставить блоки 

 
Добавление блоков и тканей инструментом Paintbrush 

 
Используйте инструмент Paintbrush (меню Edit) для добавления тканей к квилту.  
 

Используйте инструмент Paintbrush (Кисть) для добавления блоков пэчворка к квилту из библиотеки. 
 
Примечание: Блоки пэчворка не могут быть добавлены к межблоковым полоскам, соединительных 
квадратам или частям окантовки, так как они не выполнены в стиле блоков. 
 
Как добавлять блоки и ткани инструментом Paintbrush 
1 Нажмите кнопку Paintbrush (Кисть). 
2 Выберите для добавления блок пэчворка или ткань: 

◄ Нажмите кнопку Blocks для блоков пэчворка.  
◄ Нажмите кнопку Colors для одноцветных тканей.  
◄ Нажмите кнопку Fabrics для набивных тканей.  

3 Выберите на квилте блок пэчворка или ткань и щелкните правой кнопкой мыши для копирования. 
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Щелчок правой кнопкой мыши 

       
Библиотека блоков     Библиотека тканей 
Щелкните правой      Щелкните правой кнопкой  
кнопкой по библиотеке    по библиотеке лоскутов пэчворка 
блоков пэчворка 

 
4 Переместите указатель мыши так, чтобы он находился внутри блока на квилте, затем щелкните для 

помещения блока пэчворка или ткани. 

        
  Щелкните по блокам    Щелкните по фрагментам для размещения 

         для размещения 
   
 Совет: Для копирования блока или ткани во весь квилт переместите указатель мыши внутрь блока, 

затем нажмите клавишу Ctrl и щелкните, чтобы скопировать проект в квилт. 
 

Преобразование блоков и объектов 
 
Программа BERNINA Quilter позволяет проводить различные преобразования выбранных блоков. Вы 
можете перемещать их, поворачивать по часовой стрелке или против часовой стрелки. Вы можете также 
зеркально отображать блоки, переворачивая их по горизонтали или по вертикали. 
 
Перемещение блоков и объектов 
Вы можете перемещать блоки в любое время. Рисунки, вышивки или объекты аппликации можно 
перемещать таким же образом. 
 
Как перемещать блок или объект  
1 Щелкните по инструменту Select. 
2 Выберите блок или объект для перемещения. 
3 Перетащите его мышью в новое положение. 

     
Выбранный блок   перемещен в новое положение 

 
◄ При перетаскивании мышью нажмите клавишу Ctrl, чтобы переместить объект вверх или вниз. 

        
Выбранная аппликация  Клавиша Ctrl и перетаскивание  

в новое положение 
◄ При перетаскивании мышью нажмите клавишу Alt, чтобы скопировать объект в новое положение.  
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Выбранная аппликация  Клавиша Alt и перетаскивание для копирования 
 

◄ При перетаскивании мышью нажмите клавиши Ctrl + Alt, чтобы скопировать объект в новое 
положение вверх или вниз.  

 
Выбранная аппликация  Клавиши Ctrl+Alt и перетаскивание для копирования в нижнее положение 
Вращение блоков и объектов 
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Используйте инструмент Rotate 90°CCW/CW (панель Edit) для вращения выбранных блоков. Щелчок 
левой кнопкой мыши – поворот против часовой стрелки. Щелчок правой кнопкой – поворот по часовой 

стрелке. 
 
Вы можете поворачивать блоки или объекты по часовой стрелке или против часовой стрелки. Если 
выбрано несколько блоков, каждый из них вращается в собственном положении. 

    
 
Каждый выбранный рисунок, вышивку или аппликацию можно свободно поворачивать путем 
перетаскивания маркеров вращения. 
 
Совет: Удерживайте нажатой клавишу Alt во время поворота объекта с использованием маркеров 
вращения, чтобы создать повернутую копию оригинала.  
 
Как вращать блок или объект  
1 Выберите блок или объект для вращения. 
 Подробнее см. в разделе Редактирование блоков и объектов. 
2 Щелкните по значку Rotate 90°CCW/CW . 

◄ Щелчок правой кнопкой – поворот на 90° по часовой стрелке. 
◄ Щелчок левой кнопкой – поворот на 90° против часовой стрелки. 

     
Выбранный блок    Повернутый блок 

 
Совет: Вы можете также вращать объекты перетаскиванием мышью. См. также раздел Вращение 
объектов перетаскиванием мышью. 

 
Перевод в зеркальное отображение блоков и объектов 

 
Щелкните по инструменту Mirror Horizontal (панель Edit) для переворачивания выбранных блоков по 
горизонтали. 
 
 
Щелкните по инструменту Mirror Vertical для переворачивания выбранных блоков по вертикали. 
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Вы можете зеркально отображать блоки, переворачивая их по горизонтали или по вертикали. Если 
выбрано несколько объектов, они зеркально переворачиваются относительно центра всей выборки. 

    
 
Если выбран одиночный блок, то он зеркально переворачивается относительно своего центра. Если 
выбрано несколько блоков, их проекты зеркально переворачиваются относительно их центров. 
 
Как зеркально перевернуть блок или объект  
1 Выберите блок или объект для зеркального отображения. 
 Подробнее см. в разделе Редактирование блоков и объектов. 
2 Щелкните по значку Mirror Horizontal, чтобы перевернуть объект по горизонтали, или Mirror Vertical,  

чтобы перевернуть объект по вертикали. 

 
Переворот по вертикали   Копирование и переворачивание по горизпнтали 

 
Перекос объектов 
Любой рисунок или аппликация может быть перекошен таким же образом, как объект в BERNINA artista, за 
исключением того, что имеется в два раза маркеров перекоса. Вышивки могут быть перекошены в окне 
Embroidery Window. 
 
Как перекосить объект  
1 Дважды щелкните по рисунку или объекту аппликации. 

 
Появятся маркеры перекоса 

 
2 Перекосите объект путем перетаскивания маркеров перекоса. См. также раздел Перекос объектов 
перетаскиванием мышью. 

      
 

Совет: Удерживайте клавишу Alt при перекашивании объекта, чтобы скопировать и перекосить 
объект, оставив оригинал без изменений.  

 
Изменение размеров объектов 

 
Используйте инструмент Scale by 20% Down/Up (панель Design), чтобы изменить размеры аппликации 
или объектов вышивки. 

 
Размеры рисунка, вышивки или аппликации можно изменять перетаскиванием их маркеров изменения 
размера. Размеры любого выбранного рисунка, вышивки или аппликации можно изменить на 20 % от 
текущего значения инструментом Scale by 20% Down / Up таким же образом, как в BERNINA artista. 
Подробнее см. в разделе Изменение размеров объектов. Если выбран объект вышивки, откроется окно 
Embroidery Window, когда вы щелкните по инструменту Scale by 20% Down/Up или начнете использовать 
маркеры изменения размера.  
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Как изменить размер объект  
1 Выделите объект. 
2 Измените размер объекта: 

◄ Щелкните левой кнопкой по значку Scale by 20% Down/Up для уменьшения размера на 20 %. 
◄ Щелкните правой кнопкой по значку Scale by 20% Down/Up для увеличения размера на 20 %. 

 
Удаление блоков и объектов 
 
Вы можете удалить ткани из индивидуальных элементов пэчворка, используя "пустой блок". Блоки 
пэчворка могут быть удалены из квилта, используя "пустой блок" или кнопку Delete. Аппликация или 
объекты вышивки можно удалить из квилта кнопкой Delete. 
 
Удаление тканей с использованием "пустого блока" 
Ткани из индивидуальных элементов пэчворка можно удалить, используя "пустой блок". Этот прием 
полезно использовать в том случае, если нужно удалить подборку тканей с произвольным расположением 
в квилте. См. также Удаление объектов. 
 
Как удалять тканей с использованием "пустого блока" 
1 Выберите значок Colors или Fabrics. 
 

Внимание: Если выбрана кнопка Blocks, вы удалите блок пэчворка.  
2 В диалоговом окне Library нажмите кнопку Blank (Пустой). 
 Окно просмотра очистится. 

 
Выбран пустой блок 
 
 
 
 
 
 
 
 
 

3 Выделите одну или лоскутов пэчворка. 
Лоскут пэчворка будет очищен. 

 
Оригинальный квилт    Нажата кнопка Colors  

 
Совет: Удерживайте нажатой клавишу Ctrl и затем щелкните по блоку или лоскуту для удаления из 
квилта.  
 
            Нажмите Ctrl для применения ко всем 

   
Оригинальный квилт    Нажата кнопка Colors  

 
 
Удаление блоков 
Блоки пэчворка могут быть удалены из квилта, используя "пустой блок" или кнопку Delete. Этот прием 
полезно использовать в том случае, если нужно удалить подборку блоков пэчворка с произвольным 
расположением в квилте. Подробнее см. в разделе Удаление тканей с использованием "пустого блока". 
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Как удалить блок 
1 Щелкните по кнопке Select (Выбрать). 
2 Нажмите кнопку Blocks (Блоки). 
3 Выберите блок/и для удаления. 
4 Выполните одну из следующих операций: 

◄ Щелкните по окошку Blank (Пустой) в диалоговом окне Library. 
◄ Нажмите клавишу Delete. 

    
Оригинальный квилт    Выбрана кнопка Blocks  

 
Удаление объектов 
Аппликацию или объекты вышивки можно удалить из квилта с использованием клавиши Delete таким же 
образом, как в BERNINA artista. 
 
Примечание: Используйте функцию Blank совместно с кнопкой Fabrics для удаления ткани из 
аппликации.  
 
Как удалить объект  
1 Щелкните по кнопке Select (Выбрать). 
2 Выберите объект/ы для удаления. 
3 Нажмите клавишу Delete. 
 Объекты удалены. 
 

Удаленные аппликации 

 
Ткани удалены из аппликации 
 

Совет: Используйте функцию Lock Quilt (Заблокировать квилт), чтобы предотвратить ошибочное 
выделение и удаление блоков пэчворка.  Подробнее см. в разделе Блокирование фрагментов квилта. 
 
 

404



Глава 41: Программа BERNINA Quilter для опытных пользователей 

BERNINA® Artista Designer Plus Версия 4 

 

Глава 41 
 

Программа BERNINA Quilter для 
опытных пользователей 
 
Программа BERNINA Quilter позволяет импортировать 
рисунки для использования в качестве узоров ткани. Из 
единичного образца ткани вы можете создать несколько 
различных образцов. Программа BERNINA Quilter 
предоставляет разные возможности управлять вашими 
узорчатыми тканями. Также имеется возможность создавать 
новые категории ваших блоков пэчворка, удалять их и 
перемещать блоки между категориями. 
В этом разделе дается подробная информация о более 
сложных функциях программы BERNINA Quilter, включая 
управление оригиналами и образцами ткани, изменение 
внешнего вида образцов ткани и управление блоками 
пэчворка. 
 

Модификация элементов мозаики образцов тканей 
 
Из одного образца ткани вы можете создать несколько различных образцов. Каждый образец может быть 
сохранен с отдельным именем и при необходимости в разных категориях. 
 

 
Выберите различные фрагменты для создания разных образцов ткани 
 
Увеличение масштаба изображения позволяет увидеть больше деталей или просмотреть изображение в 
фактическом размере. Фрагмент с элементом мозаики может быть изменен по размеру или перемещен 
для создания привлекательного образца вашей ткани. Можно также повернуть изображение для 
изменения внешнего вида. 
 
Выбор элементов мозаики ткани 

 
Используйте команду Selection (диалоговое окно Tile Fabric) для выбора фрагмента образца ткани.  

 
Используйте диалоговое окно Tile Fabric, чтобы создать ткань с мозаичным узором по своему желанию. 
Вы можете выбрать и сохранить точный фрагмент ткани, который должен быть использован в качестве 
элемента мозаики. При выборе только маленького фрагмента ткани с использованием кадрирующего 
прямоугольника вы можете изменить вид образца ткани, так как только выбранный фрагмент 
располагается рядами и отображается в окне просмотра. 
 
Как выбрать элемент мозаики ткани 
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1 Выберите и дважды щелкните по узору в библиотеке. 
 
 
 
 
 
 
 
 
 
Выберите узор и дважды щелкните по нему. 
 
 
  
 
 
 
 
 
 
 

Откроется диалоговое окно Tile Fabric.  
 
 
 
 
 
2 Щелкните по кнопке Selection (Выбор). 
3 Щелкните и обведите прямоугольник вокруг фрагмента, который должен быть отображен в образце 

ткани. 
 
 
 
 
 
 
 
 
 
 
 
 
Выбранный  
фрагмент 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Выбранный  
фрагмент 
 
 
 
 
 

Совет: Увеличьте масштаб изображения, чтобы было легче выбрать мелкий 
фрагмент. Подробнее см. в разделе Изменение масштаба изображения 
образцов ткани. 

4 Нажмите кнопку Save As (Сохранить как), чтобы сохранить образец и 
оставить без изменений оригинал.  

Новый образец 
 Примечание: Нажмите кнопку Save, чтобы заменить оригинальное 

изображение новым образцом.  
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Изменение масштаба изображения образцов ткани 
 
Используйте инструмент Zoom 1:1 (диалоговое окно Tile Fabric) для просмотра образца ткани в 
натуральную величину.  
 
 
Используйте инструмент Zoom In (диалоговое окно Tile Fabric) для увеличения изображения образца 
ткани. 
 
 
Используйте инструмент Zoom Out (диалоговое окно Tile Fabric) для уменьшения изображения образца 
ткани. 

 
Инструменты изменения масштаба изображения используются для просмотра образцов ткани в 
натуральном, увеличенном или уменьшенном размере.  Изменение масштаба изображения не изменяет 
образец в окне просмотра. 
 
Как изменять масштаб изображения образца ткани 
1 Выберите и дважды щелкните по узору в библиотеке. 
 Откроется диалоговое окно Tile Fabric. 

 
 
2 Щелкните по одному из значков изменения масштаба: 

◄ Zoom 1:1 для просмотра ткани в натуральную величину.  

 
 
 

◄ Zoom In для увеличения   
масштаба в 2 раза.  

 
  
  
  
  
  
  

◄ Zoom Out для уменьшения масштаба в 2 раза.  
 
 
 
 

Вращение образцов ткани 
 
Используйте инструмент Rotate Left (диалоговое окно Tile Fabric) для поворота образца ткани влево. 
 
 
 
 
Используйте инструмент Rotate Right (диалоговое окно Tile Fabric) для поворота образца ткани вправо. 
 

При использовании инструментов вращения образец ткани поворачивается на 90° вправо или влево. В 
окне просмотра никаких изменений не происходит. 
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Примечание: Поворачивается ткань, но не кадрирующий прямоугольник. 
 
Как поворачивать образец ткани 
1 Выберите и дважды щелкните по узору в библиотеке. 
 Откроется диалоговое окно Tile Fabric. 
    
2 Выберите при необходимости фрагмент. 
3 Щелкните по одному из значков вращения: 

◄ Rotate Left (Повернуть влево) 
◄ Rotate Right (Повернуть вправо) 

 

 
Образец повернут влево 

4 Нажмите кнопку Save As (Сохранить как), чтобы сохранить образец и оставить без изменений 
оригинальный образец.  

Точное изменение размеров элементов мозаики 
Если вам нужно точно определить размеры кадрирующего прямоугольника, введите его размеры. 
 
Как точно изменить размер элемента мозаики 
1 Выберите и дважды щелкните по узору в 

библиотеке. 
 Откроется диалоговое окно Tile Fabric. 
    
2 Щелкните по кнопке Select (Выбрать). 
3 Щелкните и приблизительно обведите 

прямоугольник вокруг фрагмента, который должен 
быть отображен в образце ткани. 

 
 Совет: Увеличьте масштаб изображения, чтобы 

было легче выбрать мелкий фрагмент. Подробнее 
см. в разделе Изменение масштаба изображения 
образцов ткани. 

4 В поля Tile Height (Высота фрагмента) и Tile 
Width (Ширина фрагмента).введите размеры. 

 Измерения начинаются от верхнего левого угла предварительно очерченного прямоугольника. 
 
Введите размеры 

 
5 Нажмите кнопку Save As (Сохранить как), чтобы сохранить образец и оставить без изменений 

оригинальный образец.  
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Изменение размеров элементов мозаики инструментом Nudge 
 
Используйте инструмент Nudge (диалоговое окно Tile Fabric) для изменения размера образца ткани 
шагами по одному пикселю. 

 
Если вам нужно изменять размеры кадрирующего прямоугольника шагами по одному пикселю, 
используйте инструмент Nudge (Перемещение с заданным шагом). Используйте этот метод, если нужно 
обрезать или расширить элементы мозаики на небольшую величину. 
 
Как изменять размеры элементов мозаики инструментом Nudge 
1 Выберите и дважды щелкните по узору в библиотеке. 
 Откроется диалоговое окно Tile Fabric. 
2 Щелкните по кнопке Select (Выбрать). 
3 Щелкните и обведите прямоугольник вокруг фрагмента, который должен быть использован в качестве 

элемента мозаики в образце ткани. 
 
 Совет: Увеличьте масштаб изображения, чтобы было легче выбрать мелкий фрагмент. Подробнее см. 

в разделе Изменение масштаба изображения образцов ткани. 
4 Выберите инструмент Move/Edit Select  

Выбран инструмент Move/Edit Selection  

  
Фрагмент, который должен быть удален 

 
5 Установите указатель мыши вблизи одной из сторон кадрирующего прямоугольника. 

◄ Поместите указатель мыши снаружи прямоугольника, чтобы увеличить размер элемента мозаики. 
◄ Поместите указатель мыши внутри прямоугольника, чтобы уменьшить размер элемента мозаики. 

 Указатель мыши приобретет форму стрелки (Nudge). 
 

 
 
 
 
 
 
 
Указатель мыши Nudge 
 
 
 

6 Щелкайте внутри или снаружи контура прямоугольника до тех пор, пока не будут получены требуемые 
размеры. 

 
 Примечание: В полях Tile Height (Высота фрагмента) и 

Tile Width (Ширина фрагмента) проверьте размеры  
 
7 Нажмите Save, чтобы сохранить изменения. 
 
 Примечание: Для сохранения в новом файле и оставить 

без изменений оригинал нажмите кнопку Save As. 
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Управление оригиналами и образцами ткани 
 
Рисунки (растровые изображения) могут быть вставлены или отсканированы в программу BERNINA Quilter 
для использования в качестве оригиналов для оцифровывания или образцов ткани. Ткани могут быть 
одноцветными или узорчатыми. Образцы одноцветных тканей хранятся в Библиотеке цветов Colors 
Library, а узорчатых тканей – в Библиотеке тканей (Fabrics Library). Программа BERNINA Quilter 
предоставляет разные возможности управлять вашими узорчатыми тканями. См. также Сканирование 
оригиналов и тканей. 
 
Создание образцов ткани 

 
Выберите инструмент Tile Fabric (диалоговое окно Edit) для создания собственной ткани. 
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Диалоговое окно Tile Fabric позволяет создавать образцы собственных тканей и сохранять их в вашей 
собственной категории. 
 
Как создать образец ткани 
1 Вставьте или отсканируйте ткань. 
 Подробнее см. в разделе Использование 

изображений. 
 
2 Выберите изображение ткани. 
3 Щелкните по значку Tile Fabric. 
 Откроется диалоговое окно Tile Fabric. 

 
 
4 Щелкните по кнопке Select (Выбрать). 
5 Выберите фрагмент ткани, который будет использован. 
 Подробнее см. в разделе Выбор элементов мозаики 

ткани. 
6 Щелкните по кнопке Save As (Сохранить как). 
 Откроется диалоговое окно Save As. 
 
 
7 Выберите папку из каталога Manage Fabrics или 

щелкните по кнопке Create New Category для создания 
новой папки.  

8 Введите имя нового файла в поле Save As. 
9 Нажмите кнопку Save (Сохранить). 
 
Создание категорий тканей 
Диалоговое окно Manage Fabrics позволяет создавать ваши 
собственные категории тканей для упорядочивания и 
классификации ваших узорчатых тканей.  
 
Как создать категорию ткани 
1 Выберите File > Manage Fabrics. 
 Откроется диалоговое окно Manage Fabrics (Управление 

тканями). 
2 Отыщите требуемое вам местоположение. 
3 Щелкните правой кнопкой мыши и выберите New 
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Category (Новая категория) из всплывающего списка.  
 Совет: Вы можете также создавать новые категории, используя инструмент Create New Categories. 
 Будет создана папка New Category. 
 

  
 
4 Введите имя для новой папки. 
5 Дважды щелкните по новой папке, чтобы она открылась. 
6 Введите имя нового файла в поле Save As. 
7 Нажмите кнопку Save. 
 Новый образец ткани будет сохранен в новой категории/папкею 
 
Удаление тканей и категорий 
 
Используйте команду Manage Fabrics (меню File) для удаления тканей или категорий. 
 
Диалоговое окно Manage Fabrics позволяет удалять категории ткани, если в них нет больше 
необходимости.  
 
Как удалять ткани или категории 
1 Выберите File > Manage Fabrics. 
 Откроется диалоговое окно Manage Fabrics (Управление тканями). 

 
 
2 Выберите образец или категорию, щелкните правой кнопкой мыши и выберите Delete или Delete 

Category из всплывающего меню.  
 Появится сообщение о подтверждении. 
3 Нажмите Yes. 
 
 Совет: Выберите подлежащий удалению файл и нажмите клавишу Delete. 
 
Перемещение тканей в другие категории 
 
Используйте команду Manage Fabrics (меню File) для перемещения тканей в другие категории. 
 
Диалоговое окно Manage Fabrics позволяет перемещать ваши узорчатые ткани в другие категории.  
 
Как переместить ткань в другую категорию 
1 Выберите File > Manage Fabrics. 
 Откроется диалоговое окно Manage Fabrics (Управление тканями). 
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2 Выберите образец ткани для перемещения. 
3 Перетащите мышью образец ткани в новую папку в 

левой части окна. 
 Появится окно Move. 
 
 
Импортирование тканей 
 
Используйте команду Manage Fabrics (меню File) для импортирования тканей. 
 
Диалоговое окно Manage Fabrics позволяет импортировать файл, содержащий несколько тканей, из числа 
поставляемых фирмой Bernina. Новые файлы формата FLB могут быть загружены с Интернета.  
 
Как импортировать ткань 
1 Выберите команду File > Manage Fabrics. 
 Откроется диалоговое окно Manage Fabrics. 
 
 
2 Щелкните по кнопке Import. 
 Откроется диалоговое окно Import. 
 
 
 
 

 
 
3 Перейдите в каталог с файлом FLB. 
4 Выберите файл FLB для импорта. 
5 Щелкните по кнопке Import. 
 Выбранные файлы будут добавлены в библиотеку. 
 

Управление блоками пэчворка 
 
Блоки пэчворка хранятся в файлах формата BLB библиотеки блоков. Вы можете создавать новые 
категории блоков, удалять их и перемещать блоки между категориями. 
 
Создание категорий блоков 
 
Используйте команду Manage Blocks (меню File) для создания новых категорий блоков пэчворка. 
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Диалоговое окно Manage Blocks позволяет создавать ваши собственные блоки пэчворка для 
упорядочивания и классификации ваших блоков пэчворка.  
 
Как создать категорию блока 
1 Выберите команду File > Manage Blocks. 
 Откроется диалоговое окно Manage Blocks. 

 
 
2 Отыщите требуемое вам местоположение. 
3 Щелкните правой кнопкой мыши и выберите New 

Category (Новая категория) из всплывающего 
списка.  

 
 Совет: Вы можете также создавать новые 

категории, используя инструмент Create New 
Categories. 

 Будет создана папка New Category. 
 
 
4 Введите имя для новой папки. 
 
Удаление категорий блока 
 
Используйте команду Manage Blocks (меню File) для перемещения блоков пэчворка в другие категории. 
 
Диалоговое окно Manage Blocks позволяет удалять категории блоков, если в них нет больше 
необходимости.  
 
Как удалить категорию блока 
1 Выберите команду File > Manage Blocks. 
 Откроется диалоговое окно Manage Blocks. 

 
 
 
2 Выберите образец или категорию, щелкните правой кнопкой мыши и выберите Delete или Delete 

Category из всплывающего меню.  
 Появится сообщение о подтверждении. 
3 Нажмите Yes. 
 
Перемещение блоков в другие категории 
 
Используйте команду Manage Blocks (меню File) для перемещения блоков пэчворка в другие категории. 
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Диалоговое окно Manage Blocks позволяет перемещать ваши блоки пэчворка в другие категории.  
 
Как переместить блок в другую категорию 
1 Выберите команду File > Manage Blocks. 
 Откроется диалоговое окно Manage Blocks. 
2 Выберите блок пэчворка для перемещения. 

 
 
 
3 Перетащите мышью блок пэчворка в новую папку в левой части окна. 
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Часть А 
Краткое руководство по 
программе BERNINA artista  
В этом Кратком руководстве рассматриваются все опции меню и панелей инструментов, 
имеющихся в BERNINA artista. Не все инструменты активны во всех уровнях продукта. 
 
 
Окно проекта BERNINA artista  
 

Строка заголовка 
Строка  меню 

Общая панель инструментов  
Кнопки переключения  

режимов 
 

Панель рукодельных  
стежков (Craft Stitch) 

 
Панель рисунка/проекта  
(изменяется при выборе 

режима) 
  

 
 
 
 
 
 
 
 
 
 
 
 

Панель размещения 
Панель стежков и палитры  

цветов (Stitch and Color) 
Строка состояния 

 
Строка меню BERNINA artista  
Строка меню окна проекта BERNINA artista содержит описываемые ниже выпадающие меню. 
Не все команды активны во всех уровнях продукта. Некоторые из команд действуют также от кнопок панелей 
инструментов. 
 
Примечание: Стандартная клавиша Alt системы Windows применяется в клавиатурных командах. 
Используйте клавишу Alt с клавишей подчеркнутой в меню буквы. Для отмены операции дважды нажмите 
клавишу Esc. 
 
Меню File (Файл) 
New  Открыть новый пустой проект. 
Open  Открыть существующий проект. 
Close  Закрыть окно текущего проекта. 
Portfolio  Запустить программу BERNINA artista Portfolio и выбрать проект. 
Cross Stitch  Запустить программу Cross Stitch. 
Quilter  Запустить программу Quilter. 
Insert Design  Вставить существующий проект. 
Save  Сохранить существующий проект. 
Save As  Сохранить текущий проект с новым именем, в другом местоположении или формате. 
Design 
Properties  

Добавить комментарии о проекте для печати. 
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Print  Печать проекта. 
Print Preview  Предварительный просмотр проекта перед печатью. Распечатка проекта из этого 

окна. 
Card 
/Machine 
Read  

Считать (открыть) проект с карты памяти BERNINA artista Design Card или из памяти 
домашней вышивальной машины BERNINA. 

Card / 
Machine Write  

Передать (сохранить) проект на карту памяти BERNINA artista Design Card или в 
память домашней вышивальной машины BERNINA. 

Write to Magic 
Box  

Передать (сохранить) проект на карту памяти Design Card в приборе Magic Box. 

Read from 
Magic Box  

Считать (открыть) проект с карты памяти Design Card в приборе Magic Box. 

 
Меню File (Файл) 
Recent File 
List  

Список использовавшихся в последнее время файлов. Эта команда используется 
для открытия файла. 

Exit  Закрыть все открытые проекты и выйти из программы BERNINA artista. 
 
Меню Edit (Редактирование) 
Undo  Отменить последнюю команду. 
Redo  Повторить выполнение отмененной команды. 
Cut  Удалить выделенный фрагмент и поместить его в буфер обмена. 
Copy  Скопировать выделенный фрагмент в буфер обмена. 
Paste  Вставить содержимое буфера обмена в окно проекта. 
Duplicate  Дублировать выделенный фрагмент и поместить его в текущий выделенный 

фрагмент. 
Delete  Удалить выделенный фрагмент без помещения в буфер обмена. 
Select All  Выделить все объекты в проекте. 
Deselect All  Отменить выделение всех выделенных объектов проекта. 
Stitch Edit  Переместить вставленную точку в выбранную точку проекта. 
Lettering  Изменить настройки текста. 

Отобразить маркеры для изменения форм текста. Включая: 
None: удалить эффект "гибкого текста" (Elastic Lettering) 
Straight: создать прямолинейные формы 

Elastic 
Lettering  

Curved: создать криволинейные формы 
Touch Up 
Picture  

Открытие сторонней графической программы для редактирования рисунка. 

Crop Image  Кадрирование рисунка для использования в программе PhotoSnap. 
 
Меню View (Вид) 
By Color  Показать только выбранные цвета в проекте. 
Needle Points  Показать или скрыть точки укола иглой. 
Picture  Показать или скрыть фоновый рисунок. 
Show 1:1  Показать проект в натуральную величину. 
Show All  Показать проект целиком. 
Zoom Out 2X  Увеличить изображение проекта в 2 раза. 
Zoom Box  Увеличить выделенный фрагмент до размеров окна. 
Redraw  Перерисовать проект. 
Slow Redraw  Медленно перерисовать проект для прослеживания последовательности вышивания. 
Hoop  Показать или скрыть пяльцы и установить размеры и положение пялец. 
Grid  Показать или скрыть сетку и установить размеры и интервал сетки. 
Measure  Измерить размеры проекта. 
 
Меню Arrange (Расположение) 
Start and End  Установить начальную и конечную точки проекта. 
Sequence as 
Selected  

Установить последовательность вышивания для выделенных объектов в порядке их 
выделения. 

Sequence to 
Start  

Поместить выделенный объект в начало последовательности вышивания. 

Sequence to 
End  

Поместить выделенный объект в конец последовательности вышивания. 

Sequence by 
Color  

Установить последовательность вышивания в порядке выбираемого цвета. 

Color Film  Открытие диалогового окна Color Film. 
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Меню Arrange (Расположение) 
Mirror 
Horizontal  

Перевернуть выбранный объект/ы на горизонтальной оси относительно центра.  

Mirror Vertical  Перевернуть выбранный объект/ы на вертикальной оси относительно центра.  
Group  Сгруппировать выбранные объекты в один объект. 
Ungroup  Разделить сгруппированный объект на отдельные объекты. 
Remove 
Overlay 
Stitching  

Удалить стежки, когда две формы накладываются друг на друга (оставляется 
отверстие) 

Include 
Overlay 
Stitching  

Восстановить удаленные перекрывающие стежки. 

Lettering 
Remove 
Overlay  

Удалить стежки, когда текст накладывается на объект (оставляется отверстие) 

Add Holes  Удалить стежки из формы (отставляется отверстие). 
Add 
Buttonhole  

Добавить пуговичную петлю к проекту. 

Merge 
Buttonhole  

Соединить пуговичную петлю с проектом (оставляется отверстие). 

 
Меню Settings (Настройки) 
Thread Colors  Назначить цвета ниток для использования в проекте. 
Fabric 
Settings  

Выбрать типы тканей и настроек. 

Fabric Display  Выбрать ткани фона и цвета. 
Object 
Properties  

Выбрать свойства для выбранных форм. 

Options  Выбрать настройки для отображения окна. 
 
Меню Settings (Настройки) 
Security   Ввести коды при обновлении или добавлении опциональных функций. 
Display Setup  Калибровать экран. 
Scanner 
Setup  

Установить опции сканера. 

Create 
Pattern  

Создать узоры и присвоить им имя. 

 
Меню Help (Справка) 
Help Topics  Список тем онлайновой справки. 
Online 
Manual  

Открытие Руководства пользователя в формате Adobe Acrobat PDF. 

About  Информация о версии программы BERNINA artista. 
Show Design 
Warning  

Вывод на экран предупреждения при открытии проекта, размеры которого не должны 
изменяться. 

BERNINA 
International 
Home Page  

Открытие сайта BERNINA International. 

BERNINA of 
America 
Home Page  

Открытие сайта BERNINA of America. 

Embroidery 
Online  

Открытие сайта Embroidery Online. 

Access Code 
Order Form  

Открытие онлайнового бланка заказа кода доступа. 

 
Кнопки переключения режимов 
В окне BERNINA artista имеются три кнопки переключения режимов. 
В разных режимах отображаются разные панели инструментов. В режиме Artistic View (Художественный 
Просмотр) панели инструментов не предусмотрены. 
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Панели инструментов рабочего окна BERNINA artista 
 
Кнопки переключения режимов 

 
Загрузка, редактирование и сохранение рисунка в качестве фона проекта вышивки. Формы 
вышивки не показываются. 
 
 
 
Создание и редактирование проектов вышивки. Показываются формы вышивки, а также рисунки. 
 
 
 
Показывается, как будет выглядеть вышивка после вышивания. 
 
Окно содержит описанные ниже панели инструментов. Не все инструменты активны во всех  

                           уровнях продукта. Некоторые являются инструментами быстрого вызова команд выпадающих  
                           меню. 
 
General toolbar 

New  
 

То же, что File > New 

Open  
 

То же, что File > Open 

Save  
 
 

То же, что File > Save 

Print  Печать проекта с использованием текущих настроек принтера. 
 
Print 
Preview  

То же, что File > Print Preview  

Write to 
Machine  

То же, что File > Card / Machine Write 

 Read from 
Magic Box  

Считывание проектов с карт памяти с использованием прибора Magic Box. 

 
Общая панель инструментов (General) 

Write to 
Magic Box  

Сохранение проектов на картах памяти с использованием прибора Magic Box. 

Cut  То же, что Edit > Cut 
 
Copy  

 
То же, что Edit > Copy 

 
Paste  

 
То же, что Edit > Paste 

 
Undo  

 
То же, что Edit > Undo 

 
 
Redo  

 
 
То же, что Edit > Redo 

 
Show Grid  
 

 
То же, что View > Grid 

Show Hoop  
 

То же, что View > Hoop Show 

Picture  То же, что View > Picture 
Object 
Properties 

То же, что Settings > Object Properties 

Auto 
Underlay  

Добавление автоматической стабилизации ткани. 

Textured 
Edge  
 

Добавление текстурированного края к объекту. 

Color Film  
 

То же, что Arrange > Color Film 

Zoom Box  
 

То же, что View > Zoom Box 
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Write to 
Magic Box  

Сохранение проектов на картах памяти с использованием прибора Magic Box. 

Cut  То же, что Edit > Cut 
 
Copy  

 
То же, что Edit > Copy 

 
Paste  

 
То же, что Edit > Paste 

 
Undo  

 
То же, что Edit > Undo 

 
 
Redo  

 
 
То же, что Edit > Redo 

 
Show Grid  
 

 
То же, что View > Grid 

Show Hoop  
 

То же, что View > Hoop Show 

Picture  То же, что View > Picture 
Object 
Properties 

То же, что Settings > Object Properties 

Auto 
Underlay  

Добавление автоматической стабилизации ткани. 

Textured 
Edge  
 

Добавление текстурированного края к объекту. 

Color Film  
 

То же, что Arrange > Color Film 

Zoom Box  
 

То же, что View > Zoom Box 

 
Zoom Out 
2X  

То же, что View > Zoom Out 2X 

 
Общая панель инструментов (General) 

Show All  
 

То же, что View > Show All 

 Show 1:1  То же, что View > Show 1:1 
 
Панель инструментов Рисунок (Picture) 

Select 
Object  

Выбор рисунков в окне проекта. 

Reshape 
Cropping 
Outline  

Изменение формы контура кадра. 

Load Picture 
  

Вставка рисунка в окно проекта. 

Touch Up 
Picture  
 

То же, что Edit > Touch Up Picture 

Scan Picture  
 

Сканирование рисунка в BERNINA artista. 

Dim Picture Сделать блеклым или ярким рисунок, чтобы стежки были показаны более четко в 
режиме Design. 

Save Picture 
  

Сохранение рисунка после редактирования. 

PhotoSnap 
  

Перевод черно-белой или цветной фотографии в проект вышивки. 

Artwork 
Preparation  

Снижение цветности в любом рисунке. 

 

Outlined 
Artwork 
Preparation  

Повышение четкости контуров и сокращение цветности в оконтуренном рисунке. 
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Панель инструментов Проект (Design) 
Select 
Object  
 

Выбор объекта вышивания для изменения размеров, перемещения, перевода в 
зеркальное отображение или вращения. 

Polygon 
Select  

Выбор неправильных по форме фрагментов. 

Reshape 
Object  
 

Изменение формы выбранных объектов вышивки и текста. 

Lettering / 
Values  

Создание текста и изменение свойств текстовых объектов. 

Lettering 
Remove 
Overlay  

То же, что Arrange > Lettering Remove Overlay 

Mirror 
Horizontal 
  

То же, что Arrange > Mirror Horizontal 

Mirror 
Vertical  

То же, что Arrange > Mirror Vertical 

Rotate 
45°CCW / 
CW  
 

Вращение выбранных объектов шагами по 45°. Щелчок левой кнопкой мыши – 
поворот против часовой стрелки. Щелчок правой кнопкой – поворот по часовой 
стрелке. 

Scale by 
20% Down / 
Up  
 

Изменение выбранного объекта шагами по 20%. Щелчок левой кнопкой – 
уменьшение объекта/ов. Щелчок правой кнопкой – увеличение объекта/ов 

Color 
Blending  
 

Оцифровывание объектов со смешиванием цветов. 

Double Run  
 
 

Повторение стежков в выбранных объектах. 

Quilter 
  

То же, что File > Quilter 

Auto 
Digitizer  
 

Автоматическое оцифровывание подготовленного рисунка. 

 Magic Wand  Оцифровывание простых форм проекта. 
 
Панель инструментов Проект (Design) 

Open Curve 
  

Рисование и оцифровывание открытых форм. 

Closed 
Curve  

Рисование и оцифровывание закрытых форм. 

Add Holes  Вырезание отверстий в объектах. 
Block 
Digitizing  
 
 

Оцифровывание колонок с изменяющимся направлением стежков. 

Circle / Oval  Рисование и оцифровывание овалов или окружностей. 
 
Rectangle  

Рисование и оцифровывание прямоугольников или квадратов. 

Auto 
Appliqué  

Рисование и вышивание форм аппликаций. 

 
Partial 
Appliqué  

Рисование и вышивание частичных форм аппликаций. 

 
Cross Stitch  То же, что File > Cross Stitch. 
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Панель рукодельных стежков (Craft Stitch) 
Blackwork 
Border  
 

Оцифровывание строчки стежков в технике Blackwork. 

Blackwork Run  
 

Автоматическая последовательность строчки стежков. 

Stemstitch  Оцифровывание строчки стебельчатых стежков. 
Candlewicking 
Border 
  

Оцифровывание строчки стежков в технике Candlewicking. 

Stipple 
 
  

Оцифровывание пунктирной строчки. 

 Blackwork Fill  Оцифровывание заполнения в технике Blackwork. 
 
Панель рукодельных стежков (Craft Stitch) 

Lacework  
 
 

Оцифровывание заполнения кружевным переплетением. 

Backstitch 
  

Оцифровывание строчки стежков "назад в иголку". 

Candlewicking 
Fill  

Оцифровывание заполнения в технике Candlewicking. 

 
Панель инструментов Стежок и Цвет (Stitch and Color)  

Outline  
 
 
 

Выбор оконтуривающего стежка для новых и выделенных объектов. 

Outline Type 
  

Просмотр типов оконтуривающего стежка для выбора. 

Fill  
 
 

Выбор заполняющего стежка для новых и выделенных объектов. 

Fill Type  
 
 

Просмотр типов заполняющего стежка для выбора. 

Stitch Angles / 
Values 
 

Установка углов наклона стежка для выбранных объектов. 

Color list  
 
 
 

Список имеющихся цветных ниток. 

Width and height 
dimensions  
 
 

Показ размеров выбранных объектов. 

 

ART Grade  Показ степени (grade) файла формата ART. 
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Панель инструментов Размещение (Arrange) 

Group  
 
 

То же, что Arrange > Group. 

Ungroup  
 

То же, что Arrange > Ungroup. 

Align Left 
(Vertical)  

Выравнивание по левому краю выбранных объектов. 

Align Centers 
(Vertical)  

Выравнивание средних линии выбранных объектов по вертикали. 

Align Right 
(Vertical)  

Выравнивание по правому краю выбранных объектов. 

Align Top 
(Horizontal)  

Выравнивание верхних сторон выбранных объектов. 

Align Centers 
(Horizontal)  
 

Выравнивание средних линии выбранных объектов по горизонтали. 

Align Bottom 
(Horizontal)  

Выравнивание нижних сторон выбранных объектов. 

Align Centers  
 

Выравнивание средних точек выбранных объектов по центру проекта. 

Mirror- Merge 
Horizontal  

Зеркальное дублирование по горизонтали. 

Mirror- Merge 
Vertical  
 

Зеркальное дублирование по вертикали. 

Mirror- Merge 
Horizontal & 
Vertical  

Зеркальное дублирование по горизонтали и вертикали. 

Wreath  Дублирование объектов вокруг центра. 

 

 
Kaleidoscope  

 
Зеркальное дублирование объектов вокруг средней оси. 
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Часть B 
Краткое руководство по 
программе BERNINA artista Cross 
Stitch  
 
В этом Кратком руководстве рассматриваются все опции меню и панелей инструментов, 
имеющихся в BERNINA artista Cross Stitch. 
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Рабочее окно программы BERNINA artista Cross Stitch  
 

Строка заголовка 
Строка  меню 
Общая панель  
инструментов  

Кнопки 
переключения  

режимов 
 

  
Панель 

рисунка/проекта  
(изменяется при 

выборе  
режима) 

 
 
 
 
 
 
 
 
 
 
 
 

Панель 
инструментов  
Стежок и Цвет 

(Stitch and Color)  
Строка состояния 

 
 

 
Строка меню окна программы BERNINA artista Cross Stitch  
 
Строка меню рабочего окна программы Cross Stitch содержит описываемые ниже выпадающие меню. 
Некоторые команды действуют также от кнопок панелей инструментов. 
 
Примечание: Стандартная клавиша Alt системы Windows применяется в клавиатурных командах. 
Используйте клавишу Alt с клавишей подчеркнутой в меню буквы. Для отмены операции дважды нажмите 
клавишу Esc. 
 
Меню File (Файл) 
New  Открыть новый пустой проект. 
Open  Открыть существующий проект. 
Close  Закрыть окно текущего проекта. 
Save  Сохранить существующий проект. 
Save As  Сохранить текущий проект с новым именем, в другом местоположении или формате. 
Design 
Properties  

Добавить комментарии о проекте для печати. 

Recent File 
List  

Список использовавшихся в последнее время файлов. Эта команда используется для открытия 
файла. 

Exit  Закрыть все открытые проекты и выйти из программы BERNINA artista Cross Stitch. 
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Меню Edit (Редактирование) 
Undo  Отменить последнюю команду. 
Redo  Повторить выполнение отмененной команды. 
Cut  Удалить выделенный фрагмент и поместить его в буфер обмена. 
Copy  Скопировать выделенный фрагмент в буфер обмена. 
Paste  Вставить содержимое буфера обмена в окно проекта. 
 
Меню Edit (Редактирование) 
Duplicate  Дублировать выделенный фрагмент и поместить его в текущий выделенный фрагмент. 
Delete  Удалить выделенный фрагмент без помещения в буфер обмена. 
Select All  Выделить все объекты в проекте. 
Deselect All  Отменить выделение всех выделенных объектов проекта.  
Insert  Вставить стежок неполного креста в клетку с уже имеющимися стежками неполного креста при 

условии, что они не перекрывают друг друга. 
Outlines  Заблокировать или разблокировать оконтуривающие стежки для редактирования. 
Crosses  Заблокировать или разблокировать стежки для вышивки крестом для редактирования. 
 
Меню View (Вид) 
By Color  Показать только выбранные цвета в проекте. 
Show 1:1 Показать проект в натуральную величину. 
Show All  Показать проект целиком. 
Zoom Out 2X  Увеличить изображение проекта в 2 раза. 
Zoom Box  Увеличить выделенный фрагмент до размеров окна. 
Redraw  Перерисовать проект. 
Grid  Показать или скрыть сетку и установить размеры и интервал сетки. 
Crosses  Показать стежки в виде цветных "плиток" или крестообразных стежков. 
Picture  Показать или скрыть фоновый рисунок. 
Hoop  Показать или скрыть пяльцы и установить размеры и положение пялец. 
Measure  Измерить размеры проекта. 
 
Меню Arrange (Расположение) 
Center Design  Перемесить проект в центр пялец. 
Mirror 
Horizontal 

Перевернуть выбранный объект/ы на горизонтальной оси относительно центра.  

Mirror Vertical  Перевернуть выбранный объект/ы на вертикальной оси относительно центра.  
 
Меню Settings (Настройки) 
Thread Colors  Назначить цвета ниток для использования в проекте. 
Fabric Count  Установить число стежков на дюйм или миллиметр. 
Fabric Display  Выбрать ткани фона и цвета. 
Options  Выбрать настройки для отображения окна. 
Display Setup  Калибровать экран. 
Scanner 
Setup  

Установить опции сканера. 

 
Меню Help (Справка) 
Help Topics  Список тем онлайновой справки. 
Online 
Manual  

Открытие Руководства пользователя в формате Adobe Acrobat PDF. 

 
Кнопки переключения программы Cross Stitch  
В окне программы Cross Stitch имеются две кнопки переключения режимов. В разных режимах 
отображаются разные панели инструментов. 
 
Панели инструментов программы Cross Stitch  
 
Кнопки переключения режимов 

 
Загрузка, редактирование и сохранение рисунка в качестве фона проекта вышивки. Формы 
вышивки не показываются. 
 
Создание и редактирование проектов вышивки. Показываются формы вышивки, а также 
рисунки. 

 
 
Окно программы Cross Stitch содержит описанные ниже панели инструментов. Некоторые являются 
инструментами быстрого вызова команд выпадающих меню. 
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Общая панель инструментов (General) 
New 
 
  

То же, что File > New 

Open  
 

То же, что File > Open 

Save  
 

То же, что File > Save 

Cut  
 

То же, что Edit > Cut 

Copy  
 

То же, что Edit > Copy 

Paste  
 

То же, что Edit > Paste 

Undo  
 
 

То же, что Edit > Undo 

Redo  
 

То же, что Edit > Redo 

Grid  
 

То же, что View > Grid 

 
Hoop  То же, что View > Hoop 

 
Общая панель инструментов (General) 

Picture  
 

То же, что View > Picture 

Crosses  
 
 

То же, что View > Crosses 

Zoom Box  То же, что View > Zoom Box 
Zoom Out 
2X  
 

То же, что View > Zoom Out 2X 

Show All  
 

То же, что View > Show All 

 
Show 1:1 То же, что View > Show 1:1 

 
Панель инструментов Рисунок (Picture) 

Select 
Picture  
 

Выбор рисунков в окне проекта. 

Load Picture  
 

Вставка рисунка в окно проекта. 

Scan Picture  
 

Сканирование рисунка в BERNINA artista. 

Dim Picture  
 
 

Сделать блеклым или ярким рисунок, чтобы стежки были показаны более четко в режиме 
Design. 

Save Picture  Сохранение рисунка после редактирования. 

 
Панель инструментов Проект (Design) 

Select 
Object  
 

Выбор одиночного стежка или блока стежков. 

Polygon 
Select  

Выбор неправильных по форме фрагментов. 

 
Lettering / 
Values  

Создание текста и изменение свойств текстовых объектов. 
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Панель инструментов Проект (Design) 

Mirror 
Horizontal  

То же, что Arrange > Mirror Horizontal  

Mirror 
Vertical  

То же, что Arrange > Mirror Vertical 

Rotate 
90°CCW / 
CW  
 

Вращение выбранных объектов шагами по 90°. Щелчок левой кнопкой мыши – поворот 
против часовой стрелки. Щелчок правой кнопкой – поворот по часовой стрелке. 

Magic Wand  
 

Оцифровывание простых форм проекта. 

Open Curve  
 

Рисование и оцифровывание открытых форм. 

Closed 
Curve  

Рисование и оцифровывание закрытых форм. 

Circle / Oval  Рисование и оцифровывание овалов или окружностей. 
Rectangle  
 
 

Рисование и оцифровывание прямоугольников или квадратов. 

Auto Select  
 

Выбор одиночного цветового блока или не оцифрованного фрагмента. 

Pencil  
 

Рисование одиночного стежка или линии стежков. 

Eraser  
 

Стирание стежков для вышивки крестом. 

AutoStitch  Автоматическое оцифровывание рисунка. (Этот процесс отличается от аналогичной 
функции BERNINA artista тем, что пиксели конвертируются в стежки для вышивки 
крестом. 

Area Fill  
 

Заполнение замкнутых форм стежками. 

 
Rubber 
Stamp  

Клонирование выделенного элемента для использования в качестве "резинового 
штампа". 

 
Панель инструментов Стежок и Цвет (Stitch and Color)  

Outline 
  

Выбор контура, выполненного стежками для вышивки крестом. 

Fill  
 

Выбор заполнения, выполненного стежками для вышивки крестом.  

Cross Stitch 
Type  
 
 

Выбор типа стежка для вышивки крестом.  

Threads  
 

Установка плотности стежков для вышивки крестом. 

 
Color list  Список имеющихся цветных ниток. 
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Часть C 
Краткое руководство по 
программе BERNINA artista 
Portfolio  
 
В этом Кратком руководстве рассматриваются все опции меню и панелей инструментов, 
имеющихся в программе BERNINA artista Portfolio. 
 
Рабочее окно BERNINA artista Portfolio  

 
Строка заголовка 

Строка  меню 
Общая панель  
инструментов 

Тип айлов 
Просматриваемые  

каталоги 
 
 
 

Дерево каталогов 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Строка состояния 
 

 
Строка меню программы Portfolio  
Строка меню рабочего окна программы Portfolio содержит описываемые ниже выпадающие меню. 
Некоторые команды действуют также от кнопок панелей инструментов. 
Подчеркнутые буквы в названиях опций меню дают возможность выбирать эти опции без использования 
мыши путем нажатия клавиши Alt и клавиши, соответствующей подчеркнутой букве.  Для отмены 
операции нажмите клавишу Esc. 
 
Меню File (Файл) 
New  Открыть новый шаблон в BERNINA artista. 
Open with 
BERNINA 
artista 

Открыть проект с BERNINA artista. 

Open  Открыть проект в BERNINA artista или рисунок в графической программе. 
Print Designs  Печать проектов в виде свернутого в пиктограмму изображения с описанием или без 

описания. 
Publish 
Designs  

Вывести каталог проектов в виде HTML-файла, пригодного для публикации на Web-сайте. 

Export 
Designs 

Вывести информацию о проекте в виде текстового файла для импорта в базу данных или 
электронную таблицу. 

Create Zip 
Archive  

Вывести информацию о проекте в виде сжатого файла, пригодного для пересылки по 
электронной почте или сохранения на диске. 

Extract Zip Извлечь информацию о проекте из сжатого файла, полученного по электронной почте или 
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Archive сохраняемого на диске. 
Print . Отпечатать выбранные проекты. 
Write to 
Card/Machine 

Записать выбранные проекты на карту памяти Bernina. 

Convert  Конвертировать проекты в выбранные форматы. 
Properties  Открыть диалоговое окно Properties (Свойства) выбранного проекта. 
Exit  Закрыть все открытые проекты и выйти из программы Portfolio . 
 
Меню Edit (Редактирование) 
Cut  Удалить выбранные файлы и поместить их в буфер обмена. 
Copy  Скопировать выделенные файлы в буфер обмена. 
Paste  Вставить содержимое буфера обмена в папку. 
Delete  Удалить выбранные файлы без помещения в буфер обмена. 
Select All  Выделить все проекты в папке. 
Deselect All  Отменить выделение всех проектов в папке. 
 
Меню View (Вид) 
Thumbnails  Показать файлы в папке в виде свернутых в пиктограммы изображений. 
Thumbnails 
and Summary  

Показать пиктограммы и общую информацию о файлах в папке. 

Details  Показать подробности, такие как имя файла, размер, тип файла и дата сохранения. 
Sort  Выбрать вид сортировки проектов. 
Sort by Name  Сортировать проекты по имени. * 
Sort by Type  Сортировать проекты по типу файла. * 
Sort by Size  Сортировать проекты по размеру. * 
Sort by Date  Сортировать проекты по дате создания. * 
Refresh   Обновить экран. 
Refresh Tree 
Node  

Обновить дерево каталогов. 

Validate and 
Refresh  

Проверить и обновить папки. 

Browse 
Location  

Выбрать папки из дерева каталогов. 

 
* При повторении команды происходит переключение между сортировкой по возрастанию и по убыванию. 
 
Меню View (Вид) 
 
Directory Tree  Показать на полном экране проекты в папках. 
Change 
Locale  

Переключиться на другой установленный рабочий язык. 

User 
Preferences  

Настроить установки по умолчанию. 

 
* При повторении команды происходит переключение между сортировкой по возрастанию и по убыванию. 
 
Общая панель инструментов Portfolio  
Окно программы Portfolio содержит только одну панель инструментов, описываемую ниже. Некоторые 
кнопки являются инструментами быстрого вызова команд выпадающих меню. 
 
Общая панель инструментов (General) 

Open  
 

То же, что File > Open 

Print  То же, что File > Print 
Stitch the 
selected 
designs  

То же, что File > Write to Card/Machine 

Convert the 
selected 
designs  

То же, что File > Convert 

Hide/Show 
Directory Tree   

То же, что View > folder Tree 

Sort the 
current list of 
designs  

То же, что View > Sort 

View just the 
thumbnails  

То же, что View > Thumbnails 

View 
thumbnails and 

То же, что View > Thumbnails and Summary 
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Open  То же, что File > Open 

 

View design 
details in a list  

То же, что View > List 

 
Общая панель инструментов (General) 
 

Create a zip 
archive  

То же, что File > Create Zip Archive 

View design 
properties  

То же, что File > Properties 
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Приложение 

 

Приложение B  
Образцы алфавитов 
 
Образцы алфавитов для вышивания, приводимые в этом приложении, являются составной частью 
вашей программы BERNINA artista. Для получения самых лучших результатов при вышивании не 
выходите за пределы рекомендуемых максимальных и минимальных размеров, указанные для 
шрифта каждого алфавита. Указания по применению вышиваемых алфавитов см. в разделе 
Добавление текста к проектам вышивки. 
Для получения самых лучших результатов всегда проверяйте правильность выбора типа 
стабилизирующих стежков. Для мелких, узких букв стабилизирующие стежки могут не 
потребоваться, в зависимости от размеров букв и вида материала, на которых они будут вышиты. 
Например, шрифт Anniversary представлен очень маленькими символами, их минимальный 
размер при вышивании составляет 5 мм. Если использовать автоматические стабилизирующие 
стежки, то они будут видны на внешней стороне вышитых столбцов. Поэтому режим 
автоматических стабилизирующих стежков должен быть выключен. См. также Отключение 
функции автоматической стабилизации ткани для мелких букв. 
Приведен также шаблон SpecialAlphabet для алфавитов ручной вышивки  — Creative Cross и 
Quilting Text  
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Приложение 

Приложение C  
Образцы заполнения 
простегивающими стежками 
 
Узоры заполнения простегивающими стежками, показанные в этом приложении, включены в вашу 
программу BERNINA artista. (Онлайновое Руководство содержит полный ассортимент узоров 
заполнения простегивающими стежками. Вы можете получить к ним доступ из меню Help (Справка) 
программы BERNINA artista.) Указания об оконтуривании и заполнении узорами и об их 
использовании см. в разделе Создание заполнения простегивающим стежком. 
 
Примечание: Будьте уверены в том, что вы правильно выбрали угол орнаментных заполняющих 
стежков. В приводимых ниже образцах при оцифровывании был принят угол наклона стежков 0°. 
Поэкспериментируйте с разными углами наклона для получения новых эффектов. 
 
№ Образец 

стежка 
Предварительный 
просмотр 
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Приложение 

Приложение D  
Образцы проектов 
 
Образцы проектов, показанные в этом приложении, включены в вашу программу BERNINA artista. 
(Онлайновое Руководство содержит полный ассортимент образцов проектов. Вы можете получить 
к ним доступ из меню Help (Справка) программы BERNINA artista.) Эти проекты (ART-файлы) 
можно найти в папках My Designs, Samples 1 - 4. 
 
Примечание: Программа BERNINA artista Portfolio отображает пиктограммы и ограниченную 
информацию о проекте каждый раз, когда открывается папка с проектами. Вы можете 
отфильтровать содержимого окна отображения, чтобы показывались лишь файлы определенного 
типа. Подробнее см. в разделе Просмотр проектов в папках. 
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Приложение 

Приложение E  
Образцы рисунков 
 
Образцы рисунков, показанные в этом приложении, включены в вашу программу BERNINA artista. 
(Онлайновое Руководство содержит полный ассортимент образцов рисунков. Вы можете получить 
к ним доступ из меню Help (Справка) программы BERNINA artista.) Эти проекты (BMP-файлы) 
можно найти в папках My Designs, Samples 1 - 4 и AutoDigitizing. 
 
Примечание: Программа BERNINA artista Portfolio отображает пиктограммы и ограниченную 
информацию о проекте каждый раз, когда открывается папка с проектами. Вы можете 
отфильтровать содержимого окна отображения, чтобы показывались лишь файлы определенного 
типа. Подробнее см. в разделе Просмотр проектов в папках. 
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Приложение F  
 
 
 

Поддерживаемые форматы 
файлов 
 
В приводимых ниже таблицах показано, как конвертируются различные возможности при изменении типа 
файла. Используйте данные этого раздела при конвертировании проектов в различные форматы или 
оцифровывании в определенный формат, отличный от ART. 
Проекты других форматов, которые могут быть переданы в BERNINA artista, являются проектами, 
основанными на "стежковом" формате. Это означает, что они создавались не методом "объект за 
объектом", а скорее методом "стежок за стежком". 
Когда вы открываете проект другого формата в BERNINA artista, программа считывает данные и 
определяет контуры объекта и свойства объекта, так что вы можете вышивать и модифицировать эти 
проекты таким же образом, как и другие проекты BERNINA artista. 
Вы можете также использовать прибор Magic Box для считывания и передачи проектов в другие форматы. 
Подробнее см. в разделе Magic Box. 
В этом разделе приводятся рекомендации по работе с проектами других форматов и соответствующие 
ограничения. 
 
Примечание: Этот программный продукт BERNINA способен конвертировать проекты в другие "не 
родные" вышивальные форматы, которые в настоящее время находятся в стадии разработки.  
Последующие выпуски других фирменных программных продуктов могут не создавать совместимые 
форматы тех же типов файлов. 
 

Поддерживаемые форматы файлов проектов 
Имеются три типа форматов вышивальных файлов: 
◄ Контурные файлы (Outline files): Контурные, или "сжатые" файлы обычно содержат оцифрованные 

формы и линии, выбранные типы и параметры стежков и эффектов. 
◄ Стежковые файлы (Stitch files): Стежковые, или "расширенные" файлы содержат только стежки и 

функции машины и приспособлены для специфичных вышивальных машин.  
Подробнее см. в разделе Обработка файлов в различных форматах. 

◄ Файлы формата ART:  
См. приводимое ниже описание различных типов ART-файла. 

 
Файлы формата ART 
Имеется четыре степени файлов формата ART, в зависимости от того, как был создан ART-файл, Grade А 
является наилучшим форматом, Grade В более надежен, чем Grade С, но не так хорош, как формат Grade 
А, а Grade D является наименее надежным форматом. 
◄ Grade A: Файл чистого формата ART, созданный программным обеспечением BERNINA artista. 
◄ Grade B: Проекты, считанные с контурного формата, такого как CND, и сохраненные как ART-файлы. 

Вы не можете создавать проекты формата Grade B в BERNINA artista, но если проект конвертирован 
в ART в другом программном обеспечении, BERNINA artista считывает его как проект формата Grade 
B. 

◄ Grade C: Проекты, считанные с файлов стежкового формата и сохраненные как ART-файлы после 
обработки стежков. 

◄ Grade D: Проекты, считанные с файлов стежкового формата и сохраненные как ART-файлы без 
обработки стежков. 
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Когда ART-проект создается путем открытия стежкового файла с обработкой стежков, оригинальные 
стежки сохраняются до их изменения. Вы можете быть уверенными, что проект будет вышит в 
оригинальном виде. Однако, если вы масштабируете проект или что-либо делаете, приводящее к 
пересчету стежков новых контуров, то стежки, рассчитанные по предполагаемым контурам, могут 
значительно отличаться от оригинальных стежков. 
 
 Grade A Grade B Grade C Grade D 

Источник ART не родной 
контурный 
файл, 
сохраненный 
как ART 

EXP- или DST-
файлы, 
сохраненные 
как ART 

EXP- или DST-
файлы, 
сохраненные 
как ART 

Метод 
открытия 

нормальное 
открытие 

нормальное 
открытие 

открытие с 
объектами/ 
контурами 

открытие без 
объектов/ 
контуров 

Содержание контуры и 
стежки 

конвертирован
ные контуры и 
рассчитанные 
стежки 

предполагаемы
е контуры и 
конвертирован
ные стежки 

без контуров, 
но с 
конвертирован
ными стежками

 
 
Поддерживаемые форматы 
BERNINA artista поддерживает следующие форматы: 
 
 
Формат Расширение Считывание Запись 

artista design V1.0 ART ● ● 
artista design V2.0 ART ● ● 
artista design V3.0 ART ● ● 
artista template AMT ● ● 
‡ Только программа 
Cross Stitch  

† Только программа Quilter ! Платная опция 

 
Формат Расширение Считывание Запись 
artista Cross Stitch 
designs 

ARX ● ● ‡ 

artista Quilter  
designs 

ARQ ● ●     † 

Deco Wizard PES, 
Brother, Babylock 

PES ● ● 

Deco Wizard PEC, 
Brother, Babylock 

PEC ● ● 

Husqvarna/Viking HUS ● ● 
Husqvarna/Viking SHV ● ● 
Janome / Elna / 
Kenmore 

SEW ● ● 

Melco EXP ● ● ! 
Pfaff PCS ● ● 
Pfaff PCD ● ● 
Pfaff PCQ ● ● 
Poem, Huskygram, 
Singer EU 

CSD ● ● 

Singer XXX ● ● 
Tajima DST ● ● ! 
‡ Только программа 
Cross Stitch  

† Только программа Quilter ! Платная опция 

Сравнение контурных и стежковых форматов файлов. 
 
В таблице приводится сравнение информации, содержащейся в контурных (сжатых) и стежковых 
(расширенных) файлах. BERNINA artista использует вышивальные файлы формата ART, в которых 
комбинируются достоинства контурных и стежковых файлов. 
 
Включено в файл Стежковые 

файлы ART-файлы  

Свойства объекта нет да 
Данные о стежках нет да 
Типы стежков нет да 
Координаты стежков да да 
Цвет ниток некоторые да 
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Включено в файл Стежковые 

файлы ART-файлы  

Комментарии нет да 
Настройки компенсации стягивания нет да 
Настройки функции Auto spacing  нет да 
Могут быть трансформированы/ 
масштабированы без воздействия на 
плотность стежков 

макс. ±5%  да 

 

Поддерживаемые форматы рисунков и изображений 
 
Художественный оригинал может быть импортирован в BERNINA artista как векторных, так и в растровых 
форматах. См. также Оцифровывание с оригиналом. 
 
Поддерживаемые векторные графические форматы  
BERNINA artista поддерживает следующие векторные графические форматы: 
 
Примечание: Эти форматы конвертируются в растровые изображения при открытии BERNINA artista. 
 
Формат Расширение Считывание Запись 

Расширенный метафайл EMF ●  
Метафайл Windows  WMF ●  

 
 
Поддерживаемые форматы растровых изображений 
BERNINA artista поддерживает следующие форматы растровых изображений: 
 
Формат Расширение Считывание Запись 

Windows Bitmap BMP ● ● 
JPEG File Interchange JPG ● ● 
Portable Network Graphics PNG ● ● 
PC Paintbrush PCX ● ● 
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Приложение G  
 
 
Устранение возможных 
неполадок 
 
Это приложение должно помочь вам при разрешении проблем, 
связанных с BERNINA artista. Здесь рассматриваются процедуры 
проверки ваших системных требований и настроек, возвращения к 
оригинальным параметрам и проверки дисков и присоединений. 
Кроме того, описан порядок протоколирования ошибок и перечислены 
причины появления общих сообщений об ошибок и проблем. 
 

Устранение проблем в BERNINA artista 
 
При возникновении проблемы обратитесь за помощью к следующей справочной документации: 
◄ руководству пользователя по BERNINA artista – выберите Help > Online Manual (или печатной 

версии)  
◄ онлайновой справке BERNINA artista – выберите Help > Help Topics 
◄ онлайновой справке системы Windows – выберите Start > Help 
◄ руководству пользователя по системе Windows  
◄ документации, поставленной вместе с вашими аппаратными средствами. 
 
Получение помощи 
Если вы не можете сами устранить проблему, вам нужно обратиться к вашему дилеру. 
Перед тем, как обращаться за помощью, проверьте, соответствует ли ваш компьютер системным 
требованиям и проведите проверки согласно разделам Сообщения об аппаратном ключе и Общие 
проблемы в этом приложении. 
 

Возврат к заводским настройкам 
 
Если вы произвели изменения в стандартных установках программного обеспечения и вы хотите 
вернуться к заводским настройкам, используйте программу Revert. 
 
Как возвратиться к заводским настройкам 
1 Закройте BERNINA artista. 
2 Нажмите на панели задач Windows кнопку Пуск (Start) и выберите Программы (Programs) > BERNINA 

artista > Revert. 
 Откроется диалоговое окно Revert to Factory Template (Возврат к заводским настройкам).  
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3 Выберите опции, которые вы хотите вернуть к заводским настройкам. 
 

Примечание: Учтите, что возврат к стандартным установкам удалит любые изменения, которые вы 
внесли в настройки стилей, шаблонов и аппаратных средств. Новые настройки стилей, шаблонов и 
аппаратных средств останутся действующими, если они были сохранены отдельно. 

4 Нажмите кнопку ОК. 
Выбранные опции будут возвращены к заводским настройкам. 

 
Примечание: В этом случая сообщение о подтверждении не появляется. 

 

Рекомендуемые характеристики компьютера 
 
Чтобы запустить программу BERNINA artista, Вы должны убедиться в том, что выполнены приводимые 
ниже обязательные системные требования. 
 
Поддерживаемые операционные системы 
◄ BERNINA artista работает в ОС Windows 98SE или более поздней версии. 
◄ Программы Portfolio и BERNINA Quilter требуют IE 6.0 или более поздней версии. 
 
Характеристики компьютера 
Проверьте, соответствует ли Ваш ПК системным требованиям. Проверьте центральный процессор и 
оперативную память, а также свободное пространство на жестком диске. В таблице приведены 
минимальные и рекомендованные системные требования. 
 

Аппаратные средства Минимальные требования Рекомендуется 

Центральный процессор Pentium III (500 МГц) или более 
производительный процессор 

Pentium IV или более производительный 
процессор 

Операционная система Windows 98 Windows 2000 
Подключение к 
Интернету 

 Для доступа к сайту Bernina для регулярной 
информации о программных продуктах и 
обновления 

Браузер IE 6.0 IE 6.x 
Память 128 Мб (больше, если запускается 

несколько приложений) 
236 Мб – 512 Мб для запуска 
многочисленных приложений 

Свободное пространство 
на жестком диске 

1 Гб перед инсталляцией 4 Гб или больше перед инсталляцией 

Графическая карта Поддержка High Color (16-bit) и высокая 
разрешающая способность – по меньшей 
мере 1024 x 768 

Поддержка High Color (16-bit) и высокая 
разрешающая способность – по меньшей 
мере 1024 x 768 

Монитор 15" при разрешении 1024 x 768  17" при разрешении 1024 x 768  
Сканер: Совместимый с Windows  Совместимый с Windows 2000 
Принтер Совместимый с Windows  Совместимый с Windows 2000 
Последовательные 
порты 

Свободный последовательный порт для 
подключения вышивальной машины 

Стандартный порт COM1 (с драйверами 
Win95/98) 

Параллельные порты Порты LPT требуются для аппаратного 
ключа (V3) и для принтера 

Выделенный порт для аппаратного ключа 
(V3)  

Порт USB  Выделенный порт USB Выделенный порт USB 
Мышь Последовательная или PS/2-мышь PS/2- или USB-мышь 
Дисководы для компакт-
дисков и дискет 

Дисковод для компакт-дисков для 
инсталляции ПО 

Дисковод для компакт-дисков для 
инсталляции ПО 

Звуковая карта Не требуется Рекомендуется для воспроизведения 
мультимедийных обучающих продуктов 

 
Проверка характеристик центрального процессора и оперативной памяти 
Проверьте характеристики центрального процессора и оперативной памяти и версию системы Windows, 
чтобы убедиться, что они соответствуют требованиям программного пакета BERNINA artista. Подробнее 
см. в разделе Рекомендуемые характеристики компьютера. 
 
Как проверить характеристики центрального процессора и оперативной памяти 
1 На рабочем столе Windows щелкните правой кнопкой мыши по значку My Computer (Мой компьютер) т 

выберите Properties (Свойства).. 
 Откроется диалоговое окно System Properties (Свойства системы) на закладке General (Общие). 
2 Проверьте версию Windows, тип процессора и объем оперативной памяти. 
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Проверка свободного пространства на жестком диске 
Проверьте, имеется ли на жестком диске свободное пространство, достаточное для эффективной работы 
BERNINA artista. Подробнее см. в разделе Рекомендуемые характеристики компьютера. 
 
Как проверить свободное пространство на жестком диске 
1 Щелкните дважды на значку My Computer на рабочем столе Windows. 
 Откроется диалоговое окно My Computer. 
2 Щелкните правой кнопкой мыши по значку жесткого диска (обычно это диск C:) и выберите Properties. 
 Откроется диалоговое окно Properties (Свойства) на закладке General (Общие). 
 На этой закладке указывается общий объем жесткого диска и его свободное пространство. Оно должно 

быть больше 100 Мб или 10 % общего объема жесткого диска, при этом нужно принимать в расчет 
большее значение. 

 

Восстановление файлов после сбоев аппаратных средств или 
программного обеспечения 
 
После сбоев программного обеспечения или аппаратных средств обычно создаются файлы 
восстановления. При перезапуске BERNINA artista после такого сбоя проект, над которым вы работали 
автоматически открывается или, если включена функция автосохранения, открывается резервная копия 
файла. Если открывается резервная копия, то файл следует сохранить с новым именем с расширением 
ART. 
 
Примечание: Не сохраняйте копию в папке Backup, в противном случае она будет удалена. 
 
Как только файл восстановления будет сохранен и переименован с расширением .ART, сотрите из памяти 
файлы восстановления. 
 
Как восстанавливать файлы после сбоев аппаратных средств или программного 
обеспечения 
1 Запустите программу Windows Explorer (Проводник Windows). 
2 Откройте папку Artista. 
3 Откройте папку Backup. 

 
4 Выберите BAK-файл и щелкните по нему правой кнопкой мыши. 
5 Выберите Rename (Переименовать) из всплывающего меню.  
6 Замените расширение BAK на ART. 
7  Запустите BERNINA artista. 
8  Откройте новый файл в BERNINA artista. 
9  Командой Save As сохраните файл в другом месте, но не в папке Backup. 
 

Неисправимые ошибки 
 
Проблема Сбой системы с сообщением о неисправимой 

(‘unrecoverable’) ошибке.  
Причина Проект, который вы пытаетесь открыть, испорчен. 
Рекомендация Удалите любые файлы в папке C:\artista\Recover, 

используя служебную программу Purge Recovery, или 
вручную через Windows Explorer, затем перезапустите 
BERNINA artista. Вы можете также удалять файлы через 
Windows Explorer. Подробнее см. в разделе Удаление 
файлов программой Delete Recovery. 
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Удаление файлов программой Delete Recovery 
Вы можете удалять испорченные файлы, пользуясь служебной программой Delete Recovery (Удаление 
файлов восстановления). Эта программа удаляет файлы в папках C:\artista\Recover и C:\artista\Backup.  
Кроме того, необходимо периодически удалять файлы резервных копий, созданные программой Auto Save 
(Автосохранение). 
 
Примечание: Некоторые файлы, такие как MLG- и DMP-файлы, могут со временем накапливаться и 
занимать много места на жестком диске. Вы можете удалять их вручную из Windows Explorer. 
 
Как удалять файлы программой Delete Recovery 
1 Закройте BERNINA artista. 
 BERNINA artista должна быть закрыта перед удалением резервных копий или файлов восстановления, 

в противном случае вы НЕ сможете удалить эти файлы. 
2 Нажмите на панели задач Windows кнопку Пуск (Start) и выберите Программы (Programs) > BERNINA 

artista > Delete Recovery Files. 
 Откроется диалоговое окно Purge Recover and Backup Directories. 
 
3 Выберите Delete Backup Files, если вы хотите удалить резервные файлы. 

    
 
4 Нажмите кнопку ОК. 

Если некоторые файлы не могут быть удалены, то появится соответствующее сообщение. Удалите эти 
файлы из папок C:\artista\Recover и C:\artista\Backup вручную, выбрав их в Проводнике Windows 
(Windows Explorer). 

 
Совет: Если ошибки не будут устранены, попытайтесь вернуться к заводским настройкам. Подробнее 
см. в разделе Возврат к заводским настройкам. 

 

Сообщения об аппаратном ключе  
 
В этом разделе описываются сообщения, относящиеся к аппаратному ключу. Большинство сообщений об 
аппаратном ключе вызваны неправильным соединением, неправильно введенными кодами доступа или 
взаимными помехами или конфликтами с другими аппаратными устройствами компьютера. 
Для предупреждения ошибок, связанных с аппаратным ключом, введите коды доступа сразу же после их 
получения. Если вы пропустите любой из кодов доступа, функции могут быть недоступными или же 
BERNINA artista полностью перестанет работать. 
 
Совет: После ввода новых кодов закройте BERNINA artista и затем запустите снова. Подробнее см. в 
разделе Ввод кодов защиты. 
 
Неправильный код доступа 
 
 
Сообщение  Invalid Access Code 

Неправильный код доступа 
Причина •  Коды доступа, которые вы пытаетесь ввести, не 

соответствуют вашему аппаратному ключу. 
•  Вы допустили ошибку при вводе кодов. 

Рекомендация Проверьте ID-код по таблице кодов доступа, чтобы увидеть, 
соответствует ли он ID-коду в диалоговом окне Security Dialog. 
При несоответствии запишите серийный номер вашего 
аппаратного ключа и текущий ID-код и свяжитесь с вашим 
дистрибьютором. Подробнее см. в разделе Идентификация 
вашего аппаратного ключа. 

 

424
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Аппаратный ключ (Dongle) не обнаружен 
 
Сообщение  Security device not found 

Аппаратный ключ не обнаружен 
Причина Аппаратный ключ (Dongle) конфликтует с другими 

периферийными устройствами, подключенными к тому же 
параллельному порту, аппаратный ключ не может быть 
обнаружен программой BERNINA artista или же поврежден 
аппаратный ключ. 

Рекомендация Отсоедините другое устройство, подключенное к тому же 
параллельному порту, что и аппаратный ключ. Если после этого 
аппаратный ключ будет обнаружен BERNINA artista, то это 
означает, что он конфликтует с другим устройством. 
Установите второй параллельный порт. Аппаратный ключ может 
быть подключен к любому из них. Проверьте различные 
комбинации, если у вас имеется 3 или больше периферийных 
устройств и только 2 параллельных порта. 
Если аппаратный ключ все еще не может быть обнаружен, 
переустановите его драйвер. Подробнее см. в разделе Установка 
драйвера аппаратного ключа. Удалите и заново установите 
BERNINA artista, если перечисленные выше рекомендации не 
привели к успеху. 

 
Установка драйвера аппаратного ключа 
Если ваша система не может обнаружить подсоединенный аппаратный ключ, вам может потребоваться 
переустановить его драйвер. 
 
Как установить драйвер аппаратного ключа 
1 Нажмите на панели задач Windows кнопку Пуск (Start) и выберите Run (Выполнить). 
 Откроется диалоговое окно Run (Запуск программы). 
2 В поле Open (Открыть) введите: 
 C:\artista\BIN\HINSTALL /I /PORTMODE=AUTO 
 

Примечание: Вы должны оставить пробел после L и I. 
3 Нажмите кнопку ОК. 

Появится сообщение, подтверждающее, что драйвер аппаратного ключа успешно установлен. 
4 Перезагрузите компьютер. 
 
Поврежденный продукт 
 
Сообщение  Invalid product 

Поврежденный продукт 
Причина Аппаратный ключ не может быть обнаружен или он 

поврежден. 
Рекомендация Проверьте установку аппаратного ключа, чтобы 

удостовериться, что он правильно вставлен. 
Свяжитесь со своим дистрибьютором, сообщив 
серийный номер аппаратного ключа. 

 
Ошибка защиты 
 
Сообщение  Security Device Not Found (-3) 

Аппаратный ключ не обнаружен (-3) 
Причина Повреждение аппаратных средств или аппаратного 

ключа или неправильно вставлен аппаратный ключ. 
Рекомендация Проверьте установку аппаратного ключа, чтобы 

удостовериться, что он правильно вставлен. 
Попытайтесь использовать другой порт и 
перезагрузите программное обеспечение. Если это не 
приведет к успеху, свяжитесь со своим 
дистрибьютором, сообщив серийный номер 
аппаратного ключа. 
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Общие проблемы 
 
В этом разделе рассматриваются общие проблемы, которые могут возникнуть при работе с проектами. 
 
Размеры проекта 
 
Проблема Неправильные размеры проекта. 
Причина Если размеры проекта слишком большие или слишком 

малые, причина может заключаться в неправильном 
выборе системы единиц измерения. Система единиц 
измерения устанавливается в диалоговом окне 
Стандарты (Regional Settings) системы Windows. 

Рекомендация Измените единицы измерения в системе Windows. Вы 
Выберите опцию Пуск (Start) > Настройка (Settings) > 
Панель управления (Control Panel) > Язык и Стандарты 
(Regional Settings) из меню кнопки Пуск. 

 
Несовместимые результаты вывода 
 
Проблема Проблемы при передаче проектов в вышивальные 

машины для вышивания. Несовместимость 
считывания и записи. 

Причина Проблемы с последовательным или USB портом. 
Несовместимость процессов считывания и записи 
может быть вызвана неправильной настройкой порта в 
операционной системе. Другими возможными 
причинами может быть несовместимость машины с 
версией программного обеспечения. В этом случае 
свяжитесь с вашим дилером. 

Рекомендация Измените настройки порта. 
 
 
Отсутствие кнопок на панели инструментов 
 
Проблема Отсутствие кнопок на панели инструментов. 
Причина Слишком низкое разрешение экрана. Вирус в 

компьютере. 
Рекомендация Измените разрешение экрана до 800x600 или выше. 

Запустите антивирусную программу. 
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Образцы заполнения 
орнаментными стежками 
 
Узоры заполнения орнаментными стежками, показанные в этом приложении, включены в вашу 
программу BERNINA artista. (Онлайновое Руководство содержит полный ассортимент узоров 
заполнения орнаментными стежками. Вы можете получить к ним доступ из меню Help (Справка) 
программы BERNINA artista.) О заполнении орнаментными стежками и указания по их 
использовании см. в разделе Создание заполнения орнаментным стежком. 
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Приложение I  
 
 
Примеры оконтуривания и 
заполнения узорами 
 
Примеры оконтуривания и заполнения узорами, показанные в этом приложении, включены в 
вашу программу BERNINA artista. (Онлайновое Руководство содержит полный ассортимент 
узоров заполнения и оконтуривания. Вы можете получить к ним доступ из меню Help (Справка) 
программы BERNINA artista.) Об оконтуривании и заполнении узорами и указаниях по их 
использовании см. в разделе Оконтуривание и заполнение узорами. 
 
Обозначение 
узора 

Комплект узоров Узор 

901 Children 
Детские 

 

Cnr001 Corners 
Углы 

 

301 Cross 
Кресты 

 

601 Embellishment 
Украшение 

 

705 Heirloom 
Фамильное шитье 

 

401 Home Dec 
Предметы 
домашней 
драпировки 

 

10  Misc 
Разное 

 

Feather  
Перья 

Misc 
Разное 

 

Pinstit  
Шпильки 

Misc 
Разное 

 

101 Nature 
Природа 

 

327  Quilting 
Стежка квилта 

 

501 Satin-Quilt 
Стежка гладьевым 
валиком 
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Приложение J  
 
 
 

Образцы узоров рукодельных 
стежков. 
 
Образцы узоры рукодельных стежка, показанные в этом приложении, включены в вашу 
программу BERNINA artista. (Онлайновое Руководство содержит полный ассортимент узоров 
рукодельных стежков. Вы можете получить к ним доступ из меню Help (Справка) программы 
BERNINA artista.) О применении рукодельных стежков (Craft Stitches) см. раздел Оконтуривание 
и заполнение рукодельными стежками. 
 
Узоры заполнения "Блэкуорк" 
Техника Blackwork (дословно "черная работа") получила свое название от черных шелковых ниток, 
используемых в этом виде вышивания. Узоры Blackwork можно использовать как для оконтуривания, так и 
для заполнения. В большинстве случаев при таком "черно-белом" заполнении используются простые 
стежки для создания комплексных геометрических узоров. См. разделы Настройка контуров обрамления в 
технике Blackwork и Настройка заполнения в технике Blackwork. 
 
 
 
 
Узоры Candlewicking  
 
Вышивание узелковыми строчками (Candlewicking) является традиционной техникой вышивания "белым-
по-белому", выполняемому обычно на белой льняной или хлопчатобумажной ткани толстыми 
хлопчатобумажными нитками. Узоры Candlewicking можно использовать как для оконтуривания, так и для 
заполнения. См. разделы Настройка контуров обрамления в технике Candlewicking и Настройка 
заполнения в технике Candlewicking. 
 
 
 
Узоры кружевного переплетения 
 
Стежки кружевного переплетения образуют похожие на сетку узоры, которые придают объекту вид 
кружева.  Этот метод можно применять для объектов в виде замкнутых кривых или прямоугольников, 
заполняемых стежками с единым углом наклона. Подробнее см. в разделе Настройка заполнения 
стежками кружевного переплетения. 
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Приложение K  
 
 
 
 
Образцы элементов пэчворка 
 
Образцы элементов пэчворка, показанные в этом приложении, включены в вашу программу 
BERNINA artista. (Онлайновое Руководство содержит полный ассортимент элементов пэчворка. 
Вы можете получить к ним доступ из меню Help (Справка) программы BERNINA artista.) 
Реальные проекты (файлы ART) можно найти в папке My Designs\Quilting. Файлы с 
начинающимся на букву "В" именем, - например, Block-9 Patch Square – являются 
завершенными блоками пэчворка. Файлы с начинающимся на букву "S" именем, — например, 
Shape-Fan Straight — являются полосками, помещаемыми между блоками. 
 
Примечание: Программа BERNINA artista Portfolio отображает пиктограммы и ограниченную 
информацию о проекте каждый раз, когда открывается папка с проектами. Вы можете 
отфильтровать содержимого окна отображения, чтобы показывались лишь файлы 
определенного типа. Подробнее см. в разделе Просмотр проектов в папках. 
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Приложение L  
 
 
 
 
Образцы шаблонов для 
проектов квилта 
 
Образцы шаблонов проектов квилта фирмы Holice Turnbow, показанные в этом приложении, 
включены в вашу программу BERNINA artista. (Онлайновое Руководство содержит полный 
ассортимент шаблонов проектов квилта фирмы Holice Turnbow. Вы можете получить к ним 
доступ из меню Help (Справка) программы BERNINA artista.) Реальные проекты (в формате 
ART) можно найти в папке My Designs/Holice Turnbow Stencil Quilt Designs. Некоторое 
количество проектов предлагается как в малом, так и большом формате, - например, HT105 и 
HT105LG. 
 
Примечание: Проекты, находящиеся в папке Holice Turnbow Stencil Quilt Designs, созданы 
фирмой Holice Turnbow. Эти проекты охраняются авторским правом для использования 
исключительно зарегистрированными владельцами программного пакета BERNINA artista. 
Проекты не могут быть предоставлены для совместного доступа, пересланы, проданы или 
скопированы на другие электронные средства, а также переданы лицам, не являющимся 
владельцами программного обеспечения BERNINA artista. 
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